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About This Book

Purpose 

This guide describes how to use Novell  Integration Manager, a visual design environment for creating 
business-to-business integration applications, including Web Services. This documentation provides 
information on the use of Integration Manager’s design-time features. Runtime functionality is more 
thoroughly described in the Novell Integration Manager Enterprise Server Guide. 

Audience

This guide is aimed at application designers who will be building J2EE applications (including Web 
Services) using  Integration Manager. 

Prerequisites

You should be familiar with XML-related standards (including Schema, XSL, and XPath), the Document 
Object Model, and basic J2EE concepts involving file packaging (JAR/EAR/WAR files). Some 
knowledge of ECMAScript is also helpful, though not required, for using the product. If you are building 
Web Services, you should be familiar with WSDL, SOAP, and related standards.

Additional documentation 

For the complete set of Novell exteNd exteNd Director documentation, see the Novell Documentation 
Web Site (http://www.novell.com/documentation-index/index.jsp).

Organization

This guide is organized as follows:

Chapter Description

Chapter 1, Welcome to  
Novell Integration 
Manager

Gives an overview of  Integration Manager, its capabilities, and design 
philosophy.

Chapter 2, Planning 
your Application

Describes the necessary preparations for designing and building an XML 
Integration Application.

Chapter 3, Getting 
Started in  Novell 
Integration Manager

Describes launching the product and the elements of the Integration 
Manager environment.

Chapter 4, Creating 
and Managing your 
Projects

Describes projects and their elements and explains how to create them.

Chapter 5, XML 
Templates

Describes XML templates, sample documents, DTDs, XSL stylesheets, 
and XML categories and when and how to use them.

Chapter 6, Creating an 
XML Map Component

Describes XML Map Components, using XML sample documents to build 
components, DOMs, and how and why DOMs are used.
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About the PDF Documentation

Various navigational features are available when viewing this document in Acrobat Reader:

The Bookmarks frame (left side of window) lists the contents of the document, by chapter name, 
heading, and subheading. Every topic listed in the content tree is a clickable link. To flip open the 
entire subtree under any tree node, Control-click on the parent node. To toggle the visibility of the 
Bookmarks frame, press F5.
Every item in the book’s Index is a clickable link that will take you directly to the text discussion.

Chapter 7, Basic 
Actions

Describes the core actions that are available in all of Integration Manager’s 
component editors, including map actions, log actions, various flow-control 
actions, and so on. Step-by-step procedures are given for how to create 
each action. 

Chapter 8, Advanced 
Actions

Describes advanced actions including Declare Group, Repeat for Group, 
Process XSL, Repeat While, Throw Fault, Try/On Fault, and the various 
data exchange actions.

Chapter 9, Resources Describes the various types of Integration Manager resources, including 
schema resources, WSDL, code maps, code map tables, connections, and 
custom scripts.

Chapter 10, Form 
Designer

Describes the XForm designer tools.

Chapter 11, Custom 
Scripting and XPath 
Logic in  Novell 
Integration Manager

Describes custom scripting using Integration Manager’s built-in 
ECMAScript facility. Also, a discussion of how scripting can be used in 
conjunction with XPath, DOMs, and Java. An API guide to Integration 
Manager’s built-in ECMAScript extensions is presented, as well.

Chapter 12, Applying 
Actions to Common 
Tasks

Describes element and data mapping, leaf element mapping, deep copy 
mapping, transforming elements with code tables and functions, performing 
loop actions, and performing aggregate calculations.

Chapter 13, Using the 
Animation Tools for 
Testing

Describes the animation tools and how to use them to test services and 
components.

Chapter 14, Working 
with Services 

Describes how and what services are, how to build them or import them, 
what the service editor is, and how to build a service with components. This 
chapter also contains an end-to-end example of how to call an external 
Web Service based on information contained in a WSDL resource.

Chapter 15, Working 
with Registries

Tells how to use the features associated with Integration Manager’s 
“Registries” tab, including how to search UDDI registries, publish to UDDI 
registries, retrieve WSDL from registries, etc.

Chapter 16, Preparing 
Your Project for 
Deployment

Explains basic issues relating to the deployment of Integration Manager 
services to an app server. 

Appendix A Adding 
Java Extensions to 
Integration Manager 
with XCCLASSPATH 

Describes how to make Java classpaths accessible in the Integration 
Manager CLASSPATH.

Appendix B, Reserved 
Words

Lists reserved words, which should not occur in user-defined variable 
names or labels.

Appendix C, Glossary Definitions of key terms used in this Guide.

Chapter Description
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Wherever a website address (URI) appears, you will usually find that clicking on it will take you to 
the site in your browser. Even if the URI is not in blue or underlined, it will generally be a hot link. 
You can test this by hovering the mouse over the URI. The cursor will change from an arrow to a 
finger cursor if the link is hot.
Cross-references within and between chapters are also clickable.
Use Control-N to navigate to a given page in the document. A dialog will prompt you for the page 
number. 
You can Copy PDF text to the clipboard in the normal way (by shift-dragging to select text, then 
using Control-C). Many programs will allow you to Paste (or “Paste Special”) clipboard contents as 
RTF (rich text format), retaining certain formatting features. To select large portions of text 
spanning PDF pages, first click the “Continuous Pages Mode” icon in the button bar at the bottom 
of the Acrobat window: Then shift-drag to select text (or Control-A to Select All) and Copy.
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1 Welcome to Novell Integration Manager

Web Services are fundamentally changing the way enterprises exchange information and perform 
business transactions. But to succeed in web services development, business analysts and developers 
must be able to work together on sophisticated, large, distributed applications that meet strict 
requirements for performance, security, scalability, and reliability, in the face of increasingly stringent 
time-to-market demands. 

The most important factor in making a successful transition to a services-based architecture that 
leverages modern web technologies is the availability of powerful, easy-to-use development tools. Such 
tools should be:

Purpose-built, from the ground up, for Web Services development
Tightly integrated by design—not a grabbag of unrelated pieces 
Easy to learn and use, so that a diverse team of users—from business analysts to system 
administrators to software engineers—can be productive immediately in a concurrent-development 
setting
100% standards-aware in terms of all important Web Services technologies: XML grammars 
(including SOAP), description and discovery technologies (WSDL, WSIL, UDDI), transport layers 
(HTTP and others), directory protocols (LDAP, DSML), and security-related standards, among 
others.
Compatible with diverse deployment and runtime environments: that is, a variety of application 
servers on a variety of operating systems
If Java is the programming language, the development environment should be fully J2EE-aware—
not just a 3GL IDE (integrated development environment), but a front-to-back development, 
testing, packaging, and deployment toolset with full awareness of JAR/WAR/EAR issues, 
portal/portlet architectures, etc.

Novell’s Integration Manager meets all of these criteria. 

NOTE:  Before version 6.0, Integration Manager was named exteNd Composer. The exteNd Composer 
name still appears in some parts of the product user interface (for example, the Enterprise Server console) 
and in file and directory names.

The Novell Integration Manager Product Line
Novell  Integration Manager is a development (and runtime) environment designed for rapid design and 
deployment of Web Services and XML integration applications—applications that can connect to diverse 
back-end systems and data sources. 

The Integration Manager product consists of the following pieces:

Novell Integration Manager – A visual design-time tool for creating and debugging Web Services 
and XML-enabled back-end integration applications. 
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Integration Manager Connects – Individual add-in products that augment the capabilities of  
Integration Manager to permit the XML-enablement of systems that rely on specialized data 
sources, such as EDI, CICS RPC, 3270/5250 terminals data streams, Telnet, and JMS. (The  
Integration Manager JDBC Connect, which allows communication with relational databases, is 
bundled into the core Integration Manager installation suite, as is the LDAP Connect. Other 
Connect products are available separately.)

All  Integration Manager products are certified to run under the Novell exteNd, JBoss, Apache Tomcat, 
IBM WebSphere, and BEA WebLogic application servers, with support for operating systems ranging 
from Windows NT and Windows 2000 to Linux, Solaris, AIX, and HP-UX. 

NOTE:  Novell Integration Manager Connect products each have their own documentation. This Guide 
covers only the core development environment (referred to in this documentation as Integration Manager). 
See the separate JDBC Connect and LDAP Connect guides for information on those component editors.

What Is Integration Manager?
Integration Manager offers a powerful, intuitive, point-and-click GUI (graphical user interface) for rapid 
application development, giving the business analyst or application developer a powerful tool for 
creating robust XML integration applications in minimum time. 

Integration Manager offers, among other features:

An XML editor with code-completion features for WSDL, WSIL, and other “specialty grammars”
A drag-and-drop-enabled XML mapping engine, with support for schemas, DTDs, XSL, XPath, 
and DOM Level 2
An intuitive, visual editing environment for implementing standard control-flow constructs, error 
trapping, logging, etc., without the need for extensive Java programming expertise
Realtime step-into/step-over debugging and animation, so that applications can be tested in real 
time without leaving the development environment
Support for “watch variables” at debug time
Support for To-Do lists
A multi-document interface (MDI), allowing you to work in more than one document or 
component at one time
Realtime registry browsing, with support for WSDL publishing/retrieval using UDDI registries
Autogeneration of WSDL with SOAP bindings
Built-in ECMAScript support (including a custom script editor and live console) for users who 
need fine control over business logic or data manipulation
Back-end system connectivity via  Integration Manager Connect add-ins for 3270, 5250, Telnet, 
JMS, JDBC, CICS RPC, EDI, etc.
Deployment facilities for direct deployment of projects to the app server (with context-driven 
customizations for Novell, WebSphere, or WebLogic app servers)

Integration Manager also has XForm and JSP code generation features, and many other capabilities that 
aren’t listed here for space reasons. This is just a partial list of major features.
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Who Can Use Integration Manager?
Integration Manager is targeted at business analysts, IT managers, Java developers, and other 
stakeholders in the Web Services development process. 

Integration Manager is designed to be accessible to users of various skill levels. (It is not a Java-
programming IDE.) Business analysts with little or no programming background can quickly master 
complex data transformations using Integration Manager’s drag-and-drop XML mapping features. 
Webmasters can use Integration Manager’s JSP, XForms, and UDDI browse/publish capabilities to 
assemble sophisticated web apps with no need for additional tools. Java developers can use Integration 
Manager to develop sophisticated, reusable XML components that might rely heavily on ECMAScript, 
SQL, LDAP, custom Java classes, and/or specialized packagings (WAR/EAR/JAR files). 

Because Integration Manager’s user interface is rich with wizards, picklists, and drag-and-drop-enabled 
features, users of all skill levels (regardless of domain expertise) can become productive quickly. 
Sophisticated web applications that might take months to develop using a “grabbag of tools” approach 
often can be rolled out in weeks or days using Integration Manager.

Components and Services
Integration Manager application design is based on an Action Model architecture that includes two main 
processing constructs: components and services. 

Components are executable units of work that encapsulate business logic, usually in the context of 
connectivity requirements.

For example, a typical JDBC component validates an incoming XML request document, maps the 
document’s key pieces of data to an SQL inquiry, and maps the SQL result set to an XML response 
document. All of the business logic and data retrieval functionality of this type of operation can (and 
should) be encapsulated at the component level. 

Services, on the other hand, typically oversee the execution of components and coordinate the flow of 
data between them. A typical service might wrapper a series of components that receive an input XML 
document, perform sophisticated document mappings/transformations, collect information from back-
end data sources, execute transactions on mainframes and AS/400s, process error conditions, send 
context-sensitive e-mail or JMS notifications, and/or return one or more XML response documents to the 
original requestors. By breaking up a service’s tasks into discrete components, important benefits—in 
terms of testing, debugging, code maintenance, encapsulation, and code reuse—can be realized.
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You will typically use Integration Manager to create components and services that perform B2B 
integration tasks involving data retrieval and transformation through XML technologies, including 
(optionally) SOAP and Web Services technologies. You’ll deploy these components and services into a 
J2EE application server environment, where their execution is mediated by  Integration Manager 
Enterprise Server (the Integration Manager runtime). 

What Kinds of Applications Can You Build with Integration 
Manager?

You can build many types of applications with Integration Manager, but typically you will create XML 
integration applications triggered by servlets, EJBs, custom Java objects, or incoming messages on a 
JMS message queue. Your applications might, in some cases, simply be used locally on the app server to 
provide services across local processes, with no exposure to the outside world. In other cases, your 
applications will be fully web-enabled. The interface(s) to your web-facing applications might or might 
not involve SOAP or WSDL.

In general, with Integration Manager, you can implement any kind of application where data inputs and 
outputs involve XML. You can also build services that use messages for inputs and outputs.

NOTE:  Messaging (involving Message Oriented Middleware, such as IBM’s MQSeries) is a powerful 
data-sharing metaphor in its own right, allowing the use of payloads other than XML. With Integration 
Manager and JMS Connect, you can build applications that use messages for input and XML for output; 
XML on the input side and messages for output; or messaging within an XML-in/XML-out application; plus 
other variations. 

In the simple example depicted below, a buyer and a supplier connect their respective business systems 
across the Internet using XML and Integration Manager.
20   Integration Manager User’s Guide



Your organization might want to build one or more of the following types of applications using 
Integration Manager:

Internal Application Integration Services. You may have many applications between which you 
want to exchange data from diverse sources. For example, you may want to connect an Oracle 
financial application, an SAP manufacturing application, and an in-house-developed order 
processing application together. Integration Manager will help you achieve this.
External Web Service Applications. You may have a need to expose a service to trading partners 
(or other users) via the Web. SOAP services and WSDL-based Web Services can be constructed 
quickly and easily using Integration Manager. Once you’ve designed a service in Integration 
Manager, Integration Manager will actually autogenerate WSDL for the service (and even publish 
it to a UDDI registry, if you want).
Data Warehousing Applications. Integration Manager works well with data mining and 
warehousing technologies, since Integration Manager’s key function is to map data from disparate 
sources.

Automated Business Process Management (Workflow)
Packaging business applications as Web Services opens up new opportunities for automating workflows. 
The Web Services Flow Language (one of several emerging standards for workflow automation) 
provides a standard to which next-generation BPM software will build. The basis for this next-generation 
technology is workflow built on Web Services. SOAP and XML will be key technological underpinnings 
of future workflow systems.

Integration Manager plays directly to emerging standards and technologies involving automated 
workflow. Next-generation workflow engines will “hook up” Web Services (external or internal) to allow 
sophisticated long-running applications to be built, relying on BPM concepts such as timeouts/retries, 
conditional links between services, control flow between individual services involving parallel 
execution, etc. Complex choreographies involving Web Services will be attainable. (Some of the possible 
choreographies are described in RosettaNet Partner Interface Processes.) Integration Manager will be a 
valuable tool in creating WSFL-ready applications.
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About the Integration Manager Enterprise Connect Product Line
Integration Manager is built upon a simple hub and spoke architecture. The hub is a robust XML 
transformation engine that accepts XML documents, processes the documents, and returns an XML 
document. The spokes, or Connect products, are plug-in modules that “XML enable” sources of data that 
are not natively XML-aware, bringing their data into the hub for processing as XML. These data sources 
can be anything from legacy COBOL / VSAM managed information to Message Queues to HTML 
pages.

The various Connect products can be categorized by the integration strategy each one employs to XML 
enable an information source. The integration strategies are a reflection of the major divisions used in 
modern systems designs for Internet-based computing architectures. Depending on your B2Bi needs, 
Integration Manager can integrate your business systems at the User Interface, Program Logic, or Data 
levels.

In addition to JDBC and LDAP (which are core Connects, included with all versions of Integration 
Manager), there are additional Connect products:

JMS—Java-based messaging using the Java Message Service standard. This Connect product 
provides connectivity between Integration Manager applications and any JMS-aware messaging 
system.
3270 and 5250—Seamless connectivity with two of the most common terminal data stream types.
CICS RPC—Transparent ability to interact with COBOL systems via remote procedure calls 
through CICS.
Data General—Connect with Data General hosts using DG emulation.
EDI—Create XML integration applications that are EDI-aware.
HP3000—Connect with HP3000 systems.
HTML—Screen-scrape web pages and/or remap HTML data to XML data.
Tandem—Connect with Tandem-based systems.
Telnet—Screen-scrape and interact with any Telnet data stream.
SAP—Launch Integration Manager-built services when a BAPI-enabled SAP function launches.
T27—Connect with Unisys T27 systems.
UTS—Connect with Unisys UTS systems.

NOTE:  This guide describes the basic functionality of Integration Manager. The addition of each Connect 
increases the features available to you in Integration Manager. These additional features are described in 
separate user guides that accompany each Connect.

Once you install a Connect product, the Integration Manager GUI will become updated with:
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New xObject categories corresponding to the Connection Resource types and Component types 
specific to the product in question
Specialized component editors and realtime interactive Native Environment Panels (emulation 
screens) appropriate to the target system
New action types
New menu choices and associated dialogs and wizards

These customizations and additions are automatic with the installation of the Connect and integrate 
seamlessly into the existing Integration Manager design-time environment.

Updating Your License(s)
Should the need arise to update the license string(s) associated with Integration Manager or a Connect 
product, you can do so at any time, using an intuitive point-and-click UI.

IMPORTANT:  When changing a license string, remember that it is necessary to change the string for 
the design-time environment as well as the server environment. Both procedures are shown below.

Updating Design-Time License String(s)

To update a Integration Manager product license string on the design-time machine:

1 Launch Integration Manager.
2 Under the Help menu, select About Integration Manager. A dialog appears.
3 At the bottom of the “About” dialog, click the System button. A new dialog appears:

4 At the top of this dialog, click the Licenses tab.
5 The columns of the table shown on this tab give useful information about the name and status of 

each Integration Manager product, including those that for some reason didn’t load properly. To 
edit a license string, click the Edit... button next to the appropriate string under the License column. 
A new dialog will appear.
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6 Enter a new string in the New License text field.
7 Click OK to dismiss the dialog.

NOTE:  If the string you enter is not correct, you will get an alert dialog at this point. Doublecheck 
the string and reenter it. If problems persist, Cancel out of all dialogs to return to Integration 
Manager, then contact Customer Support.

8 In the System Information dialog, check the Enabled checkbox next to the field you edited, if it is 
not already checked. 

9 Click OK (or use the Enter key on your keyboard) twice to return to Integration Manager.
10 Restart Integration Manager to make your changes take effect. 
11 If you have not already updated the same license string on the app server, continue now to the 

following procedure.

Updating Runtime License String(s)
When changing license strings in the design-time environment, it is critical that you make corresponding 
changes in the app-server environment so that Integration Manager Enterprise Server will treat the 
corresponding product(s) as enabled at runtime.

To update a Integration Manager product license string on the app server:

1 Launch the app server, if it is not already running. This should also launch Integration Manager 
Enterprise Server, if it was previously installed. 

2 Go to Integration Manager’s default Administrative Console page, which is typically at 
http://localhost/exteNdComposer/Console.

3 In the upper left corner of the main console page, hover the mouse over the words “Integration 
Manager.” (See illustration below.)

When you hover the mouse over the words “Integration Manager,” the words change color (to red) 
and new text, “Version/License Manager,” appears off to the side.
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4 Click once on “exteNd Composer.” A new page appears:

5 This is the main License Manager screen. In the center of the screen, you will see version and 
license information for Integration Manager Enterprise Server. To see additional information (and 
edit license strings), click the Licenses button. A new window appears:

6 This page shows name and status information for all installed components. Each text field in the 
License column is editable. Enter a new string as appropriate, then ensure that the correct 
Enabled/Disabled radio button is active next to the text field in question. 

7 Click the Update button next to the field in question.
8 Restart the server.
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Where To Go for More Help
Perhaps the best way to understand Integration Manager is to see it in action. The Integration Manager 
installation includes a fully functional project, in the Tutorial Solution, that you can step through to see 
how the application handles a practical business operation. See the \tutorial folder, under the main 
Integration Manager installation folder. 

For the most up-to-date documentation and tutorials (plus other resources), be sure to consult 
http://www.novell.com/documentation. 
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2 Planning Your Application

Integration Manager allows you to build robust XML integration applications that can be deployed as 
Web Services. The applications you build with Integration Manager can tie together diverse back-end 
systems, effectively XML-enabling data sources that are heterogeneous with respect to communications 
protocol, file formats, and/or operating systems. 

A Integration Manager service can include components that map and transform XML content, as well as 
other operations (such as sending email), while carrying out any kind of business logic that can be 
handled with Java or J2EE technologies. 

The number of different types of back-end systems you can reach with Integration Manager applications 
depends on how many Integration Manager Connect products you have installed. Integration Manager’s 
core installation includes the JDBC Connect for reaching into database systems. Other Connect products 
allow you to exchange data with 3270/5250 systems, take advantage of CICS RPC operations, use JMS 
messaging, establish Telnet sessions, etc. You can also use EDI data and/or execute SAP functions.

Integration Manager offers an intuitive visual interface for creating integration applications and testing 
them at design time via a powerful, interactive “step-through” debugging facility. Using simple drag-and-
drop operations, you can build extremely sophisticated XML integration applications in minutes, without 
writing a single line of Java code. When you’re done, your application can be deployed quickly to a J2EE 
application server. 

How Do I Design and Build an Application in Integration Manager?
Your approach to using Integration Manager begins the same way you begin any project: by capturing the 
requirements and by understanding the building blocks available to you to meet your requirements. 

The building blocks that you’ll use in Integration Manager are:

Services
Components
Resources
XML Templates

You can think of Components as implementing the smaller units of work that will be collected into a 
Service. Resources are things like XML schemas, custom script libraries, and connection profiles that 
one or more components might need at execution time in order to do their work. Templates are typically 
XML stub documents needed by components and services.

Care should be taken when designing and building your components so that you can achieve the greatest 
amount of reuse. For example, you can create a component that uses a common XML document to access 
information from a legacy data source and call that component for each request. The component can be 
designed to preprocess incoming requests to particular format needs so that other components won’t have 
to do the same thing on a component-by-component basis.
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What is an xObject?
You’ll often see the word “xObject” used throughout this Guide. An xObject is nothing more than a 
metadata definition of a Service, Component, Resource, or Template created by Integration Manager. All 
of the data and instructions used in a Service, Component, or Resource are persisted to disk in XML form. 
Integration Manager creates the corresponding runtime object(s) via the persisted metadata. The object 
that gets created is an xObject. 

You won’t need to worry about the low-level internals of xObjects. Integration Manager handles that for 
you. From a terminology standpoint, you can think of xObjects as the XML-storable objects that make 
up a Integration Manager application: namely, Components, Services, Resources, and Templates. 

NOTE:  If you’re curious to see what an xObject looks like inside, open any of the XML files under your 
project’s directory structure, using your favorite XML editor. 

What is a Service?
A Integration Manager service is an xObject that calls one or more components designed to perform a 
logical unit of work. A service accepts one XML document as input, uses components to operate on the 
XML data, and then produces one output XML document. Services map, transform, or transfer data 
between data sources on an XML document level. Services are the runtime deployable units that integrate 
into an enterprise scalable application server environment. A service can execute other services or 
components. Examples of services that you can build include:

Sending status information to a trading partner based on an XML request 
Retrieving data from legacy data sources in response to a Web browser request
Exchanging information between internal data sources

What is a Component?
A Integration Manager component is a set of instructions or actions for processing XML document 
elements and/or communicating with non-XML data sources. Components accept one or more XML 
documents as input, performs activities on an element level, and then produce one or more XML 
documents. You can build simple or complex components of different types and link them together to 
carry out complete business operations. They map, transform, or transfer data between XML documents 
on an XML element level. They can also move data between XML documents and external data sources 
such as live 3270 transactions and SQL databases. Components can execute other components or 
services. 

Components should be designed to perform discrete processes so that these common processes can be 
shared between services. Examples of components include:

Mapping an input request to a common standard
Accessing a relational database based on the common standard
Transforming XML documents from one standard to another

What is a Resource?
As you will see later, components and services contain Action Models that execute the mapping, 
transformation, and transfer of data within XML documents. However, there are instances when the 
operations required are more specialized and complex than the Action Model’s capabilities. This is where 
resources are used. Resources do not contain Action Models, nor do they contain input or output XML 
documents. Resources work like utilities to help components and services carry out their tasks. 

Integration Manager’s resources include:
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Code Tables—Code Tables store commonly used business code tables (for example, State and 
Region tables)
Code Table Maps—Code Table Maps transform one set of codes from a Code Table into another 
set of codes (for example, State to Region mapping)
Connections—Connections establish communications with specific sources of data in Connect 
transaction environments (for example, JDBC connections).
Custom Scripts—Custom Scripts represent a library of user-developed functions using 
ECMAScript or Java language (for example, String manipulations, accessing Java Business 
Objects)

What Is an XML Template?
An XML template contains the sample documents, definitions, and stylesheets that assist you in 
designing and testing the inputs and outputs to a component. In Integration Manager, you use XML 
templates as the inputs and outputs for the components you build. It is important to note that XML 
templates are only used during design time; deployed applications use live documents during the actual 
execution of a service.

Basic Steps for Developing a Integration Manager Service
Your application development process should take into account the following basic steps.

Plan your service(s) before using Integration Manager and gather the sample XML documents, 
definitions, and stylesheets you need
Build and test the service(s) in Integration Manager
Deploy your service(s) to the server

Part One: Plan the Service (Before Using Integration Manager)
Your Integration Manager application is based on the processing of XML documents. In planning your 
application you will want to write and analyze the requirements before designing the services. You will:

Determine input/output requirements. Where is the data coming from and where is it going to and 
in what format(s)?
Collect any existing XML documents including, if available, any standard XML documents from 
industry groups and business partners
Create input and output XML documents if required

Write the Requirements

In writing your requirements, the following questions will be useful to answer:

What does the input document look like? Does it conform to an industry standard? Do I need to define 
my own?

What does the output document need to look like? Where can I get samples? Are DTDs or XSL 
stylesheets required?

What processing components are required? Will the application need an XML Map component to 
transform XML data? Will the application need a JDBC component to connect to one or more databases? 
Can I reuse any components or resources that have already been built?

What additional resources does the application need? Are customized functions required?
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Analyze the Requirements

There are many aspects of your project that you must consider when in the design stages. 

You’ll need to know the data sources to which you need to connect. You must know what data you’ll 
need, where it will come from, and what the transmission mode will be. Among the other details you to 
consider are:

Authentication—Does the data source you plan on connecting to require authentication 
information, such as user IDs and passwords? Will you need authorization from an IT group? Will 
you need to coordinate with other departments?
Security—Are there security issues? Firewalls?
Personnel—Will you need special help connecting to data sources? Is there someone in your 
organization with the skills necessary to understand, help create, and troubleshoot or debug the 
necessary external data source connections?
Legacy Applications—Will you need to contend with terminal data streams? Relational 
databases? Message queues?
Availability—Are the data sources with which you want to connect going to be available whenever 
you want to connect with them? Can you connect as often as you wish?
Transaction Control—Will your application need to incorporate rollback/commit logic?
XML Documents—Are there existing XML documents or schemas you need to obtain from 
industry groups, standards organizations, or business partners?
Logging and Notifications—Does your application have special progress-tracking or error-
monitoring needs? Do notifications (via e-mail or JMS messaging) need to be sent when certain 
conditions arise? Does your service need to adhere to well-defined escalation procedures in case of 
problems involving credit limits, dollar amounts, supply chain difficulties, etc.?
Trading-Partner Requirements—Is your service going to be used by trading partners? Do they 
have their own security, audit-trail, timeout/retry, and/or other requirements that may put 
constraints on your application’s design?

Design the Service

Once you’ve analyzed the requirements, it’s time to design the service. Your design may now begin to 
take into account Integration Manager’s building blocks, as the illustration shows.
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As described earlier, a service is comprised of components and is the unit of deployment to the 
application server. You should have a good idea at this point how many components you will need to 
build as part of your service. For example, if you need to map data from one XML document to another 
and perform a code table conversion, you will need a component to perform that task. If you need to make 
a connection to a JDBC database and extract data, you’ll need a component to accomplish that work too. 

Part Two: Build the Service
In building the service, you will:

Create XML templates
Create needed resources for the service, such as Schema and WSDL Resources, plus others
Create executable building blocks (called Components) for the service, encapsulating the various 
stages of data retrieval and XML transformation unique to your service
Create the service using the building blocks
Test the service
Document the service (if desired)

Part Three: Deploy the Service
You’ve created and tested your service. Now it’s time to deploy it to an app server and put it into action. 
Integration Manager Enterprise Edition includes a Deployment Object facility with an associated 
Deployment Wizard to step you through the process of packaging your design time service into a 
deployable archive and then deploying it. 

NOTE:  Basic (but essential) deployment considerations are discussed in Chapter 15 of this guide. A 
more detailed discussion of deployment-related issues and procedures will be found in the Integration 
Manager Enterprise Server User’s Guide. 

How is Data Handled When a Service Executes?
Services and components pass information to one another during runtime processing by way of XML 
input and output messages and message parts. The messages and parts are parsed into DOM form 
(Document Object Model, used here to mean the in-memory object representation of a document). The 
XML output for one component or service is often the XML input for another component or service; 
however, services and components don’t actually pass these XML documents as disk files, but rather pass 
“in memory” DOM images of the files. This is an important distinction, as these DOMs can be destroyed, 
changed, and recreated during processing to achieve your data integration goals without ever being 
written to disk or actually changing any disk files. Once an XML document is parsed and loaded into 
memory, it can be manipulated by the various mapping, transformation, and transfer features of the 
component editor and transaction environment each one accesses.

SOAP Messages
SOAP (Simple Object Access Protocol ) is an industry-standard XML messaging methodology in which 
XML and/or non-XML payloads and attachments are sent (typically) over HTTP. The protocol easily 
accommodates, although it does not actually specify, many common conversational modalities. 

A SOAP transmission consists of an XML document structured as a header section and a body section, 
both of which are wrappered inside an envelope. The envelope and its contents are referred to as a SOAP 
message. The SOAP message may simply convey data, or it may contain the information necessary to 
invoke a remote service ( Remote Procedure Call). 
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SOAP is a convenient mechanism for encapsulating data and meta-information about the data. Its 
advantages over unstructured, non-standard exchange of XML data (such as sending arbitrary XML via 
HTTP POST) include the following:

SOAP is lightweight, which means it is simple, easy to implement, and adds little to the payload’s 
size or handling requirements
It’s XML
It is well suited to simple text-based transports layers (such as HTTP)
It is extensible
It accommodates security layers unto itself (such as XML Signature and XML Encryption), 
independent of the transport layer

Integration Manager includes a number of SOAP-enablement features, including the ability to send and 
receive SOAP messages from a service and the ability to control custom header information, apply (or 
decode) digital signatures, and use arbitrary attachments to SOAP messages.

For more information on SOAP-related functionality in Integration Manager, see “Planning your 
Deployment” on page 379 and “The Web Service (WS) Interchange Action” on page 174.

XML Signatures
Integration Manager provides support for XML security via mechanisms defined in the XML Signature 
standard (see http://www.w3.org/TR/xmldsig-core/). 

The XML Signature specification addresses business requirements for:

Data integrity (detection of content modification)
Non-repudiation (irrefutable proof that an order was placed, or a transaction begun, by a specific 
party)
Certificate-based authentication (positive identification of transaction participants)

Integration Manager lets you build XML integration applications that support digitally signed input as 
well as signed output, using the SOAP-header mechanisms spelled out in the XML Signature 
specification. (See above URL.) You can specify, for example, that a given Web Service must receive 
input that is digitally signed. 

Refer to the discussion of the Web Service Interchange action (later in this guide) or the discussion of 
Integration Manager-service deployment options for more information.
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3 Getting Started with Integration Manager

Integration Manager is a powerful design environment for creating, testing, debugging, and packaging 
J2EE-based integration applications. 

Starting Integration Manager
You can start Integration Manager in one of the following ways:

Exiting Integration Manager
Exit out of Integration Manager by selecting File > Exit from the main menu, or by typing Alt+F4.

Understanding the Integration Manager Environment
Integration Manager offers a rich design-time environment for creating XML-based B2B integration 
services. The services you build are deployed to a Java application server and are executed by Integration 
Manager Enterprise Server. Integration Manager lets you create, organize, and collect together all of the 
resources needed (metadata, code, JARs, JSPs, and/or other items) to deploy a web application. 

Within Integration Manager, you’ll find resource editors (for example, component editors pertinent to the 
type of resource in question), a custom script editor, and component editors for creating action models. 
See the illustration below.

Linux Doubleclick the Integration Manager icon on your desktop

In a terminal window, navigate to the directory in which you 
installed Integration Manager (for example, /home/novell/nim), 
then type:

./xc

Windows Doubleclick the Integration Manager icon on your desktop

From the Windows Start menu, click Programs > Novell 
Integration Manager > Integration Manager Designer.
Open Windows Explorer, navigate to the \NIM6\Composer\bin 
directory, and doubleclick XC.exe.
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You use Integration Manager component editors to create different types of components that can access 
various data source and map or transform XML structures and data. 

How to Get Started
Whether you are using Integration Manager to build a relatively simple XML integration service, or a 
sophisticated web service, your approach to the building process will most likely follow these basic steps:

1 Become familiar with the Integration Manager environment (explained in this chapter).
2 Create a project. A project holds all objects for the application you’re building. It is stored with a a 

file extension of “spf.”
NOTE:  A single .spf file or project can contain many components and resources of many different 
types, as well as services that use these resources and components. 

3 Create XML Categories that represent the way you want to organize the sample documents you’ll 
use to build and test your application.

4 Create XML Templates that contain the sample documents.
5 Create Resources (for example, Connections, Custom Scripts, XSD or WSDL resources, etc.) that 

you need for the project.
6 Create Components that use the templates and resources.
7 Create a Service that executes your components.
8 Prepare the project for deployment.
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About the Integration Manager Environment
You use the Integration Manager main window to create and organize objects. The individual parts of the 
window are shown below. (The Navigator Frame has been specially highlighted with a dotted-line box.)

Navigation, Message, and Content Frames
The Integration Manager window, by default, exposes three frames: a Navigation frame (on the left), a 
Message frame (at bottom), and a Content frame (at right). The size of each frame can be adjusted relative 
to the others by dragging the separator bars that separate the frames. You can also adjust the size of the 
main window in the usual ways (maximize, minimize, iconize, and stretch). For maximum flexibility in 
managing “screen real estate,” you can also hide the Navigator and Message frames individually. The 
Navigator frame’s visibility can be toggled using the left/right arrows between the Navigator frame and 
the Content frame or by pressing Control-Shift-N. The Message frame’s visibility can be toggled using 
the up/down arrows between the Content frame and the Message frame or by pressing Control-Shift-O.

Navigation Frame

The Navigator frame has two tabs at the bottom: a Project tab, and a Registries tab. The Project tab allows 
you to view Integration Manager objects in Category (top pane) and Instance (bottom pane) views, as 
shown above. The Registries tab allows you to search for and display registry entries in UDDI-type 
registries. For more information on this feature, see Chapter 14.

Message Frame

The Message Frame, at the bottom of the Integration Manager window, has four tabs: a Log tab, a Watch 
tab, a ToDo tab and a Find tab. 

Log - This tab allows you to see error messages and Log Action output in real time during your 
Integration Manager session, eliminating the need to open a log file manually or check system console 
messages. 
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Watch -This tab holds the watch list so that users can examine the data values of their variables during 
the execution or animation of a Integration Manager Service or Component. Watch is a debugging tool 
which is explained in more detail in “Adding a Watch Variable” on page -116.

ToDo - This tab contains a tree list of ToDo Action items in your open component or service. To find out 
more about ToDo actions, refer to the section entitled “The Todo Action” on page 152.

Find - This tab allows you to view search results. See “Searching for xObjects or Text” on page 64 for 
more information about using the Find command.

Content Frame

The Content Frame (upper right) displays component-editor content, including DOM trees, action model, 
and Native Environment Pane. 

Manipulating Integration Manager’s MDI Windowing Environment
Integration Manager features a multi-document interface (MDI) in which you can have multiple editor 
windows open (and visible) simultaneously. As shown in the preceding illustrations, by default multiple 
open windows are shown as a tabbed interface. However, individual windows can be minimized, 
maximized, and closed, like any other windows. In addition, they can be tiled, cascaded, or arranged 
arbitrarily by clicking and dragging. You can use the Window commands in the Integration Manager 
main menubar to control the arrangement of multiple open windows:

In addition, you can hide non-editor panes (such as Integration Manager’s Navigator and Message panes) 
by clicking on the appropriate icons in the upper right corner of the main screen. This is useful when you 
are working on an Action Model and you have no need to see the Log pane, navigator tree, etc.

NOTE:  The hide/show all panes icons will be visible only when the current editor window has been 
maximized. But you can always hide or show Navigator and Message panes individually using the 
commands under the View menu; see discussion below.

Hiding all non-editor panes explodes the current edit window to take up the whole Integration Manager 
window (except for the toolbar and menus). This is often useful when an action model contains multiple 
subpanes containing numerous DOMs, or when you are working in the custom script editor and need 
more “real estate.” 

The View menu offers additional commands that adjust your Integration Manager main window 
configuration:

Navigator Tabs is the same as typing Control-Shift-N. This toggles the visibility of the 
Navigation Frame of the main Integration Manager window. 
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Output Tabs is the same as typing Control-Shift-O. It toggles the visibility of the Message Frame 
at the bottom of the window. 
Document Tabs is the same as typing Control-Shift-D. It toggles the visibility of the Document 
Tabs. The documents themselves will still be visible, but the tabs separating them will appear or 
disappear as you toggle.

Using Title Bar, Menus, Toolbars, and Status Bar
You can manipulate objects in Integration Manager using menus and toolbars. The following illustration 
shows the title bar, main menu, and toolbar that appears when you first open Integration Manager.

Title bar

The title bar displays the name of the current project you have open. A project is a collection of 
Integration Manager services that are developed, maintained, and deployed together.

Menus

The following menu options are available.

Menu Command Description

File Menu

New Used to create new xObjects and Projects. xObjects include: services, 
components, resources, XML templates, and XML categories. Resources 
include code tables, code table maps, connections, and custom scripts. See 
“Creating an xObject” on page 59. Clicking on New followed by xObject brings 
up a dialog from which you will select the kind of object you wish to create.

Open Opens an xObject in the Detail pane. You can also open an object by 
doubleclicking on it, or by pressing Ctrl-O. See “Opening an xObject” on 
page 61.

Delete Removes an object from the Integration Manager window and deletes all 
associated files on disk. You can also delete an object by highlighting it and 
pressing Delete.

Open Project Opens an existing project.

Save Project As Saves a project under a different file name to a location you specify.

Delete Project Deletes selected project from disk.

Deploy Project Begins the deployment process. 

Archive Project Creates an archive (.ear) for the selected deployment object.

Import xObject Adds an xObject to your project. See “Importing an xObject” on page 62.

Properties Displays the properties of the highlighted object. Properties include the object’s 
header information (name and description) along with information particular to 
the object type. See “Displaying an xObject’s Properties” on page 62.

Print Prints the details of the highlighted object. You can also print an xObject by 
pressing Ctrl-P. See “Printing an xObject’s Properties” on page 62.
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Recent Displays a list of recently opened xObjects and projects from which you can 
select to open.

Exit Exits the Integration Manager application. If any components are open and 
have not been saved, you are prompted to save them or ignore the changes. 
Integration Manager can also be closed by pressing Alt-F4.

Edit Menu

Undo Deletes the last operation, returning the opened object to the state it was in 
prior to the operation. The Undo option is only available in a component 
editor’s Action Model pane. See “Creating an XML Map Component” on 
page 93.

Cut Deletes the highlighted object(s) or action(s) from the Integration Manager 
window and puts them onto the Windows Clipboard. (You can also use Ctrl-X 
to cut.)

Copy Puts a copy of the highlighted object(s) or action(s) onto the Windows 
Clipboard. (Ctrl-C also copies.)

Paste Copies the contents of the Windows Clipboard into the Integration Manager 
window. (Ctrl-P will also paste.)

Delete Removes the highlighted object(s) or action(s) from the Integration Manager 
window and deletes associated files for objects. (Pressing Delete with an 
object highlighted will also work.)

Find Finds the first instance of a string in an object. The Find option is available 
whenever you have an xObject open. See also, Find on the Tools menu.

Find Next Finds the next instance of the string you entered in the Find Text dialog box. 
The Find Next option (F3) is available whenever you have an xObject open.

Replace Replaces a string with a new string you enter. The Replace option is only 
available in a component editor’s Action Model pane. See “Creating an XML 
Map Component” on page 93.

View Menu

Navigator Tabs Toggles the display of the Navigator Frame on the left side of the main 
Integration Manager window.

Output Tabs Toggles the display of the Message Frame at the bottom of the main 
Integration Manager window.

Document Tabs Toggles the display of the tabs at the tops of the component editor pane

XML Documents Allows you to modify the display of your XML documents. Sub-headings 
include: Show/Hide, Collapse All, Expand All, View as Tree/Text/Stylized.

Windows Layout Gives you the ability to select the orientation of the various panels used in the 
component editor

Tools Menu:The options in this menu change depending upon the object type you select.

Find Finds xObjects in the project by name, a string it contains, any XML templates 
it uses, or where a component is used. 

Next Occurence Find the next occurence of the last searched for string. (F4 will also search for 
the next occurence.)

Previous 
Occurence

Find the previous occurence of the last searched for string. (You can also use 
Shift-F4.)

Menu Command Description
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Toolbar

In addition to the menu options, the toolbar contains the following buttons:

Preferences Allows you to customize General, Display, Editing and Designer Settings such 
as establishing an XML editor and Web browser, setting log file details, and 
entering proxy server settings.

Project Settings Allows you to set project global variables and manage subprojects 

Profiles Allows you to create, edit and delete Registry Profiles for UDDI, WSIL and 
ebXML registry types.

Tracing Collects connection data that can be used to diagnose and resolve 
performance issues relating to connections. This feature is designed to be 
used for debugging purposes with the assistance of Novell Customer Support 
personnel.

Window Menu:Displays all open windows. 

Help Menu

Integration 
Manager Help

Displays online help for Integration Manager.

Quick Start Displays the Web Application Development page at developer.novell.com.

Tutorials Displays a submenu with links to Integration Manager tutorials.

Documentation Displays an submenu that you use to access Integration Manager PDF 
documentation and the readme file.

Online Resources Displays online resources for Integration Manager.

Integration 
Manager Overview

Displays an online product overview.

About Integration 
Manager

Displays program and version information about Integration Manager.

Button Description

New. A dialog box allows you to select the component type you want to create.

Open. A dialog box allows you to select the component type and name you want to open.

Cut. Clicking this button removes an object from the Integration Manager window and puts in 
onto the Windows Clipboard.

Copy. Clicking this button puts a copy of the highlighted object onto the Windows Clipboard.

Paste. Clicking this button puts the contents of the Windows Clipboard into the highlighted 
object.

Delete. Clicking this button removes the highlighted object from the Integration Manager 
window and deletes its associated files.

Menu Command Description
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Status Bar

In addition to the menu and toolbar, the Integration Manager window has a status bar, at the bottom of the 
window frame, that displays the state of the currently selected object. When the status bar indicates 
READY, you can perform an operation on the object.

Understanding Integration Manager Icons
Integration Manager uses icons to represent the different object types. The list below shows the icons and 
their types.

Icon Object Type

The Service group

Web Service

The Component category

XML Map component 

The Resource group

Code Table

Code Table Map

Connection

Custom Script

The XML Template Category

XML Template Group

XML Template
40   Integration Manager User’s Guide



Navigator Frame
The main Integration Manager window has a Navigator Frame on the left, which in turn can be used in 
two different modes depending on which tab you’ve selected at the bottom. The two tabs that control the 
modes are labelled Project and Registries.

The Project Tab
When the Project tab is selected, the navigation frame contains a “Services, Components, and Resources” 
pane (top portion) and an “Instance” pane (lower portion). 

NOTE:  You can adjust the relative sizes of the two panes by dragging the small horizontal divider 
(between them) up and down.

The contents of the lower pane will change as you select different items in the upper pane. For example, 
if you click on the Web Service item in the upper pane, the lower pane will be populated with the names 
of any existing web services in your current project. 

Services, Components, and Resources Pane

The Services, Components, and Resources pane contains the four main categories of objects (also known 
as xObjects) that you’ll create with Integration Manager: Services, Components, Resources, and 
Templates.

Services

Services represent the high level units of work or business partner transactions that occur on the 
application server after you have deployed a project to your production system. They are used to combine 
various components you build to create a logical unit of work within the application server environment. 
Services are the primary objects within a project that are actually executed by Integration Manager 
Enterprise Server. Services are primarily concerned with deployment related issues and can be 
differentiated by the input they receive (URL parameters or XML documents), the type of object that 
triggers their execution (Servlets or EJBs) and the output they return (XML or HTML documents).

Components

A component is an object that accepts one or more XML documents as inputs, uses a collection of actions 
to operate on the inputs and returns an XML document as output. A component is usually called by a 
service and can contain calls to actions or other components. Components are differentiated by their 
ability to XML enable external data sources. The basic XML Map component can enable XML aware 
applications. The JDBC component can XML enable relational database systems via JDBC; the 3270 
Terminal component (installed separately by the 3270 Connect) can XML enable mainframe transactions 
through the 3270 terminal data stream; etc.

Resources

Resources are xObjects that perform specialized operations. They are used by services and components 
to help perform their tasks. Resource types include Code Tables, Code Table Maps, Connections, and 
Custom Scripts.

Templates

An XML template contains the sample documents, definitions, and stylesheets that assist you in 
designing and testing a component. You’ll create XML categories to contain similar XML templates. 
Next you’ll create XML templates, that will be used as the inputs and outputs for the components you 
build.
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Working with xObjects

You can add an object to one of the four xObject categories using the New option on the File menu. You 
can remove an object from a category by using the Delete option on the context menu (described below). 
You cannot remove a main category or add to the main categories in the xObject pane.

Each category has a plus or minus sign. The sign indicates the state of the icon in the tree. If a plus sign 
appears, you can click it to expand the category to show all child nodes under the category in question. 
Likewise, if a minus sign appears next to the icon, you can click it to collapse the category, hiding all 
child nodes.

Using the Context Menu

The top pane has its own context menu, shown next, that can be accessed by clicking the right mouse 
button inside the pane.

Using the context menu, you can create a new xObject, import an xObject, and paste an xObject that has 
been copied to the Windows Clipboard. (These topics are addressed separately in other sections.)

About the Instance Pane

The Instance pane lists all user-created objects that belong to a given xObject category. When you click 
on an icon in the upper pane, its instance objects appear in the lower (Instance) pane. 

To change the view of the Detail pane:

1 Highlight an icon in the Category pane to display its contents.
2 From the View menu, select a view option. The options are Icons and List. See “View Menu” on 

page 38.

Using the Instance Pane Context Menu

xObjects in the Detail pane have a context menu, shown below.

Menu items with functionality above and beyond the standard Windows-based functionality (Cut, Copy, 
Paste, Delete, Print) are explained in the table below:

Instance Pane 
Context Menu 
Command Description

Open Makes the highlighted object visible in the content frame
42   Integration Manager User’s Guide



The Registries Tab
When you select the Registries tab at the bottom of the Navigator Frame, the frame assumes this 
appearance:

There are two panes, labelled Organization and Service (with an adjustable divider between them). These 
panes are used for searching and retrieving information contained in UDDI registries. For more 
information, see Chapter 14.

Rename Changes the name of the highlighted object.

Properties Displays the properites of the highlighted object. Depending on the type of 
object highlighted, this could open a dialog with a tabbed interface containing 
several panels.

Find Where Used For components and XML templates, this choice opens the Find dialog and 
automatically searches the project for other objects that reference the 
selected object.

XML Templates have the following additional menu items

Edit Sample Displays a list of XML documents that are included in the selected XML 
template and allows you to edit them in an XML editor. This option is available 
only when an XML template is selected.

Edit DTD Displays a list of Document Type Definition (DTD) files and allows you to edit 
them. This option is available only when an XML template is selected.

Instance Pane 
Context Menu 
Command Description
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Configuring Integration Manager’s Environment
You can configure Integration Manager in a variety of ways to meet your design-time requirements. The 
Preferences and Project Settings tabs located under the Tools menu are meant to assist you in customizing 
your user experience.

Setting Preferences
The Preferences dialog (available under the Tools menu) has four tabs: General, Display, Editors and 
Designer. The function of each tab is described below.

General Preferences

Using the up/down (spin) control, set the Number of Recent Projects to display under File>Recent
Similarly, set the Number of Recent Objects to display under File>Recent
Select a name and location for the System Log File by typing one in or clicking on Browse.
Check Overwrite system log if you want the system log cleared each time you start Integration 
Manager.
Check Show Stack Trace to turn on the functionality to log the stack traces to the log file.
Set the Log Threshold to a value from 1 to 10. This value is a threshold value that controls which 
Log actions execute inside a component and which system messages get written out. Only Log 
actions with a priority setting equal to or greater than this number will execute. (See the“Log 
Priority Levels” section in the “Basic Actions” chapter, page 135.)
NOTE:  Set this value to 10 if you wish to see all system messages (error messages); set it to a 
lesser value if you want to see only minimal system messages.

Select the executable you wish to use as your HTML browser. This will default to Internet 
Explorer.
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Display Preferences

Check Use System Settings if you would like Integration Manager to reflect your default Windows 
look and feel for colors, menu font sizes, etc. Uncheck to use the standard Integration Manager look 
and feel.
Check Show Comments in Tree View if you want the be able to see XML comments. Uncheck to 
hide comments when viewing as a tree.
Check Display Icons on Tabs if you wish to see icons on the Project and Registry tabs. Uncheck to 
hide the icons.
By default, Display Animation Complete Messages is checked, indicating that “Animation 
Complete” messages will be displayed. Uncheck if you do not wish to see these messages.
Using the up/down (spin) control, set a number for the Directory Display Length for most 
Recent. This is used for both recent projects and objects.

Editing Preferences

Type the fully qualified path of the selected XML Editor or click Browse to locate the application 
on your disk or network.
Specify an XSL Editor as indicated above.
Specify a JSP Editor as indicated above.
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Designer Preferences

The Use a proxy server check box pertains to the Data Exchange actions during component 
execution in Integration Manager. If the URL referenced in the action goes through a proxy server, 
click the Use a proxy server check box, then type in the Address and Port of the proxy server.
Click Advanced to set up Proxy Settings. (These are described in “Entering Advanced Proxy 
Settings” below.)
Under Startup Options, you can set a value for Minimum Memory and Maximum Memory to be 
used on startup.
You can also check the Display Java Console box 
If you have installed the Enterprise Edition version of Integration Manager, you will see a group of 
controls relating to Transaction Emulation. (These controls are not available in the Professional 
Edition version.) Select the type of Transaction Emulation to use for design-time testing purposes. 
(This is a design-time setting only. You control runtime transaction behavior via individual 
actions.) Your choices are:
Servlet or Bean-Managed—Means that transacted action models or code blocks will roll back or 
commit in accordance with explicit calls made via Transaction Actions.
Container-Managed—Means that transaction scope is managed by the EJB container. If Begin, 
Commit, or Rollback commands are issued within a component, an IllegalStateException is 
thrown.
NOTE:  See your Integration Manager Enterprise Server Guide for a more detailed explanation of 
transaction control as it applies to deployed services

Entering Advanced Proxy Settings
If you check Use a proxy server in the Tools>Preferences>Designer dialog box, you can enter 
advanced proxy settings. These settings establish the connections to HTTP and FTP servers, and allow 
you to exclude certain addresses from using the proxy server.

To enter advanced proxy settings:

1 From the Tools menu, select Preferences.
2 Select the Designer tab.
3 Make sure Use a proxy server is checked.
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4 Click Advanced. The Proxy Settings dialog box displays.

5 Type an Address and Port for the HTTP and FTP servers. If both are the same, fill them in for one 
server and check Use the same proxy server for all protocols.

6 If you will be going to a site that requires NTLM authentication, check the Requires NTLM 
Authentication checkbox. Then click the Set button. A new dialog will appear:

Enter the appropriate information for UserID, Password, and Domain, then dismiss the dialog by 
clicking OK.

7 Type the addresses you do not want using the proxy server(s). Separate the addresses with a pipe 
character (|).

8 Click OK to return to the Preferences dialog box.
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Project Settings
The Project Settings dialog (available under the Tools menu) has two tabs: Project Variables and 
Subprojects. The function of both tabs is described below.

Project Variables
You can think of Project Variables as being global variables with project scope. They are stored in their 
own XML document, which gets deployed with other project resources at deploy time. This tab allows 
you to specify the names and initial values of any global variables you want to use, with intra-project 
scope. (These variables will apply in the deployed project as well as at design time.) The variables are 
actually stored in an XML document at an XPath of $PROJECT/USERCONFIG. 

To create project variables:

1 From the Tools menu, select Project Settings. The Project Variables tab is selected by default.

2 Click the plus-sign icon in the dialog’s mini-toolbar to add a variable. Click minus to remove a 
selected variable.

3 After adding a new variable, enter its name under Element Name and an initial value under Text 
Value. (Project variables must have String values.)

4 In the text field at the bottom of the dialog window, enter a deployment context for your variables. 
This can be any number of labels separated by periods. (See illustration above.)
NOTE:  Do not use Java keywords such as protected, default, int, new, try, etc., in your context 
string. For the complete list of reserved words, see “Reserved Words” in the appendix.

5 Click OK to dismiss the dialog.

NOTE:  For further information on Project Variables, see “Creating Project Variables” on page 66.

Subprojects
The Subprojects tab of the Project Settings dialog is where you can add or delete subprojects (other 
Integration Manager-created .spf projects) to your current project.
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The advantage to importing projects in this way is that it can be done without actually making new copies 
of all the necessary files. This subject is discussed in detail in Chapter 4, “Creating and Managing Your 
Projects”. Refer to that section for instructions on using this tab of the Project Settings dialog.

The xconfig.xml and xuserpref.xml files
Your modifications to all the Preferences and Project Settings outlined in the foregoing pages are actually 
stored in two XML files called xconfig.xml and xuserpref.xml, located in the Integration Manager bin 
directory. These files can be edited directly, if you want, but in most cases the quickest, most convenient 
way to make changes to them is to use the Preferences and Project Settings dialogs as described above.

Integration Manager Online Help
Integration Manager has several forms of online help to assist you when using the program.

You can access context-based help at any time by using the F1 key on your keyboard, or by using the 
Integration Manager Help command under the main Help menu.

NOTE:  The first time you call up the help system, you may notice a brief delay while the system is being 
loaded and cached into memory. This delay will not occur on subsequent accesses of the help system.

Figure 0-1:

Using Online Help
You can call for online help at any time by clicking F1. A new free-floating, non-modal window like the 
one above will appear.
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NOTE:  If you were in a modal dialog at the time you press F1, you will normally see context-sensitive 
help in the content pane of the help window.

The content of Integration Manager’s online help system comes from the product documentation and 
basically duplicates the PDF documentation, only in HTML form. The HTML files are organized in your 
installation directory. To find the HTML files for a particular product’s help, go to 
\Docs\help\Composer\books\ in the Integration Manager installation directory. You can view these 
HTML files with your favorite web browser, if you want. You do not have to use Integration Manager’s 
viewer.

Note that Integration Manager’s online help viewer gives you access to all help topics in one consolidated 
helpset. 

Navigating Online Help
Integration Manager’s help system offers three navigational options, represented by a Contents tab, an 
Index tab, and a Search tab at the top of the left-hand (navigation) frame. (See graphic, above.)

Content Browsing

Select the Contents tab to see a complete listing of all help topics covering all installed Integration 
Manager products. 

The “book” icons represent folders. Click any book icon to expand the tree under that folder level. (The 
content pane will not show useful content when a book icon is selected. Select a topic beneath the book 
for detailed content.)
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“Page” icons (containing a question mark) represent individual topics for which detailed help is 
available. Single-click any page icon to see related content in the content frame of the viewer.

NOTE:  When focus is in the nav frame, you can traverse topics quickly by using the up-arrow and down-
arrow keys. You can also expand a folder (book icon) by hitting the Return key.

Index

Select the Index tab to populate the nav frame of the help window with an alphabetized index of topics. 
Single-click any topic in the list to see its content. 

Select any symbol or letter from the listing at the top of the frame to see the matching topic references in 
the index listing. This is usually faster than manually scrolling through each symbol and letter.

Keyword Search

The fulltext search engine uses a natural language search technology where matches returned from 
Searches are ranked for relevancy using “relaxation rules.”

The red circle in the first column of search indicates the relevancy rank, with a completely filled in 
circle indicating the most relevance and less filled in circles indicating less relevance. 
The number next to the circle indicates the number of matches the search engine found for the topic 
listed in the third column. 
The third column displays the names of the topics that contained matches. (See graphic, below.) 
The ranking and relevance ratings improve when search queries are more complex and contain 
more information.

Single-click any “hit” in the nav frame to see related content in the content frame. The viewer will 
automatically scroll any relevant section(s) of text into view; and you will see that “hit words” are 
highlighted in mauve. See below.

The search engine also uses a word morphing technology to find words with common roots. For example, 
when the term “build” is included in a search string, matches that contain “built”, “builder”, “building”, 
and “builds” are returned. 
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Help likewise performs partial text searches. For example, entering the letter “x” in the Index Find box 
will locate: examples, execution errors and XML Integration. Help will also find close matches to a whole 
word so that searching for execute finds “execute” and “executes.” 
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4 Creating and Managing Your Projects

What is a Project?
A project is a collection of Integration Manager objects designed to perform XML based B2B integration 
services. A project holds all the objects for the application you’re building, and is the unit that is deployed 
to the application server. You may deploy as many projects to an application server as you wish. 

The illustration shows the parts of a project.

About Services
A service is used to combine the various components you build to create a logical unit of deployment for 
the application server. Services are the objects that are actually executed within the application server. A 
Web Service is started by a Service Trigger object and accepts XML document(s) as input(s), returning 
XML documents as output. A JMS Service accepts messages as input and is triggered by the arrival of a 
message on a queue. For more information, see “Creating a New Service” on page 356.

About Components
A component is an xObject that accepts one or more XML documents as inputs, uses a collection of 
actions to operate on the inputs, and returns an XML document as output. 

A component is usually called within a service and can contain calls to actions or other components. 
(Services are basically collections of components.)

For more information about how components work, how they are created, and underlying design 
principles, see “Creating an XML Map Component” on page 93.
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About Resources
Resources are xObjects that perform specialized operations. They are used by services and components 
to help preform their tasks. Resource types include Code Tables, Code Table Maps, Connections, and 
Custom Scripts.

About XML Templates
An XML template contains the sample documents, schemas, and stylesheets that assist you in designing 
and testing a component. You’ll create XML categories to contain similar XML templates. Next you’ll 
create XML templates, then use the templates as the inputs and outputs for the components you build. For 
more information, see “About XML Templates” on page 75.

Creating a New Project
When you first start Integration Manager, a sample project, called Tutorial, is loaded. When you begin 
your own application, you should start by creating a new, empty project.

To create a new project:

1 Select File, then New, then Project. The New Project dialog box appears.

2 Type in a Project Name. This is a required field. Integration Manager adds the project name 
extension, which is.spf.
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3 Select Browse to locate the folder where you want your project to reside. The Project Location 
dialog appears.
NOTE:  If you have a project open, the Project Location dialog defaults to the folder where the open 
project resides.

4 Navigate to the folder where you want your project to reside.

5 To create a new folder in which to save your new project, click the New Folder icon ( ) A folder 
called “New Folder” will appear in the list of folders in the current directory. Click this new entry a 
single time to highlight it, then click again to rename it to an appropriate Folder Name.

6 Click OK. The File Location dialog appears with the newly-created folder in the Look In: field.

NOTE:  The File Name in the Project Location dialog defaults to the project name you designated 
in step 2.
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7 Click OK. The New Project dialog appears with your newly-created Project Name and Project 
Location displayed.

8 Enter a deployment context string in the bottommost text field of the dialog. The string should 
contain labels (no spaces) separated by periods, as in “com.server.apps.”
NOTE:  The context string should not contain Java-language keywords, such as try, catch, finally, 
int, for, etc. For a complete list of Java keywords, see the “Reserved Words” appendix.

9 Click OK. The Integration Manager window appears with the name of the project you just created 
in the title bar.

Opening Projects
You can open a project in the following ways.

Opening a Project from within Integration Manager

To open an existing project:

1 Select File then Open Project. The Open Project dialog appears.
56   Integration Manager User’s Guide



2 Click the Browse button. Optionally, you can type in the path of the project you wish to open. The 
Project Location dialog appears.

3 Navigate to the directory where the project you’d like to open resides.
4 Select the project.
5 Click OK. The Open Project dialog appears with the path of the project you just chose in the 

Project File field.

6 Click OK. The Integration Manager window appears with the name of project you just opened in 
the title bar.

NOTE:  You can also open a project by selecting a project from the Recent Projects list on the File menu.

Opening a Specific Project When Starting Integration Manager from the Command Line
As a startup option, you can launch Integration Manager by running XC.exe in command-line mode, and 
you can specify a project name parameter, such as:

C:\Program Files\Novell\NIM6\Composer\Bin\xc myproject

In this example, XC.exe is run with a project file named myproject.spf.

Opening a Project when the Recent Project is not Found
When you launch Integration Manager, the last project you worked on is automatically loaded. If you 
moved the project files, or if you are trying to access another user’s project that is inaccessible, 
Integration Manager may not be able to find your project.

At startup, Integration Manager uses the first command line parameter for the name of the project file to 
open. If the command line parameter is omitted (or is invalid), Integration Manager uses 
DEFAULTPROJECTFILENAME from xconfig.xml as the project name to open. If both the command 
line option is omitted or invalid and the DEFAULTPROJECTFILENAME is omitted or invalid, then 
Integration Manager displays the Project Create/Open dialog.
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The Project Create/Open dialog allows you to create a new project, open an existing project, or exit 
Integration Manager altogether, as well as providing relevant error information regarding the failure to 
open an initial project.

To locate a project at startup:

1 On the Project Create/Open dialog, do one of the following:
Select New Project to display the New Project dialog.
Select Open Project to locate your project.
Select Exit Integration Manager to search for the project. For more information about where 
project files are stored see “Understanding Where Project Files are Stored” on page 65.

2 Click OK.

Deleting a Project
You can use Integration Manager to delete an entire project and all its objects from your disk drive, or 
since projects are stored in normal directory structures, you can use standard windows delete functions. 
In either case, if you do so, the project will be permanently deleted and unrecoverable.

To delete a project:

1 Select File then Delete Project. The Delete Project dialog appears.

2 In the Delete Project dialog do one of the following:
Provide the full path and project.spf file of the project to be deleted.
Select the Browse radio button to locate the project you want to delete.

3 Click OK. The Confirm Project Delete dialog appears.
4 Select Yes.
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Saving a Project Using a Different Name
You can save a copy of the currently open project using a different name or save the project to a different 
directory.

To save a project using a different name:

1 Select Save Project As from the File menu.
2 Follow the steps given in “Creating a New Project” on page 54, from Step 2.

Managing xObjects
xObjects are the building blocks of all XML integration services. In order to build project components, 
you can either:

Create xObjects
Open existing xObjects
Import xObjects from other projects
Do a combination of the three above

Creating an xObject
You can create xObjects from the menubar and use them in components.

To create an xObject:

1 From the File menu, select New, then select xObject. Alternatively, you can click with your right 
mouse button on the type of xObject you wish to create in the navigator pane and select New.

2 Tab to select the type of xObject to create. The choices are Process/Service, Component, 
Resource, or Template.

3 If you select Process/Service, you can create a new Web Service. You may have additional choices 
depending on what services you have installed.
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4 If you select Component, select a component type. The visible choices depend upon which 
Connect products you have installed.

5 If you select Resource, select a resource type. There are several choices available by default and 
again, the visible choices will depend on what Connect products you have installed.
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6 If you select Template, you have the choice to create a new Template Category, or a new Template.

7 In any of the four cases, once your selection is complete, type a name for the xObject.
8 Complete the rest of the xObject definition screens. Click Finish to complete and save the xObject.

The xObject is placed under the category in Integration Manager appropriate for its type.

NOTE:  The xObjects you create are themselves stored as XML files on your hard disk in a directory of 
the same name as the category they’re in.

Opening an xObject
If there are existing xObjects in the current project, you can open them from the main Integration 
Manager window to edit or view the contents.

To open an xObject:

1 To open an existing xObject, from the File menu, select Open. Alternatively, highlight any existing 
xObject in the Instance Pane and press Ctrl+O. Either of these methods will display the Open 
xObject dialog box.

2 Select the xObject type you want to open.
3 Select the xObject.
4 Click OK.

The xObject is opened in its own window.

NOTE:  To open an xObject directly, doubleclick on it in the Instance Pane, or highlight it in the Instance 
Pane, click with your right mouse button and select Open.
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Importing an xObject
Besides opening xObjects, you can import them from another project or location.

NOTE:  The xObjects you create are themselves stored as XML files on your hard disk in a directory of 
the same name as the category they’re in. To import an xObject, select the xObject’s XML file as detailed 
below.

To import an xObject:

1 From the File menu, select Import xObject. The Import xObject dialog box appears.

2 Select the xObject type you want to import.
3 If you selected XML Template, select a category.
4 Type the path and filename of the xObject, or click Browse and search for the xObject. You may 

also read in a file from a URL by explicitly preceding your filename with “http://,” “https://” or 
“ftp.”

5 Type a name for the xObject or keep the original name.
6 Optionally, type any descriptive text, or keep the original text.
7 Click OK.

The xObject is placed under the category in Integration Manager appropriate for its type.

Displaying an xObject’s Properties
All xObjects have properties associated with them. Properties include their name, descriptions (header 
information), and other information specific to the xObject type.

To display the properties of an xObject:

1 Highlight an xObject in the Detail pane.
2 From the File menu, select Properties.
3 Click the tabs in the Properties dialog box to view the Header and XML properties.

NOTE:  You can also click the right mouse button and select Properties from the context menu.

Printing an xObject’s Properties
In addition to viewing the properties of an xObject, you can also print the properties. When you print an 
xObject, the time and date of the print, along with the name of the xObject and all Header and other 
information specific to the xObject type is included. 
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If you print the properties of a component, all data concerning the component’s DOM structures (See 
“What is a DOM?” on page 94) as well as its Action Model (See “About the Action Model Pane” on 
page 108) are printed.

To print the properties of an xObject:

1 From the File menu, select Print. Alternatively, highlight any existing xObject in the Instance Pane 
and press Ctrl+P. Either of these methods will display the Print dialog box.

2 Select an xObject type.
3 Select an xObject.
4 Click OK.
5 Set any printer options and click OK.

You can also select an xObject first and print it.

To print a selected xObject:

1 Highlight an xObject in the Detail pane.
2 Click the right mouse button and select Print from the context menu.
3 Set any printer options and click OK.

Renaming an xObject
To rename an xObject, right-click the xObject and select Rename. Type a new name into the text field. 

NOTE:  Changing the name of an xObject on its Properties page causes a Save As operation, preserving 
the original and creating a duplicate with a new name. To change just the name of an xObject, use the 
Rename option on the context menu.

Deleting an xObject
To delete an xObject, right-mouse click it, and select Delete. Confirm that you want to delete the xObject.
Creating and Managing Your Projects 63



Searching for xObjects or Text
The bigger your project gets, the more services, components, resources, and XML Templates it will 
contain. You may find it difficult, at times, to locate information with such an overwhelming number of 
objects at your fingertips. The Find tool is designed to help you locate xObjects, text within objects, or 
objects that reference a given XML Template or Component. 

To find an xObject in your project:

1 Select Tools then Find. The Find dialog appears.

2 There are several different ways to select and specify the methods you wish to search by.
Contained Text allows you to type a string to search for. This type of search will inspect all 
xObjects registered with your project. The entire text of the object will be searched, not just its 
name. Ignore Case can be toggled on or off.
Named allows you to inspect all the xObjects registered with a project by name. An asterisk ( * 
) can be used as a multi-position wildcard.
Uses Component allows you to search by component type and, if desired, by name within 
component type. If you search within a Web Service component, the search will inspect other 
components that have actions containing calls to the Web Service you have selected. Similarly, 
if you have the Process Manager installed, searching a Process component will also inspect all 
sub-process activities that use the target process.
Uses Resource allows you to search among resource type objects, including Code Tables and 
Code Table Maps, Connections, JSPs, XML Schemas, Custom Scripts, Service Providers, 
Service Provider Types, WSDL and WSIL
Uses XML Template allows you to search among your XML templates.
Any combination of the above search methods can be used.

3 Click Search.

When located, the target xObject(s) are shown in list form in the Find tab of the Integration Manager 
main window. Any component or object in the search-results list can be opened by doubleclicking it. As 
in the Category pane of the navigation frame, the icon next to the xObject indicates its type (component, 
service, resource, or XML Template).

Selecting Tools>Next Occurrence or pressing F4 will find the next result for the specified search. 
Selecting Tools>Previous Occurrence or pressing Shift-F4 will find the previous result for the search.
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Viewing System Messages
During the execution of a component, certain messages (for example, internal system messages from 
Integration Manager, or text specified by Log actions) are written to a log file, xcsyslog.txt. You can 
specify the location of this file by altering the contents of the xconfig.xml file (which is in the \bin 
directory of your Integration Manager design-time installation). Look for the <LOGFILE> element in 
xconfig.xml and change its contents to the desired pathname.

NOTE:  The easy way to change the log file path is to enter a new path in the General tab of the User 
Preferences dialog. Use the Preferences command under the Tools menu to bring up this dialog. See 
“Configuring Integration Manager’s Environment” on page -44.

At animation time or when executing a component in Integration Manager, system messages (and Log 
Action output) will appear in real time in the Message pane at the bottom of the main Integration 
Manager window. Select the Log tab at the bottom of the window. (If the Message pane is not visible, 
choose View > Output Tabs from the main menu.)

Understanding Where Project Files are Stored
All Integration Manager objects (projects, XML categories, XML templates, components, resources, 
services, etc.) that you create are stored in folders with names that match the object type.

When you create a project, the project file (for example, myproject.spf) is stored in a folder named after 
the project (assuming you manually created a new folder for the project). As you build your application 
by creating XML templates, resources, and components, the created objects are stores as XML files 
within sub folders of your project folder. So creating a service named “AcceptInvoice” creates an XML 
file named “AcceptInvoice.xml” that contains all the actions performed by that service. All XML 
template categories are stored under “XMLCategories” by name of category. All XML Templates are 
stored under category by name of template. All XML samples for a category (that is, there could be more 
than one template) are stored under “Imports” by name of sample document.

The illustration below shows an example of where files are stored.

About Design Time and Deployed Project Files
All XML documents and support files are part of a project. After you deploy your project, the project files 
are stored in a Java Archive file (a JAR file).
Creating and Managing Your Projects 65



The following table shows what files constitute a project:

Creating Project Variables
A project variable allows you to designate a value for an element and use the specified element globally 
in all components and functions you create. Unlike ECMAScript “globals,” which are scoped to the 
component in which they are used, project variables are scoped to a service’s session, which means they 
can be used by any number of components running inside a Integration Manager service.

Project variables are implemented as values stored in an in-memory DOM called $PROJECT. This DOM 
is in turn derived from a file that Integration Manager creates for every project called PROJECT.xml 
(which later gets deployed to the server). 

NOTE:  Changes to project variables that occur at runtime are not persisted across service invocations. 
In a production environment, PROJECT.xml is read-only. (To create persistent globals, you would need to 
read and write your own scratch file using XML Interchange actions.)

Because they are global in scope, project variables can perform important functions during both design-
time development of your project and runtime maintenance of your project after deployment. 

At design time, project variables provide a convenient means of centralizing project-wide values that 
might need to be used in multiple places in a project. At deployment time, the project variable file 
(PROJECT.xml) provides a convenient way of updating a project’s static variables. After deployment, 
you can conveniently change the behavior of multiple deployed components and services by updating 
just the deployed PROJECT.xml file on the application server. 

Examples of items that might best be stored as project variables include:

Any URL referenced within components for items such as:
Log file paths
DTD and Schema paths
XSL stylesheets
XML Interchange URLs

Send Mail—Mail Server Identification
Authentication information needed for establishing connections with databases or back-end 
systems
Message queue names
Versioning info applicable to your services and components

The process of updating the PROJECT.xml file is described in detail in Integration Manager Enterprise 
Server Guide.

Project File Name Description

[projectname].spf Integration Manager project file. Stores startup 
information for your project. This file is created when you 
create a new project.

PROJECT.xml This is an optional file that Integration Manager creates. 
It contains project variables that you define. See 
“Creating Project Variables” on page 66 for more 
information.

[projectname].jar A Java Archive that is created during deployment. 

*.xml, *.xsl All XML samples, definitions, and stylesheets you use in 
designing your application are stored in folders under the 
project folder.
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Adding a Project Variable to a Project
You create the names of project variables that map to specific values. By making the reference of certain 
information indirect through a project variable, you can change the data in one place and be assured that 
all places where it is used will get the same new values.

To add a project variable:

1 Select Tools then Project Settings from the Integration Manager window. The Project Settings 
dialog appears.

2 By default, the Project Variables tab will be displayed.

3 Click the Add New Variable button. A blank field appears in the Project Variable window.

4 Click in the blank Element Name field and type an element name. For example, type the element 
“CompanyName.” Do not use spaces.

5 Click in the blank Text Value field and type a text value. For example, “ACME Widget Co.”
6 Click OK. 

The Element Name and Text Value that you just created are now stored in a project XML file called 
PROJECT.xml. This file can be manually edited after you deploy your project, if you need to change the 
variable value.

The Element Name and Value are automatically added to Integration Manager dialog boxes for your use 
in building components. For example, the variable is available for use in functions.
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Creating Project Variables Dynamically
In addition to creating permanent (static) project variables, you can also create project variables 
dynamically within a component or a service.

The $PROJECT DOM is always present in the DOM lists (dropdown menus) that display in the Map 
action dialog. It’s a very simple matter to create a project variable and assign it a value, because you can 
map to the $PROJECT DOM the same way you would map elements and element values to any other 
DOM (including via drag-and-drop).

NOTE:  You can view the contents of the $PROJECT DOM in tree, text, or stylized form at any time by 
choosing Window Layout from Integration Manager’s View menu and making the $PROJECT DOM 
visible. See the discussion under “Using Window Layout and Show/Hide in the Component Editor” on 
page 101 of this guide.

If you look at the structure of the PROJECT.xml file, you’ll see that the root element is called 
USERCONFIG. User-defined variables are attached to this node as child elements. The string values of 
the child elements are the values of the project variables corresponding to the element names.

In addition to user-defined project variable names, you will also see Integration Manager-defined 
elements under USERCONFIG, because Integration Manager uses the PROJECT.xml file to persist 
certain project preference values.

Dynamically created project variables are, of course, volatile. You can use dynamic project variables for 
the lifetime of the executing service (which may in turn call many components that use it). When the 
service finishes executing, the dynamic variables are destroyed, since they were created in memory.

You can reassign values to a project variable as many times as needed, by mapping to its node in the 
$PROJECT DOM. An example of this follows.
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To create a dynamic project variable and map a value to it:

1 Doubleclick a service in the instance pane. The Service editor window appears.

2 In the main menubar, select Action, then Map. The Map dialog appears.

3 Click the Expression radio button in the Source section of the Map dialog.
4 Type in a value for your project variable in the Source field. If the value is a string, don’t forget to 

enclose it in double quotes.
5 There are two ways to enter the target expression:

Click the Expression radio button in the Target section of the dialog and type
PROJECT.createXPath(“USERCONFIG/MYPROJECTVAR”) 
in the Target field, where MYPROJECTVAR is the name of the project variable you wish to 
create—or:

Click the XPath radio button under Target, select PROJECT from the dropdown menu, and in 
the field underneath type:
USERCONFIG/MYPROJECTVAR

in the target field, where MYPROJECTVAR is the name of the project variable you wish to create. 
(See above illustration for the completed dialog’s appearance.)
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6 Click OK. The dynamic variable you just created now appears in the Action pane of the Service 
editor window.

Subprojects within Projects
You can include other Integration Manager projects within your current project—a feature designed to 
foster rapid application development via reuse of existing xObjects. When external projects are reused in 
this fashion, they are called subprojects. A subproject’s xObjects are exposed in the current project’s 
Category and Instance panes, in the usual way, except that a project prefix appears before the name of 
each object, to identify the object as coming from a named subproject. An example is shown below.
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To include a Subproject in a Integration Manager Project:

1 Under the Tools menu on Integration Manager’s main menubar, choose Project Settings. 
2 Select the Subprojects tab of the Project Settings dialog, as shown below.

3 Click the plus-sign icon in the upper left part of the dialog to add a subproject. A dialog will 
appear, allowing you to browse your file system. Choose any .spf file that was created by 
Integration Manager; it will appear in the list of subprojects. 
NOTE:  If the .spf you choose already contains a subproject of its own, you will get an error dialog 
advising you that you cannot add subprojects containing subprojects.

4 Click the Relative checkbox if you want to change the location of the subproject to a relative path 
(to the main project.spf). If the project is on a separate drive than the main project, then the Relative 
checkbox is disabled.

5 To remove a subproject, select it and then click the minus-sign icon.
6 Add as many subprojects as you like, by repeating Step 3.
7 Dismiss the dialog by clicking OK. Your subproject’s xObjects will appear in the detail pane of 

Integration Manager’s nav frame. They can be distinguished by the appearance of a 
namespace/colon prefix on each xObject name.

Imported xObjects versus Subprojects
To achieve object reuse, you can import xObjects directly, one-by-one, into a given project, rather than 
take advantage of subprojects. (See “Importing an xObject” elsewhere in this chapter.) But the 
disadvantage of importing an xObject is that it results in the original object’s underlying XML files being 
copied into the current project. This can pose code maintenance problems, in that alterations or updates 
of the original xObject will need to be made, also, in any copies of that object that might exist in projects 
that imported the object. This is not true for subprojects. When you include an external project within 
your current project, no additional copies of the subproject’s source files are made. All “source code” 
stays in one place, simplifying maintenance.

Nesting of Subprojects
Nesting of subproject beyond one level s is not supported. A given project can have any number of 
subprojects, but they must all be at the same level (one level deep). This also means that a project 
containing one or more subprojects cannot serve as a subproject for another project. For example, 
consider the case where Project A contains a subproject named Project B. A third project called Project 
C could not use Project A as a subproject, although it could use Project B. 
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If you attempt to add a subproject to your current project, and that subproject contains its own 
subprojects, you will get a warning as follows:

Scope and Visibility of xObjects and Variables in Subprojects
The sharing of xObjects and variables among projects and subprojects is limited by certain scoping rules 
that you should be aware of.

1 xObjects: A project can access a subproject’s components (and other xObjects), but the subproject 
cannot access the parent project’s objects. For example, if Project A contains Project B as a 
subproject, the components in Project B (the “child” project) cannot address components or 
resources in Project A (the parent).

2 Project variables: Variables derived from the $PROJECT DOM (see “Adding a Project Variable to 
a Project” earlier in this chapter) belong to the project in which they were created. Components and 
services in Project A cannot “see” project variables belonging to Project B, nor vice versa.

3 ECMAScript variables and functions: The lifetime of script variables is always scoped to the 
component. When a component goes out of scope, any ECMAScript variables it may have used 
also go out of scope. Custom Script resources in a subproject, on the other hand, are accessible to 
the main project, via a built-in Integration Manager ECMAScript extension called the Projects 
object. For example, suppose that the current project, Project A, contains a subproject, 
MyOtherProject; and suppose MyOtherProject contains a Custom Script resource in which there is 
a function called salesTax(). A component in Project A can use the salesTax() function by calling:

Projects.MyOtherProject.salesTax()
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5 XML Templates

Integration Manager organizes related groups of XML, XSL, DTD, and/or XSD files into named 
templates. 

Sample XML Documents, Document Definitions, XSL Stylesheets, 
and Templates

In order to simplify working with XML data at design time, Integration Manager lets you defined XML 
Templates. The purpose of the XML Template is simply to organize related documents into a single 
functional grouping. For example, it’s not unusual, when designing an XML integration application, to 
have one or more sample input documents that represent hypothetical “incoming data.” These input 
documents might or might not conform to a particular schema (.xsd) or DTD. They might or might not 
be associated with XSL stylesheets. You may or may not also want to associate various kinds of fault 
documents with the service. In Integration Manager, you would typically organize input documents into 
one XML Template and create a different XML Template (with any or all of the above-mentioned 
ancillary items) to hold sample output documents. The “XML Template” wrapper identifies a group of 
related documents: sample XML docs that go with particular stylesheets, schema docs, and/or DTD files, 
and/or fault docs that need to be used in association with each other. 

At design time, the XML sample documents in your templates serve as exemplars, or “hints,” to enable 
Integration Manager to display proper document tree views in the various GUI pieces that need to show 
your service’s inputs and outputs. In this way, it becomes possible for Integration Manager to translate 
simple UI gestures (like drag-and-drop) into XPath and ECMAScript expressions that can be used to 
carry out mappings and transformations at runtime. (Integration Manager does the “hard work” of 
generating XPath and DOM methods so that you don’t have to.)
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About Sample XML Documents
A sample XML document is nothing more than a representative model of the data your component or 
service will process: it contains the same elements, attributes, and structures. For example, if your 
application will process Company ABC’s invoices, you might use a sample invoice when building the 
application. The sample (if it’s truly representative) will have exactly the same XML structure as the 
invoices that will be processed.

One of the most important parts of planning and designing an XML integration application is determining 
all of the possible kinds of sample documents your components might need before you begin 
development.

The types of sample documents you may need are:

Sample input documents. These could include XML documents provided by a standards 
organization (for example, cXML, OAG, and OFX) containing the elements and structure for the 
particular kind of data you want to process.
Sample output documents.
Sample intermediary (“temporary” or scratch-pad) documents.
Sample fault documents. 
XSD (schema) or DTD documents. (These can be stored in a project as separate resources; they are 
merely referenced in XML Templates.)

An important concept to note is that sample documents used in designing a component are not used on 
the server at runtime. The samples in an XML Template are really only design-time hints. They cannot 
be used as sources of instance data. (For that, you’d probably want to use XML Resource documents. See 
“About XML Resources” in the chapter on Resources.)

NOTE:  If you need to initialize any data elements with hard-coded values, you can do it programmatically 
in the action model, by mapping an ECMAScript string or number to XPath locations, as needed. You can 
also load an XML Resource and create mappings from it to (say) an input document using drag-and-drop 
gestures. 

The sample document is a design aid that allows you to visualize the data manipulations that need to 
happen at runtime. At animation time (during testing or debugging) you can watch element data in the 
sample change locations or values, or show up in output, etc., in real time, in response to XML Map 
actions, ECMAScript operations, and so on. After watching the data change in real time during step-
through/step-over debugging, it’s easy to forget that the data values are just design-time values—
placeholders, if you will. At runtime, Integration Manager merely executes the map actions, XPath and 
ECMAScript operations, etc. that you specified in development. 

About XML Validation Documents (DTDs and Schemas)
Document Type Definition and XML Schema Definition files (DTDs and XSDs, respectively) can be 
used to define and validate XML documents. Schemas and DTDs define the grammatical rules of the 
document, such as which elements must be present and what the structural relationships are between the 
elements. 

Recall that a schema differs from a DTD in several ways, including:

The XSD file is a true XML file which itself conforms to a schema defined by W3C. DTDs, by 
contrast, are not true XML files.
A schema can enforce data typing, so that if an element requires (for example) data that takes the 
form of a date in CCYY-DD-MM format, such a requirement can be specified (and strictly 
enforced).
A schema allows namespace declarations, so that elements can be uniquely identified as belonging 
to a given document vocabulary.
Schemas are designed to be granular, providing for maximum reusability.
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Schemas are flexible in terms of allowing an author to specify strict enforcement of some grammar 
rules but lazy enforcement of other rules, within the same document.
Schemas are extensible in that they allow authors to define all-new custom data types.

For these and other reasons, schemas (XSD files) are gradually displacing DTD files for definition and 
validation of XML documents. 

Runtime Validation versus Design-Time Validation

Schema and DTD validation are enforced by Integration Manager only at design time. At runtime, no 
validations (other than a well-formedness check) are performed on incoming or outgoing data. 
Nevertheless, you can force runtime validation to occur by means of ECMAScript (used either in a 
Function action, or wherever ECMAScript is permitted in Integration Manager). For example, suppose 
you want your service to validate the Input document. You would execute this expression:

result = Input.validate();
if (result == true)
// do something
else
// throw fault

If a schema is associated with Input in the XML Template for Input, that schema will be used for 
validation when the above code executes. If no schema is referenced anywhere, the validate() function 
simply performs a well-formedness check and returns a boolean result.

NOTE:  The validate() function will not use DTDs.

About XSL Stylesheets
As part of the set of files you use in a component, you can include an XSL stylesheet. An XSL stylesheet 
defines the display properties of an XML document. You create or obtain the stylesheet external to 
Integration Manager. The stylesheet may be useful for a component of your application that is creating a 
page to be displayed in Web browser.

About XML Templates
An XML Template contains the sample documents, document definitions, and XML stylesheets that 
comprise a set of sample documents that can be used in designing your components. You’ll create XML 
Templates early in the component design phase, then use them to specify the inputs and outputs of the 
components you build. 

XML Templates exist primarily so that you can use and test many types of sample data at design time. It 
is possible to have two XML documents with different structures that both have to be handled without 
error by the same component. For example, if you are using an industry standard purchase order 
document as input, but one of your customers uses a slightly different version of that document in his 
business (for example, it has some optional elements missing), you can load your customer’s document 
into a component for testing purposes. Your component must be able to handle the different document 
versions, and you can test several cases by collecting all your samples into a template that serves as an 
input for a component.

About Template Categories
Instances of XML Templates are collected into Template Categories. The Template Categories have user-
assignable names and appear as folders in the XML Template Category pane of Integration Manager’s 
navigation frame. The members of a given category appear in the Instance pane under the Category pane. 
See below.
XML Templates 75



Your application can have many input and output documents, so you will want to organize them within 
XML Template Categories. Within an XML Template Category, you can organize templates in a way that 
makes sense for your application. For example, you can create folders for:

Specific business processes (for example, Accepting a Purchase Order, Sending an Invoice, 
Receiving an Invoice)
Industry standard XML documents

Here is an example of what your organizational scheme might look like.

The purpose of the folders is to store your XML Templates, which might contain sample XML 
documents, schema, and XSL stylesheets.

To create an XML Template Category:

1 Select XML Template Category in the Integration Manager Category pane.
2 Click the right-mouse button and select New.

3 Type a name for the category and click OK.
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Template Scenarios
XML output from one component is often used as input for the next component in a service. Ease of 
sample-reuse is, in fact, one of the main benefits of working with XML Templates.

Another benefit is sample organization. It’s common for a particular XML Template to hold a variety of 
documents related to a service. For example, a given template might contain four XML files: one to be 
used as Input to a particular service, one as a Temp document (a sort of scratchpad-doc to hold values that 
will change throughout the course of your service), one as Output, and one as a Fault document, which 
can hold values to be used in the case of an error. 

NOTE:  For more information on Temp and Fault Documents, refer to “Using Temp and Fault Messages 
with a Component” in the chapter on Components.

Of course, it’s entirely acceptable to create individual XML Templates for Input docs and other templates 
for Output docs. How you organize your documents is up to you.

Creating an XML Template
XML Templates can be created in a variety of ways. 

The most basic way to create an XML Template (and the way you’d use if you already have the 
assortment of XML sample docs that you want to use at design time) is to step through the XML 
Template Wizard. This procedure is outlined below.

You can also start with a schema (.xsd file) and have Integration Manager generate a sample XML 
document (and associated XML Template) from the schema. This method is described in the section 
called “Creating XML Templates from Schemas” further below.

A third option is to start with a WSDL file and let Integration Manager generate templates corresponding 
to the message parts defined in the WSDL. This option is described under “Creating XML Templates 
from WSDL” further below.

No matter which way you choose, you should begin by making sure a Template Category (a “holder” for 
your template) exists, as shown in the graphic below. (See the preceding section for information on how 
to create a Template Category.)

To create an XML Template using the wizare:

1 Select an XML Template Category in the Category Pane, then Click the right-mouse button on the 
category, and select New. 
or
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Use the main menu to select File > New > xObject, then select the Template tab on the New 
xObject dialog, and select XML Template. (Then click OK.)
The Create a New XML Template Wizard appears.

2 Type an arbitrary Name for this template.
3 From the pulldown menu under Category, select from among the existing XML Template 

Categories that you have already created. (See “To create an XML Template Category:” above.) 
4 Under Description, enter a plain-text description of the intended usage of the template. (Optional.)
5 Click Next. The document-selection panel of the wizard appears.

6 Click the blue ‘+’ icon; a file navigation dialog will appear. Use the dialog to specify an XML file 
on disk that you wish to add to this template. Repeat this step as necessary to add however many 
XML files you want. You can add files to be used as Temp and Fault documents at this time, in 
addition to Input and Output Parts. (Click the minus-sign icon to remove a given file from the list.)
NOTE:  If you do not specify existing files to be used as your XML samples, an empty default file 
will be created. You will be able to give this file a name following the last step of the wizard.

7 Under Default Samples, below Input, use the pulldown menu to select the file you want to see as 
the default Input Message for any components that use this template. (The pulldown menu will be 
populated with the names of the files shown in the list you built in the preceding step.) 

8 Below Output, use the pulldown menu to select the file you want to see as the default Output 
Message for any components that use this template. (The pulldown menu is populated with the 
names of the files shown in the list on the left.)

9 Click Next. The document validation panel of the wizard appears.
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10 To indicate the type of document validation you want to impose on your template documents, click 
one of the three radio buttons: None, Enforce DTD, or Enforce Schema. The appearance of the 
dialog will change depending on which button is active. Note that Integration Manager will 
attempt, based on inspection of the XML template document(s) you specified in the previous 
dialog, to set the correct radio button for you. You can override Integration Manager’s choice at any 
time. The radio buttons have the following consequences:
None—Choose this option if your application does not require validation of XML documents or if 
you would like to override the DTD or XSD information specified in your template documents.
Enforce DTD—Documents will be validated against the DTD whose name and/or URI are 
specified in the text fields shown.
NOTE:  If the DTD will be determined dynamically at runtime, you can supply the URI as an 
ECMAScript expression. If you plan to use a PUBLIC DTD/Schema after deploying the project, you 
must fill in the PUBLIC Name of DTD field.

Enforce Schema—Documents will be validated against the XSD or WSDL file indicated. (See 
illustration below.)

NOTE:  Integration Manager will automatically search your sample documents to discover all of the 
namespaces (if any) declared inside them and the .xsd files to which they point. The namespaces 
and their associated schemas are displayed automatically in the above dialog; in most cases, you 
will not have to fill in the dialog yourself. If any namespaces are not displayed next to the correct 
Schema Resource, select the appropriate Schema Resource from the pulldown menu on the right. 
(That is, use the pulldown menu to associate the correct schema with the correct namespace.)

11 Click Next to go to the next panel.
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12 If the documents you are using contain namespace information, the namespaces and corresponding 
prefixes will be summarized in this dialog. If you need to add additional namespace declarations 
(perhaps for documents that do not reference schemas), use the plus sign (+) icon to do so.

13 Click Next. The stylesheet selection pane of the wizard appears.

14 (Optional) Specify an XSL StyleSheet to associate with any Service Output that is defined by this 
XML Template. An XSL Processing Instruction pointing to this stylesheet will be added to the 
Service Output. 

15 If you specified an XSL stylesheet, the following occurs:
When you create a new service or component, and the template is used for the Output message 
part, Integration Manager will automatically add a Function action to the new component’s 
Action Model. The Function action adds a processing instruction to the Output XML document, 
specifying the XSL stylesheet for the document.
The stylesheet referenced in the processing instruction is the one you specified in this XML 
Template.

16 Click Finish to create the XML Template.
NOTE:  If you did not use the + sign to add pre-existing files to your template because you wished 
to create an empty one, at this point, the following dialog window will appear, allowing you to type in 
a name for your default sample:
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Creating XML Templates from Schemas
Integration Manager can generate a sample XML document and an XML Template resource from a 
schema (.xsd) document. This is useful in cases where, for example, a business partner may have 
supplied you with a schema that must be used, but you lack actual sample docs based on that schema.

NOTE:  The XML “stub document” (sample doc) that Integration Manager generates from a schema will 
initially have no data values, which means it may not validate against the schema until you edit it to add 
data values.

To create an XML Template from a Schema:

1 If you have not already done so, create an XSD Resource based on the schema file you are using. 
(See “About XSD Resources” in the chapter on Resources. The XSD Resource wizard can be 
accessed via File > New > xObject and the Resource tab of the New xObject dialog.)

2 Open the XSD Resource you intend to use. (You can right-click on it in the explorer instance pane, 
or use the File > Open command in the main menu.)

3 When an XSD Resource is open, a blue Template icon will appear in the main toolbar in Integration 
Manager:
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Click the XML Template tool button. A dialog appears:

4 Choose a Template Category in which the new template should be created, using the Template 
Category pulldown menu.

5 Verify that the Root Element, Template Name, and Sample controls (which are prepopulated with 
values derived from the schema in question) contain appropriate values. Edit any values as needed.

6 Click OK. A new XML Template is added to the Template Category.
7 Edit the newly created sample document as needed (to add data values).
8 Save your work.

Creating XML Templates from WSDL
When an external WSDL is downloaded into Integration Manager, you generally need to have XML 
templates corresponding to message parts in the WSDL in order to create working components. XML 
samples must be created which can be validated against the WSDL. (These templates can then be used in 
components to create actions then used in the WS interchange.) Integration Manager can help with this. 
If you have a WSDL Resource for a service, simply open the WSDL Resource: Integration Manager’s 
toolbar and menus will change as shown below, and you will be able to create XML stub documents 
(template docs) at the click of a button.

There are two ways to generate XML Template docs from an open WSDL Resource: 

from the Resource menu, select Create XML Template 

OR: Click the Create XML Templates button on the toolbar.

NOTE:  The samples created will not contain element data (and as a result, may cause validation errors 
until you enter dummy values of the appropriate types). You may need to populate various elements with 
sample data for test purposes. Note also that when elements refer to ##any or ##other namespaces, the 
samples are incomplete and you have to manually complete them.

Template documents can be create in this fashion for document-style as well as RPC bindings.
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To create XML Templates from WSDL:

1 From the main menu, click on Resources>Create XML Templates, or click on the button on the 
toolbar. A dialog will appear.

2 Select a Service/Port or Binding from the dropdown list as a source for creating the XML 
Template.

3 Select an Operation from the dropdown list as a source for creating the XML Template.
4 The bottom portion of the dialog box is divided into Input, Output and Fault Messages. Follow the 

same procedure for each Part: 
Check the box below Create if you will be creating the new template from WSDL.
Select a Template Category from the dropdown list. New Categories can be created.
Type in a Template Name.
The name listed under Sample defaults from the Part name. Enter a new name if the default 
name is not the sample name you want.

5 Click OK to finish.

Importing an XML Template
If you’ve already created an XML Template for another project, you can import it into the current project.

To import an XML Template:

1 In Integration Manager’s Category Pane, select the XML Template Category to which you want 
to associate the template instance.

2 Right-click and select Import from the context menu. A dialog appears.
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NOTE:  If the Import command is not highlighted, it’s because you have chosen a Template 
Category that belongs to a subproject. This operation is not allowed. If you need to import template 
docs into a subproject, close the current project. Open the subproject on its own, add templates to it, 
save it, and close it; then return to the project you were working on originally.

3 Select XML Template as the Type.
4 Select an XML Template Category from the drop down list.
5 Select the File Name location using Browse. You may also read in a file from a URL by explicitly 

preceding your filename with “http://,” “https://” or “ftp.”
6 Type in a Name.
7 Optionally supply a Description.
8 Click OK.

Showing and Hiding XML Documents
It can be convenient to toggle the visibility of XML document views when working in Integration 
Manager’s main window.

To toggle XML document visibility:

1 From Integration Manager’s main menubar, choose: View>XML Documents>Show/Hide.
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A dialog will appear:

2 The Show/Hide dialog displays the names of the XML documents associated with the open 
template or component.
NOTE:  In a component, the Input and Output XML documents default to the Show column. 
Message parts created as a result of a component action default to hidden.

3 In the Hide column, select any XML documents you want to be displayed and click the left arrow 
button. Conversely, in the Show column, select any XML documents you want to be hidden and 
click the right arrow button.

4 Select the XML document you want to display as the top document and click the up arrow button 
until the document is displayed as the uppermost document in the Show column. Conversely, use 
the down arrow to move the document down further in the list.

5 Continue to select XML documents in the Show column and use the up- and down-triangle buttons 
to move the XML documents into the desired order until they are displayed the way you like.

6 Click OK. The dialog closes and the Component editor’s data panes are rearranged accordingly.

XML Template Editor
The XML Template Editor allows you to edit the template in Integration Manager, rather than using an 
external editor. 

Viewing the documents in the Template Editor and Context Menus

The View option from the main menubar allows you to select the way you want the XML information 
displayed in the Component Editor. You can choose from tree, text or stylized. Each view has its own 
unique context menu accessed by the RMB.
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Tree View and Context menu options

The default view displays the message part as a tree, as shown below. 

This view allows you to edit element and attribute values (that is, document data) but not the XML 
structure.

The Context menu commands accessible via the right mouse button are shown below. 

Text View and Context menu options

In Text View, you can see and edit the complete XML file, including structural elements.

Text view offers a convenient way to inspect non-content-model portions of the Input, Temp or Output 
Parts, such as comments, processing instructions, DOCTYPE declarations, and so forth.

The Context menu options accessed by RMB as shown below. 
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Stylized View and Context menu options

When the Stylized view is selected pane, your view of the message part contents looks like this:

This view gives a “report” style overview of the XML contents so that you can see at a glance what the 
content is for all attributes and elements. This view uses the following algorithm to render XML.

If there is an associated stylesheet with this document component, evaluate the expression and use that 
one. 

If this fails, use the default stylesheet: com/sssw/b2b/dt/default.xsl 

To change to a stylized view, click the RMB to access the Context menu as shown below. 

Working with an XML Template

Each XML Template you create resides in an XML Template category. To view the name and creation 
date of the XML Template, select an XML Template category. All XML Templates for the category are 
listed in the Detail pane of Integration Manager. Each template has a context menu, giving you ways to 
work with the template.
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Viewing an XML Document
Each XML Template contains one or more sample documents. You can open a sample document in an 
XML editor (a separate application external to Integration Manager). 

To view a sample document in your XML editor:

1 Click the right-mouse button on an XML Template. 
2 Select Edit Sample and select the sample document you wish to edit. Whatever XML editor you 

identified during your Integration Manager installation will open (by default, Internet Explorer is 
used).

Editing an XML Template
You can modify the XML Template by adding and deleting sample documents, schema, and XSL 
stylesheets.

To edit an XML Template:

Doubleclick the XML Template instance to open it in the Content Editor. Once a sample file is 
open, right-click the mouse button to display a contextual menu which gives you several options 
(see “The XML Template Editor Context Menu” below) including Edit Data.
or
Single-click the XML Template in the Instance Pane, then click the right-mouse button and select 
Properties from the context menu.
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NOTE:  Changing the name of the template on the Properties page causes a Save As operation, 
preserving the original and creating a duplicate with a new name. To change just the name of an XML 
Template, use the Rename option on the context menu.

Saving Changes to XML Documents
Once you have made changes to your XML using the methods described above, you will, of course, want 
to save them. There are four ways to save sample XML documents i n Integration Manager.

Select File>Save from the main menubar.
Select File>Save As from the main menubar. This brings up a tabbed dialog window resembling 
the Properties screen shown above, allowing you to type over the current name of the document 
with a new name.
Select File>Save All to save changes to all the XML documents you currently have open in the 
Content Editor.
Within the Content Editor, right-click on an open document and select Save XML As from the 
context menu (see “The XML Template Editor Context Menu” below). This brings up the Save 
XML As Dialog window shown below:

To use the Save XML As dialog:

1 Select a “Part”, or XML document name from the drop-down list.
2 If you want to save the open document as a sample, then choose Save as Template Sample. 

Select a Template Category
Select a Template Name
Type in a Sample Name

3 If you want to save the open document as a file, then choose Save as File.
Click on Browse to select a directory in which to store your file and give it a name.

4 Click on OK to close the window and Save the XML.

Printing an XML Document
To print the XML document, Select File>Print from the main menubar. The document component is 
formatted according to the template. 
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The XML Template Editor Context Menu
When you open an XML sample file in the Content Editor and right-click on it, a menu appears allowing 
you to perform several functions.

These functions are explained in the table below:

Edit Data Allows you to edit element and attribute values (that is, 
document data)

Create Schema Brings up a dialog allowing you to create a new schema 
resource

Add Sample File Brings up a dialog with a file directory so you can select 
a pre-existing XML file to add to the template

Create Sample File Brings up a dialog which allows you to type in a name 
for a new sample XML file.

Add to Display Allows you to display additional XML files which are part 
of the current template but are not currently open in the 
editor pane

View Change the view of the document (see “Viewing an 
XML Document” above)

Launch Editor Opens the default XML editor you specified during 
installation

Save XML As Opens the Save As dialog window, which allows you to 
specify a part name, save the file as a sample or save 
as a file

Validate Runs a validation routine to check that your XML is 
sound

Find Opens the Find dialog allowing you to search for strings 
in the XML data or structure

Find Next Repeats previous search
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Deleting an XML Template
When you create an XML Template, Integration Manager makes copies of the original XML, document 
definition and XSL files and places them into an “Imports” directory under the proper XML category. 
When you delete an XML Template, you are going to delete the copies, not the original files. To delete 
an XML Template, highlight it in the Detail Pane of the Navigator, right-mouse click it, and select Delete. 
The file must be closed in order to delete it.

Moving an XML Template to a Different Category

To move an XML Template from one category to another:

1 Select the template you wish to move.
2 Click the right-mouse button and select either Cut or Copy.
3 In the Category pane of Integration Manager, click on another XML category.
4 In the Details pane, click the right mouse button and select Paste.

Renaming an XML Template

To rename an XML Template:

1 Select the template you wish to rename.
2 Click the right mouse button and select Rename.
3 Type the new name.
4 Click OK.

NOTE:  Be sure to rename a template using the above procedure. If you change the name of the template 
on its Properties page, it causes a Save As operation, preserving the original and creating a duplicate 
with a new name.

Understanding Where XML Templates Are Stored on Your Hard 
Drive

XML Templates are stored as part of a project. For information on where project files are stored, see 
“Understanding Where Project Files are Stored” on page 65.

NOTE:  Copies of the samples, definitions and XML stylesheets used in the template are stored in a 
folder. The original documents are not modified.
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6 Creating an XML Map Component

In many ways, the Integration Manager XML Map Component is the simplest yet most important of 
Integration Manager’s component types. You will use it to perform XML transformations of input 
documents to output documents. It is essential that you understand how XML Map Components (and 
related resources) work if you are to build useful Integration Manager services. 

This chapter introduces you to XML Map Components and describes how they work within a Integration 
Manager service. After reading this chapter, you will understand what comprises an XML Map 
component, what it can do, and how to design, create, and use an XML Map component.

What is an XML Map Component?
An XML Map component is an object that accepts one or more XML documents as inputs, uses a 
collection of actions to operate on these inputs and returns an XML document as output.

An XML Map component can perform simple data manipulation, such as mapping and transferring data 
from one XML document to another. It can also carry out sophisticated manipulations, such as 
transforming both the data and structure of a document. You can even create XML Map components that 
process XSL, send mail, and post and receive XML documents using the HTTP protocol.

The concept behind a component is to pass one or more XML documents in as inputs, process these 
inputs, and return one output XML document. The output XML document is then used as input for other 
components or returned as the final output of a service. In this way, you can create components that work 
together in a service to carry out complete business-to-business solutions.

Using XML Template Sample Documents to Build an XML Map Component
The XML documents you use when building an XML Map component are samples of the actual 
documents that will be processed in a running application. Sample documents are added to Integration 
Manager in XML template objects. You use samples of documents whose structure and data 
representation are identical to the documents that will be processed. The illustration below shows the 
difference between documents you use for building purposes and those that are actually processed by the 
component.
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The samples used to build a component are not actually used, or even referred to by name, at runtime. 
They are simply templates that represent the structure and data to be manipulated. The samples are 
temporary aids that help you construct processing actions that perform the correct runtime manipulations. 
What Integration Manager actually uses at runtime to process XML data is an object representation of the 
XML document called a DOM.

What is a DOM?
In the XML Map component editor, a sample document is represented in a format recommended by the 
W3C known as the document object model (DOM). A DOM is an XML document constructed as an 
object in a software program’s memory. It provides standard methods for manipulating the object. Using 
DOMs, Integration Manager lets you build XML documents, navigate within their structure, and add, 
modify or delete elements and content. Anything found within an XML document can be manipulated 
using a DOM method. Integration Manager supports all DOM methods recommended by the W3C 
ECMA to DOM Binding Specification (See http://www.w3.org/).

NOTE:  In some dialogs, Integration Manager refers to DOMs as Messages. 

Understanding DOM Structure
When the XML Map component editor is active, every sample document is converted to a DOM. 

DOMs are used because:

A DOM uses a standard way of naming and organizing XML structural elements so that the 
elements can be selected easily and clearly
A structural element of a DOM can be operated on 
A DOM is the structure that is created and manipulated at runtime

A DOM is organized hierarchically, which means it forms a tree structure. To understand how a particular 
DOM is structured, it’s often useful to be able to view the DOM from different perspectives. For example, 
sometimes it’s helpful to see the raw text of the XML document underlying the DOM. Other times, you 
may be interested in seeing a summary view of the data (rather than the element and attribute names) in 
a document. Integration Manager allows you to change views as necessary in order to switch between 
tree, text, and summary presentations. 
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To change views, simply right-click inside any DOM window, then select the view you want to see from 
the View submenu. The three available view types are shown below.

Elements in a DOM are defined by tags in an XML document. For instance, in the above example, there 
is an element tag in the XML document named <INVENTORYSTATUS>. The tag has an end tag 
(</INVENTORYSTATUS). All structural elements within <INVENTORYSTATUS> and 
</INVENTORYSTATUS>, such as <SKU>, are represented at a lower (or in DOM terminology, 
descendant) level in the DOM tree.

All element names are case-sensitive, meaning that <INVOICENO> is not the same as <InvoiceNo>.

An element in a DOM tree is referred to as a node. A collection of nodes is represented in a hierarchy and 
is referred to by the following naming conventions:

Each element type in a DOM has its own icon, as identified below.

Node Type Description

Root The topmost element in a DOM tree from which all other 
elements are descendants. Only one is allowed.

Descendant Any node that is below (contained within) another node

Child The immediate descendant of a node

Sibling All nodes that share the same parent node

Ancestor Any node that is above (contains) another node

Parent The immediate ancestor of a node

Leaf Any node without a descendant
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Using DOMs at Runtime
It is through DOMs that components pass and return data to one another in a running application. At 
runtime, when a component is executed, it is passed a DOM. The passed DOM becomes the Input Part to 
be operated on. As each of the component’s mapping actions executes, the Output Part is created, element 
by element.

DOM Behaviors during Runtime
The first time you open a component, the original samples are loaded into the Input and Ouput DOMs. 
When you begin animation, the Input Part remains and the Temp and Ouput DOMs are cleared from any 
data originally contained in them. At the end of execution, data appears in all DOMs.

Creating Different Types of Messages
When you create an XML Map component, you select input and output XML templates for it. However, 
within the Component Editor you can also:

Create an Output Part without using a template, as described in “Creating an Output Document 
without Using a Template” on page 110
Create a Temporary Message Part, as described in “Creating a Temporary Message Part” on 
page 111
Create a Fault Message Part, as described in “Creating a Fault Message Part” on page -112
Dynamically create a DOM from an external XML document using the XML Interchange action. 

Creating an XML Map Component
The first step in creating an XML Map component is to specify the XML templates for the component. 
For more information, see “Creating an XML Template” on page 77.

Once you’ve specified the XML templates, you can create your component, using the template’s sample 
documents to represent the inputs and output processed by your component.

NOTE:  Various other component types (such as the JDBC Component, JMS Component, etc.) are 
covered in detail in the appropriate Enterprise Connect product user guides. The same basic principles are 
used in the creation and editing of all components, however. Also, the various Basic Actions (see next 
chapter) available in the XML Map Component are also available in all other Integration Manager 
component types.
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To create an XML Map component:

1 From the Integration Manager File menu, select New then xObject. Select the Component tab and 
then XML Map. The New xObject dialog box appears.

2 Type a Name for the component.
3 Optionally, type Description information.
4 Click Next. A new panel appears as follows.

5 Specify the Input and Output templates (also called Messages).
Type in a name for the template under Part if you wish the name to appear in the Component 
Editor as something other than “Input” or “Output.”
Select a Template Category if it is different than the default category.
Select a Template Name from the list of XML templates in the selected Template Category.
To add additional input XML templates, click Add and repeat steps 2 through 4.
To remove an input XML template, select an entry and click Delete.

6 Select an XML template as an output using the same methods described in the previous step.
NOTE:  You can specify an output XML template that contains no structure by selecting {ANY} as 
the Output template. For more information, see “Creating an Output Document without Using a 
Template” on page 110.

7 Click Next to go the Temp and Fault XML template dialog. If desired, specify a template to be used 
as a scratchpad under the “Temp Message” pane of the dialog window. This can be useful if you 
need a place to hold values that will only be used temporarily during the execution of your 
component or are for reference only. Under the “Fault Message” pane, select an XML template to 
be used to pass back to clients when a fault condition occurs. 
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8 As above, to add additional XML templates, click Add and choose a Part Name, a Template 
Category and Template Name for each. Repeat as many times as desired. To remove an input XML 
template, select an entry and click Delete. Temp and Fault Message Parts are discussed in more 
detail below, beginning on page 111.

9 Click Next. For several of the component types, the Connection Info panel will appear, allowing 
you to select a previously created Connection Resource.

10 Click Finish. The component is created and the XML Map Component Editor appears.
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Namespaces and Output Parts
You should be aware that when a new XML Map Component is created whose Output template uses 
namespaces, a new Map action will automatically be placed into the action list, mapping the namespace 
URI to an attribute in the Output Part. It’s important not only that you not delete this Map action, but that 
you avoid accidentally overwriting it. An overwrite can happen if you place a Component action 
downstream of the namespace-URI Map action, and the Component action returns its results to the 
Output Part. The solution in this case is to move (by Cut and Paste) the original Map action to a spot 
downstream of the Component action.

Understanding the XML Map Component Editor
The XML Map Component Editor is where you specify the mapping, transformation, and transfer of all 
input and output structure and data. 

The XML Map Component Editor provides a logical working environment for the inputs, output, and 
actions of your component. The XML Map component editor is composed of multiple Mapping panes 
and a single Action Model pane. The Mapping panes display the XML for your sample Input and Output 
message parts. The Action Model pane displays actions that operate on the Mapping panes.

The following illustration shows the XML Map Component Editor with its menu and toolbar, one input 
Part, one output Part, and several actions in the Action Model pane.
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About the Menu and Toolbar
The main menu in Integration Manager and it’s sub-menus and toolbar options change according to the 
type of component you currently have open in the Component Editor. The following component-specific 
options occur on the main menubar when an XML Map Component is open.

XMLMap 
Component 
Menu Options

File You can create, open and delete any type of component from the File menu, just as 
you can from the Integration Manager File menu. 

Some menu choices have implications that are particularly significant for XML Map 
Components:

Save saves the inputs, output and actions in the component

Save As... saves the component under a new name and allows you to change the 
inputs, output, and actions. See “Saving Your Component” on page 117.

Save All... saves all components currently open

Save XML As . . . allows you to save the structure of the message Part into an XML 
document. See “Saving a DOM as an XML Document” on page 117.

Load XML Sample . . . allows you to load other sample documents from a template 
into a message part for testing the component. See “Loading a Sample Document” 
on page 115.

Properties lets you view the component’s templates and other information. See 
“Viewing Component Properties” on page 121.

Print lets you print your component

Edit You can undo or redo an action, cut, copy, and paste text anywhere in the component 
editor. In addition, you can do the following:

Find finds an element in a mapping pane or text in the Action Model. See “Finding a 
Document Element” on page 107.

Find Next finds the next element in a mapping pane or text in the Action Model. See 
“Finding the Next Document Element” on page 107.

Replace replaces selected text in the Action Model only. See “Replacing Text in the 
Action Model” on page 109.

View Navigator Tabs toggles the visibility of the nav frame at the left of the Integration 
Manager main window. Use this command to hide or unhide the whole nav frame.

Output Tabs toggles the visibility of the Message frame at the bottom of the 
Integration Manager main window. Use this command to hide or unhide the whole 
Message frame.

Document Tabs toggles the visibility of the XML Document Tabs in the Component 
Editor. 

XML Documents brings up a submenu with the following choices:

Show/Hide allows you to change the order and visibility of all message parts 
associated with the open component (see “To set the visibilities of XML 
documents:” below)

Collapse All hides all XML nodes except for the root node in all mapping panes.

Expand All displays all XML nodes in all mapping panes.

(as Tree, as Text, as Stylized) displays controls how XML contents are displayed 
in the Component Editor.

Window Layout allows you to specify which DOMs to display and how to arrange 
the DOM and Action Model panes within the component window. See “Using Window 
Layout and Show/Hide in the Component Editor” on page 101.
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Many of the menu items are on the toolbar. Rest your mouse on a toolbar item for a brief description of it.

Using Window Layout and Show/Hide in the Component Editor
The panes of the component editor can be displayed, hidden, repositioned and resized, making it easier 
for you to work with their contents. Use the Window Layout option and the Show/Hide option from the 
View Menu.

To arrange the panes of the component editor:

1 Select Window Layout from the View menu. The Window Layout dialog appears and allows you 
to adjust the placement of the panels in the Window.

2 Select the orientation of the XML documents and Action Model as follows:
If you want the panes to be top-to-bottom, select either XML Document or Action Model from 
the upper-most pull-down menu. If you selected XML Document for the upper pane, select 
Action Model from the lower-most pull-down menu. If you selected Action Model for the upper 
pane, select XML Document for the lower.
If you want the panes to be left-to-right, select either XML Document or Action Model from the 
left-most pull-down menu. If you selected XML Document for the left pane, select Action 
Model from the right-most pull-down menu. If you selected Action Model for the left pane, 
select XML Document for the right.

3 Click OK. 

Component Execute—Runs the component from start to finish, for testing purposes.

Reload XML Documents reloads the original samples from the Input and Output 
templates, clearing whatever is currently shown in the XML message panes. See 
“Reloading an XML Document” on page 114.

Add Watch allows you to identify certain data items and examine their data values 
during the execution of a component as a debugging aid.

Action New Action contains all actions that you can add to the Action Model.

Edit allows you to edit a selected action

Disable allows you to disable a selected action

Animate This menu contains all processing animation tools that you can use to test the 
component. The Toolbar contains buttons that allow you to run animation tools. For 
more information, see “Testing and Debugging” on page 337.

XMLMap 
Component 
Menu Options
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4 If you’re not satisfied with the result, select View then Window Layout, and then click the Reset 
button. The panes revert to the default setting.

To set the visibilities of XML documents:

1 Select View/XML Documents>Show/Hide. The Show/Hide dialog displays the visibility status of 
XML documents.
NOTE:  The Input and Output XML documents default to the Show column. DOMs created as a 
result of a component action default to Hide.

2 Select any XML documents you want to be displayed from the Hide column and click the left-
triangle button. Conversely, select any XML Documents that you don’t want to display from the 
Show column and click the right-triangle button.

3 Select the XML document you want to display as the top document and click the up-triangle 
button until the document is displayed at the level you want in the Show column.
NOTE:  If you selected a left-to-right orientation in the preceding procedure (“To arrange the panes 
of the component editor:”, above), the order of your XML documents appears from left-to-right: 
Higher-precedence documents will appear on the left.

4 Continue to select XML documents in the Show column and use the up and down buttons as 
necessary until the XML documents are in the desired order.

5 Click OK. The Window Layout dialog closes and the Component editor is rearranged accordingly.

Managing Document Panes from within the XML Panel

Individual XML document panels can be maximized, normalized or closed using icons located within the 
header area of the document panel:

Clicking the Maximize icon will cause the document to take over the entire XML Panel area, temporarily 
hiding any other open message Parts. Once a document has been maximized, the icon will change to the 
Normalize icon, so you can restore the document to its previous size. 

Clicking the Close icon will hide the document from view. Closing all XML documents leaves the XML 
Panel open but empty. To re-open a document when the editor panel is in this state, click with the RMB. 
A context menu is displayed, from which you can select a document to open.
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About the Mapping Panes
The default XML Map component editor has the following window pane configuration:

One or more Input Mapping panes (each displaying a representation of the XML for one of the 
samples in their respective XML Template), one Output Mapping pane
One Action Model pane
Temporary message part mapping panes, or XML returned as a result of executing another 
component via a component action

Note that there is a color coding aspect of the mapping pane. Red indicates the first direct mapping of an 
element, so that if you wanted to look at what elements in the output tree have been mapped, you can 
identify that by the color red. Green indicates the first occurrence of the element that has a repeat alias 
defined for it.

NOTE:  You must use Window Layout discussed above to display a dynamically created message part, 
such as mapping panes created dynamically by the XML Interchange action.

About the Input Mapping Pane
The Input Mapping pane displays one sample document from the input XML template as a document 
object in the Component Editor. (If your component contains multiple templates, each input message is 
displayed in its own pane.) The panes can be sized by dragging borders up, down, left, or right. 

If your component contains multiple input XML templates, they are displayed with the following names:

The template display order is determined by the order you specified when selecting XML templates at the 
time of the component creation. You can change this order using the up and down arrows using 
View>XML Documents>Show/Hide, as indicated above.

Display Order Document Name

First template Input

Second template Input1

Additional templates Inputn: (n = the template order minus one. For 
instance, the the last input template is the fifth input 
template, the DOM name will be Input4.)
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About DOM Elements and Data Values

Each input pane consists of two areas: the DOM tree and the Data values. The following illustration 
shows an Input Part with several elements and data for those elements.

Notice that when you select an XML element, the element name appears in the status bar showing the 
fully qualified element name. Any data associated with the element (from the XML document) appears 
in the Data area. Although the data is not used when the component processes at runtime, the data is 
helpful for setting up and testing the component. You can leave the data in the DOM elements, or you can 
change the data. For more information on changing the data, see “Editing a Value for a Document 
Element (Edit Data command)” on page 104.

About the Input Mapping Pane Context Menu

The Input Mapping pane has a context menu you can access to perform tasks on the Input Parts. To access 
the context menu, click the right-mouse button anywhere in the pane. The context menu is shown below.

Creating a Repeat for Element, Declare Alias, or Declare Group Action

You can create a Repeat for Element, Declare Alias, or Declare Group action on an element that repeats 
in the Input Part. See “The Declare Alias Action” on page 132.

You can also create a group of DOM elements which aids in transforming DOM elements into a structure 
that is different from their original positions in the sample document. When you create a group, you can 
perform aggregate operations against a group. For instance, you can arrange DOM elements into a group 
by U.S. state (for example, Alabama, Arizona) then sum the total sales by each state. 

Groups always work in conjunction with a Repeat for Group action. For more information about creating 
and using groups, see “The Repeat for Group Action” on page 186.

Editing a Value for a Document Element (Edit Data command)

You can select an element in an Input Part and set the value for it. This is helpful when you run the 
animation tools to test the component. 

NOTE:  The value is temporary for the editing session.
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To edit a value for a Document element:

1 Select an XML element from your document.
2 Click the right-mouse button in the input pane.
3 Select Edit Data. 

4 Notice that the document element you selected appears in the dialog box. Type in the value you 
wish to set for the element.

5 Click OK. The value appears in the Data area, next to the element you selected.

Add to Display

Use this context menu option to add additional XML documents to the display area of the XML Panel. 
When you select Add to Display from the menu, a list appears containing the currently unopened 
documents associated with the component, as well as the PROJECT variable and _SystemFault. Select 
from this list to open any of these items.

View Commands

You can view individual XML Message Parts as a Tree, as Text, or in stylized form (using an XSL 
stylesheet). 

Tree View

The default view displays the Message Part as a tree, as shown below. 

This view allows you to edit element and attribute values (that is, document data) but not the structure of 
the XML.
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Text View

In Text View, you can see and edit the complete XML file, including structural elements.

Display the Message Part as text by clicking on the right mouse button (anywhere in the XML panel) and 
selecting View, then As Text. The XML then appears in plain-text form, as shown here.

Text view offers a convenient way to inspect non-content-model portions of the Input, Temp or Output 
Parts, such as comments, processing instructions, DOCTYPE declarations, and so forth.

NOTE:  The Text view, like the Tree view, is updated dynamically during animation so you can see the 
results of individual Map actions as they are executed.

Stylized View

When the Stylized view is selected (by clicking with the RMB and selecting View>As Stylized), you get 
a view of the XML message contents that looks like this:

This view gives a “report” style overview of the XML contents so that you can see at a glance what the 
content is for all attributes and elements.

NOTE:  The default XSL stylesheet that Integration Manager relies on for creation of this view can be 
found inside the xcd-all.jar file in your \bin directory; its name is default.xsl. You can edit or replace this 
file by extracting (unzipping) it from the jar file and reinserting an editing version in the same place in the 
jar.

Show Comments

Another View function is Show Comments which allows you to toggle the visibility of comments in the 
source XML file. Comments, signified by markers <!-- and --> wrapping a section of content, constitute 
DOM nodes, but you may not always want to view them, particularly if you have a lengthy document. 

Expanding a Document Tree

You can display all elements in a document tree by clicking the right-mouse button and selecting 
View>Expand Tree.

Another way to expand the tree is by clicking on the plus icon just to the left of the Part name (for 
example, the word Input) at the top left-hand corner of the pane . 
106   Integration Manager User’s Guide



Collapsing a Document Tree

You can hide all elements in a document tree by clicking the right-mouse button and selecting 
View>Collapse Tree. 

Another way to collapse the tree is by clicking on the minus icon just to the left of Part name (for 
example, the word Input) at the top left-hand corner of the pane.

Reloading a Document Tree

You can reset a specific XML Message by bringing up the context menu and selecting View>Reload 
Tree. This allows you to reload an individual document tree within the XML Map component. You may 
wish to reload a tree if during testing, you halted animation, leaving the document in an unfinished state.

Launch Editor

Selecting Launch Editor from the context menu opens your document in the default XML editor you 
specified during installation.

Load XML Sample

The Load XML Sample function available in the context menu allows you to load other sample 
documents from a template into a message part for testing the component. See “Loading a Sample 
Document” on page 115.

Save XML As

Selecting Save XML As from the context menu allows you to save the structure of the currently open 
Message Part into an XML document. See “Saving a DOM as an XML Document” on page 117.

Finding a Document Element

You can search for element names and element data using the Find command (which appears in the XML 
Panel context menu). The Find dialog allows you to enter a value and search the document tree. You can 
search for partial words or whole words only, and you can ignore the text case when searching. The Find 
Text dialog box is shown below.

Finding the Next Document Element

You can search for the next occurrence of a word or string you searched for previously. There is no dialog 
box when you select Find Next or press the F3 key. Instead, Integration Manager locates the next 
occurrence of the last find. If no match is found, nothing happens.

Validating a Dom

You can validate the DOM against its DTD or schema definition file by picking Validate from the 
context menu. Validating is useful during the construction and testing of your component.
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About the Output Mapping Pane
The Output Mapping pane displays the Output Part. The Output Mapping pane also has a context menu, 
as shown.

The options on the Output Mapping pane context menu are similar to the ones on the input mapping pane 
context menu, but with the differences described below.

Mapping an Input Element to an Output Element

You can use the Map action by selecting it from the right-mouse context menu.

Setting a Value

The Edit Data option on the Output Part allows you to inspect the value of a node but not change it.

About the Action Model Pane
All components have a single Action Model. The Action Model represents the mappings, 
transformations, and other actions that will be performed on XML documents during runtime processing. 
The Action Model Pane is also resizable within the XML Map Component Editor window. Most of your 
activity that takes place in the Action Model pane involves adding and editing actions.

About the Action Model Context Menu

If you right-click in the Action Model, you see the menu shown below.

From this menu, you can select actions and perform other tasks. 
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Replacing Text in the Action Model

You can replace a word or string using the Replace option on the right mouse menu or on the component 
editor Edit menu.

To replace text:

1 Right click in the Action Model and select Replace (or select an action and select Replace from the 
Edit menu).

2 Enter the search text and click OK. 
3 Integration Manager finds the first occurrence and asks you to confirm the replacement. You can 

then replace the next or all occurrences.

Adding Actions to a Component
Once you have specified the Input and Output templates, the XML Map Editor opens, and you are ready 
to start adding actions. Actions are the processing steps that take place within the component. You will 
read more about actions in later topics.

Within components, you add actions to map DOM elements, read and write data from files, send e-mails, 
and other common tasks. A collection of actions is referred to as an Action Model.

An action in the Action Model is displayed as a line and contains an icon for the action type along with 
an abbreviated definition of the action. Some actions are subordinate to other actions. For instance, you 
can create a Repeat action that controls loop processing, then add actions inside the loop. The actions 
inside the loop are subordinate to the Repeat action and appear indented beneath it. They process as long 
as the Repeat action is true.

To add actions to the Action Model:

1 Position the cursor in the Action Model pane above where you want the next action inserted. 
2 Add an action using any of following methods. The new action is inserted below the line you 

highlighted. 
Drag and drop. You can add Map actions by dragging and dropping elements from an Input 
Part to the output or temp DOMs. Simply click on an element in the Input Part and drag it on top 
of the output or temp DOM.
Copy and Paste. You can copy an action in the Action Model pane and paste it somewhere else 
in the pane, or into an Action Model pane of another component.
The Action menu. Highlight a line in the Action Model pane and select an action from the 
Action menu. The new action is placed directly under the highlighted line.
The Action Model pane context menu. Click the right-mouse button anywhere in the Action 
Model pane and its context menu appears.
The input and output mapping pane context menus. You can add actions to the Action Model 
pane by selecting DOM tree elements and then selecting actions from their respective context 
menus.

NOTE:  You can reorder actions in the Action Model by dragging them to a new position.
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Once you’ve created the Action Model, and before you process the component with live data, you should 
test the component. Perform testing by using Integration Manager’s Animation tools. With the Animation 
tools, you can set breakpoints, start a animation, step into and over actions, and pause the animation. 

Creating an Output Document without Using a Template
You can specify an output XML template that contains no structure by selecting {SYSTEM}{ANY} as the 
Output template when you create the component. You can then build the Output Message Part 
dynamically by mapping input Part elements to output Part elements that do not yet exist.

For example, the following illustration shows a component with an input Part containing elements, and 
an output Part that has no elements.

Notice there is nothing in the output document. To dynamically build an output document, you can map 
input Part elements to a structure in the output Part that does not exist. In the next illustration, the Seller 
in the input Part is mapped to a line item called Buyer in the output Part.

The next illustration shows the resulting XML Document Panels.

You can create any output document structure by mapping an input document element to an output 
XPath. Make sure you map to a fully-qualified document name. 

NOTE:  In reality, Output and Temp Message Parts are always built dynamically. The presence of a 
sample document is merely a productivity aid to help you define actions.
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If the Output Part you created can be used for building other components, you may want to save it as an 
XML document and use it as a sample inside an XML Template. See “Saving a DOM as an XML 
Document” on page 117 for more information.

Using Temp and Fault Messages with a Component
In addition to creating Input and Output Message Parts, you can also create Temporary and Fault 
Message Parts. Temp Parts are used as work areas for performing complex manipulations of between 
Input and Output Parts. Within a Temp document pane, you can add elements from any of the Input Parts 
by using any of the five mapping methods. See “About the Action Model Pane” on page 108.

Fault Documents allow you to pass information back to clients when a fault condition occurs in a 
component or service. In Integration Manager, a Fault is, essentially, an in-memory XML document or 
Message Part, defined along with a component, just like Input, Output and Temp Parts. Fault Message 
Parts are used to store information received when a Fault or Error occurs in your service or component. 
It is a good programming practice to anticipate places in your program where errors may occur and 
surround them with Try/On Fault and Throw Fault actions. (See “The Throw Fault Action” on page -163 
for an example demonstrating the use Fault documents in fault-related actions.) 

Creating a Temporary Message Part
The Temp Part differs from the Input and Output Parts in the directionality of actions allowed. The Temp 
Part can be both a source and a target of mapping actions, whereas the Input Parts are only sources and 
the Output Part is only a target. You can add more than one temporary Part (you are only limited by 
memory), and you can delete them whenever you wish. Also, you can assign your own name to 
temporary Parts by typing over the Temp label. Temporary Message Parts can either be defined during 
the creation of a component (see “To create an XML Map component:” on page -97), or they can be 
added to an existing component.

To add a temporary Message Part to an existing component:

1 From the File menu, choose Properties. The Properties dialog appears.

2 Click on the Messages tab.
3 Click on the Temp Documents tab. 
4 Click the Add button at the far right. Selections for Part, Template Category and Template Name 

become available.
5 Enter an Part (your own label) for the temporary message part.
6 Select an XML Category from the Template Category dropdown menu.
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7 Select an XML Template from the Template Name dropdown menu.
8 Click OK.
9 Open the component. By default, the Component Editor will probably only show the Input and 

Output parts. To make the Temp document visible, go to the View menu and select Show/Hide to 
add the Temp Part you just created.
NOTE:  Alternatively, you can click with the RMB in the Component Editor and select Add to 
Display, then pick the Temp document from the list.

The XML Map Component Editor displays a Temp message pane, as shown in the next illustration.

NOTE:  You can also create a document object dynamically without using a template, as described in 
“Creating an Output Document without Using a Template” on page 110.

Creating a Fault Message Part

The _SystemFault Document

You can define the XML yourself for your Fault document, using your favorite editor, or you can use the 
default one provided by Integration Manager, which is called _SystemFault. The XML information 
contained in _SystemFault also gets written to a global object called ERROR. The structure of the 
_SystemFault document is shown below:

Beneath the FaultInfo root are the following elements:

DateTime which contains the Date and Time the fault occurred.
ComponentName which contains the name of the Component which threw the fault.
MainCode which contains the main code number for the error.
SubCode which contains a sub-code number for the error.
Message which contains the error message you specifically define when you set up a Throw 
Fault action (p.163). If you do not specify an error message in your Throw Fault action, you will 
see “A user defined Fault occurred!”. If the error occurred within a Try/On Fault action, and you 
did not specify a Fault, this element will be populated with an Exception message.

NOTE:  By default, the Fault document will not be visible in the Component Editor. To View it, click with 
your RMB, select Add to Display and choose _SystemFault.
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Creating a Custom Fault Document
The procedure for adding Fault Message Parts to your component is very similar to the procedure for 
adding Input, Output and Temp Parts. You begin by using your favorite editor to create an XML 
document that will be used to hold fault information. You can create as many Fault Message Parts as you 
need (you are limited only by memory) and Fault documents can have any structure that makes sense to 
your application. 

You might want to use a custom Fault Part along with the _SystemFault document. For example, you 
could use the DateTime, Component and Message elements from _SystemFault to populate your own 
Fault document which woul also contain information about the service itself, a log message indicating the 
last action that was sucessfully executed and some information from the Input document that might have 
been missed due to the application halting before completion. Below is an example depicting a custom 
Fault message. 

Once you’ve decided what Faults you need to capture and created the XML structures to support them, 
the Parts can either be defined during the creation of a component, or added to an existing component.

To add a Fault Part to an existing component:

1 From the File menu, choose Properties. The Properties dialog appears.
2 Click on the Messages tab.
3 Click on the Fault Documents tab. 

4 Click the Add button at the far right. Selections for Part, Template Category and Template Name 
become available. 
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NOTE:  If you do not specify a Fault Part, error information will go into the basic fault document, 
called _SystemFault.

5 Enter a Part (your own label) for the fault message part.
6 Select an XML Category from the Template Category dropdown menu.
7 Select an XML Template from the Template Name dropdown menu.
8 Repeat as necessary for additional Fault documents.
9 Click OK.
10 Open the component. By default, the Component Editor will probably only show the Input and 

Output parts. To make the Fault Part visible, go to the View menu and select Show/Hide to add the 
Fault Part you just created.
NOTE:  Alternatively, you can click with the RMB in the Component Editor and select Add to 
Display, then pick the Fault document from the list.

Reloading an XML Document
If you have made changes to the document structures through mapping, and wish to return the Message 
Parts to their original state, you can reload the XML documents. When you reload the XML documents, 
all Parts, including Temp and Fault (if these were created) are returned to the state defined by the input 
and output XML documents. Keep in mind, however, the Map actions in the Action Model pane 
remain.Thus, if you were to execute the component, all Map actions will run.

The illustration below shows a component that contains several Map actions that are reflected in the 
Input, Output, and Temp Parts.

Notice the detail in the XML and the Map actions in the Action Model pane. The next illustration shows 
the same screen after the XML documents have been reloaded.
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The documents are back to their original state but the Action Model pane remains the same. Reloading 
XML documents is accomplished by selecting Reload XML Documents from the Component menu.

Loading a Sample Document
You can load different sample documents into any of the DOMs and use the new DOM structures for 
mapping elements or testing the Action Model. Loading a different sample document from your template 
allows you to test if your Action Model can handle all cases of XML documents your component might 
receive at runtime.

When you load an XML sample, the DOM changes, but the Action Model remains unchanged. When you 
are finished testing with the sample XML document, you can reload the original XML document(s) by 
repeating the Load XML Sample procedure.

To load a sample document:

1 From the File menu, select Load XML Sample. Alternatively, click with the RMB in the XML 
Editor Panel and select Load XML Sample from the context menu. The Load XML File dialog 
appears.

2 Select appropriate message Part from the Part dropdown box where you want the new sample 
document loaded.
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3 If you want to load a sample document that is not included in the original XML template, click File 
Name and type the name of the file. Alternatively, you can click Browse and find the file on your 
computer or network. You may also read in a file from a URL by explicitly preceding your 
filename with “http://,” “https://” or “ftp.”

4 If you want to load an XML file that is included in the original XML template, click Sample and 
select the XML document.

5 Check Default if you want to make the selected sample the default XML document for the selected 
Part in this component only. (This does not apply to the file name option).

6 Click OK.

Adding a Watch Variable
During the execution of your component, it can be very useful to examine the value of certain variables 
as a debugging aid. For this purpose, Integration Manager offers a Watch List, and the ability to create 
Watch variables to add to the list. 

You can identify the following objects as Watch variables:

Input, Temp, and Output Document location paths
Location paths from PROJECT 
Repeat Aliases
Node Aliases
ECMAScript expressions and variables

To add an item to the Watch Variable List

1 From the Component Menu, select Add Watch.
2 The Add Watch Dialog displays, giving you access to all the Variables, ECMAScript Functions and 

Methods and Operators associated with your project.

3 Doubleclick on the item you wish to add to the Watch list and click OK.
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4 During the execution of your component, click on the Watch tab in the Output pane to view the 
status of the items in your Watch List.

The use of a Watch List, including examples of how this could be used as a debugging aid, are discussed 
in greater detail in Chapter 12.

Saving Your Component
Save your component often to make sure your work is not lost due to hardware or software failures. You 
can also save the component with a different name, making a backup copy. When you save it with another 
name, you can also change the XML properties, including the input and output XML templates.

To save the component with a new name:

1 From the File menu, select Save As.
2 In the Name field, type a new name.
3 To change input and output XML documents, click the XML Property Info tab.
4 Change or add input XML documents.
5 Change the output XML document.
6 Click OK.

NOTE:  If you have more than one component open at a time, clicking on File>Save All (or pressing Ctrl-
Shift-A) will save all the open components at once. Similarly, File>Close All (Ctrl-Shift-F4) will save all 
components at once.

Saving a DOM as an XML Document
You can also save any DOM as an XML document. This creates (or overwrites) an XML document that 
contains the structure and data of the DOM. The following illustration shows an Output Part and the 
resulting XML document.
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To save an in-memory DOM to an XML file:

1 From the File menu, select Save XML As. The Save XML As dialog box appears.

2 Use the pulldown menu under Part to select the source DOM that you want to save to disk. In the 
above example, Output is selected.

3 Check the Save as File radio button.
4 Type a path and name for the XML document, or click Browse and select a path. 

NOTE:  If you select an existing XML document, it will be overwritten with the source DOM’s 
structure and data.

5 Click OK.

Saving an XML File as a Template
Any DOM that’s visible in the component editor can be saved as an XML Template directly (rather than 
first saving the DOM to a file, then importing it into a template). The target Template does not have to 
exist already; you can create one on-the-fly.

Output Part 
with data.

Resulting XML 
document
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To save a DOM to an XML Template:

1 From the File menu, select Save XML As. The Save XML As dialog box appears (as shown 
above).

2 Use the pulldown menu under XML Document to select the source DOM that you want to save as 
a template. 

3 Check the Save as Template radio button.
4 If you are creating a template on-the-fly, enter a name for the Category (or else pick an existing 

category from the pulldown menu provided).
5 If you are creating a template on-the-fly, enter a name under Template Name (or else pick an 

existing XML Template name from the pulldown menu).
6 Enter a Sample Name for this XML document. (This will be the name of the file on disk. The file 

will be saved under \xmlcategories\[CategoryName]\imports in your project directory.)
7 Click OK. You will see the new XML Template appear in the Instance Pane of Integration 

Manager’s nav frame.

During on-the-fly creation of an XML Template using the above technique, you will not be prompted for 
any additional information (such as schema name or XSL stylesheet) to associate with the new template. 
If you want to inspect or edit the validation, stylesheet, or other properties of the new template, follow the 
procedure outlined below.

Inspecting and/or Editing XML Template Properties
At any after an XML Template has been created, you can inspect or change its properties. See“Editing an 
XML Template” on page 88.

Avoiding Out-of-Memory Problems
When you are working with large DOMs, it is advised that at design time, to avoid memory errors, you 
add the following line to the xconfig.xml file. See the sample xconfig file excerpt below.

Line to add (or edit): <VM_PARAMS>-Xms64m-Xmx128m</VM_PARAMS>

To adjust available memory for deployed services (in the runtime environment), you will have to alter the 
VM command-line options for the app server’s VM. Consult your app server documentation for 
information on how to do this. 

You can avoid many out-of-memory problems (at runtime as well as design time) by appropriate use of 
Performance Filters as described in the next section. 

Using Performance Filters
The Define Performance Filter command (under the Component menu on Integration Manager’s main 
menubar) offers the potential for greatly improved performance when processing large incoming 
documents. It also offers significant benefits in terms of memory conservation, since a filtered document 
can require much less memory at runtime than an unfiltered document. 

Performance filters work by stripping superfluous document elements (and attributes) from incoming 
XML documents. You specify which elements to ignore; Integration Manager does the rest. In essence, 
the input document is “rewritten” on the fly in much-streamlined form, eliminating parts of the XML that 
are not necessary for your service. This results in a smaller in-memory DOM.
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Document filtering is useful because it is very common for a service to operate on only a few XPath 
locations in a given type of document. For example, one service might operate on the “Customer Info” 
nodes in an order form; a different service might operate on the “Product Request Detail” nodes of the 
same order form; and so on. It makes sense for each service to see and use only the portions of the 
document that apply to that service. 

To create a Performance Filter

1 Open a Service xObject, if one is not already open. 
NOTE:  Performance filters cannot be defined on Components. They can be defined on Service 
xObjects only.

2 Under the Component menu on Integration Manager’s main menubar, select Define Performance 
Filter. A dialog appears.

Note that the document shown in tree-view form in this dialog is the Input document for the 
service. (It is not possible to view other documents in this dialog.)

3 Check the checkbox(es) next to the nodes you want to keep in the document. Unchecked nodes will 
be stripped off (discarded) so that the parsed DOM does not contain the elements in question. (See 
additional discussion below.) 

4 Click OK to dismiss the dialog.

In the preceding illustration, the incoming document, with root node DoctorResp, will have a /physician 
node with a /patients node under it at runtime, and the /patients element, in turn, will have a 
PatientData element under it. Likewise, the latter will have child nodes LastName and FirstName. But 
since Physician is not checked, the incoming document will not have anything under the XPath:

DoctorResp/physician/patients/PatientData/Physician

NOTE:  At design time, you will initially, upon opening a service, see the complete (non-filtered) Input 
document, with all its nodes present in tree view, even if you have defined a Performance Filter. But when 
you begin stepping through the action model in animation mode, the document tree view will update to 
show the reduced (filtered) runtime structure of the document. 
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Viewing Component Properties
You can inspect (and in some cases edit) various properties of a component at any time.

To view or change component properties:

1 Select Properties from Integration Manager’s File menu. The Properties Dialog will appear. Note 
that the dialog has three tabs:

Header Info—This is the descriptive commentary you entered (or didn’t enter) when you first 
created the component.
Messages—This is equivalent to the second dialog in the New XML Map Component wizard: 
It shows the templates and template categories used in this component.
Connections—This tab will be present only in components that are associated with a particular 
Connection Resource. (For example, a JDBC Component would have such a tab in its 
Properties.) The plain XML Map Component does not have this information, and this tab does 
not appear.

2 To view or edit descriptive commentary for this component, click the Headers tab and enter the 
desired information.

3 To view or change XML template choices, click the Messages tab. You can add or remove template 
documents and/or template categories as need be.

4 If your component uses special Connection Resources, click the Connections tab to view 
Connection Resource info for this component. (Not applicable to ordinary XML Map components.) 

5 Click OK to dismiss the dialog.
6 Save your component.

Printing a Component
You can print the contents of a component. The printout contains:

Time and date you printed the component
Name and description of the component
All XML documents that make up the Input, Output, and Temp Parts
All actions in the Action Model

To print a component:

1 From the File menu, select Print.
2 Select a printer.
3 Click OK.
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Designing, Testing, and Running a Component
The following table shows how sample documents are used when designing, testing, and running a 
component.

DOM
While designing in 
Integration Manager

While using Animation Tools 
in Integration Manager While executing in Server

Input Samples can be loaded 
and used as design time 
aids for building actions 
and test data.

The default sample 
document is loaded and 
used to simulate a runtime 
Input Part.

XML data is passed in by 
another component, a 
service, or a Service 
Trigger.

Temp(n) Samples can be loaded 
and used as design time 
aids for building actions 
and test data.

The sample document is 
not loaded. The Part is built 
by the Action Model.

The Part is built by the 
Action Model 

Output Samples can be loaded 
and used as design time 
aids for building actions.

The sample document is 
not loaded. The Part is built 
by the Action Model.

The Part is built by the 
Action Model 

Fault Samples can be loaded 
and used as design time 
aids for building actions 
and test data.

The sample documents is 
not loaded. The Part is built 
by the Action Model.

The Part is built by the 
Action Model
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7 Basic Actions

Up to this point, you’ve learned how to create XML templates and an XML Map component that uses 
templates for inputs and outputs. Now it’s time to learn about the actual work that takes place. This is 
where the action is.

NOTE:  This chapter defines the basic actions available within the XML Map component. The next 
chapter covers more powerful actions and Chapter 12, “Applying Actions to Common Tasks” covers 
detailed examples of using some of these actions. 

What is an Action?
An action is similar to a programming statement in that it takes input in the form of parameters and 
performs specific tasks. For instance, the Send Mail action sends an e-mail when you supply the 
recipient’s e-mail address as one of the parameters.

Before looking at individual actions, you should first understand Integration Manager’s Action Model. 
You may remember an earlier discussion that a component is a set of instructions for processing XML 
documents or communicating with non-XML data sources. This set of instructions is called an Action 
Model. In Integration Manager, an Action Model performs all data mapping, data transformation, and 
data transfer within components and services.

An Action Model is made up of a list of actions. All actions within an Action Model work together. As 
an example, the Action Model for a component might read invoice data from a disk, retrieve the e-mail 
addresses from the invoices, and send e-mail messages to notify the recipients that their invoices were 
received.

The Action Model mentioned above would be composed of several actions. These actions:

Open an invoice document and read invoice data into memory
Extract the e-mail address from the invoice
Compose and send an e-mail
Update the invoice record to show that an e-mail was sent then close the file
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Using Integration Manager Actions
Integration Manager provides actions with the basic XML Map component. These actions are also 
available for all other component types, such as JDBC Components, JMS Components, etc. Actions are 
grouped on the Action menu as Basic Actions and Advanced Actions. The following table lists the suite 
of basic actions available in Integration Manager. The Advanced Actions are described in the next 
chapter.

Creating an Action
There are four methods for creating a new action: 

From the Action menu in the main menubar
From the Context menu available by right-clicking within the Component Editor 
Using keyboard shortcuts (available for the most commonly used actions only, see table above)
Using Cut/Copy and Paste

In all cases, you must have the component open before you can create an action.

Basic Action Description

Comment Documents the Action Model. You can use comments to clarify the processing, 
especially if Decisions and/or Repeats are used in the Action Model.

Keyboard shortcut: Ctrl-E

Component Executes another component or service and defines runtime DOMs to be passed 
to, and received from the called component.

Keyboard shortcut: Ctrl-T

Decision Allows you to execute one of two sets of actions based on a condition you 
specify. Processing branches along a True or False path, depending on how your 
condition is resolved as the component executes.

Keyboard shortcut: Ctrl-D

Declare Alias Allows you to assign an arbitrary label to any XPath, for convenience purposes. 
The label expands to the full XPath at runtime or animation time.

Function Executes either an ECMAScript script function or a custom script you have 
previously created. You can create custom scripts using Integration Manager’s 
Custom Script Resource Editor.

Keyboard shortcut: Ctrl-U

Log Writes information to various log files specified in the component. There are three 
Log types: System Output, System Log, and User Log. 

Keyboard shortcut: Ctrl-L

Map Transfers and optionally transforms element data from one XML DOM to another.

Keyboard shortcut: Ctrl-M

Send Mail Automatically sends an e-mail to a specified e-mail address during execution of 
the component.

Switch Allows program control to branch to a particular block of actions based on a 
match between an input value and a Case value. This is essentially a 
convenience action that can be used to eliminate long, hard-to-read if/else 
(Decision action) chains.

Todo Gives you a place to maintain a Todo list that organizes and tracks your tasks. 
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To create an action using the Action menu:

1 Open a component.
2 Click the mouse on (that is, highlight or select) a line in the Action Model just above the place 

where you want a new action. The new action will be inserted below the line you selected.
3 From Integration Manager’s Action menu (main menubar), select New Action and then the type of 

action you wish to create.

4 If a dialog appears, type or select parameters pertinent to the action, as required. (These are 
described individually in subsequent topics. See below.) Then dismiss the dialog, as applicable.

To create an action using the Context menu:

1 Select a line in the Action Model where you want to place the action. The new action will be 
inserted below the line you select.

2 Click the right mouse button to display the Context menu:

3 Select an action from the Context menu.
4 Interact as necessary with any dialogs that appear.
5 Dismiss the dialog(s).

To create an action using a shortcut key:

1 Select a line in the Action Model where you want to place the action. The new action will be 
inserted below the line you select.

2 Create your new action by pressing the key combination indicated in the table above. For example, 
pressing Ctrl-L will add a Log action to your model.
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To Cut, Copy, or Paste an action:

1 Select (click on) the action in the Action Model pane. 
2 Choose Cut, Copy, Paste, or Delete, as appropriate, from the Edit menu in the main menubar, or 

from the context menu available via right-mouse-click.
3 Type Control-Z (or choose Undo from the Edit menu) if you want to undo the operation.

In addition to adding actions, you can edit existing actions and disable actions within an Action Model. 
When you disable an action, it does not execute, but it remains in the Action Model, and you can enable 
it at a later time.

To edit an action:

1 Doubleclick any action in the Action Model and edit it.
2 Alternately, you can select the action in the Action Model pane.
3 From the Action menu, select Edit. A dialog box for the action type appears.
4 Make any necessary changes to the action.
5 Click OK.

To disable an action:

1 Select the action in the Action Model pane.
2 From the Action menu, select Disable. The action is grayed out.
3 Repeat steps 1 and 2, selecting Enable, to enable the action again.

The rest of this chapter describes each basic action and gives examples on how to use them. 

The Comment Action
You can use the Comment action to document your Action Model and clarify the processing that takes 
place. You can add comments anywhere within an Action Model. They perform no processing of their 
own.

To add a Comment action:

1 Open a component.
2 Select a line in the Action Model where you want to place a comment. The new comment is 

inserted below the line you selected.
3 From the Action menu, select New Action, then Comment, or press Ctrl-E. The Comment dialog 

appears.

4 Type your comment.
5 Click OK.
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The Component Action
The Component action calls and executes another component or service with runtime inputs and outputs 
that you specify. You can call any component in your project. To call another component, you must 
specify four parameters to the action:

Component Type
Component Name
Passed IDs
Returned ID

The Component Type is simply the category of component you wish to call. The component types do not 
correspond to those listed in the Integration Manager Category pane under the Component heading. The 
following strings are valid values and are case sensitive:

service
map
jdbc
3270
5250
cicsrpc
html
jms
vt100

depending on whether or not you have the Connect installed that implements that Component Type.

The Component Name is the name of the component you wish to call or target component. The 
Component Name must be one that exists within the Component Type you select.

The Passed ID are document names within the current component or service. You can specify none, one, 
or more documents to pass into the target component. The document names you specify here will be 
passed into the target component as its Input documents.

The Returned ID is the name of a document within the current component or service that will receive the 
results of the target component. You can use the name of an existing document or force the creation of a 
new document by specifying a name that does not already exist.

You can specify these parameters in one or two ways: Predefined or Dynamic. A Predefined Component 
action populates the four parameters with values derived from the current state of the project. Once 
specified, these values remain fixed for all executions of the action unless you manually change them. A 
Dynamic Component action populates the four parameters at runtime with values calculated from 
expressions you create. This allows the Component action’s behavior to be flexible and vary based on 
runtime conditions each time it is executed. One Component action can execute a different component 
depending on various runtime conditions, or pass in different Input documents, or receive results into 
different result documents.

To add a Predefined Component action:

1 Open a component.
2 Select a line in the Action Model where you want to place a call to a component. The new action is 

inserted below the line you selected.
3 From the Action menu, select New Action, then Component, or press Ctrl-T. The Component 

dialog appears.
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4 Select Predefined, by clicking on the radio button, if it is not already selected.

5 Select the relevant Component Type from the drop down list.
6 Select a Component Name to execute (the list of Components is context sensitive to the Component 

Type selected).
7 In the Passed ID field, select a source component DOM.
8 In the Returned ID field, select the source DOM into which the called component will return its 

Output. If you wish to create a new DOM, you may type the name in the Returned ID field.
9 Click OK.

To add a Dynamic Component action:

1 Open a component.
2 Select a line in the Action Model where you want to place a call to a component. The new action is 

inserted below the line you selected.
3 From the Action menu, select New Action, then Component, or press Ctrl-T. The Component 

dialog appears.
4 Select Dynamic, by clicking on the radio button, if it is not already selected.
5 Create an ECMAScript expression that evaluates to one of the following valid Component Types: 

map, service, JDBC, 3270, 5250, CICSRPC, JMS, HTML
NOTE:  A Component Type will only be valid if the Connect implementing that Type is installed in 
your version of Integration Manager.

6 Create an ECMAScript expression that evaluates to a valid component or service name in your 
project.
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7 Create an ECMAScript expression that evaluates to a valid document ID at runtime in the current 
component or service. This document will be passed to the target component or service as its Input 
document. If passing more than one document, the expression must evaluate to a single string 
containing a comma-separated list of document IDs (e.g. Input, Input 1, Temp, MyDoc).

8 Enter an ECMAScript expression that evaluates to a document ID that will receive the results of the 
target component.

The Decision Action
The Decision action creates an if. . . then branching between actions or group of actions. You use a 
Decision action to select one branch or another, based upon a condition you supply. The condition must 
use an ECMAScript comparison operator, such as = =, <, >,!, >=, <=, (&), OR (||), or <>. The expression 
must resolve to the Boolean true or false statement. For instance, you can check to see if an invoice is 
older than a certain date and send an e-mail if it is.

To add a Decision action:

1 Open a component.
2 Select a line in the Action Model where you want to place the Decision action. The new action is 

inserted below the line you selected.
3 From the Action menu, select New Action, then Decision, or press Ctrl-D. The Decision dialog 

appears.

4 Type the expression using any of the ECMAScript comparison operators or click the Expression 
Builder button and create a Decision script (ECMAScript expression) that will evaluate to true or 
false at runtime.

5 Click OK. The Action Model displays the following Decision action, which tests for the existence 
of an INVOICE node.

6 In the Action Model pane, select the TRUE icon.
7 Add one or more actions that will execute if the expression is true. you can, of course, cut/copy 

actions via drag and drop from outside the true branch to within the true branch.
8 Select the FALSE icon.
9 Add one or more actions that will execute if the expression is false.

You can nest other Decision actions inside the TRUE and/or FALSE branches of the Decision action. 
The following illustration shows a complete decision in the Action Model pane.
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The Declare Alias Action
The Declare Alias action allows you to apply your own arbitrary custom label to a given XPath 
expression (valid within the scope of a given action model). You would use this action to make your 
action model more readable and save typing. 

To add a Declare Alias action:

1 Open a component.
2 Select a line in the Action Model where you want to place the Declare Alias action. The new action 

is inserted below the line you selected.
3 From the Action menu, select New Action, then Declare Alias. The Declare Alias dialog appears.

4 Type the name you intend to use in the Alias text field.
5 Choose either the XPath or the Expression radio button.
6 If you have chosen the XPath radio button, select a target DOM (representing the document 

containing the target XPath) from the dropdown menu. Then enter the XPath to the target node in 
the text field below.

7 If you have chosen the Expression radio button, type the appropriate ECMAScript representation of 
the target XPath in the text field, or click the Expression Builder icon (to the right of the text field) 
and use the Expression Builder pick-lists to build an expression.

8 Click OK. The new action is added to your action model

In the above example, the Input Part has a node called SHOW_PRODUCT/LIST_PRICE. Rather than 
type $Input/SHOW_PRODUCT/LIST_PRICE repeatedly throughout the action model, one could, for 
convenience, assign an alias (an arbitrary name) to the XPath expression. In this case, the alias “aPrice” 
has been assigned to $Input/SHOW_PRODUCT/LIST_PRICE. From this point on, throughout the 
action model, one can use “aPrice” instead of $Input/SHOW_PRODUCT/LIST_PRICE. At runtime, the 
alias will be expanded to the complete XPath.
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The Function Action
The Function action executes either an ECMAScript function or a custom script function you have 
already created in the Custom Script Resource Editor. To manipulate a DOM element, the script you call 
in the Function action must reference a fully qualified DOM element name in the current component.

Custom Script functions you create and add to an Action Model can act upon any XML tree element. For 
instance, you can create a function that changes the format of a date element. You can create a function 
that performs a math function on the contents of an element. You can also perform file system, database, 
or URL functions that have no interaction with a Message Part. The Function Action can also be used to 
call Java methods that you have registered in the Custom Script Resources. This gives an ability to 
visually integrate complex (and simple) Java processing directly onto the Action Model.

To add a Function action:

1 Open a component.
2 Select a line in the Action Model where you want to place the Function action. The new action is 

inserted below the line you selected.
3 From the Action menu, select New Action, then Function, or press Ctrl-U. The Function dialog 

appears.

4 Type the function in the Function Call field or click the Expression Builder button to build an 
ECMAScript expression (discussed below). Function calls are case sensitive. Also, if the function 
requires parameters, make sure to include them in the function call.

5 Click OK. Alternately, you can click on the Apply button to see the affect of the Function action 
without closing the dialog. This allows you to make repetitive edits to a Function action quickly see 
the results.
Basic Actions 133



To use the Expression Builder:

1 Add a new function action as described in the previous section.
2 Click the Expression Builder button to open the Function Expression Builder dialog.

3 Doubleclick variables, functions/methods, or operators to insert them into the function. You can 
also type directly into the function.
NOTE:  Make sure the function follows ECMAScript standards or it will not compile or run correctly. 
It is usually more efficient to create functions within a Custom Script resource and test them before 
using them. When creating a Function action, you can simply refer to the Custom Script function 
name and supply it any parameters.

4 Click Validate to verify the script before saving it.
5 Click OK to save the script.
6 Click OK again to add the function action.

NOTE:  Since ECMAScript is an interpreted language, Validate doesn’t check any runtime dependent 
expressions other than to see if they conform to valid ECMAScript syntax.

The Log Action
Log actions are designed to provide customizable reporting capabilities (design-time as well as runtime) 
for Integration Manager applications. You can exercise fine control over the degree of reporting desired, 
by the use of Log Level settings (see further below); Log Actions needn’t simply be turned "on" or "off."

Some examples of where the Log Action might be used are:

To write out certain error information to the operator console when a Try On Fault condition is 
reached.
To aid in debugging. (Since Log messages can be constructed as ECMAScript expressions, you can 
log information about variables or DOM contents whose values are known only at runtime.)
To capture specific information from each cycle of a Repeat for Element loop.
To help create self-reporting components during development.
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Log File Locations
The Log action writes information to any of various locations external to Integration Manager and 
Integration Manager Enterprise Server. The actual locations are specified by the action. There are three 
locations for log output: System Output, System Log, and User Log (see below).

System Output

The System Output option writes out messages you specify in the Log Expression field to the Java Virtual 
Machine process window at design time or the Application Server console at runtime.

To create a Log message you can write any valid ECMAScript expression or use the Expression Builder 
to generate a Log Expression. Each message logged is preceded by a Date/Time stamp and the 
Component doing the logging. These messages also appear in the Message frame of the main Integration 
Manager window.

System Log

The System Log option writes out messages you specify in the Log Expression field to the filename 
specified in the <LOGFILE> element of the Integration Manager configuration file: xconfig.xml. You 
can change the name and location of the log file from the Integration Manager Tools menu by selecting 
Tools > Preferences from the Integration Manager menubar and going to the General tab.

User Log

The User Log option writes out messages you specify in the Log Expression field to a file you specify in 
the User Log File field of the Log Action dialog (see below).

To create a Log message, you can enter a static string or write any valid ECMAScript expression (or use 
the Expression Builder to generate a Log Expression). The results of the Log Expression will be written 
out to the Log as text. Each message logged is preceded by a Date/Time stamp and the Component doing 
the logging.

To create a User Log File you can also write any valid ECMAScript expression to generate the file name, 
click the Expression Builder button to use the Expression Builder.

Log Priority Levels
Individual Log Actions can be assigned priority levels (from 1 to 10). At runtime, a Log Action’s priority 
level is compared against a reporting threshold value which you set in the General tab of the Preferences 
dialog under the Tools menu. Any Log Action whose priority is equal to or greater than the reporting 
threshold will be executed (that is, its message will be logged to system output or to disk, as appropriate), 
while Log Actions of lower priority will not have their messages reported.

Priority levels for individual Log Actions can be set in the Log Action dialog. The reporting threshold is 
set in the General tab of the Preferences dialog (as explained below). Once a threshold value is set, only 
Log Actions of equal or greater priority will execute. For example, if Log Action A has a priority setting 
of 4 and Log Action B has a priority of 9, and the threshold setting in the Preferences dialog is 8, then at 
runtime only Log Action B will execute. Log Action A will be ignored.

NOTE:  The reporting level can also be adjusted after deployment of your project, via the Integration 
Manager Enterprise Server console screen. Consult your Integration Manager Enterprise Server 
documentation for details.
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To set the reporting threshold for logging:

1 Go to the Tools menu, then choose Preferences. The Preferences dialog appears.

2 In the General tab, set the Log Threshold to a value from 1 to 10. The value you set here is a 
threshold value, which means that only Log Actions with a priority equal to or greater than this 
value will execute.

3 Click OK to dismiss the dialog.

To create a Log action:

1 Open a component.
2 Select a line in the Action Model.
3 From the Action menu, select New Action, then Log, or press Ctrl-L. The Log dialog appears.

4 In the Log to radio group, choose the location to which you want messages written. (See 
explanation of locations further above.)

5 Use the Log Level spin control to select a priority level (1 to 10) for this Log action. The default is 
5. In general, you should assign high numbers to messages with high importance. The priority you 
assign here will be ompared to the threshold number you chose in the last section (see further 
above). If the priority is equal to or greater than the threshold, the message is logged; otherwise it is 
not.

6 Enter a String or ECMAScript expression in the Log Expression text field. (You can use the 
Expression Builder—accessed by clicking the small icon to the right of the text field—to build an 
expression via pick-list selections).
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7 Check Clear the Log File if you want the data in the log file to be cleared each time the component 
is executed.

More information about log files can be found in “Viewing System Messages” on page 65.

The Map Action
The Map action is a DOM-node input/output mapping. It transfers (and optionally, transforms) data from 
one document context to another document context. A context has two parts. The first part usually 
identifies a DOM and the second part identifies a location within the DOM. The basic document context 
in Integration Manager is expressed as a DOM name combined with an element location (referred to as a 
location) identified through an XPath expression. The DOM name is usually Input, Input1, Input(n), 
Temp, Output, or any named DOM you have loaded in the component. The XPath expression identifying 
a location in a DOM has the path elements delimited by “/”.

NOTE:  A context in Integration Manager can also be a Group name that itself is simply an alias or short-
hand for an XPath expression.

About XPath and ECMAScript Expressions
When you create a Map action, you can choose between two methods for addressing locations in XML 
Documents: XPath and ECMAScript. The default choice is XPath, and it is the basic method of 
addressing.

The Basic Method: XPath by Itself

The primary purpose of XPath is to address or locate parts of an XML document (that is, elements and 
attributes). XPath also provides basic facilities for manipulation of strings, numbers and booleans 
through a simple expression syntax. XPath addresses message Part nodes, including element nodes, 
attribute nodes and text nodes.

XPath is based on pattern matching. You specify a pattern of element names that resolve to the nodes in 
the target document. Most of the time, XPath returns a node list containing the particular nodes that 
match your pattern. (Many XPath expressions return only one node, but it is very common to return 
multiple nodes.) Other times, XPath can return a primitive value (string, number, or boolean).

In all Integration Manager dialogs that take an XPath expression, you can build the expression with the 
aid of pick-lists in an Expression Builder. (See “To build an expression using ECMAScript:” further 
below.)

The complete XPath specification can be seen at http://www.w3.org/TR/xpath.

NOTE:  The XPath spec is also available under the \Doc directory of your Integration Manager 
installation.

The Alternative Method: XPath within ECMAScript

The second method to address locations in DOMs is to use ECMAScript with XPath. Choose this method 
if you wish to go beyond strict XPath addressing. ECMAScript is an object oriented scripting language 
for manipulating objects in a host environment (that is, Integration Manager). ECMAScript (ECMA-262 
and ISO/IEC 16262) is the standards-based scripting language underpinning both JavaScript (Netscape) 
and JScript (Microsoft). It is designed to complement and extend existing functionality in a host 
environment such as Integration Manager’s graphical user interface. As a host environment, Integration 
Manager provides ECMAScript access to various objects (including DOM objects) for processing. 
ECMAScript in turn provides a Java-like language that can operate on those objects.
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Integration Manager’s built-in ECMAScript interpreter recognizes a custom Integration Manager 
method called XPath(). It allows expressions such as:

Input.XPath(“Inventory/Books/Engineering”)

Construction of this type of expression is greatly facilitated by the user of Integration Manager’s 
Expression Builder facility. (See “To build an expression using ECMAScript:” further below.)

Adding a Map Action

To add a Map action:

1 Open a component.
2 Select a line in the Action Model where you want to place the Map action. The new action is 

inserted below the line you selected.
3 From the Action menu, select New Action, then Map, or press Ctrl-M. The Map dialog appears.

4 The Source type is XPath. Select a Part (Input, Output, or Temp) from the pulldown menu, then 
type the appropriate XPath expression, locating the element you want.
NOTE:  Alternatively, you can click the Expression Builder to have Integration Manager assist you 
in building the XPath expression. See “Using the XPath Expression Builder” on page 141. 

Together, the Part name and XPath specify the Source context for the Map action.
5 Repeat steps 4 and 5 for the Target.
6 Under Options, in the middle of the dialog, check Content Editor and/or Code Table Map and/or 

Advanced to exercise finer control over the mapping.
NOTE:  More information on the Content Editor and Code Table Map option is available in 
“Transforming Elements” on page 325. A discussion of Advanced options appears below. Note that 
you will 

7 Click OK. The Map action appears in the Action Model pane as shown. 
NOTE:  You can press the Apply button to see the affect of the Map action without closing the 
dialog. This allows you to make repetitive edits to a Map action and quickly see the results.
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Default Mapping Behavior

When you use the Map action to map elements and attributes within XML Documents, certain default 
behaviors occur. The following table lists those default behaviors.

Many of these behaviors can be altered, on an action-by-action basis, through the use of options exposed 
in the Advanced mapping dialog (see next section). 

Leaf Elements that Contain Markup

A special situation can arise when an element is populated at runtime by a Java or ECMAScript 
operation. It’s possible that the element might receive data that contains markup—in other words, strings 
with illegal characters, such as < and >. This presents a mapping challenge, in that if Integration Manager 
were to merely map the raw contents of such an element, unchanged, to a node in the Output DOM, the 
output document would be malformed. 

Integration Manager resolves this issue by mapping any data that contains markup to a CDATA section 
created on-the-fly in the target document.

NOTE:  A somewhat different behavior applies at design time, when markup is entered by hand. At 
design time, if you type markup data into a node (via right-mouse-click/Edit Data), the markup characters 
are entitized on the fly. If you examine the raw XML in Text View, you’ll see that any ’<’ characters entered 
by hand are converted to &lt; (and so on). The entitized data are then mapped directly to output.

Map Type Default Behavior

Leaf Element to 
Leaf Element

Transfers the element data only.

Leaf Element to 
Branch Element

Transfers the element data only.

Branch Element to 
Leaf Element

Transfers the entire branch including all child elements 
and attribute data under the branch.

Branch Element to 
Branch Element

Transfers the entire branch as above after removing the 
target’s current branch.

A particular Leaf 
Element in a list of 
Leaf Elements, to 
Element

Transfers the element data from the selected leaf (or 
element instance) to the target element.

Attribute to 
Attribute

Transfers the attribute data only.

Element to 
Attribute

Transfers element data to attribute data.

Attribute to 
Element

Transfers the attribute data only.
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Advanced Mapping Options
When the Advanced checkbox is checked in the Map Action Dialog, the following dialog appears. Note 
that the options you set in this dialog affect only the current Map Action; not subsequent ones.

The options in this dialog give you finer control over how input Part nodes are mapped to the output Part.

Copy Attributes

This grouping of controls allows you to specify how attributes are mapped. Three radio buttons appear 
under this grouping.

For Non-Leaf Root Nodes and Dependents—This button, checked by default, represents the 
standard (default) mapping behavior of Integration Manager: When a non-terminal (non-leaf) 
element is mapped to output, the element—minus its attributes—and its children are mapped to 
output. Attribute data for the children are included, but not for the original (parent) element.
Never—This option means no attribute data (whether for parent or leaf nodes) will be carried over 
during mapping.
Always—All attribute data, for all nodes, will be mapped to output.

Deep Copy

By default, Integration Manager maps whole branches at a time (that is, the target node plus all of its 
children). In some cases, you may want to turn off this “deep copy” behavior so that you can copy just 
the parent element without its children. Uncheck the checkbox labelled “Map the Dependents” if you 
want to disable Integration Manager’s standard deep-copy behavior.

Create Target

The Create Target option allows you to optionally create the destination node (or branch) that you 
specified under Target in the Map Action dialog, based on whether or not the source node (or branch) is 
present in the source DOM. The default behavior is that Integration Manager always creates the target, 
whether or not the runtime source DOM contains the node(s) that you specified in the Source XPath for 
mapping. 

For example: In the Map Action dialog, you may have specified a Source XPath that looks like
140   Integration Manager User’s Guide



$Input/Root/MySourceElement

while under Target, you may have specified something like

$Output/Root/MyParentNode/SomeOtherElement

If the arriving Input document doesn’t have a node corresponding to Root/MySourceElement, Integration 
Manager will (by default) nevertheless create an empty Root/MyParentNode/SomeOtherElement node in the 
output DOM. In some cases, this might not be what you want. Using the radio buttons in the Advanced 
Mapping dialog, you can change the default behavior.

NOTE:  The Create Target options are disabled if Code Table Map was selected in the Map Action dialog.

The options under this radio button grouping are:

• Only if Source Exists—This means that the Map Action will simply be skipped (no target nodes created in 
the output DOM) if the node specified in the Source XPath doesn’t exist in the input document.

• Raise Error—If the input document doesn’t contain the node specified in the Source XPath, it will be con-
sidered an error at runtime, if this button is selected. You should plan accordingly by wrapping your Map 
Action in a Try/OnError block so you can handle the error.

• Always—Default behavior. (Target node is always created.) When this button is selected, the nearby Default 
Value text field becomes enabled so that you can optionally enter a default data value for the target element.

Create Target as CDATA Section

This radio-button group allows you to control the way element data gets mapped into CDATA sections. 
The options are:

Only if source contains markup—This choice means that if the source data contains XML tags, HTML 
tags, or other types of markup where "illegal" characters are used, the data will be placed, unmodified, in 
a CDATA section in the target DOM. This is the default behavior of Integration Manager.

Never—With this option set, source data is guaranteed not to be wrapped in a CDATA section for output. 
Any illegal characters that occur in the source data will be converted to properly escaped entities, such as 
&gt; for >, on the output side.

Always—This means that whatever form the source data might take, it will get wrapped in a CDATA 
section on output.

Using the XPath Expression Builder
When you are in the Map Action dialog, you can build your own XPath expressions by choosing the 
Expression Builder button at the far right of the appropriate text field. The XPath Expression Builder 
dialog that appears will display pick-lists to help you construct valid XPath syntax in point-and-click 
fashion. This can be especially handy when you wish to go beyond basic XPath addressing and use some 
of the more powerful features of XPath.

Integration Manager uses the XPath addressing syntax adopted by W3C. The XPath syntax is similar to 
URI address syntax in basic appearance but includes many subtle and powerful features for addressing 
and manipulating XML. Some of the more common syntax rules are listed in the following table.

XPath Syntax Description

/ The single forward slash represents an absolute path to 
an element. /ABC selects the root element ABC.

// Double slashes represents all elements in a path. //ABC 
selects all occurrences of ABC. //ABC//DEF selects all 
DEF elements which are children of ABC.
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The complete list of operators can be seen at http://www.w3.org/TR/XPath.

To build an expression using XPath

1 Open a component.
2 Select the Map action from the Action menu.
3 Ensure that the XPath radio button is selected.
4 Click the Expression Builder button. The Source XPath dialog displays.

5 Create an expression by doubleclicking on the items from the panes.

* The asterisk selects all elements located by the 
preceding path. *ABC/DEF selects all elements 
enclosed by elements ABC/DEF. //* selects all 
elements.

[ ] Square brackets specifies a particular element. /ABC[3] 
selects the third element in ABC. This can also be used 
as a filter (similar to a Where clause in SQL). 
//ABC[“Table”] selects all elements that have the content 
“Table.”

@ The At sign selects elements with a specified attribute. 
/ABC@name selects all elements in ABC that have an 
attribute called name.

| The vertical bar allows you to specify multiple paths. 
//ACB|//DEF selects all elements in ACB and in DEF.

$ The dollar sign allows you to reference other documents 
besides the current one. 
INVOICEBATCH/INVOICE[SELLER/NAME=
$PROJECT/USERCONFIG/COMPANYNAME]

function() XPath has numerous functions that you can add to your 
XPath addresses. For instance, //*[count(*)=2] selects 
all elements that have two children.

math operator() XPath has numerous math operators that you can add 
to your XPath addresses. For instance, /ABC|position() 
mod 2 = 0] selects all even elements in ABC.

XPath Syntax Description
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6 Verify that your expression’s syntax is correct (using the Validate button).
7 Click OK.

Using the ECMAScript Expression Builder
When you select the ECMAScript radio button in the Map action, the ECMAScript Expression Builder 
appears and helps you construct valid ECMAScript syntax. This is desirable when you want to go beyond 
strict XPath addressing and use some of the more powerful features of Integration Manager's 
ECMAScript addressing.

The illustration below shows the ECMAScript Expression Builder.

Objects in the pick-lists are ordered with most frequently used objects first. All properties and methods 
for an object are also ordered. Properties are always listed first alphabetically, followed by all the object’s 
methods alphabetically.

All of the items in the Functions/Methods pick-list and the Operators pick-list have tool tips associated 
with them. To view a tool tip, simply hover your cursor over the item you’d like to know more about. If 
you hover your cursor over the items in the Variables pick-list, data associated with that item will be 
displayed.

NOTE:  While you can create complex ECMAScript expressions, they must evaluate to a document 
context consisting of a DOM and an address within the DOM.

To build an expression using ECMAScript:

1 Open a component.
2 Select the Map action from the Action menu.
3 Select the radio button next to Expression.
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4 Click the Expression Builder button. The Source Expression dialog displays.

5 Create an expression by doubleclicking on the items from the panes.
6 Optionally click Validate to verify that your expression’s syntax is correct. (This does not execute 

the expression. The expression is merely parsed.)
7 Click OK.

The Send Mail Action
The Send Mail action creates and sends e-mail messages dynamically during the execution of a 
component. When you create a Send Mail action, you specify the various parameters needed in order for 
Integration Manager to know where and how to send the e-mail. The parameters can be hard-coded or 
(alternatively) ECMAScript expressions that evaluate at runtime. 

Some possible uses of the Send Mail action include:

Sending an “order status” notice to a customer after he or she has placed an order via the web.
Triggering human intervention in a service that requires such intervention as part of normal 
workflow.
Notifying system administrators (or others) of critical error conditions requiring immediate action. 
(The mail could even be routed to a pager or other mobile device.)

The e-mail you send with the Send Mail action can have attachments of any arbitrary MIME type. Also, 
various Send Mail actions can use various mail servers (with or without user name and password). 

Mail via SMTP Simple Authentication
Although some in-house mail servers might not require a user name or password for outbound mail, 
many SMTP servers issue an authentication challenge before granting access. If your Send Mail actions 
will be using a mail server that requires user ID/password authentication, you will need to create a Mail 
Simple Authentication connection resource. This resource simply stores the network address for the 
mail server you want to use, along with a user name and password. The resource, once created, can be 
reused by any number of components and/or services within your project.
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It’s worth noting that you are not required to create one Mail via SMTP resource for each server (or for 
each user name and password combo) you intend to use. All parameters in the Mail via SMTP connection 
resource can be indirected through ECMAScript, so that server names or user credentials (or both) are 
late-bound— perhaps obtained by lookup from a directory or database, at runtime. Using ECMAScript, 
you can apply your own business logic to decide which mail server (or which credentials) to use in a 
given circumstance at runtime.

NOTE:  See the discussion at “About Constant vs. Expression Driven Connections” (in the chapter on 
Resources) for additional information on how ECMAScript can be used for late binding of connection-
resource parameter values.

To create a Mail Simple Authentication connection resource:

1 Under Resource in the navigation (explorer) frame, right-click on Connection and choose New 
from the context menu as shown below:

2 In the wizard pane that appears (see below), enter an arbitrary Name for this connection resource 
and (optionally) descriptive text.
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3 Click Next. The second (and final) panel of the wizard appears:

4 Using the pulldown menu control, select Mail via SMTP Simple Authentication as the Connection 
Type.

5 Next to SMTP Server, enter the name or IP address of the mail server you intend to use.
6 Next to User ID, enter the user name associated with the mail account you wish to use.
7 Next to Password, enter the password associated with the user account in question.

NOTE:  Again, note that any of these parameters may be entered as ECMAScript expressions. See 
the discussion at “About Constant vs. Expression Driven Connections” (in the chapter on 
Resources) for additional information on using ECMAScript here.

8 Click Finish.

How to Create a Send Mail Action

To create a Send Mail action:

1 Open a Component.
2 Select a line in the Action Model where you want to place the Send Mail action. The new action 

will be inserted below the line you select.
3 From the Action menu, select New Action, then Send Mail. The Send Mail dialog appears. Note 

the presence of three tabs: Message, Server, and Attachments.
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4 Select the Message tab if it is not already selected.

5 In the Mail Recipient field, type an ECMAScript expression to specify the e-mail address of a 
recipient. The expression should evaluate to a string of the general form name@domain.extension. If 
you are hard-coding a string value, make sure the text is enclosed in quotation marks.

6 In the Mail Sender field, enter an ECMAScript expression to specify the string you wish to show 
as the sender’s e-mail address. (It can be any arbitrary string; it does not have to be an actual e-mail 
address.) Again, if you are hard-coding a text value, make sure the text is enclosed in quotation 
marks.

7 In the Mail Subject field, type a valid ECMAScript expression to specify the e-mail subject or type 
a subject line. Again, if you are hard-coding a string, make sure the text is enclosed in quotation 
marks. 

8 In the Mail Body field, type a valid ECMAScript expression to specify the e-mail body text (or 
type the body text enclosed in quotation marks). 

9 Under Encoding, specify (using the pulldown menu) the type of encoding your message should 
use. The default is ASCII.
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10 Select (click on) the Server tab. The dialog changes appearance:

11 Click the Mail Server radio button if you wish to specify an ECMAScript expression that will 
resolve to your mail server’s address (as shown above). Alternatively, click the Connection Name 
radio button if you wish to use a server that has been specified in a “Mail via SMTP Simple 
Authentication” connection resource. (See the discussion of this resource type at “Mail via SMTP 
Simple Authentication” earlier in this section.) You would use the latter option in cases where user 
authentication (via username and password) is required in order to access the server. 

12 If you want to include attachments with the e-mail, click the Attachments tab. (Otherwise, click 
OK to return to the component editor.) The dialog changes appearance:

13 Click the plus-sign (+) button to add an attachment.
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14 Under Type, specify String or URL (using the pulldown menu control). 
Specify String if you want the value in the Attachment column of the table to be the (literal) 
attachment to the e-mail. 
Specify URL if you want to indirect the attachment target through a URL (using file: or http: 
protocol schemes). 

15 Under Content-Type, specify the MIME type of the attachment. You can either choose from the 
MIME types shown in the dropdown menu, or you can enter your own MIME type in the editable 
field. 

16 Under Attachment, enter the ECMAScript expression that will serve as the attachment content (if 
you chose String under Type) or as the URL to the file you wish to send. In the example above, the 
first attachment is a String consisting of the data associated with the /message node of the 
component’s Input document. The second attachment (a JPEG image) specifies a URL string 
contained in the previously declared ECMAScript variable named “image.” The variable in 
question could resolve at runtime to something like “file:///d:/server-
1/resourcestore/images/stockimage.jpg.” 

17 Click OK. A new Send Mail action appears in the action model of your component:

The Switch Action
The Switch Action (inspired by the Java and C-language switch statement) is designed to allow your 
application to branch to the appropriate custom logic based on the value of a particular input variable or 
XPath expression. The Switch Action is a convenience action that obviates the need for a series of nested 
Decision Actions. It increases the readability of your action model significantly by eliminating multiple 
actions and consolidating them into one coherent, easily documented, easy-to-read action. 

About Cases
The Switch Action compares a series of values or choices ("cases")—which may be either static or 
dynamic—against an input value. If an exact match occurs between the input value and one of the 
available choices, execution branches to the action(s) listed underneath the choice. Just as with a series 
of if/else statements, cases are tested in the order listed; and once a match is found, execution of the 
match logic precludes execution of any other logic in the Switch Action.

The custom logic associated with any Case can consist of a single action or a block of actions; and the 
actions can include any of the standard (basic or advanced) Integration Manager actions, as well as 
actions specific to a particular Connect. 

A Switch Example

Suppose your incoming XML document represents a retail order for goods, and one of the tasks your 
application must perform is the determination of a shipping method based on the customer’s location. 
The input to the Switch Action might be an XPath expression like:

$Input/Order/Customer/Address/Country

The case values for the Switch Action, and the associated logic for each choice, might look like:

CASE:"USA"
CALL shipMethod = (weight < 10) ? "FedEx" : "UPS";

CASE:"ANGOLA"
CALL shipMethod = "Air Gemini";

CASE:"ARGENTINA"
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CALL shipMethod = "International First Services";
CASE:"AUSTRALIA"

CALL shipMethod = "Ansett International";
.
.
.
DEFAULT:

CALL shipMethod = "UPS";

At runtime, the value of the Input DOM element at Order/Customer/Address/Country will be 
checked against each successive Case value, starting with "USA," until a match is reached. In this 
example, if the match occurs at "ANGOLA", the Function Action that assigns "Air Gemini" to the 
(ECMAScript) variable shipMethod will execute, then the Switch Action will exit immediately, and 
execution will continue with the first action (if any) following the Switch Action.

NOTE:  No explicit Break action need be inserted in any Case action group, because the built-in "fall-
through" behavior of Java and C-language case statement is not a feature of Integration Manager’s Switch 
Action. Once a match happens, fall-through to the next Case never occurs. 

The foregoing example could be equivalently written as a series of Decision Actions. The pseudo-logic 
for the chain of Decision Actions would be:

country = inputValue
if (country == USA)

ship via A or B
else if (country == ANGOLA)

ship via C
else if (country == ARGENTINA)

ship via D
else if (country == AUSTRALIA)

ship via E
[etc]

else ship via Default shipper

The Switch construct eliminates the stairstep indentation and repetitive if/else logic that characterize this 
kind of code. It also results in easier-to-read-and-maintain code. In general, any time you are faced with 
a long series of conditionals, you should consider using a Switch Action.

About the Default Case
The final "Case" under every Switch action is always labelled Default. This line is generated 
automatically and cannot be removed. Actions placed under Default are executed if and only if the 
Switch Action, at runtime, encounters no matching Case in the list of Cases. 

NOTE:  While you are not required to place actions under Default, it is good programming practice to 
have at least some kind of fallback logic for the "no match" case, even if it’s only a Log action or a Raise 
Error action.

To add a Switch action:

1 Open a component.
2 Select a line in the Action Model where you want to place a Switch Action. The new action will be 

inserted below the line you selected.
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3 From the Action menu, select New Action, then Switch. The Switch Action dialog appears. (The 
text values in the dialog shown below are not defaults. Values were entered for purposes of 
illustration only.)

4 Enter an XPath or ECMAScript expression in the top of the dialog under Expression. This is the 
input value to the Switch Action.

5 In the combo box, enter the static string values or the ECMAScript expressions that will be checked 
against the input value that you specified in the previous step. Remember that at runtime, each Case 
value will be checked in turn, in the order you list them. (Tip: For optimal performance, list the 
most likely matches first.)
NOTE:  New Case entries are, by default, added to the end of the existing list. But you can change 
the order of the choices by highlighting a given choice and clicking the Up and Down buttons as 
need be.

6 Click OK. The dialog goes away and the new Switch Action appears in your action model. See 
example below.

Once you have added a Switch Action to your action model, you will see a list of Case values. To 
associate your own custom logic with a given Case, click on the Case, then add new actions one at a time 
as needed, by clicking the right mouse button and choosing New Action from the context menu. Your 
Actions block can contain any number of actions (of any type).

To add custom case-handling logic:

1 In the action model, find the Case to which you want to add processing logic.
2 Click on the Actions line below the Case.
3 Right-click to bring up the context menu. Select New Action and pick from any of the actions 

available on the submenus. 
4 Repeat the previous step as needed to add additional actions.
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Editing Switch Actions

The primary tool for editing Switch Actions is the Switch Action dialog, which allows you to edit the 
input expression, reorder Cases, edit Case expressions, and add or delete Case values. To access this 
dialog, just doubleclick on any Switch Action within an action model.

Only a limited amount of editing can be done from the action model itself (without opening the settings 
dialog). The following limitations apply:

Cut, Copy, Delete, and Paste operations on the Switch Action (top line) itself result in the entire 
Switch block, including all matches and associated Action lists, to be cut, copied, etc.
You can Cut or Delete a Case value that has been selected in the action model, but you cannot add 
a new Case value (by pasting). 
A Cut or Delete operation will cut/delete not only the Case itself but all associated actions.
Actions in Case action lists can be edited in the normal ways.

The Todo Action
Developing Web Services and XML-integration applications can be a very complex undertaking. 
Integration Manager provides the ability for you to maintain a Todo list to help you organize and manage 
the many tasks associated with application development.

To add a Todo action:

1 Open a component.
2 Select a line in the Action Model after which you want to place your Todo list. The list item will be 

inserted below the line you selected.
3 From the Action menu, select New Action, then Todo. The Todo dialog appears.

4 Enter a Description for the item that will be displayed in your Todo list.
5 If desired, enter a Note containing additional information. This text displays as part of the item's 

tool tip when the mouse pointer is over the item.
6 Use the down arrow to select a Percent Done value for your task, or leave it at 0. As tasks near 

completion, you should edit this action item and update the percentage complete.
7 Click OK to add the item to your Action model.
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Project-Wide Todo Lists

Todo Lists are not only available within components. They can also be associated directly with a project.

To add a Todo list outside of a component:

1 Open a project.
2 Click on the Todo tab in the Message Frame (see “Navigation, Message, and Content Frames” on 

page 35.
3 Right-click with your mouse and select Add Item to add a new Todo list item. Create the item as 

indicated above.

Tracking Todo items using the Message Frame tab

Once it has been added to your component or project, you will be able to track the progress of the Todo 
Item using the Todo tab on the Message Frame. 

When viewing items in the Todo tab, you will be able to see at a glance how far along you are in your list:

a blank checkbox indicates that the task has not begun 
a gray checkmark indicates partial completion 
a green checkmark indicates that the task has been completed

Todo items can be managed either from the Action Model or by right clicking on them in the Todo tab of 
the Message frame. Items can be edited, added and deleted and re-grouped in the list using the Indent and 
Outdent menu selections.
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8 Advanced Actions

The previous chapter introduced you to the basic actions you can use when building components. The 
actions discussed in this chapter are of a more advanced nature than those discussed earlier. They include 
I/O-related actions, control-flow constructs, and miscellaneous additional actions. 

The actions discussed in this chapter can be created using commands under the Action menu’s nested 
submenus. The submenus include Advanced, Data Exchange and Repeat. They can also be accessed 
via right-mouse-click inside the action model. 

The menu structure looks like this:

The table below summarizes the Advanced actions. (The Data Exchange and Repeat actions are 
discussed in their own sections further below.)

Advanced Action Description

Apply 
Namespaces

Provides a way to override NameSpace prefixes, declare 
a new one or ignore a NameSpace altogether.

Convert Copybook 
to XML

Converts XML data into a ByteArray object using a 
COBOL Copybook

Convert XML to 
Copybook

Converts a ByteArray object into XML data using a 
COBOL Copybook

Simultaneous 
Components

Allows two or more components to be executed 
simultaneously (that is, in multithreaded fashion).
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NOTE:  See Chapter 11, “Applying Actions to Common Tasks” for examples of using some of these 
actions.

Apply Namespaces Action
Ideally, a component will always receive valid XML documents (i.e. the documents validate against their 
schema), map and transform data appropriately, and send valid XML documents. But in the real world, 
this is not always the case. Therefore, it is important to have some means of validating XML documents.

Schemas combined with Namespaces provide a mechanism that allow validation enforcement.  
However, Schemas, Namespaces and Prefixes can easily become problematic when performing XML 
transformations.  For simple straight-through processing involving document validation and marshalling, 
Integration Manager's schema support, XML Template features, and drag and drop mappings mean you 
won't normally have to worry about managing Namespaces and Namespace Prefixes. But there are many 
cases involving document transformations where documents may need special treatment of Namespaces 
and Namespace Prefixes, such as when

Business partners exchange valid documents belonging to the same Namespace but each uses a 
different Namespace Prefix.  For one party to validate or work with the other's document, the 
Namespace Prefix of each partner needs to be declared in the document.  
An XML Template is not available to resolve a Prefix to a Namespace for a document (i.e. the Input 
XML Template is System {Any}).   Yet for Map actions to work properly, the Prefixes used in the 
Map Source and Target need to be resolvable to a Namespace.   

And there are still other cases where you simply wish to ignore Namespaces altogether.  These and many 
other XML processing cases require a method of modifying or overriding the Prefix and Namespace 
handling provided by Integration Manager's default Schema and XML Template support.

Throw Fault Evaluates a condition which if true, writes the contents of 
an expression to a fault document. If used alone, it 
throws an exception, stops a component, and returns 
control to the service. If used within the Execute branch 
of a Try On Fault action, it is evaluated and control 
passes to actions in the On Fault branch. 

Transaction Allows you to invoke User Transaction commands (such 
as begin, commit, and rollback) in components that will 
be deployed as part of non-Container-managed 
services, or setRollbackOnly in components that will be 
part of Contained-managed EJB deployments.

Try On Fault Responds to actions that produce errors by executing a 
set of actions depending on the type of Fault that occurs. 
The Try On Fault action is essentially an error trapping 
and solution action, and works in a fashion similar to 
Switch.

XForm Process Allows you to preprocess an XForm document before 
mapping it to output

XSLT Transform Transforms an XML file according to instructions in an 
XSL file. The output is commonly used for rendering 
XML files in the Web browsers.

Advanced Action Description
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The Apply Namespaces Action provides a mechanism for managing Namespaces and Namespace 
Prefixes in effect for XML documents within a component’s Action Model. The action allows you to 
consolidate all your Namespace and Prefix declarations for a document in one place as well as override 
those declared in the XML Templates used by the component, or ignore Namespaces altogether.

The Apply Namespaces action can be applied to any Message Part (Input, Input1, Temp, Temp1 or 
Output.) You may also have multiple Apply Namespaces actions for a single Message Part, effectively 
changing Namespaces in effect based on conditions specified in your Action Model. The Namespaces 
declared for any part will be in effect until the end of the Action Model is reached or another Apply 
Namespaces action for that Part is executed. In other words, only the most recent Apply Namespaces 
action is in effect for any single Part.

When creating a new component, an Apply Namespaces action is created automatically for the Output 
Part if it’s XML Template declares any Namespaces. After component creation, you can manually create 
additional Apply Namespaces actions for any or all Message Parts. In both cases, the Namespaces and 
Prefixes initially specified when you first open the action dialog, are pulled directly form the XML 
Template. You can then add, change or delete Namespaces and Prefixes as needed within the action.

To Create an Apply Namespaces action:

1 Open a component that you want to apply the Namespace action. 
2 From the Action menu, select New Action>Advanced>Apply Namespaces. The Apply 

Namespaces dialog box appears as below.

3 Select from the dropdown list, For Part, where you want to apply the NameSpace (i.e. Output). 
This control displays available Message parts to which the list of Namespace declarations can be 
applied.

4 Click on the (+) icon to add a row, conversely, click on the (-) minus icon to delete a row. When 
adding a NameSpace, enter the URI and Prefix in the columns displayed.
NOTE:  The Prefix table displays all the Namespace declarations in effect for the document 
displayed in For Part control. After creating a new Apply Namespaces action, the table may or may 
not contain a list of declarations for a selected Part. The list of declarations is initially constructed 
from the declarations defined in the XML Template’s Namespace Declarations panel. If the XML 
Template for the Part is System{Any} or not Schema based, then the list will be empty, unless 
declarations have been added in the Template’s Namespace Declarations panel.
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NOTE:  Within the declaration list for a single Message Part, the Prefixes must be unique. However, 
you are allowed to have duplicate Namespace URI entries provided they are associated with unique 
Prefixes. This allows you to declare multiple Prefixes that are associated with the same Namespace 
URI.

5 Options: Click in the checkbox to Ignore Namespaces when document is used in a Map action 
Source option when you want Map Action Source XPaths to find elements by their XML local 
name only.
NOTE:  This provides for a less restrictive method of specifying Map actions and is useful when 
Map actions under some processing circumstances may contain the wrong or no Prefixes in their 
Source specifications. This allows you to put the Apply Namespaces action inside a Decision action 
that tests whether the Input Message contains Prefixes or not yet still have one set of Map actions to 
Map the Input to another document. In other words, the component normally expects the Input to 
contain Prefixes so you design all your Map actions with Prefix names. For the occasional Input that 
has no Prefixes, the Decision action activates the Apply Namespaces action defined to ignore 
Namespaces for Input allowing the Map actions to work in either case.

This option performs the same function as the setSkipNameSpaces() method available for any Part 
(i.e. Input.setSkipNameSpaces(true)). Between this method and the Apply Namespaces action, 
whichever was executed last in an action Model will be in effect.

6 Options: Click in the checkbox to Declare These NameSpaces when document is used in a Map 
Target when you want to declare a set of Namespaces in the root element of an Output document 
built by your Action model. This option is almost always checked for Output to insure that prefixed 
elements created in the Output, as a result of Map actions, will resolve to the proper namespaces.
NOTE:  This allows a recipient of the Output to validate the document properly. The Apply 
Namespaces action with this option checked could also be used to add new declarations to an 
existing document that already contains declarations.

7 Target Document Root Element Name specifies the name of the root element to contain the 
Namespace declaration attributes. If the target Message Part is based on a XML Template with 
Schema validation, then this control will be filled in automatically by Integration Manager. If the 
target Message part is not an XML Template with Schema validation (e.g. System{Any}), then you 
must enter a value.

8 Click OK and the new action will be added to the Map Action Pane in your component.

Map Actions, XML Templates, Namespaces, and Prefixes 
XML Templates and the Namespaces and Prefixes in XML documents processed by a component may 
all have an impact on whether a Map action works as expected.  By default, for a Map action to work, the 
prefix / element name combinations in the Source XPath are expanded to their full names.  A similar 
process occurs in the Message Part referred to by the Map action.  If a match is found between the Source 
specification and the Message Part, the data or content model is mapped to the Target of the Map action.  
The most critical factor is whether Prefixes are expanded to their Namespace when a Map Action's 
Source is compared to an XML Message Part.  If Namespace resolution is not performed (i.e. turned off) 
then Map actions will always work.

By default, Integration Manager performs Namespace resolution.  There are however, two ways to 
prevent Namespace resolution in Integration Manager.  The first technique is to use the 
setSkipNameSpaces() method for a Part as in Input.setSkipNameSpaces(true).   The second technique is to add 
an Apply Namespaces action and check Ignore Namespaces when document is used in a Map Action 
Source control.

When Namespace resolution is performed, two additional conditions must be met in order for a Map 
action to work.  The Prefixes used in the Map action and the Prefixes present in the document must: 1) be 
resolvable to Namespace URIs, and 2) the Namespace URIs must match. The first condition is a pre-
requisite for the second.  
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The first condition requires that the Prefixes used in the Map Action Source (what you expect to receive) 
and the Prefixes used for elements in the runtime document (what you actually receive) must be 
expanded and resolvable to Namespace URIs.  If either cannot be resolved, then the Map action fails.  In 
order for a Map action to work, the expanded form of its Source specification Prefixes must match the 
expanded form of an element in the XML document being mapped (the second condition).  The Map 
action Prefix is expanded by resolving it to a Namespace URI specified in the XML Template or in an 
Apply Namespaces action.  Prefixes for the element in the XML document are expanded by resolving to 
a Namespace URI declared in the XML document (i.e. an xmlns:someprefix="someURI" attribute in 
the root element).  If the expected Namespace URI of the Map action does not match the actual 
Namespace URI from the document, the Map action will fail.

Example: Assigning Namespace Declarations to Output Messages

When a new component is created and its Output Message is based on an XML Template containing 
Namespace declarations, Integration Manager automatically adds an Apply Namespaces action to the 
Action Model.  When the component executes, this action creates the appropriate root element, 
Namespace Prefix for the root element, and root element Namespace declaration attributes in the Output 
XML Message.  Normally, this action is appropriately left at the start of the Action Model.  In addition, 
the action allows you to add new Namespace declarations to the Output Message that are not declared in 
the XML Template.  The following graphic shows how a Declare Namespaces action is defined for a 
typical Output message.

If a component or program that receives this component’s Output is designed to work with the same 
Namespace but uses different Prefixes, you can use the Apply Namespaces action to add an alternate 
Namespace Prefix in the Output Message.  Simply open the Apply Namespaces action and press the Add 
button.  Copy the Namespace URI you wish to associate with another Prefix and paste it into the new line.  
Then specify the alternate Prefix. 

NOTE:  Note: When a Temp document is going to be used as the target of Map actions, you need to 
define a similar Apply Namespaces action for it. Since Temp documents can be both a Source and Target 
for a Map action, Integration Manager does not know your intentions and so does not create the action 
automatically for you. 
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Example: Ignoring Namespaces

In some cases namespaces and their associated Prefixes are irrelevant to the mapping or transformational 
purposes of the component.  Perhaps, a document has already been validated but needs to be re-structured 
before being inserted into a back end data store (e.g. a relational database via a JDBC component or a 
CICS transaction via a CICS/RPC component).  In this case the Map actions are concerned only with re-
structuring the Input XML message into a different hierarchy which would be much easier and quicker 
to design by referencing local names only in the document.  In this case, an Apply Namespaces action can 
be added that ignores Namespaces altogether.  This allows you to construct Map actions that omit any 
Namespace Prefixes in the Source XPath's you define.  So instead of expressing the Source of a Map 
action as

INV:INVOICEBATCH/INV:INVOICE/INV:INVOICEHEAD/INV:INVOICENO

you can write:

INVOICEBATCH/INVOICE/INVOICEHEAD/INVOICENO

which is also more readable.

The Convert Copybook to XML Action
This action to converts a ByteArray into XML data using a COBOL Copybook Resource so as to map 
COBOL fields in the ByteArray to XML elements. The XML can then be used like any other XML inside 
the component.

To create a Convert Copybook to XML Action

1 Open a component.
2 Select a line in the Action Model where you want to place a Convert Copybook to XML action.
160   Integration Manager User’s Guide



3 From the Action menu, select New Action>Advanced, then Convert Copybook to XML. A 
dialog window appears:

4 Under Source, type in the name of an existing ByteArray whose data you would like to convert to 
XML format.

5 Select a previously defined Copybook Resource (see “About Copybook Resources” on page 
-216).

6 Under Target, select an XML Message Part to be used to receive the converted ByteArray.
7 Click on Apply to see the results of your action, or click on OK to finish creating the new action 

and it it to your action model.

NOTE:  Experienced CICS RPC users will recognize that this action performs the same function as the 
Auto Map Copybook feature available in the CICS RPC Component Editor. The only difference is that no 
Map actions are created for the user. In order for the mappings performed by the Convert action to work, 
the user must have a properly formatted XML document that accurately represents the structure of the 
Copybook. Creating an XML Sample for this is easy inside a CICS RPC component or JMS Component. 
Simply use Auto Map in the CICS RPC component to create an XML Template which can then be used as 
the target for this action. Refer to the CICS RPC Component Editor User’s Guide for more information on 
this topic.

The Convert XML to Copybook Action
This action converts XML data into a ByteArray object using a COBOL Copybook Resource to properly 
map XML elements to COBOL fields in the ByteArray. The ByteArray can then be used directly by an 
ECI Execute action in a CICS RPC component or, perhaps, by a JMS Send action whose Body Message 
Type is Copybook (JMS bytes). The created ByteArray object can then be published globally using the 
Extended ECMAScript Component method named exportObject() making it  reference-able by other 
components by its name.

To create a Convert XML to Copybook Action

1 Open a component.
2 Select a line in the Action Model where you want to place a Convert XML to Copybook action.
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3 From the Action menu, select New Action>Advanced, then Convert XML to Copybook. A 
dialog window appears:

4 Under Source, select an existing Message Part whose XML data is to be converted into a 
ByteArray.

5 Select a previously defined Copybook Resource (see “About Copybook Resources” on page 
-216).

6 Under Target, type in name for the ByteArray to receive the converted data.
7 Click on Apply to see the results of your action, or click on OK to finish creating the new action 

and it to your action model.

NOTE:  Experienced CICS RPC users will recognize that this action performs the same function as the 
Auto Map Copybook feature available in the CICS RPC Component Editor. The only difference is that no 
Map actions are created for the user. In order for the mappings performed by the Convert action to work, 
the user must have a properly formatted XML document that accurately represents the structure of the 
Copybook. Creating an XML Sample for this is easy inside a CICS RPC component or JMS Component. 
Simply use Auto Map in the CICS RPC component to create an XML Template which can then be used as 
the source for this action. Refer to the CICS RPC Component Editor User’s Guide for more information on 
this topic.

The Simultaneous Components Action
The Simultaneous Components Action allows you to execute two or more components simultaneously 
(which is to say, in their own separate threads of execution). This is an important capability to have in an 
XML integration application that relies on inquiries to legacy systems which might be relatively slow to 
respond. For example: Imagine that your service needs to retrieve information via CICS RPC and JDBC 
from two data sources. The CICS inquiry might have a round-turn time of five seconds and the JDBC 
inquiry might require four seconds. If the two inquiries are performed one after the other, the total time 
spent waiting for data would be nine seconds. But if both back-end systems can be queried at the same 
time, the total wait-time is cut to approximately five seconds. This is a significant performance 
improvement.

The Simultaneous Components Action places a “Simultaneous Components” header line in the action 
model, below which you can insert any number of Component (or other) actions.
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In the above illustration, the action list under “Simultaneous Components” contains a call to a 3270 
Component, a call to a JDBC Component, and a Send Mail action. The two Component actions will be 
spawned in separate threads. The Send Mail action will then be executed immediately (whether or not the 
3270 and JDBC components have returned). 

NOTE:  You can include any type of Action (Map, Decision, etc.) in the list beneath a Simultaneous 
Components Action. But no action in the list should depend on return values from any Component actions, 
because Component Actions are not guaranteed to return before other actions in the block execute.

Downstream actions that are outside of the Simultaneous Components block can depend on return values 
from spawned components, because the Simultaneous Components action does not pass control to 
downstream actions until all spawned components have returned. Synchronization is guaranteed to 
occur, in other words, before execution continues beyond the Simultaneous Components block.

To create a Simultaneous Components action:

1 Open a component.
2 Select a line in the Action Model where you want to place a Simultaneous Components action.
3 From the Action menu, select New Action>Advanced, then Simultaneous Components. A 

Simultaneous Components header line appears in the action model (per the illustration above).
4 Place any number of actions below the header line. (Right-click on the header line and choose an 

action from the context menu, or Paste actions into the Simultaneous Components block.) 
NOTE:  No actions other than Components Actions will be spawned as new threads. 

To place new actions outside of (downstream of) the Simultaneous Components block, right-click on the 
line above the Simultaneous Components header line, and choose a new action. The new action will be 
added below the Simultaneous Components block. See below.

The Throw Fault Action
The Throw Fault action allows you to write information to an XML message on failure of an action, 
perform any number of “Before Throw” actions, and finally halt execution of a component. Throw Fault 
is only executed when a condition that you specify is true. The Message Part that gets written when a 
Throw Fault action is executed is called a Fault document, and the XML within this message will also be 
contained in a global object called ERROR. For a discussion on Fault Parts, refer to “Creating a Fault 
Message Part” on page -112.

Throw Fault actions can be used in a number of different ways:
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Using a Throw Fault Action by itself. You can easily specify a Fault Condition and it’s 
accompanying error message within the Throw Fault Action dialog. An example of this procedure 
is given below. When the action is executed, the Fault Condition is evaluated and if true the 
following occurs:

Any “Before Throw” actions you specify are executed. This can be very useful as a way to leave 
your application in a particular state before halting execution. You might want to, for example, 
send a mail message stating that the execution did not complete.
The contents of the Error Message are written to the Fault document in a node you specify, as 
well as to the global object ERROR. 
The component execution is halted.

Using a Throw Fault Action within a Decision Expression in the Decision action. You might 
want to specify your Fault Condition by entering it in the Decision Expression of a Decision 
Action. Then you put your Throw Fault statement in the True branch of the Decision action. Here 
you can either specify additional conditions in the Throw Fault dialog’s Fault Condition or leave it 
blank and simply specify the Fault document to which the fault information should be written. 
When the action is executed and all your conditions are true, the Throw Fault action is executed as 
described above. If the Fault Condition in the Decision action or Throw Fault action is false, the 
next action in the action model is executed.
Using a Throw Fault inside a Try / On Fault action. By putting either of the above methods 
inside the Execute branch of a Try / On Fault action (which is described in “The Try/On Fault 
Action” below), you prevent the component from halting execution and have an opportunity to 
respond or recover from the fault. You create your fault condition using one of the previous two 
methods inside the Execute branch of a Try / On Fault action after other actions whose output you 
want to test worked correctly. You can specify any number of unique faults so that your component 
can branch into several different directions depending on which fault actually occurs. This works in 
a similar fashion to a Switch action. When the Throw Fault action for the given fault fires, instead 
of halting execution of the component, control passes into the appropriate On Fault branch of the 
Try / On Fault action. Here you can specify other actions to remedy or respond to the error.

You can decide where it is appropriate to deal with error conditions and use Throw Fault accordingly. For 
instance, during runtime, if you want a component to stop running when an error condition is 
encountered, (and return control to the service in which it is running) use Throw Fault alone. The action 
throws an exception, which is displayed as a dialog box in Integration Manager, and a stopped 
component on the application server.

On the other hand, suppose a service calls another component from within a Try/On Fault action 
(specifically under the Try branch). Inside the other component, a Decision action inspects some data in 
an XML document. If the data is valid, the component continues executing. If the data is not valid, the 
Throw Fault action executes,writing to the Fault document , and the component stops execution, 
returning control to the service. The Try/On Fault detects that a Throw Fault occurred and logic transfers 
to the appropriate On Fault branch of the Try/On Fault action. In the On Fault branch, you can process 
the Fault Message Part any way you like. You might, for example, write a message out to a Log file.

To add a Throw Fault action:

1 Open a component.
2 Select a line in the Action Model where you want to place the Throw Fault action. The new action 

is inserted below the line you selected.
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3 From the Action menu, select New Action>Advanced, then Throw Fault. The Throw Fault 
Action dialog box appears.

4 In the Fault Condition field, type a valid ECMAScript expression that, when true, causes the action 
to throw a fault. (You can also click the Expression Builder button and build an expression.) 

5 Select Throw {System}{Fault} to write your error message to the _SystemFault document. By 
default, the message you type in the Error Message field will be placed in the 
Fault/FaultInfo/Message node of that document. Specify another node if desired. You also have 
access to the ECMAScript Expression Builder button so that you can build an expression.

6 Select Throw Defined Fault if you wish to select a Fault document that is one of the Message 
Parts you have associated with your component

7 Click OK.

The new Action is added to your model. Place any actions you wish to execute before the application 
halts in the Before Throw Actions area.

The Transaction Action
The Transaction action allows you to insert begin, commit, or rollback commands in your Action Model, 
thereby making it possible for you to exercise low-level control over transaction boundary demarcation 
within components that use transactions. 

NOTE:  This action is not available in Integration Manager when installed as part of the Professional 
Edition suite.

Any Transaction actions that you place in your action list will result in the appropriate corresponding 
Java pass-throughs being generated in your service’s application metadata. The details of how this occurs 
are beyond the scope of this discussion. See the Transaction Management chapter of the Integration 
Manager documentation for your application server.
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NOTE:  Successful use of Transaction actions requires an in-depth understanding of Java transaction 
models. The services you create in Integration Manager can be deployed using Servlet triggers or 
Enterprise Java Bean (EJB) triggers. The choice of deployment mode will have significant implications for 
transaction management.

To add a Transaction action:

1 Open a component.
2 Select a line in the Action Model where you want to place a Transaction action. The new action will 

be inserted below the line you’ve selected.
3 From the Action menu, select New Action>Advanced, then Transaction. The Transaction dialog 

appears.

4 Select from one of the available transaction command types. 
NOTE:  Radio buttons are enabled or greyed out depending on which Transaction Mode you’ve 
selected in the Designer Tab of the Preferences dialog available under the Tools menu. For 
example, in the above illustration, the first three radio buttons are enabled while the Set Rollback 
Only button is greyed out. This is because the current transaction emulation mode is Servlet or 
Bean Managed. The Set Rollback Only button is available only in the context of a Container-
managed EJB deployment; it is not applicable to Servlet or Bean-managed EJB deployments. To 
change emulation modes (and cause a corresponding change in which radio buttons are enabled in 
the Transaction dialog), click the Change button.

5 Click OK.

The following illustration shows a pair of Transaction actions as they appear in the Action Model pane.
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Once you have generated Transaction actions in your Action Model, you can test them by executing the 
component in Integration Manager (or by stepping through the action list as part of an animation/debug 
session). Appropriate error messages will appear based on any problems that might exist with your use 
of Transaction commands in your Action Model. For example, if you have used two begin commands in 
your action list with no intervening commit, you will see a warning dialog based on the fact that nested 
transactions are not supported.

The Try/On Fault Action
The Try/On Fault action executes a set of actions when a fault occurs within  the Execute branch of the 
Try/On Fault action. Any number of defined faults can be specified within the Execute branch. You can 
use the Try/On Fault action to trap anticipated errors and run other actions to remedy or report on the 
fault. For instance, you can use Try/On Fault to respond to an XML Interchange action that fails to find 
a file. 

When you add a Try/On Fault action, a dialog appears from which you select a number of pre-defined 
Fault Part Names. These are the Fault Messages you defined when you set up your component. Several 
lines are then added to the Action Model pane: the beginning of the Try action, the Execute branch, a 
branch for each Fault you specified and an “All other Faults” branch. When you are aware of potential 
faults an action can produce, you put those actions under the Execute branch. You then put error handling 
actions under each On Fault branch to handle unique situations. If a fault does occur, the actions under 
the On Fault branch execute.

Following the example given previously, if you anticipate a fault with the XML I/O action, you put the 
action under the Execute branch. Under one On Fault branch, you might add another XML I/O action that 
attempts to read the file from an alternate location. Under another On Fault branch, you might add 
another XML I/O action that looks for a file with a different extension.

To add a Try/On Fault action:

1 Open a component.
2 Select a line in the Action Model where you want to place the Try/On Fault action. The new action 

is inserted below the line you selected.
3 From the Action menu, select New Action>Advanced, then Try/On Fault.
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4 The Try On Fault Dialog appears:

5 Use the blue + icon to add Fault Part Names you have previously associated with your component. 
Use the red - icon to remove them. Use the up and down arrows to change the order of the faults.
NOTE:  If you do not define any custom Fault Parts, corrective actions can be placed in the default 
“All Other Faults” branch of the Try/On Fault action.

6 Click OK when you have finished defining your Fault Parts.
7 The Try On Fault action icon, with an Execute, one or more On Fault Branches, and an All Other 

Faults branch appears in the Action Model pane.
8 Add any actions that might cause potential errors under the Execute branch.
9 Add actions that resolve the error under the On Fault branch.

The following illustration shows a complete Try/On Fault action in the Action Model.

NOTE:  It is good programming practice to use Try/On Fault actions liberally throughout your action 
model.
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The XForm Process Action
The XForm Process action allows you to specify an XForm document and subject it to various kinds of 
preprocessing before mapping it to output. Before using this action, you would typically already have 
created an Form Resource (see the chapter on Resources) in the current project, or you would 
(alternatively) be using an XForm as your component or service’s Input message part. A typical scenario 
would be one in which a JSP, in response to a user request, kicks off a Integration Manager service to 
handle a forms session. The key responsibility of the service would be to serve out the appropriate 
XForm. 

In normal usage, an XForm is not transmitted to the user (the client) in its raw state, because an XForm 
is not renderable directly and embodies few assumptions as to what the final “rendered form” will look 
like. The same XForm may have an entirely different appearance on a desktop PC than it has on a palm 
device, for example. The decision of how to final-encode the form for presentation to the user is done at 
runtime, and the transformation from raw XForm to, say, XHTML must be handled at the server level 
since web browsers and client devices have no native support for XForm-rendering.

A typical roundtrip scenario might look like this:

1 A customer goes to Company A’s web site and decides to place an order. He or she clicks the 
“Order Now” button on the web page.

2 The button click results in a redirect to a URL that triggers a Integration Manager service. Some 
user params (perhaps the user’s first and last name, pulled from a cookie) are passed on the end of 
the URL. 

3 The service calls a component that invokes an XForm Process action.
4 The XForm Process action:

Retrieves the proper Order Form from an Form Resource
Maps the user’s name to the appropriate “instance data” locations in the form
Sends the form to the XForm Processor to be converted to the appropriate output format 
(whether XHTML, SMIL, WML, or whatever)
And finally, appends, copies, or otherwise maps the transcoded document produced by the 
XForm Processor to a suitable Output message part

5 When the service has finished executing any additional business logic that might be dictated by the 
request, it serves the output document (containing the transcoded, prepopulated form) back to the 
user.

6 The user fills out the form and clicks the Submit button, triggering a redirect or another XForm 
session, or whatever action is necessary.

NOTE:  This discussion is not meant to be a primer on XForms. For more information on XForm 
technology see http://www.w3.org/MarkUp/Forms/. 

To create an XForm Process action:

1 Open a component (if necessary).
2 Select a line in the Action Model where you want to place the XForm Process action. The new 

action will be inserted below the line you selected.
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3 From the Action menu, select New Action > Advanced, then XForm Process. A dialog appears.

4 In the upper portion of the dialog, choose one of the radio buttons:
Choose the Form radio button if you want to specify an existing Form Resource as the source 
document. The pulldown menu will be prepopulated with the names of any Form Resources in 
your project. Select the Form Resource of interest.
Choose the Part radio button if the XForm you want to use is already loaded into a message part 
(for example, Input, Input1, Temp). In this case, choose from among the message parts shown 
in the pulldown menu, and in the text field just below, enter the XPath expression that points to 
the root of the XForm.

5 Under Target, specify (via either XPath or an Expression) the DOM node that will be the root of 
your XForm. (The example shown in the above illustration represents a typical use case where the 
target message part is Output, and the root node of the output document is <html>.)

6 Optionally click the Apply button to execute the action. 
7 Click OK to dismiss the dialog. The new action is added to your action model.

The XSLT Transform Action
The XSLT Transform action takes a DOM and an XSL stylesheet you specify as input and sends the 
output to another DOM in the component. This process is also referred to as Server Side XSL Processing. 

To create XSL output you need to specify three parameters of the action. The Source Document 
Expression is a valid ECMAScript expression that results in the name of a DOM or document handle 
(such as Input). The XSL URL expression is a valid ECMAScript expression that points to an XSL 
Stylesheet. This parameter is optional if the DOM already has an XSL Processing Instruction that 
specifies an XSL Stylesheet. If an XSL Stylesheet is not specified in the DOM, then you must specify this 
parameter. If you specify this parameter, and the DOM also has an XSL Stylesheet processing instruction, 
then your parameter will override it. 

The Target Document/Element Expression specifies which DOM is to receive the results of the XSL 
processing.

To add a XSLT Transform action: 

1 Open a component.
2 Select a line in the Action Model where you want to place the XSLT Transform action. The new 

action is inserted below the line you selected.
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3 From the Action menu, select New Action>Advanced, then XSLT Transform. The XSL Process 
dialog box appears.

4 Type the name of the Source Document you want rendered, or click the Expression Builder 
button and create an ECMAScript expression that resolves to a valid Part.

5 Type the name of the XSL stylesheet you want to use for transforming in the XSL URL Expr field, 
or click the Expression Builder button and create an ECMAScript expression that points to a valid 
stylesheet.

6 Type the name of the Target Part/Element you want to use, or click the Expression Builder 
button and create an ECMAScript script expression that specifies a Part.

7 Click OK.

The following illustration shows a complete XSLT Transform action in the Action Model.

Data Exchange Actions
This submenu contains actions concerned with the reading and writing of files and the interchange of data 
in web services and in XML.

Data Exchange Actions Description

Integration Manager 
Resource

Allows you to read in an XML or XSL resource

URL/File Read Allows a file format that is not XML to be read into 
Integration Manager. 

URL/File Write Allows a file to be written into a format other than XML.
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The Integration Manager Resource Action 
The Integration Manager Resource Data Exchange Action allows you to load an XML or XSL resource 
into a Message Part.

To create a new Integration Manager Resource action:

1 From the Action menu, select New Action>Data Exchange>Integration Manager Resource. 
The following dialog appears.

2 Under Source, select a Resource Type. The available choices are XML or XSL.
3 Select a Resource Name. You must already have added the XSL or XML file as a Resource in 

order for it to appear in this list. Refer to Chapter 9, “Resources” for instructions on how to 
accomplish this.

4 Under Target, use XPath to select a Part to contain the results of your XML or XSL, or click on 
Expression to enter the ECMAScript Expression Builder.
NOTE:  Integration Manager Resources will add the text of an XML or XSL document to a Part you 
specify. It can then be manipulated like any other Part. However, it will remain read-only.

5 Click OK to add the Integration Manager Resource Action to your Model.

WS Interchange Executes a Web Service using messages and 
operations defined in a WSDL resource.

XML Interchange Reads external XML documents into the component's 
DOM or writes the component's DOM to an external 
XML document. Read/write methods include: Get, 
Put, Post, and Post with Response using the File, 
FTP, HTTP, and HTTPS protocols. 

Data Exchange Actions Description
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URL/File Read
If a file is in a format other than XML, use this action to read the file into an XPath location. 

To create a new URL/File Read action:

1 From the Action menu, select New Action>Data Exchange>URL/File Read. The following 
dialog appears.

2 In the Source File portion of the screen, enter the file’s URL. Since this is an ECMAScript 
expression, a URL string must be enclosed in quotation marks. 

3 If applicable for the file format, select an Encoding algorithm from the dropdown menu.
NOTE:  One common use case is shown above. The file in question might be binary, in which case 
it would be appropriate to select “Binary to Base64” from the dropdown. The appropriate decoding 
method can be specified in the URL/File Write action (below).

4 Select a Connection Name. Any HTTP, HTTPS and FTP connections resources you have created 
will appear in this list.

5 Specify a Connection Timeout value (in seconds), or leave as zero. Whatever value you place here 
will override any value specified in your connection resource.

6 In the Target File portion of the screen, select XPath>Input and enter the XPath destination of the 
file contents. You can also select Expression by clicking on the radio button. Doubleclick the 
Expression icon at right to bring up the Expression Builder, if desired.

7 Click the Create Target as CDATA Section checkbox if you want the contents of the file wrapped 
in a CDATA section. (This is not necessary for binary files that are to be encoded as Base64 per the 
above example.) This allows characters such as the angle brackets ( < > ) to be used inside an XML 
document without being interpreted as part of a start or end tag.

URL/File Write
If a file needs to be in a format other than XML, use this action to write the file from a DOM or message 
part.

NOTE:  This action is, in every respect, the functional complement of the URL/File Read action described 
above. 
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To create a new URL/File Write action:

1 From the Action menu, select New Action>Data Exchange>URL/File Write. The following 
dialog appears.

2 In the Source File portion of the screen, Select Source XPath>Output.
3 Enter the XPath containing the file content. (Alternatively, select the Expression radio button and 

enter an ECMAScript expression that specifies the location of the file contents.)
4 In the Target portion of the screen, enter the URL where the file is to be stored.
5 If applicable for the file format, select from the Encoding list box to specify a decoding before the 

file is written.
6 Select a Connection Name. Any HTTP, HTTPS and FTP connections resources you have created 

will appear in this list.
7 Specify a Connection Timeout value (in seconds), or leave as zero. Whatever value you place here 

will override any value specified in your connection resource.

The Web Service (WS) Interchange Action
In most cases, you will use Integration Manager to build consumable services, but in some situations, you 
may have a need for your service to act as a consumer of other services. 

The Web Service Interchange action allows your component to invoke a Web Service according to calling 
conventions specified in a WSDL Resource. (See “About WSDL Resources” on page -240 for more 
information about WSDL Resources.) You will use this action in scenarios that might require your 
component or service to act as a client in a web-service interaction involving a remote service. 

Note that before you can create a Web Service Interchange action, you must have a WSDL Resource that 
describes the service.

To create a Web Service (WS) Interchange action:

1 Open a component.
2 Select a line in the Action Model where you want to place the Web Service Interchange action. The 

new action is inserted below the line you selected.
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3 From the Action menu, select New Action/Data Exchange, then WS Interchange. The Web 
Service Interchange dialog appears.

4 Choose the desired WSDL Resource, Service Name (if applicable), Port, and Operation from the 
dropdown menus provided. (These menus will be prepopulated with choices taken from the 
information in your existing WSDL Resources. For information, refer to the section on WSDL 
Resources in Chapter 9, “Resources”) 

5 Enter the Endpoint Location (usually a URL pointing at a servlet) for the Web Service you wish to 
use, wrapped in quotation marks. (Alternatively, enter an ECMAScript expression that will 
evaluate to an Endpoint Location at runtime.) 
NOTE:  This is the only field on the WSDL tab of the dialog that you should have to fill out by hand.

6 Click the Messages tab to bring up the following panel:

7 Specify the input and output messages for the particular service you are going to invoke. The 
Message, Part, and Type/Element fields will be prepopulated. Under Expression, enter the 
ECMAScript expression that describes the source and target for each message. Usually, this will be 
an expression that specifies an XPath location in an Input Part or Output Part. Click the Expression 
Builder icon at the far right to go to the Expression Builder dialog, where you can easily build the 
appropriate expression(s) via point-and-click.
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8 Click the Connection tab to bring up the next panel:

9 Choose an HTTP Connection Resource (as needed) from the Connection Name dropdown menu. 
NOTE:  For ordinary HTTP connections, you can specify <none> here. The intent of this field is to 
let you connect via HTTPS to a secure site using the user ID and password information stored in an 
HTTP Connection Resource.

10 Specify a Connection Timeout value (in seconds), or leave as zero. Whatever value you place here 
will override any value specified in your connection resource.

11 The Parameter and Value fields in this dialog should already be populated, based on the Operation 
and Message information given in other tabs of the dialog. If the Value fields are empty, enter 
appropriate strings or expressions for the type of SOAP action and/or the content type (MIME type) 
of the exchange.

12 If you wish to specify additional HTTP header information, click the Plus sign above the combo 
box to add new HTTP parameter fields. 

13 Click the XML Signature tab to bring up the next panel: (Optional)

14 Use the prepopulated pulldown menu to select an existing Certificate Resource in your project. 
(See “About Certificate Resources” on page 200 for details about how to create this kind of 
resource.)

15 Check the box if you would like to Validate the XML Signature on the way out.
16 Click Apply to test the Web Service action in real time, or click OK to dismiss the dialog.
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The XML Interchange Action
The XML Interchange action reads external XML documents into a component’s DOM and writes data 
from a component’s DOM out as XML files. There are four types of XML Interchange actions:

GET 
PUT
POST
POST with Response

When using the Get interchange, fill in the “Interchange URL Expression” field with a URL that points 
to the XML document you want to bring into the component. If you have created an HTTP or FTP 
Authentication connection resource, you can specify it under “Connection Name.” Otherwise, the 
connection information would need to be embedded in the URL. In the “Response Part” field, you will 
specify a DOM which is to receive the XML. If the DOM name you specify does not exist, it will be 
created. 

When using the Put interchange, fill in the “Interchange URL Expression” with a URL that points to the 
location to which you want to write the XML document. Select a “Connection Name” from the list if you 
have already created an HTTP or FTP Authentication connection resource. Otherwise, the connection 
information will need to be embedded in the URL. For “Request Part”, you will specify the name of a 
DOM in your component to send its data as XML. 

When using the Post interchange, fill in the “Interchange URL Expression” with a URL that points to the 
location to which you want to write the XML document. Select a “Connection Name” from the list if you 
have already created an HTTP or FTP Authentication connection resource. Otherwise, the connection 
information will need to be embedded in the URL. For “Request Part”, you will specify the name of a 
DOM in your component to send its data as XML.

When using the Post with Response interchange, you supply the same parameters as for Post, with one 
additional parameter. You must also specify a “Response Part” DOM to receive the Response XML 
document from the Post with Response action. The difference between the two interchanges is that Post 
with Response expects a response XML object back from the origin server.

To add an XML Interchange action:

1 Open a Component.
2 Select a line in the Action Model where you want to place the XML Interchange action. The new 

action is inserted below the line you selected.
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3 From the Action menu, select New Action/Data Exchange then XML Interchange. The XML 
Interchange Action dialog box appears.

4 Select an Interchange Type.
5 In the Interchange URL Expression field, type an expression that defines a fully qualified URL 

for an XML document using any of the following supported protocols: 
file
ftp
http
https

Depending on the Interchange Type selected, this URL is the source or the destination of the XML 
file for the XML Interchange action. For example: 
file:///g:/xmldata/invoicebatch1.xml 
ftp://accounting:password@123.456.789.987:21/invoices/inv1.xml 
Since this is an ECMAScript expression, a URL string must be enclosed in quotation marks. 

6 Optionally click the HTTP Header Parameters button. The HTTP Header Parameters dialog 
appears.

7 Click the plus (+) icon to add new header parameters. Enter a Parameter name and the desired 
corresponding Value. Common HTTP header parameters include “Content-Type,” “Content-
Length,” and “Keep-Alive.” You can add any number of Parameter-Value pairs in this dialog.
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8 Click OK to close the HTTP Header Parameters dialog. The XML Interchange dialog reappears.
9 Select a Connection Name. Any HTTP and FTP connections resources you have created will 

appear in this list.
10 Specify a Connection Timeout value (in seconds), or leave as zero. Whatever value you place here 

will override any value specified in your connection resource.
NOTE:  A value of zero means that no time limit is placed on the connection, unless you are using 
an HTTP Connection Resource (which is optional for non-authenticated connections). If a timeout 
value is specified in that connection resource, it will be used. 

11 In the Request Part field, specify the name of a DOM in your component to send its data as XML. 
Request Part is used for Put, Post and Post with Response Interchange types.

12 In the Response Part Field, specify the name of the DOM tree that will receive XML. Response 
Part is used for Get and Post with Response.

13 Optionally check the checkbox next to the Filter Document pushbutton (thereby enabling it). If 
document filtering (see discussion below) is desired, click the pushbutton. A dialog will appear:

NOTE:  The document shown in the dialog will be the one selected in Response Part in the XML 
Interchange dialog. 

The purpose of this dialog is to allow you to specify individual nodes that are to be retained (rather 
than stripped off) the incoming XML document in real time for purposes of improving performance 
and reducing RAM overhead. 
Check the checkbox next to the nodes you want to keep in the document. Unchecked nodes will be 
stripped off (discarded) prior to parsing the DOM. (See additional discussion in the section 
following this one.) 
When you have selected nodes that you wish to be kept, click OK to dismiss the dialog.

14 Click OK. Alternatively, you can press the Apply button to see the affect of the XML Interchange 
action without closing the dialog. This allows you to make repetitive edits to a XML Interchange 
action and quickly see the results.

Performance Enhancement Using “Filter Document”
The Filter Document button in the XML Interchange dialog (further above) offers the potential for 
greatly improved performance when processing large incoming documents. It also offers potential 
benefits in terms of memory conservation, since a filtered document will require less memory. 

The Filter Document button brings up a resizable dialog containing a tree view of the document in 
question. 
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For XML Interchange actions, the document shown in this dialog will depend on the interchange mode 
(GET versus POST with Response) as well as the target message part you’ve selected in the combo boxes 
provided. (Note that you cannot get to this dialog if PUT or POST have been selected, since in those cases 
there will be no incoming document; only an outgoing one.) In the tree view display, every element of the 
document will have a checkbox next to it. Any elements that you check will be kept when the document 
is DOM-parsed for use in your component. Any boxes that are unchecked will result in the associated 
elements (and their attributes) being discarded, so that the parsed DOM is smaller than it would otherwise 
be. 

In the above illustration, the incoming document, with root node DoctorResp, will have a /physician 
node with a /patients node under it, and the /patients element, in turn, will have a PatientData element 
under it. Likewise, the latter will have child nodes LastName and FirstName. But since Physician is not 
checked, the incoming document will not have anything under the XPath:

DoctorResp/physician/patients/PatientData/Physician

Similarly, there will not be anything under /physician/NoOfInquiries, /Department, etc., because those 
nodes were not checked.

It’s quite common to encounter scenarios in which only a few nodes or XPath locations in a given input 
document are of interest to a particular component or service. When this is the case, it makes sense to use 
the Filter Document dialog to strip away unneeded portions of the input document. Careful use of 
document filtering will allow you to create services that process documents efficiently and quickly, with 
minimal RAM impact. 

NOTE:  You can apply document filtering (using the above dialog) to any input document for any kind of 
service (not just documents arriving via the XML Interchange action). See the discussion in Chapter 6, 
“Creating an XML Map Component”, for further information on how to filter Input documents.
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Repeat Actions
This submenu contains actions that implement looping and loop-control constructs. 

The Break Action
The Break Action stops the execution of a Repeat for Element, Repeat for Group, or Repeat While loop. 
The Action Model continues execution with the next action outside the loop. 

The use of a Break is appropriate when, for example, you are using a loop to search a node list for one 
particular item. When the target item is found, there is no need to continue iterating; hence a Break can 
be used to terminate the loop immediately.

NOTE:  A Break action will typically occur in one branch of a Decision action (within a loop). You’ll place 
the Break action in either the True or False branch of the Decision action, as appropriate.

Repeat Actions Description

Break Stops execution of a Repeat for Element, Repeat for 
Group, or Repeat While loop and continues execution with 
the next action outside the loop.

Continue Stops execution of the current Loop iteration in a Repeat 
for Element, Repeat for Group, or Repeat While loop, and 
continues at the top of the same loop with the next 
iteration.

Declare Group Allows you to create and name a group based on an 
element that occurs multiple times. Groups are used in the 
Repeat for Group action. 

Repeat for 
Element

Repeats one or more actions for each occurrence of a 
specified element in your DOM tree. The Repeat For 
Element action allows you to create a loop based on an 
element that occurs multiple times.

Repeat for 
Group

Repeats one or more actions for each member of a group. 
A Repeat For Group action allows you to re-structure your 
data and calculate aggregates on your data. 

Split Document Allows a service or component to read (and process) a 
large input document in sections, rather than all at once. 
This can be an important strategy for reducing machine-
resource requirements at runtime. It can also result in 
faster throughput.

Repeat While Repeats one or more actions by creating a loop. A While 
Repeat action allows you to base a processing loop on any 
valid ECMAScript expression. 
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To add a Break action:

1 Open a component that contains a Repeat action you wish to modify to include a Break action.
2 Select a position inside the loop where you wish to place the Break action. Generally, this will be in 

one leg or the other of a Decision action (as shown below).
3 From the Action menu, select New Action>Repeat then Break. The Break action appears 

immediately in the action model. (There is no setup dialog.) See below.

The Continue Action
The Continue action causes execution of the current iteration of a Repeat for Element, Repeat for Group, 
or Repeat While loop to stop and execution to begin at the top of the loop, with the next iteration. The 
Continue action provides a way to short-circuit downstream actions inside the loop while allowing the 
loop to continue on to the next iteration.

A Continue action is appropriate in a situation where, for example, one item in a list should be skipped 
over some reason, yet execution of the loop must continue.

NOTE:  A Continue action will typically occur in one branch of a Decision action (within a loop). You’ll 
place the Continue action in either the True or False branch of the Decision action, as appropriate.

To add a Continue action:

1 Open a component that contains a Continue action you wish to modify to include a Continue 
action.

2 Select a position inside the Loop actions where you wish to place the Continue action. This will 
generally be inside one fork or the other of a Decision action; see illustration below.

3 From the Action menu, select New Action>Repeat>Continue. A Continue action appears in the 
action model.

The Declare Group Action
The Declare Group action allows you to create two special lists, each in reference to a DOM. These group 
lists can then be used as the basis for a loop in the Repeat for Group action. To create the lists, you supply 
a Group Name and specify an XPath. Integration Manager then creates the lists as follows: a Group list 
is created that contains one entry for each unique value found among all the elements that match the 
XPath. The Group list is referred to by the Group Name you supply. Then a Detail list is created for each 
unique entry in the Group list that contains as many entries as there are members in the Group (that is, a 
non-unique list). The Detail list is referred to by the Group Name you supply post-fixed with the label 
“(Detail).”

Grouping allows you to select a repeating element in your Input DOM and create fewer elements based 
on the unique values across all instances (siblings) of that repeating element. So instead of having 
multiple elements, you end up with one element for each unique element value in your Output DOM.
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To add a Declare Group action:

1 Open a component.
2 Select a line in the Action Model where you want to place the Declare Group action. The new 

action is inserted below the line you selected.
3 From the Action menu, select New Action>Repeat then Declare Group. The Declare Group 

dialog box appears.

4 Type a name for the group.
5 Optionally, select a parent group. This is used if you want to create multiple group levels.
6 Click Add. The Add Element dialog box appears.

7 Select a Part name and an element.
8 Click OK.
9 Repeat steps 6 through 8 to add more elements to the group.
10 Click Remove to delete elements from the group.
11 When you have all the elements you want in the group, click OK.

NOTE:  An example of this can be found in the Action Examples sample project installed on your 
computer.
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The Repeat For Element Action
The Repeat action creates looping structures within an Action Model. Loops give you the ability to repeat 
a set of one or more actions. There are three types of loops: Repeat For Element, Repeat For Group, and 
Repeat While.

XML allows multiple instances of an element in a document (analogous to multiple records in a database 
table). The number of instances can vary from document to document and is defined in the Document 
Schema (DTD or XML Schema). For instance, you might receive an XML document containing 
lineitems for an invoice on a daily basis. Each day the XML document has a different number of 
lineitems. Not knowing how many instances of “lineitem” are in the XML document poses a problem if 
you want to transfer these item numbers from the input XML document to an output XML document 
programatically. The Repeat For Element action solves this problem.

The Repeat For Element action allows you to mark an element that occurs multiple times. The action then 
sets up a processing loop that executes one or more actions for each instance of the marked element until 
no more instances exist. In the example above, the processing loop would contain a single Map action to 
transfer the lineitem number and this action would be repeated until all lineitems had been mapped.

The Repeat for Element action also uses the concept of an alias. An alias performs two functions. It is an 
alternate name or shorthand for the marked repeating element, which saves you the work of re-specifying 
long XPath expressions. In some cases, the repeating element may be several levels down in the 
document hierarchy. When you create Map actions in the Repeat loop that transfer child elements of the 
marked element, using the alias is quicker than re-typing a long XPath expression. An alias is also an 
indicator to Map actions within the Repeat loop to use the next instance of the repeating element each 
time the loop processes. A Map action within a Repeat for Element loop that does not use the alias always 
refers to the first instance of the element in the source Part.

NOTE:  Hovering the mouse over a Repeat alias in the Map dialog will display a tool tip showing the 
XPath represented by the alias.

The Repeat For Element action allows you to process more than one action within the loop. In the 
simplest case, the repeat loop might only contain one Map action that transfers the value of the current 
element instance from the input Part to the output Part. You can also define multiple actions in the 
processing loop, for example: a Map action to transfer the current value and a Log action that writes to a 
file, creating an audit of each transfer.

To use a Repeat For Element processing loop:

1 Create a Repeat For Element action.
2 Create actions (Map, Log, Decision, etc) within the Repeat For Element processing loop.

To create a Repeat For Element action:

1 Select the first instance of a repeating element in an XML Document tree.
2 Right-click on the repeating element in the Part or, from the Action menu, select New 

Action>Repeat, then Repeat for Element. 
The Repeat for Element dialog appears.
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3 Begin by identifying your Source.
Type in the Alias field. A good naming convention for an alias is to use the element name with 
a prefix indicating sources or target and the type of repeat action such as “S1Lineitem.”
Enter an XPath expression, or click the Expression Builder button and build an XPath 
expression for the repeating element. The example above show an XPath which points to a root 
node of “inv1” and it’s child node “lineitem.”

4 The next step is to identify your Target.
Create another Alias, such as “TgtLineitem.”
Use the checkbox to indicate if you want to Always create new output elements. This box 
would be used in situations where you had multiple input documents containing similar node 
structures which you wanted to merge into a single Output DOM with common node names. 
Refer to the Action Model following the final step of this procedure for an example.
Enter an XPath expression, or click the Expression Builder button and build an XPath 
expression for the repeating element. In this case, we are using “mrgd/Lineitem.”

5 Click OK. Your Repeat for Element loop is added to the Action Model.
6 Highlight Loop Actions to begin adding Map actions or whatever other actions are necessary for 

your component.

The following illustration shows an Action Model for a component containing two Repeat For Element 
actions and the input and output XML documents that are used by the component. This model contains 
two Repeat For Element groups because the user has two very similar input DOMs containing an 
unspecified number of lineitems. Map actions are used within the processing loop to transfer the 
lineitems from the two input DOMs to the single output DOM.
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The Repeat for Group Action
The format of an XML document that you receive is not always the format that meets the requirements 
of your business process. For instance, an XML document might contain invoices from different sellers. 
The data is received as individual invoices, but in the context of a business-to-business transaction, you 
might need to summarize the data and send the summary data to a manager, and at the same time, send 
the invoice data to the Accounts Payable department.

A Repeat for Group action allows you to re-structure your data and/or establish a framework to calculate 
aggregates on your data. Grouping allows you to select a repeating element in your input Part and create 
fewer elements based on the unique values across all instances (siblings) of that repeating element. 
Instead of multiple seller elements across the invoices (some with the same seller value), you end up with 
one element for each unique seller value in the output Part. 

The Repeat For Group action sets up a processing loop based on one of two lists created by the Declare 
Group action. The loop executes as many times as there are entries in the list you use (either the Group 
list or Group (Detail) list).   In the above example, if you use the Group list, once you have one element 
per seller, you can add Map actions to the processing loop to calculate how many invoices each seller had. 
You can also list the individual invoice numbers beneath each seller. By combining a Repeat for Group 
with Map commands, you can create a new XML document whose structure and data are different from 
the original.

In a way similar to the Repeat for Element action, a Repeat for Group action also uses the concept of an 
alias. The values for Source Group used in the Repeat for Group dialog are the list names created by the 
Declare Group action. The list names perform two functions. They are an alternate name or short-hand 
for the XPath source of any Map actions within the loop. This saves you the work of re-specifying long 
XPath expressions. The group list name when used in place of a DOM name in a Map action source, is 
also an indicator to the Map action within the Repeat loop to use the next instance in the group list each 
time the loop processes. A Map action within a Repeat for Group loop that does not use the group name 
always refers to the first instance of the element in the source Part. 
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The target aliases created in the Repeat for Group action also serve two functions. They are an alternate 
name or short-hand for the XPath target of any Map actions within the loop. This saves you the work of 
re-specifying long XPath expressions. The target alias when used in place of a Part name is also an 
indicator to Map actions within the Repeat loop to create a new instance of the Source in the target 
Message Part.   A Map action within a Repeat for Group loop that does not use a target alias always 
overwrites the first instance created in the target Message Part with subsequent instances from the Source 
group list.

To create a Repeat for Group action, you need to complete these three tasks:

Create a Declare Group action to create the group lists.
Create a Repeat for Group action specifying which group list to use.
Create Map actions inside the loop.

To add a Repeat for Group action:

1 Open a component.
2 From the Action menu, select New Action>Repeat, then Repeat for Group. The Repeat for 

Group dialog box displays.

3 Under Source, select a Group name on which to base the Repeat for Group action loop.
4 Optionally, type in a Where clause to filter the group list, or click the Expression Builder button 

and create a Where expression.
5 Under Target, you can optionally create an Alias name to be used by Map actions in their target 

expressions. 
6 Create an XPath or Expression to be represented by the alias.
7 Click OK.

The following illustration shows a complete Repeat For Group action in the Action Model pane.
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The Repeat While Action
The Repeat While action repeats one or more actions as long as a condition that you specify remains true. 
For instance, you can create a variable that contains the total sales from line items within invoices. You 
can then create a Repeat While action that reads invoices, totals the line items, and stops when the line 
item total reaches a certain amount.

The target alias created in the Repeat While action serves two functions. It is an alternate name or short-
hand for the XPath target of any Map actions within the loop. This saves you the work of re-specifying 
long XPath expressions. The target alias when used in place of a DOM name in a Map action is also an 
indicator to Map actions within the Repeat loop to create a new instance of the Source in the target DOM. 
A Map action within a Repeat for Group loop that does not use a target alias always overwrites the first 
instance created in the target DOM with subsequent instances from the Source.

NOTE:  Unlike the Repeat for Element and Repeat for Group, the Repeat While does not have to be 
based on data in a DOM tree. The loop can operate independently of data in the DOM tree.

To add a Repeat While action:

1 Open a component.
2 Select a line in the Action Model where you want to place the Repeat While action. The new 

action is inserted below the line you select.
3 From the Action menu, select New Action>Repeat, then Repeat While. The Repeat While dialog 

box appears.

4 Under Source, type an expression to test the While loop, or click the Expression Builder button 
and build an expression.

5 Type a name for a variable that keeps track of the condition of the loop.
6 If you know the alias for the Target element, type in the Alias field.
7 If you do not know the alias, select either XPath and a Part element, or Expression and type in a 

valid expression.
8 Enter a criteria statement, or click the Expression Builder button and build an expression.
9 Click OK.

The following illustration shows a complete Repeat While action in the Action Model pane.
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The Split Document Action
When a service receives an input document, Integration Manager’s default behavior is to read the entire 
document into memory at once, then parse it into a DOM. Message Parts (Input, Input1, Temp, etc.) are 
then passed between components—or from service xObjects to components—as self-contained DOMs. 
This approach is appropriate for most services. But in some circumstances, such as when a service 
routinely encounters large documents, machine memory and parsing overhead become significant issues. 
In such situations, it can make more sense to process large documents in pieces.

The Split Document action is a special-purpose action designed to enable piecewise processing of large 
XML documents. With the Split Document action, input documents are treated as streams. A stream can 
be consumed in arbitrarily defined chunks; the chunks, in turn, can be processed serially. The net result 
is a much reduced demand on system RAM, and (potentially) higher throughput from reduced DOM-
handling overhead.

You should consider using the Split Document action when:

Your service can be expected to encounter large input documents (200+ Kbytes) containing 
repeating elements, or
Your service runs out of memory on the server due to large DOM sizes, or
Your deployed service has a performance bottleneck that you think may be related to DOM parsing, 
or
The nature of your business logic (and/or your input documents) is such that it would be more 
natural to process the data streamwise, in chunks, than to create and debug a single large Repeat 
For Element loop.

Limitations of Stream-Based Document Processing
The Split Document action is subject to some important caveats. The most obvious limitation is that the 
document in question should be piecewise-processable; which is to say, it should contain repeating 
elements (identifiable split points where the document can be separated into chunks). The split points are 
defined in terms of an XPath expression representing the type of node on which to break. (While it is 
technically possible to split a non-repeating XML Document into two parts using the Split Document 
action, this would be an abnormal use case and is not recommended.)

It’s important to understand that because the document is encountered in chunks, and because each chunk 
is released from memory (goes out of scope) after it is processed, any business logic that has to “know 
about” data in downstream parts of the document (such as a footer section) while processing upstream 
parts can’t be expected to work. In general, any dependencies that span “document chunks” will, at the 
very least, require custom workarounds involving operations that “keep track of” document 
characteristics as processing occurs.

NOTE:  If global knowledge of document statistics is required—or if it is necessary to use aggregate-
oriented XPath methods like count(), last(), etc.—then stream-based processing using the Split Document 
action is not appropriate, because the entire document needs to be read into memory.
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How the Split Document Action Works
The Split Document action should be used in the top-level Service xObject that wrappers all of your 
service’s components. It also should be the first “DOM-processing” action in that service’s action model. 
That is to say, no other action preceding the Split Document action should reference the Message Part 
(typically Input) that will be split. 

The first action in the action model that references a document determines how that document will be 
handled. If the first action to reference Input is a Map action (or other non-Split-Document action), then 
Input will be treated as a single, monolithic DOM. If, on the other hand, the first action to reference Input 
is a Split Document action, the source document for Input will be treated as a stream. At that point, no 
self-contained “DOM version” of the streamed document will ever be available, for the life of that service 
instance.

NOTE:  Within a given service, a particular document can be processed either as a DOM or a stream, but 
not both. However, if an Input document is processed in stream fashion, only that document is handled 
that way. Other documents (Temp, Output, etc.) will be subject to the normal DOM parsing.

The Split Document action requires you to specify an XPath expression representing the type of 
document element on which to split. Consider the following hypothetical XML document, representing 
a batch of invoices. 

<DATA>
<PrologInfo/>
        <BatchDate/>
<InvoiceBatch>  

<Invoice/>
        <Line Item/>
        <Line Item/>
    <Invoice/>
        <Line Item/>
        <Line Item/>
    <Invoice/>
        <Line Item/>
        <Line Item/>
    <Invoice/>
        <Line Item/>
        <Line Item/>
    <Invoice/>
        <Line Item/>
        <Line Item/>
</InvoiceBatch>
<SummaryLog/>
     <NumberOf<Invoices/>
</DATA>

The natural “split point” for this document might be an XPath of 

DATA/InvoiceBatch/Invoice

Using this XPath with a Split Document action, the above document would be read in the following 
chunks:

<PrologInfo/>
        <BatchDate/>
<InvoiceBatch/>  
     <Invoice/>
        <Line Item/>
        <Line Item/>

followed by:

<InvoiceBatch/>  
     <Invoice/>
        <Line Item/>
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        <Line Item/>

<InvoiceBatch/>  
     <Invoice/>
        <Line Item/>
        <Line Item/>

<InvoiceBatch/>  
     <Invoice/>
        <Line Item/>
        <Line Item/>

<InvoiceBatch/>  
     <Invoice/>
        <Line Item/>
        <Line Item/>
<SummaryLog/>
     <NumberOf<Invoices/>

There would be five chunks, total. The first and last chunks would be “special” in the sense that they 
contain header and trailer (or prolog/epilog) data in addition to the Invoice data. There is nothing special 
about how they were created, however. The document was simply split wherever 
DATA/InvoiceBatch/Invoice occurred.

NOTE:  Each time a split occurs, the chunk that gets created contains the entire subtree under the 
parsing node. If the chunk is the first chunk in a document that contains prolog information before the first 
parsable node, then the first chunk will contain all of the document (including prolog) up to and including 
the first parsable node and its children. Similarly, if the document has information following the last parse-
tree, anything trailer-nodes will travel with the chunk.

Controlling the Size of Chunks

If the document in the foregoing example had contained thousands of invoices, splitting it into one-
invoice chunks probably would not be wise. (Component-calling overhead could be expected to result in 
a performance hit.) For efficiency, it would be better to break the document into larger-sized pieces. The 
Split Document action allows you to do exactly that. You can override the default “strict parsing” 
behavior shown above by specifying a value greater than one in the “Occurrences per split” portion of the 
Split Document dialog. (See further below.) This way, in a document containing a thousand invoices, one 
could split on every ten or every hundred invoices. It would be up to the invoice-handling component (the 
component to which “chunks” are passed) to loop through individual invoices at the action-model level. 

Suppose the document in the previous example were processed with a Split Component action in which 
the “Occurrences per split” parameter is set to 2. The resulting chunks would look like:

<PrologInfo/>
        <BatchDate/>
<InvoiceBatch>  

<Invoice/>
        <Line Item/>
        <Line Item/>
    <Invoice/>
        <Line Item/>
        <Line Item/>

followed by

<InvoiceBatch/>  
     <Invoice/>
        <Line Item/>
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        <Line Item/>
<InvoiceBatch/>  
     <Invoice/>
        <Line Item/>
        <Line Item/>

followed by

<InvoiceBatch/>  
     <Invoice/>
        <Line Item/>
        <Line Item/>
<SummaryLog/>
     <NumberOf<Invoices/>

Notice that once again, header elements come as part of the intial chunk, while footer elements are 
contained in the final chunk. The first two chunks contain two invoices each. The final chunk contains 
just one, since 5-modulo-2 is one. The final chunk, in other words, contains the “remainder” (or leftover 
pieces) from the splitting operation. This means that the Repeat loop in your chunk handler will need to 
be able to deal gracefully with situations where a chunk contains less than the expected number of pieces. 
One way to do this is to base the loop’s termination condition not on a fixed number, like 2 or 10 or 100 
(representing the “Occurrences per split” value), but on an actual count of the number of target nodes 
contained in the incoming chunk. 

For example, the following ECMAScript expression would tell you how many <Invoice> elements are in 
a given chunk, in the previous example:

Input.XPath('InvoiceBatch/Invoice').length

You can safely continue iterating until the loop counter variable reaches the amount returned by this 
expression. 

Loop Control and the Split Document Action

The Split Document action is itself a looping action: Integration Manager places a “Loop Action” block 
under the Split Document line in the action model automatically. You will probably put a Component 
action within the Loop Action block, along with pre- and post-processing logic for chunks, exception-
handling code, etc. 

Loop termination is handled automatically, in the sense that you do not have to declare a counter variable 
(nor specify a termination condition). Integration Manager simply performs the appropriate number of 
stream-reads and splits, and stops when there are no more “chunks” in the stream. 

You can terminate the loop prematurely (or continue on to the next iteration at any point in the loop) by, 
for example, placing a Break (or Continue) action in the True branch of a Decision action. More 
sophisticated loop control can be achieved using Try/On Fault (see “The Try/On Fault Action” above) in 
the service and Throw Fault in the chunk-handler component, or by analyzing a custom Output doc 
returned by the chunk handler, etc.

Chunks as Documents

Typically, you will place a Split Document action in a service that calls a chunk-handling component 
(which might be an XML Map component, a JDBC component, or any other component type). The 
service will call the component via a Component action. The component will operate on the chunk’s 
contents, using whatever business logic is necessary. The component may or may not hand an Output 
document back to the original service; and the service itself may or may not construct an Output 
document for the benefit of the invoker. 
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The service containing the Split Document action will typically be splitting the Input message part. The 
Component action (calling the chunk handler) will in turn specify “Input” as the input to the handler 
component. In effect, a chunk becomes a DOM (a first-class document) in its own right. Any of the 
normal DOM operations can be performed against it. It can be passed component-to-component, written 
to disk, appended to other DOMs, mapped into or out of, etc.

Special Considerations for Animation and Debugging
When you open a service containing a Split Document action, the Input document window will initially 
be empty. (Ordinarily, you would expect to see your Input template document in tree view.) As you step 
through the action model in animation mode, the document window will populate as soon as you execute 
the Split Document action. The window will show the first “chunk” of the input stream, based on a 
parsing of the Input template. If you continue to use Step Into, each trip through the Loop Action block 
will re-load the Input window with the appropriate chunk from the input stream. At any time, during any 
of these iterations, you can Stop the animation and then perform drag-and-drop mapping of data from 
Input to other message parts (such as Temp or Output) as needed. 

After the Split Document action is complete, the last chunk of the document will remain in the Input 
pane. Footer data can be mapped at that point (using drag-and-drag or an ordinary Map action) to Output, 
or otherwise processed, as desired.

NOTE:  At no time will the entire Input template document be visible in the document window. Only pieces 
will be visible. If you need to see the entire document, open the appropriate Template itself, outside the 
component.

An important behavior to be aware of at design time is that the document-handling mode (stream versus 
DOM) is not set until you Save the component or service you’re editing. In other words, if you add a Split 
Document action to an action model and immediate animate it (without Saving), the stream processing 
behavior will not be evident. You should Save the service or component after making any change to the 
action model that would change the document-handling behavior (stream vs. single DOM) of the 
service/component. 

Another important principle to be aware of at design time is that if you happen to place an action that 
references Input anywhere upstream of the Split Document action in your action model (even if it’s 
merely a Function or Log action used for debugging purposes), Input will be treated as a single large 
DOM at animation time. When you then Step Into the Split Document action, an exception occurs, 
because there is no stream. (The stream has already been fully consumed in order to create the DOM.) As 
mentioned earlier, the Split Document action must be the first action that references the document in 
question. Any other actions that reference that document must occur downstream of Split Document in 
the action model.

A final consideration to bear in mind is that although the Split Document action is designed to facilitate 
working with large documents, you should not actually use a large document as a sample at design time. 
Integration Manager needs a large amount of memory at design time when large sample documents are 
loaded. This is true even though a particular service might use stream processing (via Split Document) to 
process the document. For design time, you should use a relatively small sample document—a reduced-
size version of the “real thing,” just large enough to prove out the action model. Use fullsize documents 
after deploying to the app server. 
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Creating the Split Document Action
The following procedure steps you through the process of creating and using a Split Document action. It 
assumes that you have an Input sample document to work from, representing (in structure, if not in 
actuality) a large, splittable XML document. It also assumes that you have created a component to handle 
the processing of individual document chunks (a “chunk handler”), and a Web Service that calls that 
component.

To create a Split Document action:

1 Open the service in which you plan to use a Split Document action, if it is not already open.
2 Place the cursor at the point in the action model where you intend to add the new action. (Highlight 

or select the line preceding the intended location.)
NOTE:  Be sure to heed the earlier warning about not placing the Split Document action after 
(downstream of) any existing action that references the document to be split (typically Input). If Input 
will be split, no action in the action model should reference Input unless the action in question comes 
after (downstream of) the Split Document action.

3 Either use the Action menu to create the new action, or right-mouse-click and choose 
New Action > Repeat > Split Document... from the context menu. A dialog appears.

4 Under Source, use the dropdown menu to select the message part (for example, Input) representing 
the document to be split.

5 Also under Source, enter (in the text field provided) an XPath expression representing the node 
axis on which to split the document. (Click the small X-icon at the far right to bring up the XPath 
Expression Builder, if you’d like to have Integration Manager help you build the expression in 
point-and-click fashion.)

6 Under Occurrences per Split, enter a positive integer representing the number of repeating pieces 
to include in a chunk. The default is one, meaning that Integration Manager will split the document 
on every occurrence of the specified parsing node. To split on every third occurrence, enter 3. For 
every fourth occurrence, enter 4. And so on.

7 (Optional) Check the Ignore Comments checkbox if you would like XML comments to be 
automatically stripped from the input stream as the document is processed. This is a performance-
enhancing option designed to speed the processing of (and reduce memory usage related to) 
documents that might contain large quantities of comments (possibly machine-generated). 
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8 (Optional) Check the Ignore Attributes checkbox if you would like Integration Manager to 
discard attribute data while reading the input stream. Again, this is a potential performance-
enhancer, meant to conserve memory and reduce processing overhead when dealing with large 
documents.

9 Click OK. A new action is added to the action model of the service.

Note that a “Loop Action” block appears automatically under the Split Document action. 
10 Add a Component Action to the Loop Action block, so as to call the chunk handling component 

that will process individual pieces of the input doc. (See “The Component Action” for information 
on how to create and use this action.) In the above example, an XML Map Component called 
“Mapping” is called, with the service’s Input passed as input to the component. 
NOTE:  Remember that at execution time, Input (in this case) actually represents a piece of the 
service’s input doc.

11 Optionally add any other pre- or post-processing actions your service might need, in the Loop 
Action block.

12 Save your service.
IMPORTANT:  Your Split Document action will not work (in animation mode) unless you have first 
Saved your service.
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9 Resources

A resource is a reusable xObject that a component may need in order to carry out a task. For example, 
most XML integration applications communicate with a “back end” system of some sort; and to do this 
usually requires establishing a connection of some kind involving the specification of IP or JNDI 
addresses, ports, driver location, user ID and password, etc. This type of info can be stored in a reusable 
object and then accessed by a component at runtime. Resource xObjects accomplish this.

A Resource consists of the resource itself (whether a JPEG image, a JSP, an XSL stylesheet, or what have 
you) plus XML metadata about the resource, so that the characteristics of the resource are known to 
Integration Manager Enterprise Server and to other runtime processes. At deployment time, all of your 
project’s resource are packaged into the deployment archive (usually a JAR inside an EAR), and they 
become available on the application’s classpath. 

The core resource types available in Integration Manager include those listed below. 

Certificate
Code Table
Code Table Map
Connection
Copybook
Custom Script
DTD
Form (XForm)
Image*
JAR (Java archive)
JSP (Java Server Page)
WSDL
WSIL
XML
XSD
XSL

In addition to these core types, various Integration Manager Connect products use additional resource 
types specific to the connector. For example, the EDI Connect allows you to specify EDI Document 
Metadata and EDI Interchange Metadata resources. 

NOTE:  The creation of Connect-specific resource types is explained in the documentation for the 
connector. Only core Integration Manager resource types are discussed in the sections to follow.

Resource types have distinguishing icons (which are displayed in the Category Pane of Integration 
Manager’s main navigation frame). The resource categories and their associated icons look like this:
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Working with Resources
Custom-created resources of a given type appear in the Instance Pane when you select (highlight) a 
particular resource category (Code Table, Connection, etc.) in the Category Pane. Each resource instance 
is reusable by the various components and/or services in your current project (and can be imported into 
other projects as well). 

At component creation time, the wizard for the component will prompt you for the name(s) of the 
resource(s) you would like to be used by the component. This means that resources need to be created 
first, so that components can use them.

All resources are created using the same basic procedure, indicated below.

To add a new Resource to a Project:

1 From Integration Manager’s File menu, select New, then xObject. From the Resource tab, select 
the desired category of Resource. See below.

2 Once you select your resource type, a wizard will appear, prompting you for the name of your 
custom resource and other information pertinent to the type of resource being created. Fill in the 
information requested by the wizard.

3 On the final screen of the wizard, click OK. The new resource is added to the Resource Category in 
question, and its name is displayed in the Instance Pane.
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Support for Language Versioning of Resources
Integration Manager supports a mechanism for dynamically selecting a language-appropriate version of 
an XML resource at runtime based on filename hints. The way it works is as follows. Suppose you have 
have two versions of an XML Resource file named MyInvoice_en.xml and MyInvoice_jp.xml.  The 
"_en" file would contain Latin characters while the "_jp" file would have Japanese characters. (The 
language specifier is the two-character ISO-639 code.) At runtime, a Load Resource action can choose 
the appropriate language version of the XML resource in question, based on the language settings 
specified in design time.

To take advantage of this scheme, you must adhere to the following rules:

You must use file-naming protocol mentioned earlier. (Namely: Every file name must end with an 
underscore followed by the two-character ISO-639 code for the language.) 
You must create one resource for each individual file. The applicable resource types are XSL, 
XML, and Form (that is, XForm).
You will specify a Language option when creating a Integration Manager Resource action, or when 
specifying a stylesheet resource in a deployment object.

In Integration Manager dialogs that offer a resource-picker dropdown list, such as the Integration 
Manager Resource action, you will see a Language button. If you press that button, you will bring up the 
following dialog.

Choose one of the radio buttons:

None: Applies no preference.
Environment: Choose the language of the host machine.
Session: Chooses the language specified in the servlet request.

Depending on which button you choose, the resource picker will update dynamically to show the list of 
available resource choices. Choosing None above means that every available resource (of all languages) 
will be displayed in the picklist. Choosing Environment or Session means the Resource Name list box 
will be populated with only the unique names of resources for the selected Resource Type after stripping 
the language and locale suffixes from the file names. In other words, the list is filtered according to the 
language-awareness preference chosen in the above dialog.
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About Certificate Resources
Certificate Resources are used to hold Digital Signature information. Data that can be stored in this kind 
of resource include a public key x509 certificate, a corresponding private key, and a private key 
password.  

The Certificate Resource can be used in several ways:

In the Web Service Interchange action, it can be used to digitally sign a request.
In SOAP deployment, it can be used to signal the SOAP Server to digitally sign the outgoing 
response. (This option can be set in the options-panel UI for the SOAP HTTP trigger.)
In the HTML Connect, it can be used to authenticate to a server.  
In the Process Manager, you can use a Certificate Resource to sign the outbound request of a Web 
Service Send activity. 

NOTE:  Since the Certificate Resource is a first-class Integration Manager resource, it can be shared 
among components and services within a project. 

To create a Certificate Resource:

1 In Integration Manager’s navigator pane, right-click on Certificate (under Resource) and choose 
New from the context menu. A dialog will appear.

2 Enter a Name for the resource.
NOTE:  The name is required and may not contain the characters:   / : ?  " <  > .  |  Names are case- 
insensitive (i.e. MyObjectName is the same as myobjectname).

3 Click Next. A new dialog appears.
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4 Use the Browse button to navigate your local drive or network to locate a suitable Client 
Certificate (x509). 

5 Use the Browse button to navigate your local drive or network to locate a corresponding Private 
Key file. This key will be used for encryption of outbound digests and payloads. It will not be 
transmitted nor exposed to processes other than those residing in your Integration Manager project.

6 Enter a Private Key Password (as applicable) so that your private key can be retrieved from the 
local keystore.

7 Click Finish. The resource is added to the navigator detail pane.

About Code Tables
In building your Integration Manager applications you are often faced with the requirement to 
repetitively transform data you receive. Typical examples for this type of conversion include changing 
state codes (for example, Alabama, Illinois) to regions for classification or accounting codes as they are 
moved between systems. Integration Manager provides the capabilities to assist you with this type of 
conversion. For example, a “Code 1” for a bookstore may represent the fiction category, or a department 
store may use “Code M” to represent men’s clothing. 

If you were to design your application so that the output XML only included “Code 1” or “Code M,” with 
no other description, the result could be cryptic and confusing. This is where a code table comes into play. 
A code table stores commonly used business code tables and works in conjunction with a code table Map 
to produce an output XML document that is more meaningful to the person or business process receiving 
the output. In the case of the bookstore, the input XML that included “Code 1,” might be mapped using 
a code table to produce an output XML with a category “fiction.”
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About the Code Table Editor
The Code Table Editor includes both menu options and a tool bar. In addition to the menu options, the 
Code Table Editor includes a tool bar with the following buttons:

To create a code table:

1 Select File>New>xObject. From the Resource tab, select Code Table. The Create a New Code 
Table xObject wizard appears.

2 Type in a Name.
3 Optionally, you may type in Description information.
4 Click Next. The Code Table Editor appears with the name of your empty code table in the title bar.

Button Description

Save. Clicking this button saves changes to the open code table.

Cut. Clicking this button removes the highlighted data from the 
Code Table Editor and puts in onto the Windows Clipboard.

Copy. Clicking this button puts a copy of the highlighted data onto 
the Windows Clipboard.

Paste. Clicking this button puts the contents of the Windows 
Clipboard at the position of the cursor, or replaces highlighted text.

Delete. Clicking this button removes data from the currently active 
(or selected) cell of the Code Table Editor.

Add Row. Clicking this button adds a new, blank row into the Code 
Table Editor.

Delete Row. Clicking this button deletes the currently active (or 
selected) row from the Code Table Editor.
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When you close the Code Table Editor, the name of your new code table appears in the Resource category 
of the Integration Manager window, under Code Table, as shown.

To open a code table:

1 Select File>Open. The Open xObject dialog appears.

2 Select Code Table from the xObject Type dropdown list.
3 Select the code table you wish to open from the xObject dropdown list.
4 Click OK. The code table you selected opens in the Code Table Editor.

NOTE:  Optionally, you may select Code Table in the category pane of the Integration Manager 
window and doubleclick a code table from the detail pane.
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To add data to a code table:

1 Open the code table to which you’d like to add data. The code table you open appears in the Code 
Table Editor.

2 Click on the Add Row button. A blank row appears in the Code Table Editor window.

3 Click in the cell where you want to add data.
4 Type in the new data:

In the Value field, type in the element data from the XML sample you are using
In the Brief Description field, type a short description.
In the Long Description field, type the full description.

5 Repeat steps 3 and 4 until you’ve added all your data.
6 Select File>Save, or click the Save button. 

NOTE:  Alternate and faster ways to enter data are to copy data from a spread sheet and paste it into the 
code table. Make sure your selection contains three columns. The first column must contain data; the 
second and third columns are optional. Open the spreadsheet, copy the three columns and as many rows 
as needed. Open the code table and immediately press the Paste button. You can also copy data from 
tables in a Microsoft Word® document using the same technique.

To edit a code table:

1 Open the code table you’d like to edit.
2 Highlight the data you’d like to edit.
3 Use the Edit menu or the Code Table Editor tool bar buttons to cut, paste, or copy selected data.
4 Click the Save button when you are done editing.
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About Code Table Maps
A code table map is a resource used to automatically transform one set of codes into another set of codes. 
These maps are useful in translating and exchanging data between XML samples within a component. 
For example, one company may use numeric codes to store a status field while another uses alphabetic 
codes. 

NOTE:  You must create two individual code tables before you can create a code table map, since a code 
table cannot map to itself (See “About Code Tables” on page 201). 

To create a code table map:

1 Select File>New>xObject. From the Resource tab, select Code Table Map. The Create a new 
Code Table Map xObject wizard appears.

2 Type in a Name.
3 Optionally, you my type in Description information.
4 Click Next. The second page of the Create a New Code Table Map xObject appears.

5 Select an Input Code Table. (These codes represent the data content as it will be received into a 
component.)

6 Select an Output Code Table. (These codes represent the desired code values.)
7 Select a Handling method. This feature allows you to instruct Integration Manager on how to deal 

with values from the input Code Table that have no corresponding value in the output Code Table 
to which you are mapping. For example, if there are six values in Code Table 1 and only five values 
in Code Table 2, you must let Integration Manager know how to deal with the additional value. You 
have two choices:
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Use Source Value—This choice simply uses the input value as the output value. For example, 
an input of “Warehouse1” would simply map to an output value of “Warehouse1.”
Use Default Value—This choice would default to the value you set in the Default Value field. 
For example, you may enter “Not Applicable” in the Default Value field.

8 Click Finish. The newly-created code table map appears.

When you close the Code Table Map Editor, the newly-created code table map appears in the Resource 
category of the Instance Pane, under Code Table Maps, as shown above.

Mapping the Code Tables
Once you’ve selected the Input and Output Code Tables, you need to map the values. The code table map 
initially displays the In Value mapped to a Default setting in the Out Value field. The In Value is grayed 
out, since it cannot be edited. Once you click in a Default field, a dropdown list allows you to map the In 
Value to any one of the values in the Out Value field. This enables you to map more than one In Value to 
the same Out Value.

To open a code table map:

1 Select File>Open. The Open xObject dialog appears.

2 Select Code Table Map from the xObject Type dropdown list.
3 Select the code table map you’d like to open from the xObject dropdown list.
4 Click OK. The code table map you’ve selected opens.

To map values in the code table map:

1 Open the code table map in which you’d like to map values.
2 Click the Out Value field in the first record. A dropdown list with all the available values from the 

Output Code Table appears.
206   Integration Manager User’s Guide



3 Select the desired value from the dropdown list.
4 Repeat Steps 2 and 3 for all records.
5 Select File>Save or click the Save button on the tool bar.

To edit a code table map:

1 Open the code table map to which you’d like to make edits (See “To open a Code Table Map” 
above).

2 Click inside the Out Value cell to which you’d like to make edits.
3 Select the new value from the dropdown list.
4 Select File then Save or click the Save button on the tool bar.

Using a Code Table Map
Once you’ve created a code table map, you use it as you build components. For example, in the XML 
Map component editor, you could create an action that would map an element from an input DOM via a 
code table map to an output DOM. The action might look like this:

By using the code table map in the Map action, you not only transfer the input data, but also transform it 
before placing it in the output.

See Chapter 7, “Basic Actions” for more information.
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About Connections
A connection resource is a reusable object that wrappers connection-related information: typically an IP 
address, port number, and authentication credentials in the simplest case. The Connection Resource also 
stores critical information about driver names and/or JNDI names, LDAP distinguished names, time-out 
and retry settings, code pages, and/or whatever endpoint specifications might be needed to set up a 
connection with a given type of data store or stream.

Connection resources are needed not only for various data sources (such as database connections) but 
also for the URL File/Read, URL File/Write and XML Interchange actions—three of Integration 
Manager’s core actions. These Data Exchange actions allow you to transfer XML and non-XML 
documents via HTTP, HTTPS or FTP. The FTP Authentication Resource allows you to perform a simple 
FTP login and specify a connection time-out. The HTTP Connection Resource stores user-authentication 
and security information needed to set up an HTTPS session. 

Some of the user-supplied information in a Connection Resource can be bound dynamically at runtime 
through the use of ECMAScript expressions. (See discussion below.) Not every piece of user info in the 
Connection Resource need be static.

Because Connection Resources specify detailed access information for the data stream or endpoint in 
question, you will generally need to create one Connection Resource for every type of data source that 
your component or service will use. For example, if your application requires you to interact with a 
database as well as a directory, you will need at least one JDBC Connection Resource and one LDAP 
Connection Resource. (You do not necessarily need one resource for each data store or system, however, 
since connection parameter values can be bound dynamically via ECMAScript; see the next section.) 

It’s worth noting that Connection Resources may be reused by multiple components. They are true 
resources.

About Constant vs. Expression Driven Connections
You can specify Connection parameter values in one of two ways: as constants or as expressions. 

A constant based parameter uses the literal value you provide every time the Connection is used. An 
expression based parameter allows you to specify the value using an ECMAScript expression, which 
means the value might be different each time the connection is used at runtime. This late binding allows 
for flexible runtime behavior, since connection parameters can be determined using business logic or 
looked up from a backing store (including, potentially, an LDAP directory).

One simple use of an expression driven parameter in an HTTP Connection would be to define the User 
ID and Password as PROJECT Variables (e.g. PROJECT.XPATH(“USERCONFIG/MyDeployUser”). 
At runtime, your service can populate these variables with values that are calculated or looked up on-the-
fly (or derived from the service’s input data); any connection resources used by any of your components 
can then obtain these values from the PROJECT variables at instantiation time (via ECMAScript). 

A more sophisticated use of expression-driven parameters would be a case in which user credentials are 
looked up in a directory using LDAP queries. The procedure for doing this is described in the section 
called “Using LDAP to Obtain Connection Parameters” further below.

Setting Up an Expression-Driven Connection

Any parameter in a Connection Resource (not only User ID and Password, but IP address, port number, 
etc.) can be expression-driven. The steps for setting this up are outlined below.
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To switch a parameter from Constant to Expression driven:

1 Click the RMB in the parameter field you are interested in changing.
2 Select Expression from the context menu. A flyout menu control will appear to the far right of the 

field, containing two buttons: an ECMA Expression button and an LDAP Expression button. If you 
will be looking up the connection parameter value from a directory, select the LDAP button. 
Otherwise, accept the ECMA Expression button (which is the default). 
NOTE:  For information on how to use the LDAP Expression button, see the section called “Using 
LDAP to Obtain Connection Parameters” further below.

3 Click the ECMA Expression button. The expression editor appears:

4 Use the expression editor to build an ECMAScript expression that will evaluate to a valid 
parameter value at runtime. (Note that most of the nodes in the various picktrees will autogenerate 
ECMAScript code for you if double clicked.) In the above example, a project variable (“adminID”) 
is consulted for the UserID value in a connection. 

5 Dismiss the expression editor (click OK) to return to the connection-resource dialog. 
6 Repeat the above steps as necessary for any other parameter fields to which you wish to apply 

expressions.
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Using LDAP to Obtain Connection Parameters
User names and passwords are often stored in a directory (such as Novell eDirectory). The ability to look 
up user data at runtime is important in any application that has access control requirements. Integration 
Manager allows you to leverage LDAP for this purpose. No matter what kind of back-end system you’re 
connecting to, you can set up your Connection Resource in such a way that any or all of the connection 
parameters are obtained via directory lookup at runtime (with or without extra business logic to fine-tune 
connection particulars).

In order to obtain connection parameters by LDAP query, you must first create (or already have in your 
project) an LDAP Connection Resource. This resource tells Integration Manager which directory to use, 
which port to go out on, the Base DN to use, etc., so that a connection (secure or non-secure) can be 
established to the target directory. (Detailed information on how to create an LDAP Connection Resource 
is contained in the LDAP Connect User’s Guide.)

Once you have an LDAP Connection Resource, you can set up LDAP-driven connection parameters for 
any Connection Resource, using the technique outlined below.

To bind a connection parameter to a directory lookup:

1 In the “Create a New Connection Resource” dialog, right-mouse-click inside the text field to which 
you wish to assign a directory-lookup value. A context menu will appear.

2 Choose Expression from the menu. A flyout control (note the small triangle) will appear at the far 
right of the text field in question.

3 Click the flyout and choose LDAP Expression. The button next to the flyout changes to the LDAP 
Expression Editor button.

4 Click the LDAP Expression Editor button. The LDAP Expression Editor window appears.
NOTE:  You will get an error dialog at this point if you do not have at least one LDAP Connection 
Resource in your project. 
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5 At the top of this dialog, choose the LDAP Connection you will use. (The dropdown menu is pre 
populated with the names of LDAP Connection Resources in your current project.)

6 Under Distinguished Name, enter the LDAP Distinguished Name of the user or entity for which 
you are looking up data. If you don’t know the proper LDAP syntax, use the DN Editor (also 
known as the LDAP Browser): 

Click the small DN-and-pencil icon to the far right of the Distinguished Name text field. A new 
screen appears:

Navigate the directory’s tree view until you get to the node (object) that contains the information 
you need. Click the node to highlight it.
Click OK. You’re returned to the LDAP Expression dialog. Notice that the DN field of the 
LDAP Expression dialog now contains the properly formatted Distinguished Name for the 
object you intend to query.

7 Under “Object Classes,” select the type of object appropriate to the search you want to use, if it is 
not already showing.
NOTE:  This control will normally already be showing the name of the object that corresponds to 
the DN you specified in the previous step. You should not have to do anything.

8 Using the Attribute pulldown menu control, select the name of the attribute that contains the data 
you wish to look up. (This control is prepopulated with the names of all attributes defined on the 
object class chosen in the previous step.) 

9 Click OK to return to the Connection Resource setup dialog. An appropriately formatted 
ECMAScript expression will be generated for the connection-param field in question. The 
expression uses the Integration Manager extension method getLDAPAttr( ). At runtime, the 
connection parameter will be determined dynamically by LDAP lookup. You can test this 
capability at design time, of course, either by clicking the Test button in the connection setup 
dialog, or by running your component (the component that uses this connection) in animation 
mode.

How to Create an HTTP Basic Authentication Connection Resource
Integration Manager supports many types of connection resources, including LDAP, JDBC, FTP 
Authentication, HTTP (in three flavors, depending on the type of authentication specified), and SMTP in 
the core product; plus 3270, 5250, Telnet, HP3000, CICS RPC, JMS, SAP, Tandem, Data General, and 
Unisys-terminal connectivity in the various Connect products. Since the basic procedure for creating 
connection resources is the same for most of these different types, the following example (using HTTP 
Basic Authentication as the resource type) can be considered typical. 
Resources 211



NOTE:  See the user guide for the Connect product in question if you would like detailed information on 
how to create a connection resource for a particular back-end system, device, or protocol. Also, see the 
discussion at “Mail via SMTP Simple Authentication” (further below) for detailed instructions on how to 
create a mail-server connection resource.

To create an HTTP Basic Authentication Connection Resource:

1 Select File>New>xObject. From the Resource tab, select Connection. The Create a New 
Connection xObject wizard appears.

2 Type in a Name.
3 Optionally, type Description text.
4 Click Next. The second page of the Create a New Connection Resource wizard appears.
5 Select HTTP Basic Authentication from the drop down list. This will be used in conjunction with 

an XML interchange which uses HTTP connections.

6 Enter a UserID and Password. These are not actually submitted during the establishment of a 
connection. They are simply defined here (password is encrypted). The user will have access to 
UserID and Password variables from ECMAScript, allowing them to map UserID and Password as 
values into the screen. This way, no one ever sees the passwords.

7 Choose a Client Certificate by clicking on the Browse button and selecting the certificate file you 
want to use for this service connection.

8 Choose a Client Private key by clicking on the Browse button and selecting the client key file for 
security. 
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9 Enter the Password for the Private key. Private key is a another level of security for the owner of 
the Client Private Key.

10 Enter a Connection Timeout value in seconds.
11 Select the Default check box if you want this particular Connection to appear as the default 

connection in the appropriate Component wizards. 
12 Click Finish. The connection is created.

NOTE:  For more details on Connection Resources, see the “Getting Started” section in each Connect 
Guide.

How to Create an FTP Authentication Resource
Most FTP connections require a user name and password. The FTP Authentication Resource wrappers 
basic credential information so that you can reuse the credentials as needed in various components that 
might use FTP to read or write remote documents. FTP access is supported, for example, in the XML 
Interchange Action. (See previous chapter.) In the setup dialog for that action, you can specify an FTP 
Authentication Resource to use when executing the action.

To create an FTP Authentication Connection Resource:

1 Select File>New>xObject. From the Resource tab, select Connection. The Create a New 
Connection xObject wizard appears, as shown earlier (see Step 1 of procedure above).

2 Type in a Name.
3 Optionally, type Description text.
4 Click Next. The second panel of the Create a New Connection Resource wizard appears.
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5 Select FTP Authentication from the drop down list. The panel changes appearance:

6 In the screen that appears, enter a User ID, Password, and Connection Timeout value (in 
seconds). 
NOTE:  The timeout value represents the amount of time that will be spent trying to obtain a 
connection, not the amount of time devoted to keeping the connection open.

Mail Simple Authentication Connection Resource
E-mail account information can be stored in a Mail Simple Authentication Connection Resource. Any of 
your services or components that make use of the Send Mail action (see “Mail via SMTP Simple 
Authentication” for details) can take advantage of a Mail Simple Authentication resource for obtaining 
account information.

To create a Mail Simple Authentication connection resource:

1 Under Resource in the navigation (explorer) frame, right-click on Connection and choose New 
from the context menu as shown below:
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2 In the wizard pane that appears (see below), enter an arbitrary Name for this connection resource 
and (optionally) descriptive text.

3 Click Next. The second (and final) panel of the wizard appears:

4 Using the pulldown menu control, select Mail via SMTP Simple Authentication as the Connection 
Type.

5 Next to SMTP Server, enter the name or IP address of the mail server you intend to use.
6 Next to User ID, enter the user name associated with the mail account you wish to use.
7 Next to Password, enter the password associated with the user account in question.
8 Click Finish.
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About Copybook Resources
If you are accessing a COBOL CICS mainframe or using a JMS system, your application may need to use 
a Copybook source file to define its data layout. Similarly, if your Integration Manager project uses any 
kind of file manipulation (via FTP, EDI data exchange, etc.) you may have a need to work with COBOL 
Copybooks. Integration Manager has a Resource called Copybook that allows you to convert XML data 
into a ByteArray that can be used as Input to CICS RPC or JMS components. It can also be used to 
convert the ByteArray Output from these components back into XML format using Convert actions, 
which are described in Chapter , “Advanced Actions” beginning on page 160.

To create a Copybook resource:

1 Select File>New>xObject. From the Resource tab, select Copybook. The Create a New 
Copybook wizard appears.
NOTE:  Alternatively, you can select Copybook from beneath the Resource tree in the Navigator 
pane and click on New.

2 Type in a Name. Add Description information if desired. 
3 Click Next. The Copybook parameters screen appears.

4 Use Browse to search your file system for a COBOL Copybook.
5 In the Code Page field, from the drop down menu, select the appropriate code page for the type of 

operating system character data standard your machine uses (for example, CP037 for EBCDIC or 
8859_1 for ASCII).

6 In the Machine Type field, from the drop down menu, select the platform of your CICS 
Region/Server (MVS, OS2, NT, AIX).
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7 In the Floating Point Format field, from the drop down menu, select a name dependent upon the 
machine type selected: IBM or IEEE.

8 In the Endian field, from the drop down menu, select the order of the most/least significant bytes in 
integers (BIG if the most significant byte precedes the least significant byte in memory, otherwise 
select LITTLE). 

9 Click Finish to add the Copybook Resource to your list of available Resources and open it in the 
Component Editor. An example of an open Copybook Resource is shown below:

NOTE:  Copybook Resources must be created prior to the use of any Convert XML to Copybook or 
Convert Copybook to XML Actions.

About Custom Script Resources
A Custom Script Resource is a library of user-developed functions created in the ECMAScript 
programming language. You can make the functions available to be used throughout components and 
within other functions. Using custom scripts, you can develop functions that perform:

Almost all the same functionality as the basic XML Map components, with your own 
customizations
Data manipulations involving Strings, dates, numbers, regular expressions, etc. 
XML document manipulations using the W3C ECMAScript-to-DOM Binding methods
Integration with standard or custom Java classes

NOTE:  You must have a thorough understanding of the ECMAScript language in order to create custom 
functions. The following sections are intended only as general guidelines, not a tutorial in scripting. For 
more information on scripting in Integration Manager, see the next chapter.

Organizing and Using Custom Functions
You may prefer to organize functions into different libraries. For example, you may have several math, 
string, or database functions that you’ll need for your application. If you group similar functions (for 
example, create all string functions in the same library), you can also use the Custom Script Editor to 
declare global variables that can be used by all functions within the same library.

As you create and validate functions, Integration Manager makes them available in all expression editors 
within component actions.

For example, if you write a custom function library called “String” containing ten functions, they will 
appear in the Expression Editor under the Custom Scripts label with the other standard functions.
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To create a custom script:

1 Select File>New>xObject. Then, from the Resource tab, select Custom Script. The “Create a 
new Custom Script xObject” dialog appears.

2 Type in a Name.
3 Optionally, you can type in Description information.
4 Click Next. The Custom Script editor appears with your newly-created Custom Script name in the 

title bar.
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About the Custom Script Editor Window
The Custom Script Editor window is divided into several panes. You can change the view of the panes to 
include the content you need.

The illustration below shows the editor after several functions have been added.

NOTE:  In the preceding illustration, the Output (Error Message) Pane has been hidden (Control-Shift-O) 
and the Navigation frame has been hidden (Control-Shift-N).

Creating and Validating a Function
You create a function by typing it in from scratch. You can also use the Expression Builder in creating 
your function. For more information, see “Using the Expression Editor to Build Functions” on page 226.

To create and validate a function:

1 Type the word function in the function creation area.
2 On the same line, type the function name after the word function.
3 On the same line, type any function parameters, separated by commas, and enclosed with 

parentheses.
4 Type a left curly brace and press Enter.
5 Type in the function statement(s).
6 Type a right curly brace and press Enter.
7 Add comments to the function, if desired.

Your function should look similar to the following example:
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To validate the syntax of your function:

Click the Validate button.

If your function is valid, Integration Manager adds the function name to the validated function list. If your 
function contains an error, Integration Manager presents a detailed error message.

To test your function:

1 Type the function name complete with valid parameters in the test area.
2 Press Enter.

Before you can test your function, it must pass the syntax validation described in the previous section.

Adding a Function Tool Tip Description
Once your function has been validated, and is added to the validated function list, you can write a 
description for it. The description appears as a “tool tip” when your mouse rests on the function name, 
wherever the function appears in Expression Builders throughout Integration Manager.

To add a description:

1 Create and validate a function.
2 In the Description text box, overwrite the default description with the text for your function, as 

shown.

3 Select the Function is Public check box as desired. When you check this box, two things happen:
The function can be used from any expression builder in any action.
The function appears in the expression builder pick-lists under the “Custom Scripts” heading.
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Viewing DOM Trees within the Script Editor
For many of the custom script functions that you create, you will want to reference or work directly with 
data in specific XPath location in your XML documents. To make this easier, the Custom Script Editor 
allows you to display XML documents (in any of the three available views: text, tree, or stylized) in the 
editor. This makes specifying XPath references easier by allowing you to drag and drop XML elements 
into the body of your function definition.

To show an XML document in its own pane:

1 Be sure you have opened a Custom Script and are in the Script Editor environment.
2 In Integration Manager’s main menus, select File then Load XML Samples. (See illustration 

below.) 

When you choose this command, the Load XML Sample dialog will appear:

3 In the pulldown menu control labeled Part, choose which DOM (Input or Output) to associate the 
file with.

4 Use the Browse button to bring up the file-navigation dialog. Navigate to the XML file you wish to 
load, and dismiss the navigator. If you wish to load in a file from a URL, you must explicitly type 
“http://,” “https://,” or “ftp://.”
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5 Click OK to dismiss the Load XML Sample dialog. The file you chose appears in its own pane.

6 Navigate to the directory of the XML document you wish to use and select a file. An Input and 
Output Mapping Pane appear.
NOTE:  If you want to use XML documents from your XML Templates, go to the appropriate 
“Imports” directory below the “XMLCategories” directory in your project (e.g.: 
/Tutorial/XMLCategories/OfficeSupply/Imports).

Integrating Java Classes with Custom Scripts
If you are building a custom script that needs to invoke Java methods or instantiate custom Java classes, 
you can expand the view for the Custom Script Editor window to show the information you need in a 
browsable class navigator. The Java class browser scans your current CLASSPATH (as well as any JAR 
Resources you have added to your project) and displays the classes, methods, and properties it finds. This 
makes specifying and using Java constructors, methods, and properties easier by allowing you to drag 
and drop these items into the body of your function definition, or into the test (console) area, to test your 
functions.

To use Java classes:

1 Select View > Show Java Class Context from the Custom Script Editor menubar.
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After choosing this command, the Java Class panel appears in the main editor.

2 In the Java Class panel: 
Type a name in the Class Name field, or
Click the Browse button. After a brief delay, the Class Browser dialog will appear, showing the 
Java packages available in the Integration Manager CLASSPATH.

3 Navigate the context tree to get to the class you want to use. (Click the small plus signs to the left of 
the context nodes to expand them.)

4 Select the class you want to use, then click OK to dismiss the dialog. The class becomes visible in 
the class-list area of the editor.

5 Expand the class (by double clicking it or clicking the adjacent plus sign) to show its constructors, 
methods, and properties. See below.
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6 (Optional) Drag and drop individual methods or properties into the editor pane or the console to use 
the properties in question.

If you want, you can add your own classes into the Class Browser by either putting them into the 
Integration Manager CLASSPATH or extending Integration Manager’s CLASSPATH to include your 
classes.

NOTE:  If you are using custom Java classes, be sure to install those classes on theapplication server (or 
include them in your EAR/WAR files) when you deploy the application. 

Working with a Java Class in ECMAScript
The following example shows you how to create a script function named RoundToDecimalPos() that uses 
the Java DecimalFormat class. In this example, your function accepts two parameters, a number to round, 
and the number of places to round.

To create a script function that uses Java:

1 With the Java class panel displayed, enter a function signature in the function pane as shown.
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2 In the Class Name control, select the Browse button. The Class Browser dialog appears.

3 Navigate to Java > Text > DecimalFormat as shown above.
4 Click OK. The Custom Script window’s Class Name field is now populated.

5 (Optional) Enter a name in the Variable Name field. 
6 Drag and drop the desired Constructor to the function pane. Fill in the parameters for the 

constructor.
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7 Edit your ECMAScript function as desired. One possible function is shown below.

Using the Expression Editor to Build Functions
Rather than writing functions from scratch, you can use the Expression Editor to build them. The 
advantage of using this feature is that the Expression Editor exposes virtually all DOM methods, 
Integration Manager extensions, built-in ECMAScript methods, and DOM node targets, via point-and-
click pick-lists. Building an expression by the use of pick-lists is not only convenient and quick, but less 
prone to result in typos. It’s also a useful reference, since the calling syntax for every available method is 
shown in rollover tooltips for each leaf node in the picktree(s).

The Custom Script Editor displays two different views in the Expression Editor, based on the view you 
select. The basic view lists the ECMAScript objects and operators available for building your own 
functions, as shown.

If you select, View, then Show XML Documents in the Custom Script Editor, the Expression Editor 
appears with an additional pick-list for selecting elements in the DOMs, as shown.
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To use the Expression Editor:

1 From the main menubar, select Tools then Expression Editor. The Expression Editor appears.

2 Expand the trees in the Variables, Functions/Methods or Operators panes and doubleclick on the 
elements to build your functions. Once you doubleclick an element, it appears in the bottom 
Expression pane. 

Alternatively, you can use the right-mouse button to bring up the Expression builder in either the 
Function editing pane or the test area.

NOTE:  For additional tips regarding ECMAScript, see the subsequent chapter called “Custom Scripting 
and XPath Logic in Integration Manager” in this guide.
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About DTD Resources
You can package DTDs into your project for deployment as part of your application. The procedure is as 
follows.

To create a DTD resource:

1 From Integration Manager’s File menu, select New, then xObject, then from the Resource tab, 
select DTD. (Alternatively, right-click on the DTD Resource icon in the Category pane, and choose 
New.) The first pane of the DTD Resource wizard appears.

2 Provide a Name for the DTD, add descriptive information if desired, and (if you are creating this 
DTD using the Integration Manager Editor) click on Next to proceed to the next screen.

3 Optionally click the “Associate Public Identifier” checkbox and enter the appropriate identifier 
string in the text field shown.

4 Click Finish. The Integration Manager Editor opens with your DTD showing in text view.
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About Form Resources
The Integration Manager Form Resource gives you the ability to create XML-based forms (XForms) for 
use within your project. 

NOTE:  When installed as part of the Professional Edition suite, Integration Manager does not support 
this resource type. The following discussion applies only to users of the Enterprise Edition product.

The Form wizard will guide you through the necessary steps to create the initial instance data.

To create an XForm:

1 From Integration Manager’s File menu, select New, then xObject, then from the Resource tab, 
select XForm. (Alternatively, right-click on the XML Schema Resource icon in the Category pane, 
and choose New.) The first pane of the Form Resource wizard appears.

2 Provide a Name by which you will refer to the XForm, add descriptive information if desired and 
click on Next to proceed to the next screen.

3 Select an Instance Data Source Type. Choices include: 
Schema
XML Sample
WSDL

4 If you select a Data Source Type of Schema, you will need to indicate which Schema Root should 
be used for the instance data.
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5 If you select a Data Source Type of XML Sample, select the Location of the XML Source using 
the dropdown lists under Project Resources for templates that already exist as part of the project. 
The first box contains Template Categories, the second contains Template Names, and the third box 
will be populated with Sample Names.
Alternatively, you can Browse to select a local file or type in the fully qualified URL to locate the 
XML Source for the XForm.

6 If you select a Data Source Type of WSDL, you must select a Service and and an Operation that 
are associated with the instance data. 
Then, select a WSDL Resource using the dropdown below Project Resource. Alternatively, you 
may Browse to select a local file or type in a fully qualified URL to locate the WSDL Source for 
the XForm.

7 Click on Finish to create the Form Resource object and open it in the Forms editor.

NOTE:  The forms editor interface is described in detail in Chapter 10, “Form Designer”.

About Image Resources
It is sometimes useful to package image files into a Integration Manager project. For example, if your 
project contains Java Server Pages that reference GIF, JPEG, or PNG files, it’s often convenient to 
package images within the same JAR or WAR file as the JSP that uses them. The JSP can then refer to 
the images via a relative URL (as described below).

The first time you create an Image resource, Integration Manager creates a subdirectory called \image in 
your project folder and puts a “src” folder under the image directory. Every image resource you create 
results in two files:

An XML file describing the resource
A copy of the original image

The former appears in the \image subdirectory. The latter appears in the \src subdirectory. 

So for example, if your project is called MyProject and you created an Image resource based on an image 
called Sample.jpg, you would be able to find the following directory structure:

Inside the \image folder, you would also find a file called Sample.jpg.xml, representing the xObject 
wrapper (the metadata) associated with the Sample.jpg resource. 
230   Integration Manager User’s Guide



Image Resource Naming (and Renaming)
By default, when you create an Image resource, it acquires a name identical to that of the image you are 
assigning to the resource. Nevertheless, you can rename the Image resource after creating it (the same 
way you would rename any other resource): Just right-mouse-click on the resource instance in the object 
pane in Integration Manager’s main view, and choose Rename from the popup menu that appears. Then 
enter a new name for the resource. (Renaming the resource in this way changes the name of the actual 
image file as well as the xObject.)

NOTE:  As with other resource renaming operations, you will need to close the resource in question (if it 
is open) before you can rename it.

Context in the JAR
At deployment time, your Image resource will be packaged inside a JAR file (along with all the other 
xObjects in your project) and placed inside the deployment EAR. Each physical image will have a default 
deployment context of 

[Your project context]/image/src

Therefore, any Java Server Page that lives at root level in the JAR can refer to a given image using a 
relative URL of /image/src/imagename. For example:

<img src=”MyProject/image/src/Sample.jpg”/>

How to Create an Image Resource
Creating an Image resource is much like creating any other resource xObject, except that in this case, the 
object’s default name is chosen for you.

To create an Image resource:

1 Either right-mouse-click on the word Image under Resources in Integration Manager’s navigation 
frame and choose the New command from the context menu (as shown below), or go to the File 
menu and select File > New > xObject. From the Resources tab, select Image and OK.

2 In the dialog that appears, choose the radio button labelled Create from existing external file(s). 
See below.
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3 If you know the location of the file, you can enter it directly in the text field (either as a file-system 
address or a fully qualified URI beginning with http:// or ftp://). Otherwise, click the Browse 
button and navigate to an image file.
NOTE:  Supported file types are GIF, JPEG, and PNG.

TIP:   When using the file-chooser dialog (via Browse), you can Control-click or Shift-click to select 
multiple images; then all will be brought into Integration Manager at once. Each image will retain its 
original name. 

4 Click the Finish button. The dialog goes away and a new Image resource appears in the instance 
pane of Integration Manager’s navigator frame.

How to Import an Existing Image Resource
You may find that you want to import an existing Image resource from another project into your current 
project. You can do this as follows.
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To Import an Image resource from another project:

1 Right-mouse-click on the Image resource category (as shown in the last section) and choose 
Import from the context menu. The Import dialog appears:

2 Use the Browse button to go to a file-chooser dialog. Browse your network or file system as 
necessary, and when you have located the Image resource you wish to import, click Open to return 
to the above dialog. If you wish to load in a file from a URL, you must explicitly type “http://,” 
“https://,” or “ftp://.”
NOTE:  Image resources are XML files. They will always be found in the \image folder of a 
Integration Manager project. 

3 The name of the resource is shown in the Name field of the dialog. Use this text field to change the 
resource’s name if you wish to do so at this time. (You can also rename it later.)

4 Click OK. The resource is added to the instance pane of Integration Manager’s navigation frame.

How to View an Image Resource
Once you have created or imported Image resources into your project, you can view an image by double 
clicking the resource in the instance pane (or by highlighting it and using RMB, then Open). The image 
will be rendered in its own tabbed window in the Integration Manager desktop:
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The size of the view (the magnification factor) can be controlled in various ways. If you right-click on the 
image itself, a context menu appears:

In addition to using the various Zoom commands on the context menu, you can control the magnification 
factor of the image view by means of the mouse and/or keyboard:

To zoom in: Use the plus (+) key on the numeric keypad, or left-click anywhere on the image.

To zoom out: Use the minus (-) key on the numeric keypad, or Control-left-click anywhere on the image.

To restore the original view: Use the equal sign (=) key or Shift-left-click anywhere on the image.

About JAR Resources
JAR resources provide you with the ability to add custom utility classes or business objects to a 
Integration Manager project. Custom scripts and components you create within your project can then use 
these classes. The Custom Script editor’s class browser provides access to the JAR resource, allowing 
you to drag and drop Java objects in to your custom scripts. You may also use function calls within your 
components to instanter objects of the imported class type, and invoke the class methods. 

NOTE:  If you wish to add another Integration Manager project as a subproject, do not use the JAR 
Resource mechanism. Instead, use Tools > Project Serttings > Subprojects to import another 
Integration Manager project into your current project.

The first time you create a JAR resource, Integration Manager creates a subdirectory called \JAR in your 
project folder and puts an import folder under the JAR directory. Every JAR resource you create results 
in two files:

An XML file describing the resource
A copy of the original JAR

The former appears in the \JAR subdirectory. The latter appears in the \import subdirectory. 

For example, if your project is called TutorialStudent and you created a JAR resource based on a JAR 
called mycontacts.jar you would be able to find the following directory structure:
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Inside the \jar folder, you would also find a file called mycontacts.xml, representing the xObject 
wrapper (the metadata) associated with the mycontacts.jar resource. 

JAR Resource Naming (and Renaming)
By default, when you create an JAR resource, it acquires a name identical to that of the JAR file you are 
assigning to the resource. You can rename the JAR resource after creating it, if you wish. From 
Integration Manager’s main view click the right mouse button on the resource instance in the object pane. 
Choose Rename from the popup menu that appears. Then enter a new name for the resource. Renaming 
the resource in this way changes the name of the actual JAR file as well as the xObject.

NOTE:  The JAR file resource must be closed in order to rename the resource.

Context in the Integration Manager Project
To reference classes in the JAR resource you reference the context of the class package. If the class is in 
the root of the jar no context is needed. In the example below two jar object classes are referenced, the 
first myFirstStringProcessorObj references a class at the root of the JAR. The second, 
mySecondStringProcessorObj is referenced by its context, com.Novell. Notice that in both cases the 
Packages keyword precedes the context. To avoid name collisions between classes with identical method 
names, you should package your classes within a context.

The following example depicts the function expression used to instantiate an object of the 
myStringProcessor class residing in the com.Novell context.

Context in the Integration Manager Project JAR
At deployment time, your JAR resources will be packaged inside a WAR file (along with your project 
JAR) and placed inside the deployment EAR. Each physical JAR will have a default deployment context 
of 

/JAR/import
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How to Create a JAR Resource

To create a JAR resource:

1 Either right-mouse-click on the word JAR under Resources in Integration Manager’s navigation 
frame and choose the New command from the context menu, or from the File menu select File > 
New > xObject. Select the Resources tab from the New xObject dialog (shown below), select 
JAR.

2 In the dialog that appears, the radio button labelled Create from existing external file(s) is 
selected. See below.

3 If you know the location of the file, you can enter it directly in the text field (either as a file-system 
address or a fully qualified URI beginning with http:// or ftp://). Otherwise, click the Browse 
button and navigate to the JAR file.
TIP:   When using the file-chooser dialog (via Browse), you can Control-click or Shift-click to select 
multiple jars; then all will be brought into Integration Manager at once. Each jar will retain its original 
name. 

4 Click the Finish button. The dialog goes away and a new jar resource appears in the instance pane 
of Integration Manager’s navigator frame.
236   Integration Manager User’s Guide



How to Import a JAR Resource

To Import a JAR resource:

1 Right-mouse-click on the JAR resource category and choose Import from the context menu, 
alternatively you may select File > Import xObject from the menu. The Import dialog appears:

2 Select JAR form the Type dropdown list.
3 Use the Browse button to go to a file-chooser dialog. Browse your network or file system as 

necessary, and when you have located the JAR resource you wish to import, click Open to return to 
the above dialog. If you wish to load in a file from a URL, you must explicitly type “http://,” 
“https://,” or “ftp://.”

4 The name of the resource is shown in the Name field of the dialog. Use this text field to change the 
resource’s name if you wish to do so at this time. (You can also rename it later.)

Click OK. The resource is added to the instance pane of Integration Manager’s navigation frame.]

About JSP Resources
You can create Java Server Pages directly in Integration Manager (and then store them in your project as 
JSP Resources), import JSPs from a local drive or URI, or import existing JSP Resources from another 
Integration Manager project. Once you create a JSP Resource, it is deployed as part of your project’s 
deployment JAR. 

Integration Manager’s native JSP editor offers a convenient way not only to edit and create JSPs but to 
generate JSP-based triggers for Integration Manager services (using Integration Manager’s custom tag 
libraries). This is described further below.
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To create a new JSP Resource from an existing file:

1 Either right-mouse-click on JSP under Resources in Integration Manager’s navigation frame and 
choose the New command from the context menu (as shown below); or go to the File menu and 
select File > New > xObject. From the the Resources tab, select Image and OK.

2 In the dialog that appears, choose the radio button labelled Create from existing external file(s). 
See below.

3 If you know the location of the JSP file that you want to use in this resource, manually enter it in 
the text field under File/URL to Import. Otherwise, use the Browse button (and the file chooser) 
to navigate to the file and select it.

4 Click Finish. A new resource is added to the instance pane and the JSP in question opens in 
Integration Manager’s JSP editor as shown below.
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Creating a JSP-Based Service Trigger
Integration Manager can, if you wish, automatically generate a JSP that contains code for triggering an 
existing service in your project. The following steps tell how.

To create a new JSP Resource containing service-trigger code:

1 Either right-mouse-click on JSP under Resources in Integration Manager’s navigation frame and 
choose the New command from the context menu (as shown in the previous section); or go to the 
File menu and select File > New > xObject. from the Resources tab, select JSP and OK.

2 In the dialog that appears, choose Create JSP to execute a Integration Manager service. When 
you click this option, the dialog will change to have the appearance shown below.

3 Under Name, enter a name for this JSP.
4 (Optional) Under Description, enter any descriptive text that might apply to this resource.
5 Click the Next button. A new wizard panel appears:

6 Check Execute a Integration Manager Service if you want Integration Manager to generate the 
custom-tag code to trigger a particular service. (If you do not check this box, you will simply be 
creating an empty JSP. Click Finish now if your intent is to hand-write a new JSP.) When you 
check the checkbox, the controls below it become enabled.

7 Under Service, select a service from the dropdown menu. The menu will be pre populated with the 
names of services in your project.
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8 Under Service Trigger Type, select one of the available values. 
9 Click Finish. A new JSP containing code that executes your service will appear in the editor pane 

as shown below.

About WSDL Resources
WSDL (Web Services Description Language) is an XML vocabulary for describing web services. Using 
WSDL, it is possible to describe (in a standardized manner) the interface, protocol bindings, and various 
other types of information about web-based services, at a level of detail sufficient for businesses to begin 
to interact online. The complete standard can be seen at http://www.w3.org/TR/wsdl

There are three ways to create or acquire WSDL Resources.

Use Integration Manager’s XML editor to create your WSDL by hand.
Let Integration Manager generate WSDL for you. (Integration Manager can generate a WSDL file 
automatically for any Web Service that you have added to your project.) The procedure for this is 
described below.
Acquire WSDL from a registry (such as a UDDI public registry) by downloading it directly into 
your project. This method will be discussed further below.

To generate a WSDL Resource from an existing service or create one in the XML editor:

1 From Integration Manager’s File menu, select New, then xObject. From the Resource tab, select 
WSDL. 

or
Right-click on the WSDL Resource icon in the Category pane, and choose New. (This will 
associate the WSDL resource with an existing service.)

or
Right-click on the WSDL Resource listed in the Instance pane of the Navigator and choose Create 
WSDL. (This method will also associate the WSDL resource with an existing service.)
Any of these methods will cause the first pane of the WSDL Resource wizard to appear.
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2 As indicated by the radio buttons, you have the choice to Create WSDL from an existing file, or 
describe a new Integration Manager Service.

If you choose to create the WSDL from an existing file, simply browse through your file system 
to locate the WSDL, and click Finish once you have located it.
If you choose to describe a new Integration Manager Service, select that radio button and follow 
the steps below:

3 Enter a Name for the resource. (This will also show up in the name attribute of the /service element 
in your WSDL.)

4 Optionally enter descriptive information.
5 Click Next. A new pane appears.
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6 Check the Associate Web Service checkbox if you intend to create WSDL based on an existing 
Web Service in your project. 
NOTE:  If you wish, instead, to hand-create your own WSDL in the XML editor environment, leave 
the Associate Web Service checkbox unchecked and click Finish. After the dialog goes away, right-
click in Integration Manager’s content pane and select View As Text from the context menu, then 
begin typing.

7 Select a Service from the pulldown menu.
8 Check the Generate SOAP Binding checkbox if you wish to have Integration Manager 

automatically create SOAP Binding information in your WSDL. Choose the binding style that you 
want from the radio buttons labelled Document and RPC.

9 Enter the URI that you want to appear in the location attribute of the WSDL’s 
/service/port/address element.

10 Click Finish. The newly generated WSDL appears as a DOM tree in a content window in 
Integration Manager. Right-click on the DOM and choose View > As Text to see a text view of the 
WSDL document, which you can then edit manually if need be. See below.
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To acquire WSDL from an external service via the Registry browser:

1 Click the Registries tab in Integration Manager’s nav frame.
2 Begin a search (either of Organizations or Services) as described in “Registry Browsing” on page 

-369.
3 Choose a service for which detail information is available in the Service Pane.
4 Acquire the WSDL for that service as described in “Retrieving WSDL from the Registry” on page 

-376. The tree view for the acquired WSDL will appear automatically in the component editor’s 
content pane. (To choose other views, right-click inside the content pane and select View As from 
the context menu.)

5 Choose Save As from Integration Manager’s File menu. Enter a name for the resource and click 
OK.

6 The new WSDL Resource, based on the retrieved WSDL, appears in the Instance pane of 
Integration Manager’s nav frame. (The WSDL is also persisted to disk at this point.)

Obtaining a Stylized View of WSDL
By default, when you first open a WSDL Resource, the document is displayed in a syntax-colored text-
edit view. But you can also see a stylized view of WSDL documents, created by applying an XSL 
stylesheet to your document.

To see a stylized view of a WSDL document:

1 Open a WSDL Resource.
2 Right-click in the WSDL editor pane and choose View > As Stylized from the context menu. After 

a short delay, tview changes to a stylized view.

In this case, the Summary stylesheet has been applied to the document. You can apply a custom 
stylesheet instead, if you prefer; see procedure below.

To choose a custom stylesheet for the stylized view:

1 With the WSDL document already visible in Stylized form, right-mouse-click inside the pane. A 
contextual menu appears. Click Select Stylesheet.
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The following dialog will appear:

2 Choose the System radio button if you wish to select one of the existing standard stylesheets 
(Details or Summary) as the basis for the stylized view.

Details provides a detail-oriented plain-text view of the WSDL document (with no XML tags).
Summary provides a more concise view of WSDL contents.

3 Otherwise, choose the Custom radio button and enter the path to the stylesheet of your choice (or 
use the Browse button to bring up a standard file navigation dialog). If your path is in the form of a 
URL, you must explicitly type “http://,” “https://,” or “ftp://.”

4 Check the Set as default checkbox if you want to apply the stylesheet you’ve chosen as the default 
in Stylized views. Your preference is now set across Integration Manager sessions.

Adding Elements to a WSDL Document
Although Integration Manager can automatically generate WSDL for you, there are times when you may 
want or need to edit (or create) WSDL elements by hand. Integration Manager’s WSDL Editor (a WSDL-
aware version of the Integration Manager XML editor) allows normal text insertion and cut-and-paste 
editing, the same as any text editor. But you can also make use of special context features that are 
designed to let you create standard WSDL document elements quickly and easily.

WSDL documents contain (either directly, or by importation) a minimum of four standard element types: 
message, portType, binding, and service. These elements build upon one another with cascading cross-
references, so it is advisable that when you create a WSDL file without the use of the dialogs, you create 
the message section first, followed by the portType section, then the binding section and finally the 
service section. The WSDL Editor offers dialog-based assistance in creating each of these four types.

Adding a Message Element

In WSDL, the Message is an abstract, typed definition of the data being exchanged. At runtime, the actual 
message is represented as a DOM.

To create a new Message element:

1 Open a WSDL Resource if one is not already open.
2 Be sure the WSDL document is in Text View mode. (Right-click anywhere in the document and 

choose View > As Text.) 
3 Click the right mouse button inside the Text View pane. A context menu appears.
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4 Select Insert WSDL Element > Message . . . to bring up the Insert New Message dialog.

5 Click on the Add button to add a blank row in the parts table.
6 In the Name text field, enter the value of the name attribute for the main <message> element.
7 In the Documentation field, enter any human-readable comment or descriptive language you 

would like to associate with the definition element.(Optional.)
8 Under Parts, in the Name column, enter the name attribute for the first <part> element of your 

message section.
9 Select a Typing value from the pulldown menu (Element or Type).
10 Under Value, enter the element value for this part. 
11 Click the Add button to add another part entry to this message.
12 To remove an entry, first click into the entry to highlight the row in question, then click the Remove 

button to remove that entry.
13 Click OK. The dialog box closes and a new section is added to your document:

<message name="GetLastTradePriceOutput">
<part name="body" element="xsd1:TradePriceResult"/>

</message>
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Adding a Port Type Element

The WSDL Port Type is an abstract definition of the operations supported by a service and the 
communications mode (one-way, request-response, etc.) that will be used in the service.

To add a new Port Type to a WSDL document:

1 Place the mouse inside the Text View pane of the editor and click the right mouse button. A 
contextual menu appears.

2 Select Insert > Port Type . . . to bring up the Insert New Port Type dialog.

3 Click on the Add button to add a blank row in the parts table.
4 In the Name field, enter the value of the name attribute for the <portType> element you are creating.
5 In the Documentation field, enter any human-readable comment or descriptive language you 

would like to associate with the definition element.(Optional.)
6 Under Operations, enter a Name for this operation.
7 In the Type column, select One-Way, Request-Response, Solicit-Response, or Notification, as 

appropriate, from the pulldown menu.
8 Under Formats, enter an input and output message or build the appropriate messages using the Edit 

Operation dialog. To open the Edit Operation dialog, click the Set. . . button at the end of the row. A 
new dialog appears.
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9 The Edit Operation dialog has several control groupings. Only those that are appropriate to the 
Operation in question (Request-Response, Solicit-Response, etc.) are enabled. For example, if you 
chose Notification in the Type column in Step 6 above, only the Output control group is enabled. 
For each enabled group, a Name and Message appropriate to the operation is required for Input 
and Output. However, Fault group is not required but optional.

10 Click OK to close the Edit Operation dialog.
11 Click Add to add more operations to the current Port Type section.
12 To remove operations, select the operation you want to remove, then click the Delete button.
13 Click OK to close the Insert New Port Type dialog. A new section is added to your WSDL 

document:
<portType name="StockQuotePortType">

<operation name="GetTradePrice">
<input name="input" message="tns:GetLastTradePriceInput"/>
<output name="output" message="tns:GetLastTradePriceOutput"/>

</operation>
</portType>

Adding a Binding Element

The Binding specifies concrete protocol and data format specifications for the operations and messages 
defined by a particular Port Type.

To add a new Binding to a WSDL document:

1 Place the mouse inside the Text View pane of the editor and click the right mouse button. A 
contextual menu appears.

2 Select Insert > Binding . . . to bring up the Insert New Binding dialog.
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3 In the Name field, enter the value of the name attribute for the <binding> element you are creating.
4 In the Documentation field, enter any human-readable comment or descriptive language you 

would like to associate with the definition element.(Optional.)
5 Select the proper Port Type for this binding, using the pulldown menu next to Port Type. The 

pulldown menu contains the names of Port Types that you have previously created (if any) for this 
document; see “Adding a Port Type Element” above.

6 If your WSDL document will specify a SOAP binding, check the SOAP Binding checkbox, then 
select a Style (RPC or Document) from the pulldown menu and enter a Transport value (or accept 
the default).

7 If an HTTP Binding will be used, check the HTTP Binding checkbox and enter the appropriate 
Verb (GET or POST).

8 Click OK to dismiss the dialog. A new Binding section is added to your WSDL document:
<binding name="StockQuoteSoapBinding" type="tns:StockQuotePortType">

<soap:binding style="rpc" transport="http://schemas.xmlsoap.org/soap/http"/>
<operation name="GetLastTradePrice">

<soap:operation soapAction="http://example.com/GetLastTradePrice"/>
<input>

<soap:body use="literal" namespace="http://example.com/stockquote.xsd
encodingStyle="http://schemas.xmlsoap.org/soap/encoding/"/>

</input>
<output>

<soap:body use="literal" namespace="http://example.com/stockquote.xsd"
encodingStyle="http://schemas.xmlsoap.org/soap/encoding/"/>

</output>
</operation>

</binding>

Adding a Service Element

The Service element names the entry-point address (or addresses) for the service in question. These 
addresses are in the form of URIs and constitute ports.
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To add a new Service to a WSDL document:

1 Place the mouse inside the Text View pane of the editor and click the right mouse button. A 
contextual menu appears.

2 Select Insert > Service . . . to bring up the Insert New Service dialog.
3 Click on the Add button to add a blank row in the service table.

4 In the Name field, enter the value of the name attribute for the <service> element you are creating.
5 In the Documentation field, enter any human-readable comment or descriptive language you 

would like to associate with this service element. (Optional.)
6 In the Ports section, under Name, enter the name of this <port> element. 
7 In the Binding column, select an existing binding from the pulldown menu. The available bindings 

will reflect Binding sections that have already been created for this document (if any).
8 In the Address Type column, specify None, SOAP, or HTTP, as appropriate, using the pulldown 

menu.
9 Under Location, enter the URI via which your service will be available.
10 Click Add to add more rows (more port entries) to the Service.
11 To remove an entry, select the entry, then click the Delete button.
12 Click OK to close the dialog. A new Service entry is added to your WSDL document:

<service name="StockQuoteService"> 
<port name="StockQuotePort" binding="tns:StockQuoteBinding"> 

<soap:address location="http://example.com/stockquote"/> 
</port> 

</service> 

Type-Ahead (Code Completion) in the WSDL Editor
The WSDL editor incorporates a “smart type-ahead” feature that comes into play whenever you type a 
less-than sign (for example, the start of an element tag). A contextual menu will pop up automatically, 
displaying available tag-name choices based on the schema specified for the file and where you are in the 
document. 

For example, if you are creating a WSDL document manually and you are near the top of the document, 
typing ‘<‘ will cause a menu to appear near the cursor location, with the following choices:
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Notice that the element names in this menu correspond to legal tag names in WSDL. To choose a menu 
item, just doubleclick it.

The menu choices are highly context-sensitive in that if you are deep in some portion of an element tree 
and you type a less-than symbol, the choices that appear in the type-ahead menu are constrained to just 
the values that would be legal in the XPath context in which you are typing. For example, if you are inside 
a <documentation> node anywhere in a WSDL file and you type ‘<‘, the type-ahead menu will appear with 
only one choice, namely </documentation>, because the only legal tag you could create at this point would 
be a closing tag. (The WSDL schema does not permit child elements inside documentation elements.) 

You can, of course, always ignore the type-ahead menu altogether and enter whatever you want, as the 
occasion requires. For example, you might want to enter a comment.

NOTE:  Type-ahead hints are based on the schema that applies to the document. Obviously, if the 
document does not specify namespaces or schemas, there is no way for the editor to “know” what the valid 
tag choices are, and you’ll get no type-ahead menu.

Validating a WSDL document
When a WSDL document is open and its contents are visible in the editor, you can validate it by changing 
the View to “As Text” and clicking the small green check-mark icon in the top left corner of the WSDL 
document window. If the document validates successfully, you will see a dialog:

Otherwise, you will see an error alert giving information identifying the malformed statement(s) in the 
document.

NOTE:  You should carefully review your WSDL even if the document validation is successful. The W3C 
WSDL specification does allow for extensibility elements throughout all levels of a WSDL document. So if 
you built the document without using the dialogs, or did an extensive amount of cut and paste from other 
sources, it’s possible the document will test as valid, but not necessarily be what you want.
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About WSIL Resources
WSIL (Web Services Inspection Language) is a specification for the discovery and publishing of Web 
services. It was designed to be more lightweight and portable than the previous standard, UDDI 
(Universal Description, Discovery and Integration), and in a sense, to pick up where UDDI leaves off. 
Although WSIL has yet to be submitted to one of the standards bodies (W3C and OASIS) it is gaining in 
popularity. To read the WSIL specification, see http://www-
106.ibm.com/developerworks/webservices/library/ws-wsilspec.html.  

Like WSDL, WSIL is an XML vocabulary.  Its focus, however, is on exposing services rather than 
describing them. It is meant to facilitate discoverability of Web Services.

There are two ways to generate WSIL Resources. One way is to acquire WSIL from an external, existing 
file. A second way is to create a WSIL document using Integration Manager’s WSIL wizard and XML 
editor. The wizard will generate a stub file containing empty <service> and <description> elements which 
you can then fill in.

To generate a WSIL Resource from an existing file:

1 From Integration Manager’s File menu, select New, then xObject. From the Resource tab, select 
WSIL. 

or
Right-click on the WSIL Resource icon in the Category pane, and choose New. 
Either of these methods will cause the first pane of the WSIL Resource wizard to appear.

2 If you choose to create your WSIL from existing external files, type in the fully qualified URL or 
click on Browse to locate a file on your local hard drive or network.

3 Click Finish to open the WSIL file in the XML Content editor (see below).

To generate a WSIL Resource manually:

1 From Integration Manager’s File menu, select New, then xObject. From the Resource tab, select 
WSIL. 

or
Right-click on the WSIL Resource icon in the Category pane, and choose New. 

2 Select Create Using Integration Manager Editor. 
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3 Enter a Name for the resource. 
4 Optionally enter descriptive information.
5 Click Finish. Begin entering your WSIL in the Content Editor Screen.

The XML Content Editor Pane, with an open WSIL resource, is depicted below:

As with a WSDL document, if you right-click on the content editor and choose View > As Text, you will 
see a text view of the WSIL document, which you can then edit manually, including the node names. 
Similarly, you can select View>As Stylized for a Stylized view of the WSIL. Type-ahead code-
completion and text validation (described above) also apply to editing WSIL documents.
252   Integration Manager User’s Guide



About XML Resources 
Integration Manager allows you to specify individual XML files as first-class resources (xObjects). 
When you specify a file as an XML resource, a copy of the file is made in a folder called \xml_resource 
under your project hierarchy. This file then gets included in the deployment JAR (in that context) so that, 
for example, your Java Server Pages can refer to the file with a relative URL in an href attribute. More 
commonly, you’ll access XML resource documents in a component’s action model by using the 
Integration Manager Resource action (see previous chapter, and further discussion below) to bring the 
document into an Input or Temp message part (DOM). 

How Do XML Templates and XML Resources Differ?
XML Resources are different from XML Template documents. An XML Template is merely a design-
time aid (a hint, if you will) that allows you to work with a “scratch copy” of a particular type of 
document (which, in turn, may or may not be based on a schema) at design time. Instance data in the 
template doc is visible at design time but not at runtime. At runtime, the template document is never used 
as a data source. 

An XML Resource, by contrast, is a physical document that can be used as a static data store for instance 
data of various kinds. Data might consist of legal notices (for example, copyrights, disclaimers, 
warranties); names and addresses of key people who may need to be notified during the execution of a 
component; lookup-table data with hierarchical structure (or data that’s too complex to use in a Code 
Table resource, but too straightforward to warrant the connectivity overhead of RDBMS storage); or 
common data needed by more than one service in the project.

If the dataset in question is of reasonable size, you may be able to realize significant performance benefits 
by using an XML Resource instead of a relational database for data lookups.

Think of an XML Resource is as a lightweight structured data store—a low-overhead container for 
hierarchically organized static (read-only) data. 

To create an XMLResource:

1 Either right-mouse-click on the XML category under Resources in Integration Manager’s 
navigation frame, then choose the New command from the context menu (as shown below); or go 
to the File menu and select File > New > xObject, then the Resources tab, then XML and OK.

2 In the dialog that appears (see below), choose one of the two available radio buttons as described 
below. 
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Choose the Create from existing external file(s) radio button if you wish to use a preexisting 
XML file. (A copy of the file will be brought into your project.) Then specify the file’s URI in 
the text field provided, explicitly typing “http://,” “https://,” or “ftp://,” or use the Browse button 
to navigate to the file of interest.
Alternatively, choose the Create using Integration Manager Editor radio button if you want 
to create the XML file yourself, by hand. If you select this radio button, the dialog changes 
appearance:

At this point, you can enter a Name (and optionally, descriptive information) for the resource.
3 Click Finish to exit the dialog. A new XML Resource appears in the instance pane of Integration 

Manager’s nav frame, and the file itself opens in tree view in the editor pane.

How to Import an XML Resource
Unlike non-XML resource types (such as Image, JSP, and JAR), XML Resources are not indirected 
through xObject metadata stored in a separate file. Therefore, when you import an XML Resource, you 
are not restricted to importing xObjects from other Integration Manager projects. Instead, you are 
actually importing an XML file directly (into a folder called \xml_resource under your project-folder 
hierarchy). That is to say, the resource and the underlying data file are one and the same. So although the 
steps below are slightly different from those in the previous section, they essentially give the same result.
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To Import an XML Resource:

1 Right-click on XML under Resources (as described above) and choose the Import menu 
command.

2 The Import dialog appears. (See the discussion, and screen shot, at “To Import an Image resource 
from another project:” earlier in this chapter.) Enter the file name or URI of the XML file you want 
to import, or use the Browse button to navigate to an XML file. 

3 Click Finish. The newly imported XML file will be added to the instance pane of the navigation 
frame, but the file itself will not automatically open in the editor pane. (If you wish to open it for 
editing, you can either doubleclick the file name in the XML resource instance pane, or right-
mouse-click on it and choose Open from the context menu.)

How to Access an XML Resource in a Component 
To load an XML Resource into a Part (DOM) at runtime, use the Integration Manager Resource action 
type. The document and its data will be accessible via XPath or ECMAScript like any other document. 
You can map its nodes to other Parts, selectively pull data from certain elements, or even map the entire 
document to Output. Of course, you should bear in mind that an XML Resource document is a static 
resource (that is, read-only). If you try to modify it or write to it using XPath or ECMAScript, it may 
appear as though you are changing the document—and you are—but the changes will last only for the life 
of the component instance in which changes are made. In other words, changes are volatile and do not get 
saved or carried over to future invocations of the component/service.

To load an XML Resource document into a Part:

1 In the action model, right-mouse-click at the point where you want to load the XML resource. In 
the context menu that appears, select New Action > Data Exchange > Integration Manager 
Resource. See below.

2 In the dialog that appears, under Resource Type, use the pulldown menu to select XML. (See 
below.)
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3 Under Resource Name, select the (preexisting) XML Resource that you wish to bring into your 
component. (The pulldown menu will be pre populated with the names of all XML Resources that 
exist in the current project.)

4 Under Target, select either the XPath or the Expression radio button. Assign a target location for 
the XML Resource DOM.
NOTE:  You can assign the contents of the XML resource doc to any node of any existing DOM. If 
you want to assign it to a Temp Part, you will need to create the Temp Part in advance, or else go to 
File > Properties > Messages to add a Temp Part to the currently open component.

5 (Optional) Click Apply if you want to test the action now. You should see the XML resource 
appear in the expected location, in the specified target DOM.

6 Click OK to dismiss the dialog. A new Integration Manager Resource action is added to your action 
model, and from this point on in that model, you can map to or (more likely) from the nodes of the 
XML resource doc.

About XSD Resources
XML Schema Definition (XSD) files are specified in their own resource type so that they can be reused 
by various components, services, and Integration Manager projects, and also so they can be edited or 
modified over time without having to be re-imported one at a time into every project or component that 
uses them.

There are two ways to create an XSD Resource for use in your project. 

Generate XSD directly from a sample document using Integration Manager’s schema generator, or
Designate a preexisting XSD document as an XSD Resource using the Create XSD Resource 
wizard

We will discuss each option in turn.

Using Integration Manager’s Schema Generator
You can tell Integration Manager to generate a schema (XSD Resource and corresponding .xsd file) from 
any existing XML sample document. The procedure is as follows.

To generate a Schema (XSD) Resource from an existing XML document:

1 Add the XML document to an existing XML Template, or create a new XML Template based on 
the XML sample document.

2 Open the XML Template containing your sample document. (Right-click on the template instance’s 
name in Integration Manager’s explorer frame, and choose Open... from the context menu.)

3 Be sure the sample document is showing in Tree View in the document window. (If you were 
looking at it in Text View, right-click on the editor pane and choose View > As Tree from the 
context menu.)

4 Right-click inside the document, in Tree View, to bring up a context menu.
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5 Select Create Schema... from the menu. A dialog appears:

6 Enter a Name for the new Schema Resource.
7 Click OK. Note that a new resource appears in the instance pane under the XSD Resource category.

NOTE:  You may need to edit your original sample document to use the namespace prefixes shown in the 
generated schema before the sample will validate against the schema. 

Using the XSD Resource Wizard
If you wish to use an existing .xsd file as the basis of an XSD Resource, you can do so by following this 
procedure.
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To add a Schema (XSD) Resource based on an existing .xsd file, using the resource wizard:

1 From Integration Manager’s File menu, select New, then xObject, then from the Resource tab, 
select XML Schema. (Alternatively, right-click on the XML Schema Resource icon in the 
Category pane, and choose New.) The first pane of the XML Schema Resource wizard appears.

2 If you wish to create the Schema using an external file, check the Create from existing external 
file(s) button and type in a file or URL to import. You can also Browse to navigate your file system 
to select a file on your disk or network.

3 If you wish to create the Schema using the Integration Manager Editor, check the Create Using 
Integration Manager Editor button. 

Type a Name for the resource.
Optionally enter descriptive information about the resource.

4 Click Finish. If you chose to import an existing file, the file will be opened in the Integration 
Manager Component Editor. If you chose to create a schema definition file manually, you will be 
able to create your schema in the content window of Integration Manager.

5 In either case, an XML Schema Resource is added to the Instance Pane.
6 Optionally right-click in the content pane and choose View As > Text to go to the XML editor. 

About XSL Resources
The XSL Resource offers a convenient way to package XSL stylesheets into your project’s deployment 
JAR. You can refer to them via relative URLs from other documents, or you can load an XSL Resource 
into a DOM, dynamically, using the technique described at “How to Access an XML Resource in a 
Component” further above.
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How to Create an XSL Resource

To create an XSL Resource:

1 Either right-mouse-click on the XSL category under Resources in Integration Manager’s 
navigation frame, then choose the New command from the context menu (as shown below); or go 
to the File menu and select File > New > xObject, then the Resources tab, then XSL and OK.

2 In the dialog that appears (see below), choose one of the two radio buttons as described below. 

Choose the Create from existing external file(s) radio button if you wish to use a preexisting 
XSL file. (A copy of the file will be brought into your project.) Then specify the file’s URI in 
the text field provided, or use the Browse button to navigate to the file of interest.
Alternatively, choose the Create using Integration Manager Editor radio button if you want 
to create the XSL file yourself, by hand. If you select this radio button, the dialog changes 
appearance:

At this point, you can enter a Name (and optionally, descriptive information) for the resource.
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3 Click Finish to exit the dialog. A new XSL Resource appears in the instance pane of Integration 
Manager’s nav frame, and the file itself opens in text view in the editor pane. 

How to Import an XSL Resource
Unlike non-XML resource types (such as Image, JSP, and JAR), XSL Resources are not indirected 
through xObject metadata stored in a separate file. Therefore, when you import an XSL Resource, you 
are not restricted to importing xObjects from other Integration Manager projects. Instead, you are 
actually importing an XSL file directly (into a folder called \xsl under your project-folder hierarchy). 
That is to say, the resource and the underlying data file are one and the same. So although the steps below 
are slightly different from those in the previous section, they essentially give the same result.

To Import an XSL Resource:

1 Right-click on XSL under Resources (as described above) and choose the Import menu command.
2 The Import dialog appears. (See the discussion, and screen shot, at “To Import an Image resource 

from another project:” earlier in this chapter.) Enter the file name or URI of the XSL file you want 
to import, or use the Browse button to navigate to an XSL file. 

3 Click Finish. The newly imported XSL file will be added to the instance pane of the navigation 
frame, but the file itself will not automatically open in the editor pane. (If you wish to open it for 
editing, you can either doubleclick the file name in the XSL resource instance pane, or right-
mouse-click on it and choose Open from the context menu.)
260   Integration Manager User’s Guide



10 Form Designer

This chapter introduces the Novell Integration Manager Form Designer and describes how to use it to 
create and modify XForms 1.0-compliant Web forms. It includes these sections: 

About XForms
About the Form Designer
Defining the presentation 
Working with model elements
Working with events and actions
Testing forms

About XForms
XForms provide a robust, standards-based way to define Web forms. The advantages of the XForms 
standard include:

Separate data, logic, and presentation modules
A powerful event model (so that you don’t have to use a lot of scripting for client-side validation or 
calculations)
A way to process XML data

XForms cannot run as standalone applications. They are designed to run as components within a host 
language like XHTML.

About the Form Designer
The Form Designer provides a graphical environment for developing XForms 1.0-compliant Web forms. 

The Form Designer is divided into these tabs:  

Tab Description

Form Lets you define the form’s user interface. You can 
graphically:

Lay out and style form controls

Bind form controls to data

Define events and actions for form controls

For more information, see “Defining the presentation” on 
page 262.
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Defining the presentation
The Form tab provides the tools to define the user interface. This section describes how to use the Form 
tab. It includes these topics:

About the Form tab
About form controls
Shortcut keys
About form controls
Manipulating controls
Applying styles to controls
Using the CSS Editor
Working with model elements

About the Form tab
The Form tab provides a graphical way to create and manipulate the form controls that make up the user 
interface. The Form tab looks like this:

Model Lets you define the form’s model elements. You can:

Create and edit models

Create and edit instance data

Set up data constraints

For more information, see “Working with model elements” on 
page 278.

Source Launches a powerful XML source editor.

XForms Preview Lets you run a form in test mode. 

For more information, see “Testing forms” on page 300.

Tab Description
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The Form tab provides: 

Form tab limitations

Only the form controls in layout regions on the page are editable. You cannot use the Visual Editor to edit 
the XHTML on the page. The XHTML tags are not expanded to display their content—only the tags are 
displayed. You cannot insert a form control into an XHTML tag.

Shortcut keys
You can use the following shortcut keys in the Visual Editor: 

Tool Description

Visual Editor Use the Visual Editor to graphically create and manipulate the controls. The 
editor includes a tabbed toolbar that includes: 

XForms toolbar—the set of controls and blocks that you can drop on your 
form.

Align/Distribute toolbar—allows you to change the way selected controls 
are aligned (left/right) or distributed (vertically/horizontally).

Instance Data Pane Use the Instance Data Pane to bind instance nodes to form controls. 

You cannot use the Instance Data Pane (in the Form tab) to modify the 
structure of the instance data. Use the Instance Data Pane in the Model tab 
for those types of functions. 

Property Inspector Use the Property Inspector to manipulate the CSS and data binding 
properties on the currently selected control. 

For more information on using the Property Inspector, see “Setting form 
control properties” on page 273.

Event Editor Use the Event Editor to define the events and actions for controls on the 
form. 

For more information, see “Working with model elements” on page 278.

Keystroke Description

Ctrl-X Cut

Ctrl-C Copy

Ctrl-V Paste

Delete Delete

Arrow keys (left, right, up, down) Moves the selected object 5 pixels in the corresponding 
direction

Ctrl-arrow key (for example, Ctrl-right 
arrow)

Moves the selected objects 1 pixel in the corresponding 
direction

Shift-arrow key (for example, Shift-right 
arrow)

Stretches the selected object 5 pixels in the corresponding 
direction

Ctrl-Shift-arrow key (for example, Ctrl-
Shift-right arrow)

Stretches the selected objects 1 pixel in the corresponding 
direction
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About form controls
The Form Designer supports all of the XForms controls outlined in the XForms 1.0 specification and 
several other controls used by the Form Designer to control formatting. The controls include:  

Icon Control Description

XForms trigger 
control

A standard XForms trigger control. For example, a button on a form.

Allows user-triggered actions.

XForms trigger 
styled as a link

A standard XForms trigger control preconfigured to emulate a link. CSS 
rules are applied to make the trigger look like a link not a button. 

This means that:

The trigger contains an <xforms:action> event handler that listens for 
the DOMActivate event (button press).

The action element contains an <xforms:load> element that loads a 
new page via an HTTP GET operation. Use the control’s property sheet 
to specify the URL to use for the GET.

See also Emulate link, Style as link, Request type, Target URL, 
Submission in the section on “Setting form control properties” on 
page 273.

XForms output Displays read-only data to the user. 

This control supports the format property which allows you to specify 
formatting for certain data types. You apply the formatting in the Property 
Inspector .

XForms text 
area

Allows users to enter freeform, multiline content.

XForms 
upload control

Allows users to upload a file from the local file system.

IMPORTANT:  The instance node to which the upload control is bound 
must be defined as a schema type of base64Binary or you will encounter 
inconsistent behavior at runtime. For example:

<lastname xsi:type=”xsd:base64Binary”/>

XForms input Allows users to enter single-line freeform data.

This control supports the format property which allows you to specify 
formatting for certain data types. You apply the formatting in the Property 
Inspector .

For more information, see “Format” on page 274.

XForms range Allows users to select from a sequential range of values.

XForms secret Allows users to enter single-line freeform data. The characters are 
disguised during data entry. Useful for things like passwords.

XForms Select 
One

Allows users to select a single item from a set of choices.

XForms Select 
Many

Allows users to make more than one selection from a set of choices.

XForms submit 
button

A special form of trigger that allows users to submit the contents of the 
form.

XHTML image Displays an XHTML image loaded from the project’s resource set. Visible 
in the Form tab, and View form in browser modes.
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For more information on the properties that you can specify for the controls, see “Setting form control 
properties” on page 273.

Manipulating controls
After you generate an initial form, you can refine it by adding or moving controls. You can use the Form 
tab for: 

Adding and removing controls
Moving controls
Sizing controls
Aligning controls
Grouping and ungrouping controls
Binding controls to data

HTML content 
box

Read-only display of static HTML content. 

Absolute 
positioning 
region

Used for managing layout.

XForms repeat Use to display collections of homogeneous data. 

To manage the repeated elements, add a repeat block to the form, then 
add the controls representing a single instance of the repeated data within 
the repeat block. 

At runtime the processor renders the repeat block once for each data 
element that the repeat control is bound to. Each instance of the repeated 
data is processed as a block. Each block is placed below the preceding 
block. All of the remaining, nonrepetitive content is placed below that. 

You cannot directly position nonrepeated objects :

Below the repeated elements within the repeat block

To the right of the repeated elements within the repeat block

XForms switch Use to perform conditional processing of controls on the form. 

The switch element allows any number of case elements as children. Each 
case represents a subform, exactly one of which is rendered at any time by 
the runtime processor. The case rendered is determined by an action in an 
event handler not based on the result of a calculation. 

The Form Designer represents switch elements as a layout region for each 
case element. 

You cannot specify the order of the case statements within a switch 
block—but that is not necessary, since only one will be displayed at a time. 
The event handler determines how cases are displayed in response to the 
events that you specify.

Pageflow link 
region

At runtime this control is replaced with one or more submit buttons.

Icon Control Description
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Adding and removing controls

Adding controls

To add unbound controls from XForms toolbar:

1 Click on the control type in the toolbar.
2 Click within the layout area to place the upper-left corner of the control on the form.

To add unbound controls from the Form Designer menu:

1 Select Form Designer>Insert.
2 Select the control from the popup menu.
3 Click within the layout area to place the upper-left corner of the control on the form.

Removing controls 

You cannot remove a control without also removing its label.

To remove a control:

1 Click the control.
2 Press the Delete key.

OR
3 Select Edit>Cut.

Moving controls

To move a control:

1 Click the control. 
2 Drag it (or use the arrow keys to move it) to the new location.

To move more than one control:

1 Select the controls to move by:
Click one control, then press the Ctrl key and click any other control(s).
OR
Click and drag a box around the controls you wish to select—any controls within the box are 
selected.

2 Drag the set of controls to the new location.

Sizing controls

By default, a control’s width and height are unspecified so that they can automatically adjust to their 
content. You can specify an exact width and height in the two ways described below

NOTE:  When you define the width and height, the contents of the control wrap to to accommodate the 
specified size. The runtime results are not guaranteed. 

To size a form control graphically:

1 Click the control so that the handles are visible. 
2 Size the control by:

Selecting a handle and dragging it to the desired sized. 
OR
266   Integration Manager User’s Guide



Selecting a handle and using the arrow keys (Shift-arrow key).

To size a form control using the Property Inspector:

1 Select the control.
2 Open the Property Inspector and specify the width and height for the control.

Aligning controls

You can align controls within a layout, repeat, or switch block. 

To align controls:

1 Select the control to use as a reference, plus the additional controls that you want to align with it.
2 Choose the alignment you want (from the Align toolbar) to apply to the selected objects.

OR
3 Choose Form Designer>Align Distribute selected objects.

Grouping and ungrouping controls

You may want to create groups of controls, because a group can:

Provide a hint to the client side XForms renderer, so that related controls can appear together on 
limited capability devices, such as cell phones and PDAs.
Simplify the XPath expressions within a group by establishing a context for the controls in the 
group.
Provide a container for the controls to which you can apply CSS styles within the group via 
inheritance.

Rules for grouping controls
A control can belong to more than one group.
Groups must be strictly nested—that is, the entirety of a group must be contained by a higher-level 
container such as group, repeat, or switch/case blocks. 
The entirety of a control (not just the label, for example) belongs to a group. 
Be careful when using groups. Grouping a set of controls in the Form Designer does not lock the 
controls together spatially. You cannot ungroup and regroup a set of controls without losing 
information (such as the instance data context, or style information attached to the group element).

Most of these rules are required because of the hierarchical nature of XML. 

To create a group:

1 Select the controls you want to group.
2 Select Add to Group from the Form Designer menu or by right-clicking and selecting it from the 

popup menu.
3 Choose New Group.
4 Enter a name for the group.

The Form Designer creates the new group, and it becomes the current selection. The Property 
Inspector displays properties for the selected group. When the group is selected, it can be dragged 
around the page to reposition the controls within the group.

What happens when you group controls

When you create a group:

The XML is reorganized to create a new group element whose parent is the parent of the control 
that is the primary selection.
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The selected controls become children of the new group element.  
The nodeset binding for the group node is set to the instance data node that is the “lowest” ancestor 
to the instance data nodes bound to the selected controls
The XPath bindings for the controls in the new group are adjusted to become relative to that node. 
Binding specifications using the bind attribute are not adjusted.

To add a control to a group:

1 Select the control to add.
2 Select Form Designer>Group>Add to Group (or right-click to display a popup menu).
3 Select the name of the group to add the control to.

The selection does not change to the entire group, in case there are additional commands to be 
performed on the selected control. The XML element for the control is moved under the group 
element representing the group, and the instance data binding XPath is adjusted to be relative to the 
node bound to the group element.

To remove controls from a group:

1 Select the controls to remove.
2 Right-click and select Remove from group (or select it from the Form Designer menu). 
3 Choose the group from which the element should be removed.

The XML elements representing the controls are detached from the group element and made 
siblings of it; the instance data XPath expressions are adjusted to absolute expressions.  If no 
controls remain in the group, the group element is removed from the document. 

To remove a group:

To remove a group (but not its associated controls) from a form, you can:
Select Form Designer>Group>Remove Group.

What happens when you remove a group

When you remove a group:

The XML elements representing the controls in the group are detached from the group element and 
made siblings of it.
The group node is deleted.
The instance data XPath expressions for the controls are adjusted to absolute expressions.

Applying styles to controls
The Form Designer provides default styles (based on standard portlet CSS class definitions) to 
implement color, sizing, and fonts used in the form’s presentation. The default class attributes for the 
styles are defined in wsrp-classification.xml (located in the \Common\Resources\CSSClassifications 
directory). At runtime, the various portal theme files define the styles associated with these class 
attributes, and with some internal Novell class attributes.

Changing CSS Classifications

Integration Manager generates class attributes for each of the controls on a form. For example, an input 
field on a form could be given a name like:

class=”nvP1_wsrp_rewrite_ portlet-form-input-field”

The nvp1 class value references a unique selector in the internal style node that specifies the 
absolute positioning rules for this element.
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The wsrp_rewrite is a token that is replaced at runtime to ensure unique names for all of the 
controls on a page in a multiportlet page. 
The portlet-form-input-field is the class name that references a formatting rule in an external style 
sheet (normally a portal theme file).

These classes are defined in WSRP-classification.xml in the Common\Resources\CSSClassifications 
directory. This file maps the class names to particular control types. 

To apply CSS Classifications to a file that was not generated with these values:

1 Open the form in the Form tab.
2 Choose Form Designer>Set CSS Classification. 

The Apply CSS classifications dialog displays:

3 Complete the panel as follows: 

4 Click OK.

Field Description

Select the 
set(s) of 
classifications 
to be applied 
to this 
document

You must select WSRP.

NOTE:  Further sets of classifications may be made available in the future.

Apply new 
class values to 
existing 
controls

Check this box to have the new class values added to existing controls, as well 
as to new controls that get created later.

Remove old 
class values 
from existing 
controls

Check this box to strip all of the classification-defined class values from the 
controls on the form. 

For example, a control with the attributes:
class=”nvP1_wsrp_rewrite_ portlet-form-input-field”

will become: 
class=”nvP1_wsrp_rewrite_ “ 

If you check this box, you will lose any formatting associated with the class 
values that were removed.
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Using the CSS Style Manager

You can use the CSS Style Manager to edit any internal or external CSS style sheets associated with your 
form from within the Form Designer. You can use it to specify CSS properties like background color, text 
color, and font size associated with specific controls and labels. (The Form Designer directly handles 
control and label positioning; you cannot use the CSS Style Manager for this function.) 

To open the CSS Style Manager:

1 With a form open, choose Form Designer>Style Manager.

NOTE:  Pressing cancel on this main dialog does not cancel completed actions. 

You’ll use the CSS Editor to create, edit, and delete style rules for both internal and external style sheets.

Using the CSS Editor

The CSS Editor provides two views for working with a CSS file:

The CSS View tab enables you to develop and examine your style sheet in a graphical way. You 
can:

Manipulate the list of rules for the style sheet
Specify the selectors for any rule
Set the properties for any rule

The Source View tab displays a source editor that you can use to examine and edit your CSS code 
directly. The Source View offers the same standard text editing features that are available in the 
XML Editor’s Source View.
270   Integration Manager User’s Guide



Working with layout regions
To allow you more precise control of the layout of the controls on a form, the Form Designer requires you 
to place form controls within a layout region. A layout region is a container for the XForms controls 
within an XHTML page. Like other form controls, you can add, remove, size, and set properties on layout 
regions. The following controls can act as layout regions:  

Absolute positioning region
XForms repeat control
XForms switch/case control
Pageflow link region

Layout regions are identified with a gutter in the far left of the Visual Editor. :

Click the gutter to select the control for setting layout region properties, resizing, or deleting.

To add a layout region to a form:

1 Choose the layout control to add from the XForms toolbar.
2 Position the cursor to the location where you want to add the control. 

The cursor displays as a pink arrow.

3 Click to place the layout region.
The layout region is added to the form.
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To remove a layout region:

1 Select the layout region (it is selected when the gutter label is highlighted).
2 Right-click and choose Delete.

To resize a layout region:

1 Select the layout region to resize. 
2 Grab the handles of the layout region and drag the box to the required size.

To create nested repeat blocks:

Click the Insert XForms Repeat icon in the XForms toolbar.
Click in the white space of an existing repeat block in the Visual Editor (click away from the 
block’s boundary—clicking on or near the lower boundary of the repeat block adds the new repeat 
after, not within, the existing block).
The Form Designer adds an empty repeat group to the form. It looks like this:

To create a switch block:

1 Click the Insert XForms Switch icon in the XForms toolbar.
2 Move the pointer to the white space at the bottom of the bottommost block.

The Add New Cases to Switch dialog displays. 
3 Enter two or more case IDs separated by spaces.

You’ll use the case IDs to program the behavior in the Event Editor. 
4 Click OK.

The The Form Designer adds a switch block with a case block for each case id you entered. 
5 Add controls to the case layout regions, as described in “Adding and removing controls” on 

page 266. 

TIP:  You can add or remove cases by selecting the switch box, right-clicking and choosing the action 
from the popup menu.
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Setting form control properties

Properties are attributes that you can set at design time for a particular control. You specify property 
values in the Property Inspector. See the table below for properties specific to Integration Manager 
extensions (such as the Pageflow link region) or conveniences (such as the Alert literal text). For all other 
definitions, see the XForms specification. 

Property 
name Description Applies to

Alert literal 
text

The text displayed in an alert box.

See “Informing users of validation errors” on page 287

All controls for which model 
item properties can be 
defined

Button 
height

Specifies the height of buttons added to the Pageflow 
link region at runtime.

The default is 25.

Pageflow link region

Button 
layout

Specifies the layout of the buttons added to the 
Pageflow link region at runtime. 

The default is Horizontal.

Pageflow link region

Button 
spacing

Specifies the spacing between the buttons added to the 
Pageflow link region at runtime. 

The default is 5 pixels.

Pageflow link region

Button width Specifies the width of the buttons added to the 
Pageflow link region at runtime. 

Pageflow link region

Dynamic 
choices 

See “Populating the Select controls” on page 276 XForms Select Many

Edit class 
style rules

Launches a dialog that lets you:

Modify the CSS class styles on the currently selected 
control

Create new or edit existing styles (by launching the 
CSS Editor)

All controls for which CSS 
styling applies

Emulate link Defines a trigger control’s appearance. 

Checked—Trigger is styled as a link. Adds an 
<xforms:action> event handler that listens for the 
DOMActivate event (button press). The action element 
contains an <xforms:load> element that loads a new 
page via an HTTP GET operation (and thus the 
Request type is set to Get).  

There is no default URL to use for the GET; you have to 
add that via Target URL. 

UnChecked—Trigger is styled as a button.

XForms trigger control, 
XForms trigger styled as a 
link, Pageflow link region
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Field type Sets the data type that the control assumes for the 
instance item it is bound to. 

Use this in conjunction with the Format property. 

Make sure that you specify a field type that is valid for 
the data type of the field. When there is a conflict 
between these two types:

The instance node the form control is bound to 
becomes invalid.

The event xforms-invalid is dispatched to form 
controls bound to that node.

The form control becomes invalid and thus the CSS 
styles with the :invalid pseudoclass apply.

If the invalid instance node is part of the document 
fragment being submitted, the submit fails.

See also Format

All controls that can be 
bound to data

Format Specifies how to format the data when displaying it. 

Valid formats are:

Number, currency, percent, ###,###.##, #####0.##, 
#####.00

See also Field type

All controls that can be 
bound to data

Hint literal 
text

The text displayed in a tooltip. All visible controls

ID A unique identifier for the control. All controls 

Label The text displayed for the control’s label. All controls that can have a 
label

Model ID The ID of the model associated with the Form control. All controls that can be 
data bound.

Request 
type

Get—Uses the <xforms:load> action. Requires a Target 
URL property.

Post—Uses the <xforms:send> action. Requires a 
Submission property.

XForms trigger control, 
XForms trigger styled as a 
link, Pageflow link region

Source Specifies the name of the source file containing the 
XHTML image to insert.

XHTML image

Style as link Checked—The XForms Trigger control is styled as an 
HTML link. 

Adds a CSS class selector (nv-link-style) to the 
trigger's class attribute.  This CSS selector styles the 
trigger to look like the default appearance of the HTML 
<a> tag. This selector rule is added to the page’s 
<style> node so you can modify it to look the way you 
want.

All triggers marked to emulate links share this same 
style. 

Unchecked—Removes the selector name from the 
trigger's class attribute, but does not delete the selector 
rule from the <style> node.

XForms trigger control, 
XForms trigger styled as a 
link, Pageflow link region

Property 
name Description Applies to
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Binding controls to data
The Form Designer makes it easy to bind controls to a single node or a node set. In many cases you won’t 
need to take any action to bind a control to data. For example:

Integration Manager automatically creates data-bound controls
When you drag a data node from the Instance Data Pane onto a control in the Visual Editor, the 
Form Designer generates the data bindings automatically

If you want to modify the generated bindings, or if you want to bind controls that you’ve added to the 
form from the toolbar, you can use the Property Inspector to specify the binding attributes. You can also 
set up a <bind> in the Model tab, then set the bind property to the <bind> element’s ID. See “Binding 
elements to controls” on page 287.

NOTE:  The following procedure generates a binding via a <ref> attribute on the control. It’s possible to 
specify either a <ref> or a <bind>. When you specify one, the Form Designer removes the other. If you 
enter both via the Source tab, the <bind> takes precedence.

To bind a control to a single node via an XPath:

1 In the Visual Editor, select the control you want to bind.
2 Using the Property Inspector, specify the model ID (when there is more than one model element for 

the form). 
3 Specify the XPath by:

Typing the XPath in the text box of Reference (generates a <ref> attribute)
OR
Launching the XPath Navigator (by clicking the ellipsis next to the XPath text box)

3a In the XPath Navigator dialog, locate the node you want to bind to and select it.
3b Click OK to return to the Form Designer.

To bind a control to a node set:

NOTE:  <repeat> elements require that you bind to a node set.

1 In the Visual Editor, select the control you want to bind.
2 Using the Property Inspector, specify the model ID.

2a In the XPath Navigator dialog, locate the node you want to bind to and select it.
2b Click OK to return to the Form Designer.
NOTE:  If a <ref> resolves to multiple nodes, the first node is used.

Submission Specifies the value of <xforms:send>'s submission 
attribute.  (This is the ID of an <xforms:submission> in 
the <xforms:model>.)

XForms trigger control, 
XForms trigger styled as a 
link, Pageflow link region

Target URL Specifies the value of <xforms:load>'s resource 
attribute.  

(The URL that a GET is sent to in order to load the new 
page.) 

This URL automatically gets marked up for URL 
rewriting in the portlet context, so specifying a relative 
URL here will get back to your portlet.)

XForms trigger control, 
XForms trigger styled as a 
link, Pageflow link region

Property 
name Description Applies to
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Populating the Select controls

There are two ways to provide a list of values for the Select controls: 

List values Lists have two types of values: 

A label (for display) 
A value (for storage)

The user sees the label, but the associated value is the value written to the instance node. This allows you 
to display user-recognizable text while storing keys or other types of codes in the instance node. For 
example, if you entered the words apples, oranges, and pears, these words would appear in the display 
list. However, selecting apples might return the value 1, oranges could return 2, and so on. 

Instance elements A Select control is usually associated with two instance elements:

One containing the display values
One containing the element to which the value is written

To load the list statically: 

1 Highlight the Select control and access the property sheet.
2 Choose the Edit Select Choices link. 

The Select Control Choices dialog displays.

Method Enables you to When to use

Statically Specify the list values 
while you are designing 
your form. 

Use this method when the list is 
relatively short, you know what the 
values are, and the values won't 
change.

Dynamically Specify the list values 
come from a nodeset. 

Use this method when the information 
is located in an XML file. 

When you do not know what the list 
items will be or the list changes 
frequently. 
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3 Click the Static Choices radio button.
4 The dialog enables the Label and Value text boxes:

To change the predefined Label and Value choices, double-click within the text box and change 
the text.
To add a new choice, click Add, and place the cursor within the added text box and add the 
Label and Values.

5 When you are done, click OK. 

To load the list dynamically: 

1 Highlight the Select control and access its property sheet.
2 Choose the Edit Select Choices link. 

The Select Control Choices dialog displays:
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3 Click the Dynamic choices radio button.
4 Choose the model from the dropdown list box.
5 Click the ellipsis next to the Nodeset XPath to access the XPath Navigator to choose a nodeset.
6 Click the ellipsis beside Label XPath to access the XPath Navigator to the display value.
7 Click the ellipsis beside the Value XPath to access the XPath Navigator to choose storage value. 

This value is written to the instance node.
8 When you are done, click OK.

Working with model elements
The XForms model element defines the structure of the XML data available to the form. It defines the:

Structure of the data displayed to or entered by the user
Structure of the data to submit
Data for initializing form controls (instance data)
Rules for validating user data

The Model tab includes these elements: 

Element Description For more information, see

Model The model root “Specifying model elements” 
on page 279

instance Points to or contains the data 
used to initialize the form

“Specifying instance 
elements” on page 281
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About the Model tab
The Model tab provides a graphical way to define the elements that comprise the form’s model. The 
Model tab looks like this: 

The Model tab provides: 

Specifying model elements

To add a model element:

1 With the form open in the Model tab, click Add (at the top of the Model Editor). 
The following dialog is displayed. 

action Defines event handlers and 
actions that can be accessed 
from any part of the form

“Specifying actions” on 
page 283

submission Defines the set of data to submit 
and how to submit it

“Specifying submission 
elements” on page 283

bind Defines properties (called model 
item properties) of the instance 
data—like readonly, relevant, 
calculations, and indirect binding, 
and so on

“Specifying Bind elements” 
on page 285

Tool Description

Model Editor Use to add and remove elements. 

Instance Data 
Pane

Use the Instance Data Pane to modify the structure of the 
instance data. 

Property Inspector Use to create and modify attributes on the selected model 
element.

Event Editor Use to define the events and actions on the selected model 
element.

Element Description For more information, see
Form Designer 279



You’ll see that wsrp_rewrite_ is appended to the model ID name. This is a placeholder that is 
recommended. At runtime the wsrp_rewrite_ is replaced with a unique ID to ensure that no naming 
conflicts occur among other forms or portlets on the same page.

2 Name the model and click OK.
The Form Designer creates a new, empty model tree and displays it in the Model Editor.

To remove a model element:

1 With the form open in the Model tab, select the model element you want to delete from the 
dropdown list box. 

2 Click Delete.

Specifying model properties:

1 Select the model in the Model Editor.
2 Access the Property Inspector and complete the properties as follows: 

For information about adding events, see “Customizing event handlers” on page 300.

NOTE:  Some element types only allow you to add elements to the root (like Instance). Others allow you 
to nest elements within other elements (like bind). You can determine which elements can be nested by 
selecting an element (not the root) and right-clicking to see if Add item is offered on the menu.

Property Description

ID Specifies a unique identifier for a model.

A model ID is not required (unless there are multiple models), but 
Integration Manager always generates a model ID and uses the 
token wsrp_rewrite. It is good practice to use an ID because at 
runtime there might be multiple XForms on a single page.

Schema 
URI

Specifies a list of external schema documents that are needed to 
describe the structure of the instance data and allow it to be 
validated.

To add schema documents:

1 Click Edit schema list. (The Edit Schema File List dialog 
displays).

2 Click Add.

2a In the Select Schema File dialog, specify the name and 
location of the schema file.

2b Click OK.

3 Click OK.
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Specifying instance elements

To set instance data properties:

1 Select an instance element (not the root).
The instance element’s properties are displayed in the Property Inspector. They include:  

Property Description

ID A unique identifier for the instance data. This is necessary only when there 
are multiple instance data nodes in a single document. 

It is good practice to always allow the Form Designer to add 
_wsrp_rewrite_ because at runtime there might be multiple portlets with 
multiple XForms on a single page.

Use pageflow data 
at runtime?

Specifies how instance data should be handled at runtime (once the form 
is incorporated within a pageflow). 

Options are:

always (the default)—Always replace the data at runtime. If no 
replacement data is available, a runtime error is generated. 

if-available—Replace only if new data is available at runtime; otherwise 
use the design-time data.

delete-if-not-available—Use new data if it is available at runtime. Don’t 
ever use the design-time data—delete it.

never—Use the design-time data alone. 

IMPORTANT:  When you incorporate a form into a pageflow (as an 
XForms activity), you’ll be able to specify a set of scoped paths (using the 
Property Inspector for the activity), indicating the replacement data for 
each of the replaceable <xforms:instance> nodes. (These are the instance 
nodes whose Use pageflow data at runtime is set to always, if-available, 
or delete-if-not-available. )

Is primary instance 
data?

Specifies whether data for an <xforms:instance> node is treated as the 
primary instance data. 

The primary instance data is the input data to the page rendering's XSLT 
transformation; it is the default context for use in XSLT expressions in the 
page.  All other input data is secondary input data and can be accessed 
only via variable references in XSLT expressions. 

For more information, see “About runtime replacement of instance data” on 
page 282.

Is inline? Check this box when data is contained within the model element of the 
form.

When this is checked, you can use the instance data generated by 
Integration Manager or you can import the instance data from a file located 
within the project’s resource set. 

See Import instance data from file (below).

Uncheck this box when you want the data to be referenced from an 
external file. See Source (URI) (below).
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About runtime replacement of instance data

At runtime, the form’s data is replaced as specified by the Use pageflow data at runtime? property. The 
data is replaced for each form (which runs as a portlet) separately, and it happens before aggregation into 
the portal page. Additionally, the data corresponding to one or more input documents may be made 
available, according to the following rules: 

For more information on adding events to the instance element, see “Working with events and actions” 
on page 287.

Import instance 
data from file

To import instance data:

1 Click the ellipsis button.

2 In the Import File into Instance Node dialog,

2a Type the name of the file to import.

or

2b Click Import, navigate to the file to import, and click Open.

3 Click OK.

Source (URI) When the data is not inline, you can specify the location of the data using a 
URI. 

NOTE:  The URI must reference a location within the current project’s 
resource set.

To add a link to the instance data:

1 Click the ellipsis next to the Source URI text box.

2 In the Select File dialog, choose the file and click OK.

Rule Description

No replaceable 
<xforms:instance> 
element is specified as 
the primary instance 
data.

If there is only one instance element, that one instance element is 
treated as the primary instance data. The primary input document is 
mapped to the primary instance data.

If there is more than one default <xforms:instance> element in the page, 
one instance element must be defined as the primary instance data—
and:

All other replaceable <xforms:instance> elements use secondary 
input data. 

All secondary input data is made available to XSLT expressions in 
the page via XSLT variables. XSLT allows only a single input 
document, so other documents must be made accessible via the 
XSLT variable mechanism.

The variable identifiers are equal to the ID of the corresponding 
<xforms:instance> elements.  (You use a dollar sign in XSLT to 
access a variable in an XPath expression; thus if you had 
<xforms:instance id="foo"> you'd access its runtime data via 
something like <xsl:value-of select="$foo/a/b/c"/>.)

Property Description
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Specifying actions
The Form Designer provides multiple ways for defining actions within your form: 

The remainder of this section describes how to specify actions in the Model tab.

To create an action/event handler:

1 From the Model tab, select the top-level action node from the model tree.
2 Right-click and choose Add item.
3 Navigate to the Property Inspector and supply the following properties:  

4 Right-click and choose the action you want performed for the event.
5 Navigate to the Property Inspector to define the specification for the selected action. 

Specifying submission elements
The submission element defines:

The structure of the data to submit
Where to submit it
How to submit it

To create a submission element:

1 From the Model tab, select the top-level submission node from the model tree.
2 Right-click and choose Add item.
3 Navigate to the Property Inspector and supply the following properties: 

Method Description

The action node of 
the Model tab

Use the action node of the Model tab as a place to create one or more 
actions (with unique IDs) and then reference them elsewhere in your form.

The Event Editor in 
the Form tab

Use the Event Editor launched from the Form tab to create actions for your 
form controls

For more information, see “Working with events and actions” on page 287.

Property What to specify

ID Provide a unique name for the action/event handler.

Event name Choose the event from the dropdown list.

Observer (Optional) Choose an element as the observer.

Target (Optional) Choose an element as the target of the action.

Property Description

ID Specifies a unique ID for the submission element. 

Binding ID Specifies the ID of a Bind element. Choose the ID of the bind element 
that specifies the node(s) to submit.

XPath of reference An XPath specifying the node(s) to submit.

Action (URI) Specifies the URI to the location where the submission is sent.
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Method Specifies how to do the submission.

Values:

Post

Get 

Put

form-data-post

multipart-post (treated like a Post)

urlencoded-post

Replace Specifies what the processor should do with the document returned 
after the submission.

Values:

all (the default)

instance

none

Separator Specifies what separator character to use on url-encoded 
serialization. 

Values:

;

&

Indent For application/xml serialization only. Specifies whether to insert 
white space.

Values:

True

False

Standalone For application/xml serialization only. Specifies whether to include a 
declaration. 

Values:

True

False

Omit XML declaration For application/xml serialization only. Specifies whether to include an 
XML declaration. 

Values:

True

False

Encoding For application/xml serialization only. 

Specifies the type of encoding to use. 

Property Description
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For more information on adding events to the submission element, see “Working with events and actions” 
on page 287.

Specifying Bind elements
Use the Bind element to set rules on the instance data. For example, you can define fields as required, 
enabled, or disabled depending on selections that the user makes, and so on. You can also use a bind 
element as an indirect way of specifying the binding for a control; instead of using <ref> or <nodeset>, 
use the bind=bindingID attribute on the control. Once you have defined the bind elements in the Model 
tab, you can return to the Form tab and associate them with form controls to create a UI Binding 
expression.

To create a bind element:

1 Select bind.
2 Right-click and select Add item.

To delete a bind element:

1 Select the bind element.
2 Right-click and select Delete item.

Edit namespace list For application/xml serialization only. 

Specifies the namespaces to include in the serialized XML. Not 
specifying any namespaces is the same as specifying all.

To edit the namespace list:

1 Click edit namespace list.
2 Select the namespaces you want to include. Use Shift to select a 

contiguous group and Ctrl-Shift to select multiple non-contiguous 
items.

3 Click OK.

Mediatype Specifies the Internet media type for the serialized instance data. 

Version For application/xml serialization only. 

CDATA section elements For application/xml serialization only. 

To add CDATA elements:

1 Click Edit CDATA element list.
2 In the Edit CDATA item list dialog, click Add.

3 Type the name in the Add List dialog.

4 Click OK.

5 Click OK.

Property Description
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To set properties on a bind element:

1 Select the bind element. 
2 Access the Property Inspector and complete the properties as follows:  

Specifying model item properties

You can specify these Model Item properties like this: 

Property Description

ID A unique ID for the bind element. 

XPath of Nodeset The node(s) in the bind.

Model Item Properties Lets you define the model item properties to apply to the nodes 
defined in the XPath of Nodeset above. 

For more information, see Specifying model item properties below.

Type Specifies the XML schema data type for the associated node. 

The Form Designer includes a convenience that allows you to 
specify formatting for certain data types. Only the data types shown 
in bold support this formatting. 

You apply the formatting in the Form tab Property Inspector for the 
control bound to such a node. 

For more information, see “Format” on page 274

Model item property Description

Readonly Users are not allowed to change the data. Any form controls bound to a read-
only node are not enabled.

To make a node readonly:

1 In the Property Inspector, choose readonly.

2 Create an XPath expression that evaluates to a boolean, or change the 
value to true().

Required Users are required to supply a value. Any form controls bound to a required 
node will generate a submit error if a value is not supplied.

To make a node required:

1 In the Property Inspector, choose required.

2 Create an XPath expression that evaluates to a boolean, or change the 
value to true().

Relevant Specifies whether a node is visible. Form controls bound to nonrelevant 
nodes are disabled or not visible. 

If you make a nonrelevant node required, the required property is ignored. 

To make a node nonrelevant:

1 In the Property Inspector, choose relevant.
2 Create an XPath expression that evaluates to a boolean, or change the 

value to false().

Calculate Specifies a calculation that defines the value of the node. 

To create a calculation on a node:

1 In the Property Inspector, choose Calculate.

2 In the XPath Navigator, construct the calculation.
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Informing users of validation errors

The Form Designer makes it easy to notify users that a control (or the form) has failed one of the model 
item property validation tests.

To notify users of an error:

1 When you’ve defined the model item properties, access the Form tab.
2 Select the control bound to the node for which the model item property is defined.
3 In the Property Inspector for the control, access the Hints tab.

4 Choose the Binding associated with the model item property definition from the dropdown.
5 Type a message in the Alert literal text to display to the user when a failure is encountered.

Binding elements to controls

When you’ve defined the bind elements in the Model tab, you can return to the Form tab and associate 
them with form controls to create a UI Binding expression.

Working with events and actions
XForms supports and extends the DOM Level 2 event model which is based on the XML event model. 

You use the Event Editor to create event handlers and define XForms Actions.

This section includes the following information:

About the Event Editor
XForms Actions Reference
Customizing event handlers

Constraint Specifies a boolean expression that when false causes the associated model 
item to be regarded as valid. (The converse is not necessarily true.) 

Model item property Description
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About the Event Editor
The Event Editor is available on both the Form tab and the Model tab. It looks like this:

The Event Editor is enabled when you select an item that allows event handlers such as a form control, a 
submission element, or a bind.

The Event Editor supports all XForms events and actions, but not all events are presented as choices 
when creating an event handler. If an event is not presented as a choice, you can type it in the choice box 
or use the Source tab to define it.

To launch the Event Editor:

1 Navigate to the bottom of Form Designer (in the Form or Model tabs).
2 Click the icon next to the Event Handlers label. The following graphic shows the location of the 

icon in the Form tab.

The Event Editor opens.
3 Select a form control or model item for which you want to define an event.

The Event Editor is now available to edit existing or create new Event Handlers.
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To create an event handler:

1 Select the element that you want to define the event handler for.

2 Click the Create a new event handler icon.

 
The Create Event Handler for Element dialog displays:

3 Choose an event from the Event Type dropdown, or type an event name (if it is not listed).
3a If you want to further customize the event handler by adding observers, and default actions, 

click Advanced options and see “To customize event dispatching:” on page 300.
4 Click OK.

The Event Editor now allows you to choose XForms Actions to respond to the event handler 
(described next). 
NOTE:  You can’t put an event handler on the instance element because instance nodes are 
restricted to a single child element. When you use the Event Editor to add an event handler to the 
instance element, it will put it on the model.

To specify XForms Actions for an event handler:

1 After creating an event handler, click the New Action icon.

 
2 Select an XForms Action from the popup list.

The selected action and it’s properties are displayed.
3 Complete the properties.
4 Save the form.

The Event Editor generates the event handler and XForms Action defined by the properties you specified. 

For more information about Action properties, see the XForms specification.

To delete an action:

1 Select the action from the Action List.
2 Click the delete icon.
Form Designer 289

http://www.w3.org/MarkUp/Forms/


To delete an event handler:

1 Select the event handler from the Event Handler list.
2 Click the delete icon.

XForms Actions Reference
Click an action to display complete information.  

Delete 

Description Deletes a specific node of repeated instance data. Typically, the nodeset is bound to a repeat block. 

Attributes To construct the action, use the Event Editor to define it’s attributes.

Complete the attributes as follows: 

Action Action

Delete Reset model

Dispatch Send instance data

Insert Set Focus

Load link Set index in repeat

Message Set value

Rebuild, Recalculate, Refresh, and Revalidate 
model

Toggle select case in switch

Attribute What to do Notes

Use XPath 
expression

Choose Use XPath expression to specify 
an XPath expression that identifies the data 
node to delete.

You can type the expression in the 
choice box, or click the ellipsis to 
launch the XPath Navigator.

The Event Editor constructs an 
<xforms:action> with a nodeset 
definition.
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Dispatch 

Description Dispatches XForms events to a named element on a form. You can dispatch events that are:

Standard XForms events—like xforms-enabled, xforms-disabled, and so on. 
Custom XML events—A custom event that you’ve defined for the form. 

Attributes To construct the action, use the Event Editor to define the attributes.

Model ID Optional. 

Choose a Model ID from the choice box. 

A Model ID is only needed when: 

You choose Use XPath expression.

The form references multiple models 
containing instance data elements of 
the same name.

Use binding Choose Use binding to specify an existing 
bind expression that identifies the data 
node to delete, then choose a binding ID 
from the choice box. 

The choice box is only populated if 
you’ve defined a binding element and 
specified IDs for them in the Model tab. 

Location Specify the location of the data node to 
delete via an XPath expression.

You can type the expression in the 
choice box, or click the ellipsis to 
launch the XPath Navigator.

Valid expressions include:

last()—specifies the last item in the 
nodeset.

1—specifies the first item in the 
nodeset.

index()—Refers to the position of the 
current selection in the specified 
repeat. 

Attribute What to do Notes
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Complete the attributes as follows: 

Insert 

Description Inserts a new node of instance data. The XForms Specification requires that the instance data be a 
homogeneous collection (typically, a repeat block).

By default, the inserted node is a duplicate of the last node in the nodeset. 

Attributes To construct the action, use the Event Editor to define it’s attributes:

Complete the attributes as follows: 

Attribute What to do Notes

Send event Choose an event to dispatch. If the event is not listed, you can type it in 
the choice box.

target Choose the ID of the element the 
event is dispatched to.

The choice box is populated with elements 
for which you have defined IDs.

Valid target elements include:

Model elements

Instance elements

Action elements 

Submission elements

Form controls

bubbles Check if the dispatched event bubbles. For custom events only.

Optional.

cancelable Check if the dispatched event can be 
cancelled. 

For custom events only.

Optional.

Attribute What to do Notes

Use XPath 
expression

Click Use XPath expression to specify 
an XPath expression that identifies the 
data node to insert.

You can type the expression in the choice 
box, or click the ellipsis to launch the XPath 
Navigator.

Model ID Optional. 

Choose a Model ID from the choice 
box. 

A Model ID is only needed when: 

You click Use XPath expression.

The form references multiple models 
containing instance data elements of the 
same name.
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Load link 

Description Navigates an URL in the same or different browser window. 

To test the Load link action, use View in browser option (available from the XForms Preview tab). The 
Load Action is not supported in Preview mode. 

If the link fails at runtime, no navigation occurs and the xforms-link-error event fires. You can set up an 
event handler for the xforms-link-error event to intercept and handle this error gracefully.

Attributes To construct the action, use the Event Editor to define it’s attributes:

Use binding Click Use binding to specify an 
existing bind expression that identifies 
the data node to delete, then choose a 
binding ID from the choice box. 

The choice box is only populated if you’ve 
defined a binding element and specified an 
ID for it (in the Model tab). 

Location Specify the location for the insert, within 
the data node, via an XPath 
expression.

You can type the expression in the choice 
box, or click the ellipsis to launch the XPath 
Navigator.

Valid expressions include:

last()—specifies the last item in the 
nodeset.

1—specifies the first item in the 
nodeset.

index()—specifies the position of the 
current selection in the specified repeat.

Position Choose Before to insert the new 
node before the node specified by 
the location attribute.

Choose After to insert the new node 
after the node specified by the 
location attribute.

Attribute What to do Notes
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Complete the attributes as follows: 

Message

Description Launches a modal, modeless, or ephemeral message box.

Attributes To construct the action, use the Event Editor to define the attributes of the action:

Attribute What to do Notes

Data node Choose to specify a data node that 
resolves to a URI. 

The URI must include the URL scheme such 
as HTTP or HTTP.

Choose Use XPath expression to 
specify the URI via an an XPath 
expression that resolves to a URI.

You can type the expression, or click the 
ellipsis to launch the XPath Navigator.

A Model ID is only needed when: 

You click Use XPath expression.

The form references multiple models 
containing instance data elements of the 
same name.

Click Use binding to specify an 
existing bind expression that 
resolves to a URI.

The choice box is only populated if you’ve 
defined a binding element and specified an ID 
for it in the Model tab. 

URI Choose when you want to manually 
specify the URL.

The URI must include the URL scheme such 
as HTTP or HTTPS.

For example:
http://www.novell.com

New window Choose if successful navigation 
should launch the URL in a new 
window.

Current 
window

Choose if successful navigation 
should launch the URL in the 
current window.
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Complete the attributes as follows: 

Rebuild, Recalculate, Refresh, and Revalidate model

Description Forces xforms-rebuild, xforms-recalculate, xforms-refesh and and xforms-revalidate events to occur. 
Use the corresponding actions to specify a behavior different from the default for these events.

For more information on XForms event processing flow, see the xforms-rebuild, xforms-recalculate, 
xforms-refresh, and xforms-revalidate events in the XForms 1.0 Specification. 

Attributes To construct the action, use the Event Editor to define it’s attributes:

Attribute What to do Notes

Display 
Message

Choose one:

Inline text Use for simple, static messages.

Type the message you want displayed in the text box.

URI Use to display the contents of the file at the specified 
URL.The URL is invoked and the raw text is displayed in 
an alert box.

For example:
http://www.myserver.com/error-msg/data-
error.txt)

TIP:  You might use this as an alternate way of storing 
(and localizing) error messages; the URL could even 
pass arguments to a CGI script or a servlet to fetch 
localized messages.

Data node Displays a message stored in an instance data node. 

Expression Use to construct complex inline text messages. 
Constructs an XForms output element as a child of the 
xforms:message element.

For example:
if(string-length(“account-info/account-
number”)>4),’You have entered too many 
characters.’, ‘The data is invalid’)

Message 
level

Choose one:

Modal Blocks user input to all other windows until the user 
dismisses the message.

Modeless Allows users to work with other windows without having 
to respond to the message.

Ephemeral
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Complete the attributes as follows:  

Reset model

Description Sets the instance data, of the specified model, to the values at form initialization. 

For more information on XForms event processing flow, see the xforms-reset event in the XForms 1.0 
Specification. 

Attributes To construct the action, use the Event Editor to define it’s attributes:

Complete the attributes as follows:  

Send instance data 

Description Forces the form to begin submit processing. 

Attributes To construct the action, use the Event Editor to define it’s attributes:

Attribute What to do Notes

Model ID Choose the Model ID from the choice 
box. 

This is the model that will receive the 
event.

Attribute What to do

Model ID Choose the ID of the Model you want reset
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Complete the attributes as follows: 

Set Focus 

Description Use Set Focus to move focus to a specific form control.

Attributes To construct the action, use the Event Editor to define it’s attributes:

Complete the attributes as follows: 

Set index in repeat

Description Use the Set index to specify the current node of a repeat block.

Attributes To construct the action, use the Event Editor to define it’s attributes:

Attribute What to do Notes

Submission ID Choose a submission ID Submission elements are defined in the 
Model tab. 

The choice box is only populated when a 
Submission element is created and given 
an ID.

Attribute What to do Notes

Control ID Choose a Control ID from the choice box. You can define a Control ID in the 
Property Inspector (in the Form tab).

The choice box is only populated 
when control elements are named in 
the Property Inspector.
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Complete the attributes as follows: 

Set value

Description Use to set the value of an instance node.

Attributes To construct the action, use the Event Editor to define it’s attributes:

Attribute What to do

Repeat 
element

Choose a repeat element from the 
choice box.

Item index Specify an XPath expression that 
defines index
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Complete the attributes as follows: 

Toggle select case in switch

Description Use to specify the case to display in a Switch element.

Attributes To construct the action, use the Event Editor to define it’s attributes:

Complete the attributes as follows: 

Attribute What to do Notes

Data node Choose one to specify the data node 
whose value you want to set.

Use XPath expression—to specify an 
XPath expression.

You can type the expression in the choice 
box, or click the ellipsis to launch the 
XPath Navigator.

A Model ID is only needed when the form 
references multiple models containing 
instance data elements of the same 
name.

 Use binding—to specify an existing 
bind expression.

The choice box is only populated if you’ve 
defined a binding element and specified 
an ID for it in the Model tab. 

New Value Choose one:

Inline text—to specify static values. For example:
This is a test value.

Expression—to construct dynamic 
values based on user input or other 
elements not known at design time.

For example:
concat('Test: ', 
/data:test/data:form_data/data:i
nstance_node)

Attributes What to do Notes

Case to select Select the case ID from the choice box. The choice box is only populated 
if you’ve defined a Switch 
element.
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Customizing event handlers

To customize event dispatching:

1 Access the Advanced Options dialog by:
Clicking Advanced options when you first choose the event you want to dispatch
OR
Clicking Options from the Event Editor. 

2 Complete the dialog as follows: 

3 Click OK.

Testing forms 
You’ll want to test your form’s data processing logic and its look and feel. The Form Designer provides 
built-in tools for each of these tasks:  

Option Description

Handle event at observer 
element

Choose an observer element from the list box. 

This option moves the event handler to the selected XML element.

NOTE:  You should not put an event observer on the body tag. To 
achieve the same result, click Attach event handler to model, 
select a model, and specify the body element as the observer.

Handle event during 
phase

Lets you control the order in which event handlers are executed.

Restrict handler to events 
on selected element

This is valid only when the event handler is attached to an ancestor 
of the selected control; it makes the handler specific to the selected 
control. 

You can use this option to cause something to happen at a 
particular point in the event-handling sequence for the specified 
control.

Continue event 
propagation after handlers 
at this element

When used in combination with handlers on ancestor nodes and 
phase options, this is a way to control which event handlers are 
executed for a particular event. 

Perform or cancel default 
action button

Provides a means of overriding the default behavior of the XForms 
processor. 

Choosing cancel always cancels the default behavior—no 
conditional processing is allowed. (Not all XForms events allow you 
to cancel the default behavior.) 

Use this tool To test this

XForms preview Event and data processing

XHMTL component look and feel

View Form in Browser The look and feel of all components on the page
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Using XForms Preview
XForms Preview uses a Swing renderer to render the XForms controls on the page. This feature is 
especially useful for testing the structure of your submitted data. 

To use XForms Preview:

1 Open the form.
2 Choose the XForms Preview tab.

The form is rendered and is available for interaction: 
Any controls that are unexpectedly disabled (you didn’t mark them disabled in your code) might 
indicate a data binding problem. 
You can view submission nodes in the left pane of the XForms Preview. 

XForms Preview limitations The XForms Preview does not display any HTML associated with the 
XHTML page.

Using View Form in browser
The View Form in browser uses an XHTML renderer to display both the XHTML and the HTML on a 
single page. This feature is especially useful to help you work out any layout issues. 

To use View Form in browser, your form’s project must be deployed to an application server. Once your 
project is deployed, changes that you make to the form are immediately available—you don’t have to 
redeploy your project.

To use View Form in browser:

1 Open the project.
2 Open the form you want to view.
3 Choose XForms Preview.
4 Choose the View Form in browser button.

The Specify Location of Processor Servlet dialog displays:

5 Complete the dialog using the following values: 

Field What to specify

Location of processor servlet Specify the name of the server where the 
Form’s project is deployed. 

Use default browser Choose this radio button if you want the 
Form Designer to locate the default browser 
for the current machine.

User browser Choose this radio button and the 
corresponding text field to specify a browser 
other than the default.
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6 Click OK.
The form displays in the browser. If you receive a Page Not Found error, make sure that the form’s 
project has been deployed to the server specified.

Testing browser font sizes

You may want to test your form with various font sizes.

To test browser font sizes at design time:

1 Open the form in the Form tab.
2 Choose Form Designer>Set browser font override.

The Set override font displays:

3 Complete the dialog as follows: 

4 Choose OK. 
The font you specify is applied as a font size style on the <body> tag.

This styling applies only at design time. The Form Designer deletes the link to the theme file when the 
file is saved and restores it when the file is reopened (in the Form Designer). To remove the link 
completely, reopen the dialog and choose No.

Validating the form’s XML structure

You can validate the form to ensure that its XML is well formed and that it conforms to the schemas for 
the declared namespaces that can be resolved. To validate a form, select Form Designer>Validate.

Field What to specify

Override font? Choose yes to override the browser’s font size in the 
design environment.

Choose the override 
font size and units for 
this page

Specify the font size and units to be used. 
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11 Custom Scripting and XPath Logic in 
Integration Manager

Novell Integration Manager incorporates an onboard EMCAScript interpreter, which allows you to 
extend the functionality of Integration Manager applications in various ways. For example, you can use 
scripting to:

Manipulate XML data directly, via DOM Level 2 methods
Execute Integration Manager components programmatically
Call Java directly
Perform file I/O operations
Augment your Action Model with custom processing logic
Develop your own utility libraries for performing common data-manipulation tasks
Bind data connections dynamically at runtime
Use alert( ) functions in debugging
Quickly prototype and test concepts that might ultimately be implemented in Java

The XPath language also offers opportunities to exploit custom logic in your Integration Manager 
components. The XPath specification includes over two dozen predefined functions that can be used to 
filter, qualify, aggregate, and/or locate XML data.

This chapter discusses some of the techniques and capabilities applicable to the use of custom 
ECMAScript and/or XPath logic in Integration Manager and describes the relationship of various W3C 
standards to XPath and ECMAScript.

What is ECMAScript?
ECMAScript is a lightweight, object-oriented scripting language for extending the functionality of 
diverse host environments (such as web browsers, editors, and IDEs) by enabling the use of custom logic. 
It is designed to complement or extend existing functionality in a host program such as Integration 
Manager. In the web-browser world, ECMAScript is often called JavaScript or JScript.

ECMAScript is especially appropriate for a Java host environment, since:

It is an object-oriented language with a distinctly Java-like syntax.
Scripts written in ECMAScript can call Java constructors and methods directly.

The extensibility of ECMAScript, its powerful string-handling tools (including regular expressions), its 
DOM binding, and its ability to provide a bridge to Java, make it an ideal language to augment the 
programming constructs and standards used by Integration Manager.

NOTE:  You can find detailed information regarding ECMAScript at the European Computer 
Manufacturers Association (ECMA) web site: http://www.ecma.ch/
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What Capabilities Does ECMAScript Offer?
In addition to letting you incorporate finely tuned custom logic into your Action Model, scripting gives 
you a great deal of flexibility in manipulating data, because of the various DOM- and XPath-related 
objects and methods available in Integration Manager’s ECMAScript extensions. Also, as an extensible 
language, custom user-defined objects can be created on-the-fly in ECMAScript and used in your 
Integration Manager components and services.

The usefulness of ECMAScript is especially apparent when dealing with in-memory DOMs. Integration 
Manager constructs XML documents as in-memory objects according to the W3C DOM Level 2 
specification. The DOM-2 specification, in turn, defines an ECMAScript binding (see 
http://www.w3.org/TR/DOM-Level-2-Core/ecma-script-binding.html), with numerous methods and 
properties that provide ready access to DOM-tree contents. The standard Integration Manager DOMs—
Input, Input1, Input(n), Temp, and Output—are objects recognized by ECMAScript in Integration 
Manager, and any of the W3C-defined ECMAScript extensions that apply to DOMs can be accessed 
from Integration Manager.

ECMAScript also provides bridges to other expression languages such as XPath. In Integration 
Manager’s case, this allows you to use the Novell-supplied method XPath() on a DOM to address various 
elements within its document structure.

Another useful aspect of Integration Manager’s ECMAScript binding is its inclusion of file-I/O 
extensions (which are not a part of the core language). Using custom scripts, you can easily read or write 
scratch files, persist information to disk, or perform other common file-access tasks.

Integration Manager’s ECMAScript binding also includes database extensions that permit programmatic 
access to databases via JDBC. SQL statements can be passed as strings and executed against any database 
to which a connection can be defined.

How Scripting Is Exposed in Integration Manager’s User Interface
Integration Manager offers access to ECMAScript in many parts of the component editor user interface, 
as described throughout this Guide. The most common form of access is through the Expression Builder, 
which can be entered whenever you see this icon:

This icon can be found in many Integration Manager dialogs, such as the Map Action dialog, Connection 
Resource dialogs, etc. If you click this icon, you bring up a dialog similar to the following.
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The Expression Builder dialog provides pick-lists of available objects, methods, and properties in the top 
panes (all of which are resizable), with rollover tool tips to help you build ECMAScript statements. 
Doubleclicking any item in any picktree will cause a corresponding ECMAScript statement to appear in 
the small edit pane in the lower portion of the window. In the example shown above, the DOM picktree 
corresponding to PROJECT has been opened in the Variables pane, and the node at

USERCONFIG/PROJECT_CONFIG/DESIGNER_EMULATION_MODE 

has been doubleclicked. The ECMAScript expression that can access the contents of this node in the 
PROJECT DOM appears automatically in the edit pane.

In the window’s button bar, there is a Validate button. Clicking this button will result in the ECMAScript 
interpreter syntax-checking your expression(s) in real time. If there are problems involving ECMAScript 
syntax, you will see an error dialog immediately. You can then edit the expression(s) and revalidate as 
needed. (Validation is, however, optional.)

NOTE:  The Validate process does not execute your expression(s). It merely checks syntax.

Expressions for Dynamic Parameter Values

Each Integration Manager action typically requires one or more parameters needed to perform the action. 
Wherever possible, Integration Manager allows you to substitute ECMAScript expressions for these 
parameters. You can enter a static string, or an expression, or a series of expressions separated by 
semicolons. Since expressions are evaluated at runtime, this enables you to defer the choice of a 
parameter value until execution. This kind of late binding of parameter values is essential in cases where 
input values simply aren’t known in advance.

Example: You might choose to hard -code a static string value for a Send Mail action’s Recipient 
parameter. But you could also use ECMAScript to construct an e-mail address from data inside an 
incoming XML document, creating a flexible data-driven action with the ability to provide customization 
based on runtime knowledge. 

Most of Integration Manager’s actions accept ECMAScript expressions for parameter values. In most 
cases, an XPath expression is also accepted. You will usually be able to choose from two radio buttons, 
labelled “XPath” and “Expression.” To access the ECMAScript Expression Builder, choose the 
Expression radio button and click the small Expression Builder icon next to the text field where the 
parameter value should appear. 

Custom Script Libraries

ECMAScript is also integrated into Integration Manager as a general resource called Custom Scripts. The 
Custom Script resource provides an editing environment for creating custom ECMAScript functions, 
which you can run and debug with a command-line evaluator right inside the editor. The script editor also 
provides access to sample XML documents (DOM trees) and has a Java class browser so that you can 
easily write scripts that bridge to custom Java code. You can save libraries of custom scripts as Custom 
Script resources and see them listed in the instance pane of Integration Manager’s navigation frame. Also, 
when you’ve assembled custom functions into a Custom Script Resource, they automatically appear in 
all Expression Builder dialog pick-lists. 

See “About XSD Resources” on page 256 for more detailed information about Custom Script resources 
and the script editor.
Custom Scripting and XPath Logic in Integration Manager 305



Function Actions

Another way in which ECMAScript functionality is exposed in Integration Manager is through the 
Function Action, which is one of the core actions available in all component editors. You can insert a 
Function Action anywhere in your action model, to initialize variables, call custom functions, etc. One of 
the handiest uses of the Function Action is as a debugging aid. You can call the built-in alert() function 
with any string argument (the content of a DOM node, for example) in order to inspect the contents of a 
parameter value before and after an action or block of actions. The alert() function will bring up a dialog 
showing the string.

NOTE:  For obvious reasons, you should disable alert() calls prior to deployment. This is strictly a design-
time method with no applicability to the server environment.

See “The Function Action” on page 133 for information on how to create and use Function actions.

ECMAScript Access from XPath
Some dialog fields require an XPath expression. But in some instances, you may find that you prefer the 
greater expressivity of ECMAScript over XPath, or your logic requirements may not be accommodated 
by XPath’s relatively limited set of built-in functions. In cases of this sort, you can still use ECMAScript: 
Access to ECMAScript is available, in any field requiring XPath, via the userfunc namespace.

For example, let’s say you’ve defined your own custom ECMAScript function called getTotal():

function getTotal(a,b) {
return Number(a) + Number(b);

}

You could define this function either in a Custom Script resource in your project, or inside a Function 
Action. 

Suppose you want to call this function from an XPath statement, passing (as arguments) values stored in 
two DOM nodes given by ORDER/SUBTOTAL and ORDER/TAX. Here is how you would write the 
XPath:

userfunc:getTotal(ORDER/SUBTOTAL,ORDER/TAX)

Here is how this call might look in an XML Map Action dialog:
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XPath Access from ECMAScript
Just as you can reach ECMAScript functions from XPath, you can also obtain node objects, node data 
values, etc.via ECMAScript. Integration Manager offers a variety of ECMAScript extensions for 
manipulating DOM elements (discussed further below). Probably the most often-used of these 
extensions is the XPath() method, which takes an XPath-style path string as the sole argument:

var taxNode = Input.XPath(“ORDER/TAX”);
var taxAmt = taxNode.toString() * 1;

Notice that the XPath() method, which is parented off a DOM root (in this case, Input), always returns a 
node object, not the node’s value. To obtain the node’s data value, apply the core-language ECMAScript 
method toString() to it. If the resulting string value will be used as a number, cast it to a number either by 
wrapping it in ECMAScript’s Number() constructor or by multiplying by one (as shown). 

NOTE:  The most common error when using the XPath() method is to assume that it returns a data value 
(string, number, etc.), when in fact it returns a or node list. Use item(0).toString() to obtain the data value 
from the first node object in the returned node list.

Scope of Custom Script Functions and Variables
Functions stored in Custom Script resources are available to any component or service in your project, at 
any point in any action model. (Note, however, that after you’ve written a custom function, the associated 
Custom Script resource must be Saved before the function is available to a component.) 

Global variables within Custom Script resources (that is, variables declared outside of custom functions) 
are visible only to Custom Script resource functions that use the variable(s). In other words, if you declare 
a variable, myVariable, inside a Custom Resource called myFunctions, only the functions within 
myFunctions will be able to see and use myVariable.

Variables declared within a component’s action model are scoped to the component. That is, a variable 
declared at the top of an action model (in a Function Action) is visible to any action downstream of the 
declaration, and lives for the lifetime of the component, but that variable is not available to external 
components.

To achieve inter-service scope of variables, use the putSessionValue() and getSessionValue() methods 
described further below, in the section titled “Component (xObject)” on page 317.

Looking at an ECMAScript Example
Inside the body of any custom function, you can treat a DOM as an ECMAScript object and call valid 
methods on the object—such as toString(), which writes the DOM out to a string as text. 

NOTE:  In addition to custom functions, all of the standard built-in ECMAScript objects (Array, Boolean, 
Date, Function, Math, Object, Number, RegExp, String, and the top-level Global object), and their 
associated methods and properties, can be accessed from your expressions.

An example of a custom ECMAScript expression that you might use in a Function action is:

var onHand = Input.XPath("INVENTORYSTATUS/ONHAND");
if (Number(onHand) < 10)
   Output.XPath("PRODUCTRESPONSE/INVENTORYSTATUS") =

"Time to reorder";

This script says to check the value in the Input DOM at the INVENTORYSTATUS/ONHAND element 
node, and if it is less than 10, map the string “Time to reorder” to the Output DOM at element 
PRODUCTRESPONSE/INVENTORYSTATUS. 
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Note that in accordance with ECMAScript syntax rules, no data-type label need be included in the 
declaration of the local variable onHand. The value retrieved in onHand is likely to be a string, however. 
To cast it to a number, we apply the core ECMAScript Number() function to it. This permits us to use the 
less-than operator inside the conditional.

It’s entirely possible, of course, that onHand might end up being assigned a value (such as an empty 
string) that cannot be cast to a number, in which case Number() will return the problematic value NaN, 
which will then cause our conditional to generate an exception. In order to handle this possibility without 
generating the exception, one could do:

if ( !isNaN(Number(onHand) ) ) ?
if (Number(onHand) < 10)

[ code here ]

The isNaN() method is a core ECMAScript-language method which checks for “numberness.”

As an alternative to the isNaN() tactic, one could wrap the example code in a try/catch statement and 
handle any exception in the catch block. (The try/catch construct is supported by ECMAScript.)

NOTE:  For more ECMAScript examples, open (or import into your project) any of the Custom Script 
resources included in the sample Integration Manager project called “Expressions.”

Performance Considerations
ECMAScript is an interpreted language, which means that every line of script in an expression must be 
parsed and translated to the Java equivalent before it can be executed. This adds considerable overhead 
to the code and results in overall slower execution of scripts than pure Java. Before using ECMAScript 
extensively in your components and services, you should think about the possible performance 
ramifications. 

The following guidelines will help you achieve optimal performance in your components and services:

Whenever a logical task can be accomplished using one of Integration Manager’s built-in Action 
types, you should implement the task in terms of ordinary actions so that the majority of your logic 
runs in Java. 
When a task can’t be accomplished using actions, consider whether it can be accomplished via the 
use of a custom Java class (which you can call from ECMAScript). 
In cases where you either can’t perform a task in terms of actions or you need the fine control 
offered by scripting, use ECMAScript.

Bear in mind that the key to good performance is always a good implementation: choosing the correct 
algorithm, attention to reuse of variables, etc. Good code written in a slow language will often outperform 
bad code written in a fast language. Writing something in Java does not guarantee that it will be faster 
than the equivalent logic written in ECMAScript, because Java has its own overhead constraints 
involving, for example, constructor call-chains. (When you call a constructor for a Java object that 
inherits from other objects, the constructors for all ancestral objects are also called.)

ECMAScript’s core objects (String, Array, Date, etc.) have many built-in convenience methods for data 
manipulation, formatting, parsing, sorting, interconversion of strings and arrays, etc. These methods are 
implemented in highly optimized Java code inside the interpreter. It is to your advantage to use these 
methods whenever possible, rather than “roll your own” data-parsing or formatting functions. For 
example, suppose you want to break a long string into substrings, based on the occurrence of a delimiter. 
You could create a loop that uses the String methods indexOf() and substring() to parse out the substrings 
and assign them to slots in an array. But this would be a very inefficient technique when you could simply 
do:

var myArrayOfSubstrings = bigString.split( delimiter );
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The ECMAScript String method split() breaks a string into an array of substrings based on whatever 
delimiter value you supply. It executes in native Java and requires the interpreter to interpret only one line 
of script. Trying to do the same thing with a loop that iteratively calls indexOf() and substring() would 
involve a great deal of needless interpreter and function-call overhead, with the attendant performance 
hit.

Skillful use of built-in ECMAScript methods will pay worthwhile performance dividends. If you will be 
using scripts extensively, take time to learn about the fine points of the ECMAScript language, because 
this can help you eliminate performance bottlenecks.

What Is XPath?
XPath is the W3C standard that describes a syntax for addressing or locating content within an XML 
document. XPath also provides a lightweight expression language for manipulation of strings, numbers 
and booleans, so that users can exercise fine control over the harvesting and aggregation of XML data. 

XPath models an XML document as a tree of nodes with parents and children. The nodes include element 
nodes, attribute nodes and text nodes. XPath uses an addressing scheme that resembles the directory/file 
path-specification conventions of some file systems, in that a slash separates parents from children. The 
following familiar constructs apply:

/ (forward slash) – a separator between a parent and child element in the tree
. (dot) – the current location in the tree
.. (dot dot) – the parent location in the tree

An XPath address is often called an expression and is evaluated in reference to a context. A context in 
Integration Manager is usually a DOM such as Input, Input1, Input(n), Temp or Output. A context in 
Integration Manager can also be a Group name which itself is simply an alias or shorthand for an XPath 
expression.

Who Is the Target Audience for XPath?
XPath is intended to be used by all users of Integration Manager for almost all tasks needed in processing 
XML documents. In some cases, as a programmer, you may find XPath insufficient in its addressing 
capabilities. In these cases, you may choose instead to use the more granular DOM methods, (described 
in “About DOMs” on page 320) for addressing an XML document. If XPath and DOM both prove 
inadequate then you can always choose to process an XML document directly with a Java program.

When Would I Want to Use XPath?
You can use XPath expressions whenever you want to reference an element (or attribute) or group of 
elements (attributes) in an XML document. In particular, you will use XPath expressions frequently in 
Map actions in order to specify inputs and outputs for data transfer between XML documents. You will 
also use XPath in Group declarations (which create a list of tree nodes matching an XPath expression) 
and Repeat for Element actions, which create an alias name for a repeating pattern of elements in a 
document.

You can also use XPath expressions in the custom ECMAScript expressions you create. Integration 
Manager provides a special bridge method called XPath() that allows you to use XPath expressions within 
ECMAScript functions. A typical syntax is:

Input.XPath(“ROOT/PARENT/CHILD”)
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Notice that the XPath() method is parented off the DOM object, which in this example is named Input. 
Also notice that the argument to XPath() is a string. (It can be either a literal, static string, or a string 
variable.)

How Is XPath Integrated into Integration Manager?
XPath is the fundamental addressing mechanism in Integration Manager. It is integrated directly into 
Integration Manager via the dialogs for such actions as Map, Repeat for Element, and Group (plus many 
others). In these actions, an XPath is specified as two parts: a context and an expression. The XPath 
context represents the “base address,” relative to which evaluation of the rest of the expression should 
occur. In most cases this is simply the name of a DOM (Input, Input1, Temp, Output, etc.), which 
represents the root in an XML document (that is, the Document object).

The expression part of an XPath specifies, in top-down order, the chain of elements that leads to the node 
(or list of nodes) to be processed.

An XPath is created in Integration Manager automatically by Map actions created via drag and drop. You 
can specify XPath expressions yourself in Map Action dialogs using the XPath Expression Builder, 
which provides pick-lists of valid XPath statements. You can access the XPath expression builder by 
pressing the Expression Builder button (shown below) whenever the XPath radio button is selected in a 
dialog:

Integration Manager integrates XPath with ECMAScript by the special method .XPath(). This allows 
you to address parts of an XML document using XPath syntax within the ECMAScript language.

Integration Manager also provides the concept of groups in conjunction with XPath. When you declare a 
group name, it is associated with an XPath pattern that occurs multiple times in a document. This results 
in two special lists of nodes in the tree. The first list is a Group containing one entry for each unique node 
value found in the XML document based on the pattern. You can then set up a Repeat for Group loop that 
processes actions once for each group.

The second list is a Group(Detail) containing one entry for each member of each group (unique or not). 
You can then set up a Repeat for Group loop that processes actions once for each group member

Looking at an XPath Example

XPath in the Map Action

In the above example, the context is the “Input” DOM. The XPath expression is 
INVOICEBATCH/INVOICE/INVOICEHEAD/INVOICENO, specifying the element location of 
INVOICE NO as a child of INVOICEHEAD, which is a child of INVOICE, which is a child of 
INVOICEBATCH.
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XPath in ECMAScript

In the above example, the context is the XML document object “Input1” which uses the method 
“.XPath( )” to specify a location of INVENTORY_STATUS/SKU and convert it to a text string (source 
XML). This text string object can then be manipulated using ECMAScript methods.

XPath in Groups

In the above example, the group name “srgSELLERNAME,” creates a list of nodes based on the unique 
data values in the XPath “$Input/INVOICEBATCH/INVOICE/SELLERNAME.” This list of unique 
nodes can then be processed by a Repeat for Group loop action to map data based on the unique group 
values instead of the individual values of each member of each group.

XPath Functions
By way of augmenting XPath’s literal-addressing capabilities, XPath’s designers built an expression 
language into the specification, to allow sophisticated filtering, introspection, and aggregation of node 
sets. XPath, in fact, predefines more than two dozen convenience functions (see Table ) that natively 
recognize four data types: string, number, boolean, and node-set. The use of these functions in 
conjunction with ordinary XPath addressing gives the XML developer a powerful tool for manipulating 
XML data.
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Note that all of these functions are exposed in Integration Manager’s Expression Builders, complete with 
rollover (tooltip) help.

XPath Functions

Node-Set Functions

number last() 

number position() 

number count(node-set) 

node-set id(object) 

string local-name(node-set) 

string namespace-uri(node-set) 

String Functions

string name(node-set) 

string string(object) 

string concat(string, string, string*) 

boolean starts-with(string, string) 

boolean contains(string, string) 

string substring-before(string, string) 

string substring-after(string, string) 

string substring(string, number, number) 

number string-length(string) 

string translate(string, string, string) 

Boolean Functions

boolean boolean(object) 

boolean not(boolean) 

boolean true() 

boolean false() 

boolean lang(string

Number Functions

number number(object) 

number sum(node-set) .

number floor(number) 

number ceiling(number) 

number round(number) 
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While a detailed discussion of the use of XPath functions is beyond the scope of this Guide (see instead 
the complete XPath specification at http://www.w3.org/TR/xpath), a few quick examples will illustrate 
the power and elegance of the XPath expression language:

For more XPath examples, see the “Action Examples” project that ships with Integration Manager.

Documentation Resources for XPath
You can find detailed information regarding XPath at the following Web site: 
http://www.w3.org/TR/xpath.

The W3C XML Path Language (XPath) documentation is also provided in the \Docs directory of 
your Integration Manager installation.

XPath Expression Meaning

//* The node set consisting of all 
nodes in the document

count(//*) The number of nodes in the 
document

count(//*[contains(name(),'myNode
')])

The number of nodes in the 
document whose name contains 
the (sub)string “myNode”

name(//*) From the set of all nodes, find the 
name of the first node of the 
document, in document order. 
(That is, find the root node’s 
name.)

//*[name()='myNode']/@* Starting with the set of all nodes, 
find a node whose name is 
“myNode” and obtain the value of 
the first attribute under that node, 
in node order.

name(//*[name()='myNode']/@*) Obtain the name of the first 
attribute node found in the node 
‘myNode’

concat(//*[name()='myNode4']/@*,' 
is what was found')

Combine the value stored in the 
first attribute that occurs under 
the element “myNode4” with the 
string “ is what was found”.
Custom Scripting and XPath Logic in Integration Manager 313

http://www.w3.org/TR/xpath


About XSL
The following section describes writing custom scripts that use XSL .

What is XSL?
Extensible Stylesheet Language is a language for transforming XML documents into other kinds of 
documents.As a stylesheet language, XSL includes an XML vocabulary for specifying formatting. 

Unlike HTML, element names in XML have no intrinsic presentation semantics. Without a stylesheet, an 
XML delivery process has no way of knowing how to render the content of an XML document other than 
as an undifferentiated string of characters. XSL provides a comprehensive model and a vocabulary for 
writing understandable stylesheets using an XML syntax. 

The functionality of XSL is augmented by XSLT (XSL Transformations), which is a non-presentation-
oriented transformation language for manipulating XML structure. XSLT makes use of the expression 
language defined by XPath for selecting elements for filtering, conditional processing, and generating 
string values either supplied from a source XML document or by the stylesheet author.

Who is the Target Audience for XSL?
Users who are interested in XSL are webmasters, eCommerce site builders, portal builders, and anyone 
else in need of a graphical representation of XML documents as part of business-to-business transactions.

Given an XML document, designers can use an XSL stylesheet to express how that structured content 
should be presented; in other words, how the source content should be styled, laid out, and/or paginated 
onto some presentation medium, such as a window in a Web browser or a hand-held device, or a set of 
physical pages in a catalog, report, pamphlet, or book.

When Would I want to Use XSL?
XSL is designed to permit XML delivery devices to display XML in a way that is meaningful to humans. 
XML data exchanges often involve user interactions—Web shopping experiences, data auditing, 
notifications, and other XML uses requiring a graphical display of data. In short, you would use XSL 
whenever you need to make XML presentation-enabled.

How is XSL Integrated into Integration Manager?
XSL is integrated into Integration Manager by means of the XSL Transform Action, which is available 
in all components. To use the action, you need to specify parameters for a source DOM, an XSL 
Stylesheet, and a destination DOM (for example, Temp or Output). See the next section for an 
illustration.

Integration Manager also provides special XSL methods for use in Custom Scripts or Function Actions:

transformNodeViaDOM() 
transformNodeToObject(,)
transformNodeViaXSLURL()

See the API descriptions further below for details on these methods.

Web services that you create using Integration Manager can also be set up to output XSL-transformed 
XML directly as HTML. 
314   Integration Manager User’s Guide



Looking at an XSL Example
The Process XSL action shown below uses the XSL stylesheet specified in the XSL URL field to 
transform the input Part, placing the result into an XML element called “MyHTML” in the output doc.

For additional examples of how to use XSL, be sure to see the “Action Examples” project in your 
Integration Manager installation.

Resources for XSL
You can find detailed information regarding XSL at the following WEB site: 
http://www.w3.org/TR/xsl

XSL documentation (from W3C) is also provided in the \Docs directory in your Integration 
Manager installation hierarchy.
For working examples in Integration Manager, see the “Action Examples” project in your 
Integration Manager installation.

About Novell Scripting Extensions
The Novell extensions to ECMAScript consist of a set of convenience methods for general purpose 
scripting involving xObjects, DOMs, and other Integration Manager objects. All of the methods are 
exposed in the Expression Builder pick-lists. An introduction to the API is given below.

General Purpose Extensions

The general purpose extensions are categorized by the type of objects they operate on and consist of the 
following:

Node

XML—This property returns a string representing the DOM.

createXPath(XPathType asPattern)—Creates the XPath pattern.

getXML ()—This property returns a string representing the DOM.
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Document

text—This property returns a concatenated string of all the text nodes (content) under it.

setDTD(node RootElementName, object PublicName, object URL)—Sets DTD file for the document.

setValue(Object aValue)—Sets the Value of a Document from the passed object, if it is in another 
document, then this method copies child nodes (elements and attributes). If passed object is text, it is 
parsed to create a DOM.

toString()—Converts a DOM document to an XML formatted string.

transformNodeViaDOM(XSLDOM)—Transforms the document according to the XSLDOM and returns a 
string. The parameter XSLDOM is an XSL stylesheet, that may have been read into the component by an 
XML Interchange Action. This method could be used in the source of a Map Action, or call it in a Servlet 
using the Server Framework class IGXSXSLProcessor.

transformNodeToObject(XSLDOM, OutputDOM)—Transforms the document according to the XSLDOM 
and returns results to Output DOM. The parameter XSLDOM is an XSL stylesheet that may have been 
read into the component by an XML Interchange Action. The parameter Output DOM is the target DOM 
for the results. From a component, this method could be in a Function Action, or from a Custom Script, 
you can use it once you have all three DOMs, or call it in a Servlet, using the Server Framework class 
IGXSXSLProcessor.

transformNodeViaXSLURL(XSLURLLocation)—Transforms the document according to the 
XSLURLLocation and returns a string. The parameter XSLURLLocation is an XSL stylesheet. This 
method could be used in the Source of a Map Action, or from a Custom Script you can use it once you 
have a DOM, or call it in a Servlet using the Server Framework class IGXSXSLProcessor.

validate()—XPathTypes can be of type NodeList, String, Number, or Boolean. Usually used to return a 
Nodelist matching the XPath pattern. Use brackets to select a particular node from the list [for 
example,.Input.XPath("INVOICE/LINEITEM[1]") or Input.XPath("INVOICE/LINEITEM[last()]")]. 
Use the @ to select a node by attribute (e.g. Input.XPath("INVOICE/LINEITEM[@myattr]"). To select 
by attribute value...Input.XPath("INVOICE/LINEITEM[@myattr='abc']").

Nodelist XPath(XPathType asPattern)—XPathTypes can be of type NodeList, String, Number, or Boolean. 
Usually used to return a Nodelist matching the XPath pattern. Use brackets to select a particular node 
from the list [for example,Input.XPath("INVOICE/LINEITEM[1]") or 
Input.XPath("INVOICE/LINEITEM[last()]")]. Use the @ to select a node by attribute [e.g. 
Input.XPath("INVOICE/LINEITEM[@myattr]")] To select by attribute 
value...Input.XPath("INVOICE/LINEITEM[@myattr='abc']").

Element

text—This property returns the concatenated text of all the text nodes under it.

booleanValue()—Returns the boolean value (true | false) of this object if possible.

countOfElement(String propertyName)—Returns a count of the named child.

doubleValue()—Returns a double value for this object if possible.

exists(String propertyName)—Check for the existence of the named child.

getIndex()—Returns back the current index.

getParent()—Returns the parent element.

setIndex(int aiIndex)—Sets the iterator index value for this element.

setText(String asText)—Sets the text node associated with this element.

setValue(Object aValue)—Sets the Value of an Element from the passed object, if it is another element then 
this method copies child nodes also (elements and attributes).
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toNumber()—Gets the text node and converts it to a number.

toString()—Gets the text node associated with this element.

Nodelist XPath(XPathType asPattern)—XPathTypes can be of type NodeList, String, Number, or Boolean. 
Usually used to return a Nodelist matching the XPath pattern. Use brackets to select a particular node 
from the list, for example, Input.XPath("INVOICE/LINEITEM[1]") 
or\nInput.XPath("INVOICE/LINEITEM[last()]"). Use the @ to select a node by attribute, for example, 
Input.XPath("INVOICE/LINEITEM[@myattr]") To select by attribute 
value...\nInput.XPath("INVOICE/LINEITEM[@myattr='abc']").

Attribute

text—This property returns the text value of the attribute.

setValue(Object aValue)—Sets the Value of an Attribute from the passed object.

toString()—Gets the text node associated with this attribute.

Nodelist

avg(NodeList)—Returns a number equal to the average value in the NodeList. The NodeList parameter of 
type XPath. If no parameter is supplied, then the current NodeList/GroupName is used.

count([NodeList])—Returns a number equal to a count of the nodes in the NodeList. The optional 
NodeList parameter is of type XPath. If no parameter is supplied (the usual case), then the current 
NodeList/GroupName is used.

min([NodeList])—Returns a number equal to the lowest value in the NodeList. The NodeList parameter of 
type XPath. If no parameter is supplied, then the current NodeList/GroupName is used.

max([NodeList])—Returns a number equal to the highest value in the NodeList. The NodeList parameter 
of type XPath. If no parameter is supplied, then the current NodeList/GroupName is used.

sum([NodeList])—Returns a number equal to the sum of the values in NodeList. The NodeList parameter 
of type XPath. If no parameter is supplied, then the current NodeList/GroupName is used.

where(XPathType asPattern)—Gets a NodeList of nodes matching the XPath pattern.

Component (xObject)

An object called theComponent is exposed within each Integration Manager component via the Expression 
Builder. (You can open the Expression Builder window by clicking the Expression icon in any Function 
action, Map action, or other dialog in which the icon appears.) The component-based methods are 
exposed in the pick-list under Extended ECMAScript/Component, as shown below.
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The object called Component has the following methods:

getName()—Returns the name of the currently executing component. To obtain the name of the currently 
executing component, you would call:

Component.getName()

exportObject(key,value)—Allows you to store a reference to any ECMAScript variable or Java object in a 
hash table so that other components within a given service can look up the object and use it. (Otherwise, 
user variables are scoped to the component in which they are declared and cannot be seen by other 
components.) For example, suppose you have created a variable, testString, and you wish to make it 
available to other components in the same service:

// create an instance of the string:
testString = 'hello';

// now export it:
theComponent.exportObject("myExport", testString)

Note that the hash key “myExport” is simply any arbitrary name. Other components will need to use this 
name to look up the exported object (testString). Within another component, you can do:

var copyOfString = theComponent.getExportValue("myExport");

The component that executes this code will then have access to the string 'hello' that was in the variable 
testString within the other component. 

It is important to understand that variables or objects exported in this fashion are scoped to the service 
instance in which they are created. This means:

When the service ends, the exported objects go out of scope.
Only components that run within the given service can “see” exported variables.

NOTE:  To achieve inter-service scope of session variables, use the putSessionValue() and 
getSessionValue() methods described further below.

It is also important to understand that at design time, exported variables will not be in scope (will not be 
usable) unless the service or component that created them is itself running. Suppose Service A creates a 
variable myVar and exports it as 'myExportedVariable'. Service A calls (executes) Component B. Inside 
Component B is a Function Action that looks up the exported variable:

theVar = theComponent.getExportValue('myExportedVariable’)
318   Integration Manager User’s Guide



In order for theVar to contain the correct value, Service A must already be running and it must already 
have exported myVar. In other words, if you merely animate Component B without running Service A, 
you’ll encounter a problem since myVar is not in scope. The correct thing to do is to begin your animation 
from Service A. Step through Service A until you reach the Component Action that executes Component 
B. Use the Step Into button to step into the action model for Component B. Then step through Component 
B. This way, both A and B are in scope at the same time and any exported variables will be usable.

getExportValue(key)—Allows you to access a reference to any ECMAScript variable or Java object that 
was previously exported by another component. (See discussion above.) 

putSessionValue(key,value)—Allows you to store a reference to a Java object in a global variable so that it 
can be referenced from any other service or component running in the same servlet session (which may 
span many HTTP hits). Objects published in this fashion have servlet-level scope. (Session life is 
dependent on the HTTP Server Session timeouts.) The first argument is a String representing the name 
for the published object. The first argument is a String representing the name you wish to associated with 
the published object. The second argument is the object. (The syntax follows the convention for 
exportObject, shown above.) 

NOTE:  This method will generate an exception if it is used in a Web Service that was deployed using an 
EJB. Also, this method cannot be used in a JMS Service.

getSessionValue(key)—Allows you to obtain a reference to a Java object that was previously published via 
the putSessionValue() method (above). This method will return null if no object matching the key is found; 
otherwise, it returns an Object. 

NOTE:  This method will generate an exception if it is used in a Web Service that was deployed using an 
EJB. Also, this method cannot be used in a JMS Service.

removeSessionValue(key)—Allows you to destroy a reference to a Java object that was previously 
published via the putSessionValue() method (above).

NOTE:  This method will generate an exception if it is used in a Web Service that was deployed using an 
EJB. Also, this method cannot be used in a JMS Service.

LDAP Methods

getLDAPAttr(String connResource, String dn, String attr)—Looks up a value stored in a particular attribute of 
a named object in an LDAP directory, using the connection resource whose name is supplied in the first 
argument. The second argument is the object’s LDAP distinguished name. The third arg is the attribute 
of interest. The value returned may be numeric or String data. Use ECMAScript’s typeof operator to 
determine if the value is of type “number” versus type “string.” 

The getLDAPAttr() method is available for use in any component, service, or connection resource, 
whenever ECMAScript can be used. (In other words, its use is not limited to LDAP Components.) Other 
ECMAScript extension methods involving LDAP are available only within the LDAP Component editor. 
See the separate LDAP Connect User’s Guide for more information on those methods.

Connector-Specific Extensions

Additional custom ECMAScript objects and methods beyond those described here are available in 
conjunction with most Connect products. (For example, JMS-specific methods are available for use in 
components and services created using the JMS Connector.)

Consult the appropriate Connect documentation for details about connector-specific ECMAScript 
objects and methods.
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When Would I Want to Use Novell Scripting Extensions?
Use Integration Manager’s general purpose extensions wherever you find them helpful and /or where 
they are more robust than similar methods in XPath, DOM or XSL.

You might want to use some of Integration Manager’s grouping or aggregation-related extensions when 
you want to summarize common data that repeats but is scattered about an XML file. For instance, an 
XML file may arrive with 50 randomly organized invoices, generated by only seven departments in your 
organization. Using Integration Manager’s grouping capability and group-oriented methods, you can 
easily organize the 50 invoices by the departments and summarize “invoice totals” across each group.

How Are Novell Scripting Extensions Integrated into Integration Manager?
The general purpose extensions are built right into ECMAScript and appear on the Expression builder 
pick-lists alongside other objects, properties and methods.

Integration Manager’s Group action is used to specify Groups by simply clicking a pick-list to generate 
an XPath pattern that forms the basis for the group. There is a Repeat for Group Action that allows you 
to process a set of actions for each member of the Group or Group(Detail). The aggregate calculation 
methods are available in the ECMAScript Expression Builder in the Map dialog.

The types of actions described here are available in all Connect component types.

Extension Code Examples
See the “Action Examples” project in the \Samples directory of your Integration Manager installation for 
examples of how to use ECMAScript in Integration Manager to accomplish a wide variety of tasks. 

About DOMs

What is DOM?
The Document Object Model is an interface that allows programs and scripts to dynamically access and 
update the content, structure and style of XML documents. W3C’s Document Object Model (DOM) is a 
standard internal representation of an XML document structure inside a software program and aims to 
make it easy for programmers to access elements, attributes and data and delete, add or edit their content 
and style.

What Does a DOM Do? What are the Key Features?
The DOM defines a set of standard methods and properties for creating and operating on XML 
documents programmatically as objects. It provides methods for manipulating all parts of an XML 
document including Elements, Attributes, Text, Processing Instructions, etc.

The DOM also provides a set of methods for addressing or locating nodes in an XML document.

Who is the Target Audience for DOM Methods?
The DOM methods and programming model is targeted at professional developers who need absolute 
control over DOM manipulation. Working with DOM methods gives developers control over primitive 
operations involved in constructing and manipulating DOMs. A simple Map action in Integration 
Manager might translate to tens of lines of ECMAScript/DOM instructions.
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When Would I Want to Use DOM Methods?
You may wish to use DOM methods when the basic Integration Manager actions combined with 
ECMAScript functionality cannot meet your XML document processing needs.

How Are DOM Methods Integrated into Integration Manager?
The methods and properties of the DOM for manipulating Integration Manager DOMs are available only 
in the Custom Script editor or ECMAScript expression builder in Actions. You can access the 
ECMAScript Expression builder by pressing the Expression Builder button whenever the Expression 
radio button is selected in a dialog.

Looking at a DOM Methods Example
See the Custom Script function titled dbIOtoDOM() in the Database.es file in the directory 
\NIM6\Composer\Samples\CustomScripts.
See the sample project “Expressions” for a full treatment of all the DOM methods/objects.

Documentation Resources for DOMS
You can find detailed information regarding DOM at the following WEB site: 
http://www.w3.org/TR/2000/REC-DOM-Level-2-Core-20001113/

About Java Integration
Java is more than merely a programming language. It’s a computing platform designed to allow the same 
software to run on different kinds of devices: PCs, Unix workstations, wireless devices, handheld 
computers, consumer electronics, and embedded systems of various kinds. Using networks, it is possible 
to create distributed applications using Java that tie together diverse devices into a single working 
application. 

In addition to being a computing platform in its own right, Java is a robust, object-oriented computer 
language that forms the basis of the Java 2 Enterprise Edition (J2EE) computing architecture, which is 
increasingly preferred by IT organizations because of its adaptability, robustness, platform neutrality, and 
track record of successful adoption by large companies. J2EE is also firmly connected to emerging 
standards in the areas of XML and Web Services, which makes Java an ideal enterprise-programming 
language.

How Is Java Accessible in Integration Manager?
Java is integrated into Integration Manager services through the ECMAScript scripting environment, 
which provides a direct bridge to external Java objects. Integration Manager provides a Java class 
browser in the Custom Script editor with drag-and-drop functionality, enabling you to quickly integrate 
Java objects and use their constructors, properties, and methods within your scripts.

When Should You Use Java?
Most Integration Manager users will be able to achieve their Web Services and XML integration 
objectives without needing to augment Integration Manager’s native functionality through the use of 
custom Java classes. Nevertheless, there are situations where it may be desirable to integrate Java objects 
into Integration Manager. For example:
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You want to access (reuse) existing Java business objects, some of which may access data in other 
computing environments or programs
You want to provide an XML interface to your own Java business objects
You need to perform complex manipulations of XML documents that are more effectively handled 
by Java than with Integration Manager actions or ECMAScript
You’ve prototyped a concept using ECMAScript and now want (for reusability and/or performance 
reasons) to implement the same concept in Java

Looking at a Java Integration Example
A simple use of Java in an XML application may be to perform a case-insensitive comparison of data in 
two XML elements. In this case, you could create a Custom Script function using the Java string object 
as follows:

// Case Insensitive Compare, returns 0 if strings are equal, non-zero if not…
function nonCaseCompare(string1,string2)
{
var s1 = new Packages.java.lang.String(string1);
var s2 = new Packages.java.lang.String(string2);
return s1.compareToIgnoreCase(s2);
}

Then you might use the function in a Decision action to conditionally execute different actions, as the 
illustration shows.

Documentation Resources for Java
You can find detailed and definitive information regarding the Java platform and the Java programming 
language at the following Web site: http://java.sun.com 
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12 Applying Actions to Common Tasks

Actions are the atomic units of work in all Integration Manager components. They are responsible for the 
control flow and logical constructs that make custom applications possible. As you might expect, some 
actions are used more than others, and certain design patterns reoccur frequently in Web Service 
applications created with Integration Manager. This chapter discusses some of the actions and design 
patterns you’re most likely to encounter when using Integration Manager.

About the Examples in this Chapter
The Integration Manager design-side installation includes a few sample projects, one of which is called 
ActionExamples.spf. The project contains sample documents called InvoiceBatch*.xml. This chapter’s 
examples are based on using the InvoiceBatch template as Input to XML Map components.

If you’d like to follow along as you read the examples, you can open ActionExamples.spf from the 
Integration Manager File menu. The file is located in:

\Samples\ActionExamples\ActionExamples.spf

You can find other Action Model examples like the ones in this chapter in the Tutorial project.

About Element and Data Mapping
One of the powerful tools in Integration Manager is element mapping. You can map elements between 
DOM trees with different structures, allowing you to pass data between XML documents.

NOTE:  For a summary of the basic mapping behavior in Integration Manager, see the table “Map Type” 
on page 139.

Mapping Leaf Elements
Many of the element mappings you create with Integration Manager will be between leaf elements 
(terminal nodes) of two DOMs. For instance, you might map a product SKU in the Input Part to a product 
part number in the Output Part. When the service executes, the transfer between the two Parts takes place 
and the SKUs from the input XML document are written to the part numbers in the output XML 
document.

One method of mapping two leaf elements is to select them in the Input and Output panes of the XML 
Map Component Editor and add a Map action.

NOTE:  By default, Integration Manager’s Map actions transfer element data, but not attribute data.
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To map leaf elements using the Action menu:

1 Open a component.
2 Select a line in the Action Model pane where you want to place the Map action. The new Map 

action will be inserted below the line you selected.
3 In the Input pane, expand the Input Part until you see the leaf element you want to map.
4 Select the leaf element.
5 Repeat steps 3 and 4 in the Output pane.
6 From the Action menu, select New Action, then Map.
7 When the Map dialog box appears, click OK. The mapping from input element to output element is 

created automatically.

You can also use Integration Manager’s drag and drop feature to map an input leaf element to an output 
leaf element, as explained next.

To map leaf elements using drag and drop:

1 Open a component.
2 Select a line in the Action Model pane where you want to place the Map action. The new map 

action will be inserted below the line you selected.
3 In the Input pane, expand the Input Part until you see the leaf you want to map.
4 In the Output pane, expand the Output Part until you see the leaf you want to map.
5 Select the Input leaf element.
6 While holding the left mouse button down, drag the Input leaf element on top of the Output leaf 

element.
7 Release the mouse button. The Map action appears in the Action Model pane.

Mapping a Parent and its Children (Deep Copy Mapping)
The second way you can map elements is to map a parent element to the target Part. When a parent 
element is mapped, all of its child elements and their attributes are included in the mapping. For instance, 
suppose you select a parent element named Line_Item, and it has child elements that include Item_SKU, 
Item_Description, Item_Quanity, and Item_Cost. Suppose you map the Line_Item element to an element in the 
Output Part named PO_Line. The resulting map action transfers the Line_Item element and all its child 
nodes to the PO_Line element in Output, retaining the original branch’s structure.

NOTE:  The default mapping behavior of Integration Manager’s Map action can be overridden. See 
“Advanced Mapping Options” on page 140.

To map a parent element and all its children:

1 Open a component.
2 Select a line in the Action Model pane where you want to place the Map action. The new Map 

action will be inserted below the line you selected.
3 In the Input pane, expand the Input Part until you see the parent element you want to map. 
4 Select the parent element.
5 Repeat steps 3 and 4 in the Output pane.
6 From the Action menu, select New Action then Map.
7 When the Map dialog box appears, click OK.

You can also use Integration Manager’s drag and drop feature to map an input parent element to an output 
parent element, as explained in “To map leaf elements using drag and drop:” on page 324.
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The third way to map elements is to map a parent element without its descendant elements. In essence, 
you are mapping the high-level data and ignoring the data and its descendants. For instance, if you map 
an element named Invoice and it contains descendant elements, the Output Part will only receive data 
pertaining to the invoice element.

To map a parent element without its child elements:

NOTE:  Since the default Map action behavior is to transfer descendant elements, you need to create and 
apply an ECMAScript method to the element name to map only the element.

1 Open a component.
2 Select a line in the Action Model pane where you want to place the Map action. The new Map 

action is inserted below the line you selected.
3 In the Input pane, expand the Input Part until you see the parent element you want to map. Select it.
4 Do the same in the Output pane.
5 From the Action menu, select New Action then Map.
6 When the Map dialog box appears, select Expression and click the Expression builder button in the 

Source.
7 Type the following in front of the XPath fragment: Input.XPath(“

8 Enter the XPath fragment.
9 Type the following at the end of the XPath fragment: “).toString()

10 Click OK twice.

The following illustration shows a Map action for a parent element without its child elements.

Transforming Elements
There will be times when you want to map two elements that have different formatting. For instance, the 
element leaf in the Input DOM might be formatted with four numbers and uppercase characters 
(1234CAT) while the output element leaf might be formatted with lowercase characters and six numbers 
(cat001234). 

Integration Manager provides three methods for transforming element formatting so data can be mapped 
appropriately between DOMs. The three methods are all available from the Map Action:

The Content Editor
Code Table Maps
Functions
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Transforming Elements With the Content Editor
The Content Editor allows you to change the format and content of the input element to match that 
required by the output element. Using the Content Editor, you can slice the input data into small parts, 
move the parts to different locations relative to one another, add new parts, omit some parts, and apply 
functions to individual parts.

To access the Content Editor:

1 Open a component.
2 Select the two elements to map from different Parts.
3 From the Action menu, select New Action then Map. The Map dialog box appears.

4 Click the checkbox beside the Content Editor button. This enables the Content Editor button.
5 Click the Content Editor button. The Content Editor appears.

6 Optionally click the New Sample button and enter a sample string. 

Dismiss the dialog.
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7 In the Sample field, move the top slider to the position where you want the first cut to take place 
and the bottom slider to the position where you want the end cut to take place. The sliders 
determine how to take a substring from the input data.

8 Click Apply. The substring is copied to the Result field as a separate object. 
9 Repeat steps 6 through 8 for each part of the sample you want, in the result in the order you want. In 

this way, you can build a new string out of portions (substrings) of the original input.

To change the format of an object in the Result field:

1 Select an object.
2 Click Modify. The Content Region Modify dialog box appears.

NOTE:  The Start Cut at Character(s) field displays that character in the string where the first cut 
will take place. The first Occurrence field displays when the cut will take place. In the previous 
illustration, the first cut will take place at the first occurrence of the letter T. The End Cut at 
Character(s) field displays that character in the string where the last cut will take place. The second 
Occurrence field displays when the cut will take place. The Offset field displays the number of 
characters from the beginning of the original string where the object will start. The Length fields 
displays the length of the object.

3 The Script Expression field supports the ECMAScript expression builder. Any content region 
created by the Content Editor can have the full functionality of the expression builder applied to it.
NOTE:  The %r is a local variable representing the content region to which you would like to apply 
a function. For example, if you want to apply the uCase() function to the content region, you would 
write the Script Expression as: uCase(%r).

4 You can assign a constant to an object by highlighting it, checking the Constant box, and typing a 
constant string.

5 Click OK to apply any format changes.

When you are finished mapping string formats with the Content Editor, click OK to save the changes and 
close the Content Editor.

Transforming Elements With Code Tables
Mapping with Code Tables allows you to automatically transform one set of codes used in the Input Part 
into another set of codes used on the Output Part. In order for you to transform elements with Code 
Tables, you must have already created Code Tables and Code Table Maps. 
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To transform elements with Code Tables:

1 Open a component.
2 Select two elements to map.
3 From the Action menu, select New Action then Map. The Map dialog box appears.

4 Click the checkbox beside the Code Table Map button.
5 Click Code Table. The Code Table Map dialog appears.

6 Select a Code Table Map.
7 Click OK to assign the Code Table Map.
8 Click OK again to save the Map action.

Transforming Elements With Functions
You might come across situations where the Content Editor is not sufficient to transform element format 
structures. For instance, you might want to extract the month number from a date format (i.e. 5/23) and 
convert it to the month name (May 23). You can perform custom transformations by creating 
ECMAScript and XPath custom functions and applying them to element expressions.

Integration Manager comes with a library of sample custom script functions organized in the following 
categories:

String
Math
File
General
Date
Database
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You can import a category of functions from the \NIM6\Composer\Samples\CustomScripts 
subdirectory.

To apply an ECMAScript custom function to an XPath expression:

1 Open a component.
2 Select an input and output element to map.
3 From the Action menu, select New Action then Map. The Map dialog box appears.
4 Open the XPath expression builder.
5 Use the pick-lists to navigate to the custom script function you want and double click.

6 Edit the expression as necessary to make it syntactically correct.
7 Click OK to add the Map action.

NOTE:  When transforming element data within a Map action using a function, make sure that the result 
of the function returns a fully qualified DOM element name.

If you want to transform an element’s data outside of a Map action, use the Function action. See “The 
Function Action” on page 133.

“Userfunc:” is a bridge Novell extension method that allows you to use ECMAScript function on XPath 
expressions. XPath also has limited set of native functions categorized as Node-set, String, Boolean, and 
Number. These functions do not require the use of the userfunc: keyword. 

Using Loops in Action Models
In the chapter on Advanced Actions, you read about the three Repeat actions and how they are used to 
perform iterative processing within an Action Model. This section further explains the Repeat actions 
and shows how they are used to read, map, and write data Input and Output Parts.

The Repeat action has three types of loops. They are:

Repeat for Element
Repeat for Group
Repeat While
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The Repeat for Element Action
XML allows multiple instances of an element in a document. The number of instances can vary from 
document to document. For instance, you might receive an XML document containing invoices on a 
daily basis. Each day the XML document has a different number of invoices. Not knowing how many 
instances of the invoice are in the XML document poses a problem if you want to transfer the invoice 
number from each invoice in the input XML document to an output XML document. The Repeat for 
Element action solves this problem.

The Repeat for Element action allows you to mark an element that occurs multiple times. The action then 
sets up a processing loop that executes one or more actions for each instance of the marked element until 
no more exist. In the example above, the processing loop would contain a single Map action to transfer 
the invoice number.

The Repeat for Element processing loop allows you to process more than one action. In the simplest case, 
the repeat loop might only contain one Map action that transfers the value of the current instance from 
the Input DOM to the Output DOM. You can also set multiple actions in the processing loop: a Map 
action to transfer the current value and a Log action that writes to a file, creating an audit of each transfer.

The first step in adding a Repeat for Element action is to position the cursor in the Action Model pane 
where you want the repeat processing to take place.

To add a Repeat for Element action:

1 Open a component.
2 Select a line in the Action Model pane where you want to place the For Element Repeat action. The 

new action is inserted below the line you selected.
3 In the Input DOM, select the first instance of the element that repeats.
4 Using the context menu, select Repeat for Element. The Repeat for Element dialog box appears.

5 Type an alias name for the Source element.
6 Accept the default XPath, or select Expression, and type in a valid expression.
7 Repeat steps 4 through 6 for the Target.
8 Check the Always create new output elements box if you have repeating actions which should 

add new elements rather than updating existing ones.
9 Click OK.

Once the Repeat For Element action is created, you can add a Map (or any other) action within the loop. 
For instance, to simply transfer the invoice number element from an input XML document to an output 
XML document, define a Map action as shown in the following illustration:
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Notice the use of the repeat alias as the XPath context. The alias is defined in the Repeat action and 
resolves to an actual DOM name and path.

The Source field specifies that data from the location in the Input Part 
(seINVOICES/INVOICEHEAD/INVOICENO) will be transferred to a location in the Output Part 
(teMYINVOICES/INVOICENO).

The Repeat for Element action and the Map action should appear in the Action Model pane as shown in 
the next illustration.

The Repeat for Group Action
The format of an XML document that you receive is not always the format that will meet the 
requirements of your business process. For instance, an XML document might contain invoices from 
different sellers. The data is received as individual invoices, but in the context of a business-to-business 
transaction, you might need to summarize the data and send the summary data to a manager, and at the 
same time, send the invoice data to the Accounts Payable department.

A Repeat For Group action allows you to re-structure your data and establish a framework to calculate 
aggregates on your data. Grouping allows you to select a repeating element in your Input Part and create 
fewer elements based on the unique values across all instances (siblings) of that repeating element. 
Instead of multiple seller elements across the invoices (some with the same seller value), you end up with 
one element for each unique seller value in our Output Part.

The Repeat For Group action sets up a processing loop that executes for each unique value in the group. 
Once you have one element per seller, you can add Map actions to the processing loop to calculate how 
many invoices each seller had. You can also list the individual invoice numbers beneath each seller. By 
combining a Repeat For Group processing loop with Map commands, you can create a new XML 
document whose structure and data are different from the original.

To create an action Repeat For Group, you need to complete these three tasks:

Create a group to identify the repeating element.
Create an action Repeat For Group.
Create Map actions inside the loop.
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To create a group:

1 Select the element in the Input Part on which you want to repeat.
2 Click the right mouse button and select Declare Group. The Declare Group Info dialog box 

appears.

3 In the Group Name field, type in the alias name you wish to use to reference the group by in your 
Map actions.

4 If you want to create multiple group levels, select a group in the Parent Group field.
5 The Group Elements/Attributes field specifies the full name of the element you selected. If you 

wish, you can add other elements to this list, thus creating groups based on the concatenation of two 
or more values in different elements.

6 Click OK to save the group. A Declare Group line appears in the Action Model.

Once you have created a group based on an Input Part element, you can create a Repeat For Group action.

To create the Repeat for Group action:

1 Select a line in the Action Model where you want to place the Repeat for Group action. The new 
action is inserted below the line you selected.

2 From the Action menu, select New Action>Repeat then Repeat for Group. The Repeat for Group 
dialog box appears.

3 The Source fields specify the basis for the processing loop. Select the group you wish to use as the 
basis for the loop.

4 The optional Where Script Expression field allows you to selectively omit some repeating 
elements from the group processing. Type an expression, or click the Expression Builder button, 
and write an ECMAScript expression that determines which elements participate in the group.

5 The optional Target fields allow you to specify the position in the Output Part to place data mapped 
within the Repeat for Group action. Give the Target an alias, select a Part and specify an XPath. 
This alias is used as the target context for Map actions within the loop.
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6 Click OK to complete the Repeat for Group action.

Once the Repeat for Group action is created, you can add one or more Map actions within the loop. The 
following illustration shows a Map action using groups as the Input and Output Part elements.

Notice the use of the dot. It indicates the current location, which is whatever the context 
“sgTHESELLERNAME” resolves to (defined in a Declare Group action earlier in the Action Model).

The Repeat for Group action and the Map action should appear in the Action Model pane as shown in the 
next illustration.

The Repeat While Action
The Repeat While action creates a processing loop based on any criteria you wish to define. This gives 
you a different kind of flexibility in creating repeat loops than do the Repeat for Element and Repeat for 
Group actions, both of which base their looping on data in a document or DOM.The Repeat While action 
allows you to base your processing loop on any valid XPath or ECMAScript expression.

For example, you could base the execution of your loop on an ECMAScript expression that looks at the 
system clock to determine when to break out of the loop. In another example, you could base your loop 
on the existence of files in a directory. In this case, the actions within the loop will process the files and 
the loop will only break when no more files are present.

To create a Repeat While action, you need to perform the following tasks:

Select a place in the Action Model pane where you wish to place the Repeat While action.
Create the action.
Create one or more actions inside the Repeat While action.
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To add a Repeat While action:

1 Select a line in the Action Model where you want to place the Repeat While processing loop. The 
loop is inserted below the line you selected.

2 From the Action menu, select New Action>Repeat then Repeat While. The Repeat While dialog 
box appears.

3 The While Script Expression field is where you type an ECMAScript expression. When it 
evaluates to false, the execution of the loop will stop. You can also press the Expression Builder 
button and type an expression or select from a list of pre-written expressions.

4 The Index Variable field allows you to create a name for a loop counter. This counter is 
incremented each time the loop executes. You can capture its value in the While Expression to 
further control the loop processing.

5 Optionally, you can enter Target information. Enter an alias and select either XPath and a DOM 
element, or Expression and type in a valid expression. You can also click the Expression Builder 
button and build an expression.

6 Click OK to complete the Repeat While processing loop.

Once the Repeat While processing loop is created, you can add one or more Map actions within the loop. 
The following illustration shows a Repeat While loop with two Map actions.

Performing Aggregate Calculations
The aggregate calculations include the following examples which can be found in the component named: 
[008] aggregate calculations in the Action Examples project.

Calculating a sum
Finding the highest total
Finding a specific match for the highest total
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Calculating a Sum
Suppose you have a component that is handling the processing of invoices, and you want to calculate the 
sum of line item totals (before taxes) across all invoices.

A simple ECMAScript expression using an XPath syntax does the trick. Create a Map action and select 
the Expression radio button for Source. Type the following ECMAScript expression:

$Input.XPath(“//LINETOTAL”).sum()

For the Target, select Output, and specify an XPath to receive the result:

MYINVOICEBATCH/LINEITEMTOTALa. 

The Source expression uses the XPath // pattern symbol to select all Input nodes regardless of parentage 
labeled LINETOTAL, and then applies a Novell aggregate method: sum().

NOTE:  Because no XML template was specified for the Output, it will be built dynamically (i.e, if a Map 
Action does not find the element specified in the “Map To” control, it will be created).

Here is an example of what the action looks like:

Finding the Highest Total
Suppose you have a component that is handling the processing of invoices, and you want to find the 
highest total of the invoice amounts.

To find the maximum of an element across multiple INVOICEs, you can specify the “max” method in a 
Source specification. This establishes the context for the max() function. Then you can continue the 
specification down to the point of the DOM tree where the element you are interested in finding the max 
of resides “TOTALS.INVOICETOTAL.”

Here is an example of what the action looks like:

Finding a Specific Match for the Highest Total
Continuing with the previous invoice example, suppose you want to select the one invoice that matches 
the highest total.

To look across all INVOICEs but only select one of them, you can specify the “where” method in a 
Source specification, (the where method implies that you will be processing each INVOICE). The 
specification continues by comparing TOTALS\INVOICETOTAL for each INVOICE against the “max” 
of all the TOTALS.INVOICETOTALs. The max is found and compared against the value of each 
INVOICE. Once the match is found, the specification continues to retrieve the INVOICENO. 

Here is an example of what the action looks like:
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13 Testing and Debugging

Novell Integration Manager provides many aids to testing and debugging. In fact, in most cases you’ll 
find it possible to do end-to-end animation (complete roundtrip testing) of all services in your project 
without having to deploy to the app server. Document input/output, XML transformations, transaction-
control logic, logging, etc., can be tested in real time using “live” connections to back-end systems. Since 
Integration Manager’s design-time/debug-time environment executes against exactly the same Java 
classes that are used in the Integration Manager Enterprise Server environment, you can have high 
confidence that if a service is trouble-free in the design-time setting, it will operate reliably on the app 
server. 

Among the powerful testing and debugging features offered by Integration Manager are:

Robust step-into/step-over animation capability, allowing you to execute a component’s action 
model one line at a time (and pause or abort animation at any time)
Assign unlimited breakpoints and use run-to-breakpoint animation to get quickly from one 
breakpoint to another
Create “watch lists” of variables and XML elements whose values you want to observe in real time, 
at various points in an execution cycle
Highly fine-tunable logging capability
Fault documents and a “Throw Fault” action for flexible exception handling.
Try/On Fault action allows you to trap exceptions, handle them gracefully, and continue executing
“To-do lists” for keeping track of pending-action items
Conditional enablement of debug code 
Indirection of test values through Project variables

These features and strategies for their use will be discussed in this chapter.

What are the Animation Tools?
Integration Manager’s service and component editors provide animation tools that allow you to test and 
troubleshoot actions interactively within your services and components. You can execute a service or 
component’s Action Model step-by-step and watch the result of each action. Not only will you see any 
errors as they happen, but you can verify that connections and data have behaved as you had planned.

For concentrating one particular section of an Action Model, the animation tools allow you to toggle one 
or more breakpoints. When used in conjunction with the run-to-breakpoint tool, breakpoints allow you to 
quickly run through action-model sections that work properly, coming to a stop at exactly a particular 
action, From there, you can step through each action in sequence. You can also, optionally, step over 
loops, Component Actions, and other code blocks that would otherwise be tedious to “step into.”
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The Basic Animation Tools
The animation tools are available on the service and component editor Action Model tool bars. In 
addition to the Action Model tool bars, the editors provide menu options on Integration Manager’s 
Animate menu, as well as corresponding keyboard commands. The table below describes the various 
tools and their functions.

Animation 
Toolbar 
Button Description

Start Animation—Clicking this button starts the animation 
process. Optionally, you may select Animate>Start Animation 
or press the F5 key.

End Animation—Clicking this button stops the animation 
process. Optionally, you may select Animate>End Animation 
or press the Shift + F5 keys.

Step Into—Clicking this button executes the currently selected 
action and highlights the next sequential action. If the currently 
selected action is a Component, Repeat, Decision, or Try/On 
Fault action, then the next highlighted action becomes the 
details of those actions. For a Repeat Loop pressing Step Into 
will execute each action in the loop as well iterate through each 
loop. For a Decision Action, Step Into will process the next 
action in the True or False branch. For the Try/On Fault action, 
Step Into will process the next action inside the execute, and 
possibly the On Fault branch. For a Component action, a 
separate window will open and you will “step into” that 
component. Optionally, you may select Animate> Step Into or 
press the F7 key.

Step Over—Clicking this button executes the currently 
selected action and highlights the next sequential action. 
Unlike the Step Into button, clicking this button does not 
highlight and execute the details of Component, Repeat, 
Decision, or Try/On Fault actions. For a Component action a 
separate window will NOT open when another service or 
component is called. It simply executes the call and moves 
onto the next sequential action; you essentially “step over” the 
called service or component, or Repeat, Decision, or Try/On 
Fault action. Optionally, you may select Animate> Step Over 
or press the F8 key.

Toggle Breakpoint—Clicking this button sets the highlighted 
action in the Action Model as a breakpoint. You may set more 
than one breakpoint. Other ways to Toggle a breakpoint 
include selecting Animate>Toggle Breakpoint, pressing the 
F2 key and clicking with the RMB while in the action model.

Run To Breakpoint/End—Clicking this button runs the 
animation to the next breakpoint or to the end of the Action 
Model. Optionally, you may select Animate>Run To 
Breakpoint/End or press the F9 key.

Pause Animation—Clicking this button pauses the animation. 
Optionally, you may select Animate>Pause Animation or 
press the F6 key.
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Starting Animation
When you first open a service or component, the Start Animation and Toggle Breakpoint tools are the 
only “enabled” tools; the others are dimmed. Once you click the Start Animation button, the remainder 
of the Action Animation tools become enabled and you can click them at any point. If you want to halt 
the animation temporarily, you can use the Pause button. Likewise, if you want to abort the animation, 
you can do so at any time by clicking the red “End Animation” button.

CAUTION:  Although Copy, Paste, and action editing operations (including adding new actions) are all 
available at animation time, we recommend that you not edit the action model during animation. If you do, 
exceptions and/or unpredictable behavior may occur. If you need to edit the action model, use the Stop 
button to abort the animation first, then apply your edits; then begin the animation again.

To start the animation:

1 Open a service or component. The service or component appears in its respective editor.

2 Click the Start Animation button in the Action pane’s tool bar, or press F5 on the keyboard. All of 
the tools on the action tool bar become active, except for the Start Animation button, which is now 
dimmed.

3 Follow the instructions in the sections below to perform the desired Animation activity.

Toggling a Breakpoint
The Toggle Breakpoint tool allows you to set a breakpoint in the Action Model where you’d like the 
process to stop. This is especially helpful if you have a lengthy Action Model with long sections that 
work properly. You can set the breakpoints at the beginning of each action that is causing a problem and 
then step through the action to troubleshoot it.

To toggle a breakpoint:

1 Open a service or component. The service or component opens in its respective editor.
2 Adjust the Action pane as necessary to view its content.
3 In the Action pane, select the action where you’d like the breakpoint to be. This is where the 

animation will stop.

Start Animation 
Button
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4 Click the Toggle Breakpoint button on the Action Model tool bar, or press F2 on the keyboard. 
The action you select changes to a red background with white text.

5 If desired, repeat steps 3 and 4 to select additional Breakpoints.
6 If it is not grayed out, click the Start Animation button on the Action Model tool bar. (If Start 

Animation is grayed out, you can choose another animation tool to complete the animation process 
from the current breakpoint.) The following changes occur when you click Start Animation:

The Start Animation button becomes inactive
The remainder of the buttons on the Action Model tool bar become active
The cursor moves to the beginning of the Action Model and highlights the object’s name, for 
example, “ProductInquiry.”
The action you selected as your breakpoint changes to a white background with red text

7 Follow the instructions in the sections below to perform additional animation processes.

Running To a Breakpoint
The Run to Breakpoint tool works in conjunction with the Toggle Breakpoint tool to let you control the 
animation process. When you have a lengthy Action Model it is helpful to be able to control how long 
you want the animation process to run and at which point you’d like the process to stop. The Run to 
Breakpoint allows you to do just that.

To run the animation to a breakpoint:

1 Open a service or component. The service or component you open appears in its respective editor.
2 Adjust the editor’s panes as necessary to view the Action pane’s content.
3 Select the action that you’d like to be the breakpoint for your test.
4 Click the Toggle Breakpoint button on the Action pane tool bar, or press F2 on the keyboard.
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5 Click the Start Animation button on the Action pane tool bar, or press F5 on the keyboard. The 
Action pane of the service or component you’ve opened should look similar to this:

6 Click the Run to Breakpoint button on the Action pane tool bar, or press F9 on the keyboard. The 
animation process runs all of the actions prior to the breakpoint, then stops and highlights the 
breakpoint in red, as shown.

7 Follow the instructions in the sections below to continue the animation process.

Stepping Into an Action
The Step Into tool runs the highlighted action in the Action Model and then moves to the next action in 
the sequence, even if it is inside another component. (In other words, if the next action is a Component 
Action, the target component opens and animation continues at the first action in that component’s action 
model. You can use the Step Into tool to step through each action in the entire Action Model, or you can 
use it in conjunction with the Run to Breakpoint tool. Execution stops at the next breakpoint or when the 
action model ends, whichever comes first.

A possible scenario for using a breakpoint would be if you have ten actions that you know work properly 
but have doubts about the eleventh. You could set the eleventh action as a breakpoint, execute the Run to 
Breakpoint tool, and then step through the eleventh (and subsequent) action(s) by executing the Step Into 
tool.

NOTE:  When a service or component is called from an Action Model and a separate editor opens to 
display the called object, you must step through that object’s Action Model to completion, at which point it 
closes and you return to the original Action Model. 

Run to Breakpoint button
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To run the Step Into tool:

1 Open a service or component. The service or component appears in its respective editor.
2 Adjust the panes as necessary to view the Action Model’s content.
3 Click the Start Animation button on the Action pane tool bar, or press F5 on the keyboard. The 

Animation tools become active and the object’s name is highlighted in the Action Model.

4 Click the Step Into button on the Action tool bar, or press F7 on the keyboard. The first action 
becomes highlighted.

5 Click the Step Into button again. The action executes and the next action becomes highlighted.
6 Continue to work through the Action Model by clicking the Step Into button after each action 

executes and the subsequent action becomes highlighted.
7 When an action that calls another service or component becomes highlighted, click the Step Into 

button. The following results:
A new window opens and displays the appropriate editor (that is, service or component).
The Action pane displays with all tools (except “Start Animation”) active. 

8 Click the Step Into button on the Action pane tool bar of the called component.
9 Continue to click the Step Into button to execute all of the actions in the called component. When 

you’ve executed all of the actions, the window closes and you are returned to the point in the 
original Action Model where you left off and the next action is highlighted.
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10 Continue to click the Step Into button to execute all of the actions in the original service or 
component. When you are done, a message appears.

NOTE:  An Action Model may call one or more components, and each component may call 
components as well. In each occurrence of a called component, the animation tools work exactly the 
same. For example, you may want to Toggle a Breakpoint within a called component and then 
perform a Run to Breakpoint in the original service or component. The Action Model begins to 
execute its actions, opens the called component, and then stops at the breakpoint you’ve set.

Stepping Over an Action
The Step Over tool is useful when you don’t want to step into the details of the Component, Repeat, 
Decision, or Try/On Fault actions. 

For a Component action, it means you avoid the potentially timeconsuming opening of a separate editor 
to continue animating through the target component. The Step Over tool simply executes the target 
component and then highlights the next action in the Action Model. 

Similarly, for blocks of code wrapped in Try/On Fault, Repeat, or other control-flow actions, using Step 
Over means you can execute an entire block of code at once without stepping individually through each 
action (which could get tiresome inside a loop). 

You’ll often find it handy to use the Step Over tool in conjunction with the Run to Breakpoint tool. For 
example, you could toggle a Breakpoint, execute the Run to Breakpoint tool, and then use the Step Over 
tool to execute the action you’ve designated as the breakpoint. The Step Over tool can save a great deal 
of time when testing lengthy Action Models, since you can avoid tediously stepping through individual 
actions that might not be of interest to you.

To use the Step Over tool:

1 Open a service or component. The service or component appears in its respective editor.
2 Adjust the panes as necessary to view the Action Model’s content.
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3 Click the Start Animation button on the Action pane tool bar. The Animation tools become active 
and the object’s name is highlighted in the Action Model.

4 Step through the Action Model with the Step Into button until you reach a loop or other line of 
code that precedesan indented code block. 

5 Click the Step Over button on the Action tool bar, or press F8 on the keyboard. The first action 
after the block of indented code becomes highlighted. (All of the indented code will execute 
normally and you will be taken straight to the next “outdented” action, without needing to step 
through the indented action lines individually.) 

6 Continue to work through the Action Model by clicking the Step Over button as necessary.
7 Continue to click the Step Into and/or StepOver buttons to execute all of the actions in the Action 

Model. When complete, a message appears.

Pausing Animation
The Pause Animation tool allows you to pause the execution of an action in the Action Model. This is 
especially helpful in cases where Action Models contain lengthy loops.

To pause the animation:

1 During the execution of an action, click the Pause Animation button on the Action pane’s tool bar, 
or press F6 on the keyboard.

2 To resume the animation process, click the Step Into, Step Over, or Run to Breakpoint (if a 
breakpoint has been set) as desired.

CAUTION:  Although Copy, Paste, and action editing operations are available when animation is 
paused, we recommend that you not edit the action model during animation. If you do, exceptions may 
occur.
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Aborting Animation
The Stop Animation tool simply stops the animation process. Once you stop the animation, you cannot 
restart from the place where you left off: you must restart from the beginning of the Action Model.

To stop the animation:

1 While the animation is in progress, click the Stop Animation button on the Action pane’s tool bar, 
or press Shift + F5 on the keyboard. The following message appears.

2 Click OK.

Execution Errors
If an action does not execute correctly, an error message appears.

You can click the Details button to read more about the problem encountered. This will give you the full 
Java stack trace.

Error messages are also written to the System Log, which is viewable from the Integration Manager View 
menu. 

NOTE:  Integration Manager’s Log (or Output) pane will also show messages. To get the most 
comprehensive reporting of messages to the Log tab, set the Log Threshold to one in the General tab 
under Tools > Preferences. Also, check the Show Stack Trace checkbox in the same dialog.
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Clearing All Breakpoints
Once you have your action model working properly you will want to run through it from start to finish 
without interruption. To do this, you’ll need to eliminate any breakpoints you had previously set. All your 
breakpoints can easily be removed at once using the Clear All Breakpoints menu option. This can be 
accessed in two ways:

1 From the Animate menu, select Clear All Breakpoints
2 While in the Action Panel of the Component Editor, right-click to bring up the contextual menu. 

Select Clear All Breakpoints.

Resetting All Documents
You may find it desirable or necessary, during a testing or debugging session, to reset the component’s 
input, output, temp, and fault documents to their original states. You can do this manually by using the 
Reload XML Documents command under the Component menu on the main menubar. 

Clearing a Document
You can completely clear a document, including its root node, programmatically, using ECMAScript. 
Insert a Function Action that contains code similar to the following:

Temp.removeChild( Temp.firstChild );

Execute the statement using the Execute button on Integration Manager’s main toolbar, or use the Apply 
button in the Function Action dialog. You will see the contents of the Temp document (in this case) “zero 
out.” 

NOTE:  The removeChild() method and the firstChild property are standard DOM ECMAScript extensions 
defined by W3C. You can use these and other methods to remove, add, or modify any portion of a 
document’s structure in any action that uses ECMAScript. See Chapter 11, “Custom Scripting and XPath 
Logic in Integration Manager”, for more information.

Testing Tips 
You may find it useful to leverage one or more of the following techniques when testing and debugging 
action models: 

The ECMAScript alert() function, as well as java.lang.System.out.println()
Project variables as a way of conditionally enabling debug code
Watch list (data values that you want to watch at animation time)
Try / On Fault actions
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Fault documents

Each of these is discussed below.

Using the ECMAScript alert() Function
You may want to inspect a data value before and/or after running a map or other type of action. To do so, 
you can create Function actions that contain the ECMAScript alert() function. The alert function displays 
a message box with a value you specify. 

In the following example, an alert function action has been constructed so as to display a confirmation 
value of true. 

NOTE:  You will want to disable any actions that use the alert() function prior to deploying your project to 
the app server environment. The alert() functionality is of use in design-time testing only. It should not be 
allowed to execute after deployment to the app server.

Using a Project Variable to Turn Debugging On or Off
If your component or service contains many debugging related actions, you can ensure they do not run 
when your project is deployed. One way to do so is to create a project variable that can be used in a 
Decision action to decide whether to execute your debugging actions. Then place all your debugging-
related actions inside Decision actions in your components.

Another tactic is to use a direct call into one of Integration Manager’s internal methods to determine 
whether the current environment is a runtime one versus a design one:

gDebugMode = !Packages.com.sssw.b2b.rt.GNVxObjectFactory.isRuntime();

This is an example of using ECMAScript to call a custom Java method. The result here is that the 
(component-scoped) variable gDebugMode contains true if the component is running in Integration 
Manager at design (or animation) time, but false if the component is running in a deployed project on a 
server.

An example of using this “sentinel variable” to decide whether it’s okay to call alert() is shown below:
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NOTE:  Log Actions are also invaluable for debugging and can be controlled easily via the General tab of 
the Preferences dialog. See “The Log Action” beginning on page 134.

Watch Lists
You can watch specific data values change at animation time by adding one or more variables or data 
nodes to a watch list. 

The watch list is visible when you bring the Watch tab (in the output pane, at the bottom of Integration 
Manager’s main window) to the front. 

The Watch list is essentially an in-memory XML document (DOM) to which “watched” data items can 
be added or deleted. Watch-data updates in real time as you step through a component or service. Of 
course, the Watch view is strictly a design-time aid: It does not exist at runtime (on the server).

Watch-List Persistence and Scope 

You can create a Watch list for each component and switch back and forth between components; each list 
is scoped to its own component.

If you add a Watch list variable or variables to a component, then re-Save the component, the Watch list 
will be there again the next time you open the component. The list is persisted along with the component.

You can also Save a Watch list as an XML file at any time. (Use the Save As XML menu command that 
appears in the context menu when you right-click the WATCH node.) This can be useful for 
troubleshooting purposes, since it lets you compare Watch list values at the same point in two different 
execution runs in two different design sessions.

Types of Variables You Can Watch

You can add two types of variables to the Watch view: ECMAScript variables and DOM nodes (for 
example: elements). If the DOM node is not a leaf node, it can be added to the Watch list either as a single 
node or with all its children. (The Watch target can be defined using XPath.)

NOTE:  Watch lists are read-only. You can add and remove items in the Watch window, but you cannot 
change the values of those items yourself. 
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How to Add Items to a Watch List

You can add items to the Watch tree in any of three ways:

By using the Add Watch... menu command under Component (in Integration Manager’s menubar), 
as shown below.

By using the Add Watch command in the context menu that appears when you right-mouse-click 
on any node in the Watch view itself. Note that in addition to the Add Watch command, the 
context menu provides Delete Watch and other commands, as shown here:

By using drag-and-drop: Just pull any node of any XML document that’s visible in tree-view 
mode down to the Watch window and let go out of the mouse. The node(s) in question will be 
added to the Watch list.
NOTE:  The drag-and-drop method is useful for document nodes only. To add ECMAScript 
variables to the Watch window, you must use the Add Watch menu command. See example below.

Step-by-Step Example

The following steps show how to add a variable to a watch list, animate through a Component so as to see 
the variable change value, and delete an item from the list.

1 Open a Component if one is not already open.
2 Click the Watch tab (at the bottom of the Integration Manager main window) to bring it forward.
3 Right-mouse-click the root node (“WATCH”) of the Watch view. A context menu appears. (See 

illustration above.)
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4 Select Add Watch from the context menu. A dialog appears:

This dialog is an expression builder: It lets you construct an ECMAScript expression that evaluates 
to an XPath value. You can do this in point-and-click fashion by choosing appropriate items in the 
pick-lists in the top three panes of the dialog. For example, if you want to add the Input element at 
INV:INVOICEBATCH/INV:INVOICE to your Watch list, using the above example, you would simply 
open the Input tree nodes as shown and doubleclick the appropriate node. The corresponding 
ECMAScript statement appears automatically in the text-edit field, as shown above.
NOTE:  If you are interested in watching an ECMAScript variable, simply type the variable’s name. 
(You must enter it by hand since ECMAScript user variables are not shown in the pick-lists.)

5 Optionally use the Validate button to check the syntax of the expression.
6 Close the dialog by clicking OK. 
7 Notice that the node or variable in question has been added to the Watch view. If the variable is a 

DOM node with children, doubleclick the node (or single-click the plus sign next to it) to toggle the 
node open, exposing its children and their values.

8 Now click the Start Animation button to begin stepping through your action model.

9 As you step through actions that change the values associate with the Watch variable(s), notice how 
the values change.

10 To delete the Watch variable, right-mouse-click the node in question and choose Delete Watch 
from the context menu. The item disappears.
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Environmental Differences between Animation Testing and 
Deployment Testing

There are significant environmental differences between Animation testing in Integration Manager and 
Deployment testing. Both types of testing are needed to adequately verify the components and services 
you build. The differences are detailed in the table below.

Testing in Integration Manager Deployment Testing

OS Win98 or WinNT or Win 2000 WinNT, Sun Solaris, etc.

Platform JRE (Java Runtime Environment) Application Server JRE 

Component or Service 
Startup

Directly from Integration Manager By Service Triggers only (that is, 
deployment Servlets or EJBs).

xObject access From disk files From a JAR file in Application Server

Runtime Context Test individual components or 
components running within a service

Always from within a service

Service and 
Component Inputs

Input documents frequently come 
from sample XML documents on the 
local machine as well as DOMs from 
other services or components

Input documents are passed into the 
services and components via 
Service Triggers, or DOMs from 
other services or components

Project Variables for:

Log File Paths

DTD URLs

XSL URLs

Send Mail Server

XML Inter-change 
URLs

Usually point to locations on local 
machine (but could be on Servers or 
Web)

Should point to locations on 
production Servers and Web

Testing Tools In addition to Log actions, you can 
use dialog boxes (ECMAScript 
alert() function) to display runtime 
values

No dialog boxes can be used

JDBC Connection Doesn’t use Server Connection 
Pools

Uses Server-provided Connection 
pools

HTTP and LDAP 
Connections

May or may not be pointing to local 
machine(s) or test servers

Should be pointing to production 
server(s)
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14 Working with Services

A service is Integration Manager’s basic unit of execution: It is a Integration Manager object (an xObject) 
that wrappers the various components you build, so as to create a logical unit of processing within the 
application server environment—one that’s initiated with a request and results in a response. A service 
typically responds to a request by executing one or more components in a sequential and/or conditional 
manner (and can even execute other services). It can be, but doesn’t have to be, exposed on a URL and 
triggered by a servlet. 

Because the service xObject is the entry point for all web apps built with Integration Manager, it’s 
important that you understand the design philosophy behind services and how Integration Manager’s 
runtime architecture handles services. This chapter will tell you what you need to know in order to build 
and use services effectively.

Terminology
The term Web Service, as used in this discussion, is generic. It refers to any Integration Manager-created 
service running on the app server, whether triggered by a servlet request in an HTTP session, arrival of 
e-mail, direct invocation by a custom Java class, or some other mechanism. It may (but doesn’t always 
have to) refer to a web-facing service that is described by WSDL.

A SOAP service, in Integration Manager, is not a service type per se, but a way of specifying how a 
service needs to be invoked (and how its data needs to be marshalled or unmarshalled) on the server. In 
Integration Manager, you specify SOAP-HTTP as a trigger type. A specialized type of servlet is used to 
trigger the service.

It’s also important to note that a given service can be associated with different trigger types. For example, 
it is possible (though perhaps not likely) that you would deploy a service with several triggers: a servlet-
based trigger that handles data passed via HTTP GET; another servlet (on another URL) that handles data 
arriving via a form field using HTTP POST; and another that expects data passed in a String object, 
programmatically, via a custom application running locally on the server.

What Are the Available Service Types?
In Integration Manager, there are two types of services: Web Services, and JMS Services. (JMS stands 
for Java Messaging Service, a Sun-defined interface for message oriented middleware.) Your project, 
deployed (typically) as an EAR file, might contain one or more of either or both kinds of services. The 
two service types are referenced by two different icons under the “Service” heading of Integration 
Manager’s navigation frame (see below).
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JMS Services
The JMS Service type will not be visible to you in Integration Manager if you have not installed the JMS 
Connect. The Web Service category, however, is always visible.

The defining characteristic of a JMS Service is how it is triggered. If a service that uses enterprise 
messaging will be triggered via the web, it must be created as a Web Service. If it will be triggered by 
arrival of a message, it must be created as a JMS Service.

Service Architecture
A service is actually a specialized type of Integration Manager component. As mentioned earlier, a 
service has an action model and can perform most of the tasks that components perform, including XML 
mapping, looping, logging, fault-trapping, conditional processing based on Decision and Switch actions, 
etc. For reasons of good design, you should limit these tasks to an exception basis only, delegating 
business logic to underlying components. The main actions you should use in a service are Component, 
Log, Decision, Function, Try/On Fault, and Throw Fault. (See “Building a Service with Components” on 
page 361 for examples of how a service uses these actions.) Anything connectivity-related, data-related, 
or implementing business logic, should happen at the component level. 

NOTE:  You can execute any number of components of any type (JDBC, XML Map, LDAP, etc.) in a 
service; and you can fire off those components synchronously (in serial, one-by-one fashion) or 
asynchronously (all at once). Also bear in mind that a service can invoke another service.

Using the service as the basic unit of processing in an application server should be a major goal in the 
design of your Integration Manager applications.

Integration Manager Web Services and WSDL
A Integration Manager Web Service can be, but doesn’t have to be, a WSDL-described service deployed 
on a URL. In simplest terms, a Integration Manager Web Service is merely a component that calls other 
components. What makes it a “service”instead of a component is that the Web Service xObject can be 
triggered via a servlet or Java object on the server, whereas Component xObjects are not triggerable this 
way. (Components are called by services.) What makes a service a “Web Service” in the conventional 
sense of the term is exposure of the service as an endpoint as described in an associated WSDL file.

A Integration Manager Web Service can implement any of the interaction patterns alluded to by WSDL: 
notification, one-way, request-response, or solicit-response. It can be deployed on a public URL or it can 
be executed as a local app. It can be associated with WSDL, or not; and it can accept SOAP requests, or 
not.
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Looking at an Example Web Service
The following picture shows the parts and function of a Web Service and is explained below.

In the drawing, the large rectangular grey box represents a Web Service. The shaded oval shapes with 
numbered text represent actions in the Action Model. The input and output XML files (squares) and the 
called components (small rectangles outside the service) are visible.

The purpose of this service is to receive an invoice (in an industry standard format) and to notify the 
sender that the invoice was received. Accomplishing the service requires some manipulation of the 
invoice, which is received as an XML document.

Here is how the service works.

1 The service is invoked by its Service Trigger (an object created at deployment time, designed to 
start a service in response to some external event). The servlet can be started by a business partner's 
application server issuing an HTTP Post to the servlet; or, alternatively (as shown by the longer 
grey arrow), the servlet could be invoked programmatically by a Java process on the host server.

2 The first job of the service, in this example, is to execute a Log action to write a file to record the 
activities of the service as they are executed.

3 The service then executes a Component action to call the Convert to My Format component. 
4 The Convert to My Format component uses an industry standard invoice format as input and 

returns an XML file formatted to the company’s internal format (My Format), as output. 
5 The service executes another Component action to call the Send Email component. The My Format 

file is the input for the Send Email component.
6 The Send Email component executes several actions (extracts an email address from the invoice 

using the XML Interchange action, sends an email using the Send Mail action, and so on) and 
returns an XML file, eMail.

7 The Company standard format file is output by the service.
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Looking at an Example JMS Service
The following graphic shows the parts and functions of a JMS Service.

It is important to note that the JMS Service does not differ substantially from the Web Service discussed 
earlier; it differs mainly in that it is invoked by the arrival of a message on a queue (or topic, in 
Publish/Subscribe parlance). The JMS Service implements a MessageListener object whose onMessage() 
method is called automatically when a message arrives at a queue or topic with which the listener has 
registered. The onMessage() method executes the service.

The JMS Service must, by its nature, contain one (and only one) Receive Message action, created using 
the JMS Connect. The Receive Message action allows the service to gain access to the incoming 
message’s data and properly acknowledge its receipt.

The remainder of the Action Model is the same for this service as for the preceding Web Service.

NOTE:  This example is relevant only if you have purchased and installed the Novell Integration Manager 
JMS Connect.

Creating a New Service
You create a new service just like you create a new XML Map component. If you have not yet created 
any XML Map components, you must create any required XML templates before creating a service. For 
more information, see “Creating an XML Template” on page 77.

About Specifying XML Templates for a Service
When you create a service, you specify input and output templates, just as you do for a component. If 
your service is designed to call components, rather than process data directly, the input template you 
choose for the service will often be the same template that the first component uses. The output template 
will often be the same one that is output for the final component in the sequence.

If you intend to create a SOAP service that uses custom SOAP headers, you should create XML 
Templates for the headers separately
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To create a new Web Service:

1 From the Integration Manager window File menu, choose New, then xObject, then from the 
Process/Service tab, select Web Service. 
The Create a New Web Service Component wizard appears.

2 Type in a Name and an optional Description. 
You can use the optional description fields to describe the tasks the service performs.

3 Click Next to display the Input/Output Templates panel.

4 Specify the input and output templates as follows. See “About Specifying XML Templates for a 
Service” on page 356 for some tips.

Type in a name under Part if you wish the Message Part name to appear in the Component 
Editor as something other than “Input” or “Output.”
Select a Template Category if it is different than the default category.
Select a Template Name from the list of XML templates in the selected Template Category.
To add additional input XML templates, click Add and repeat steps 2 through 4.
To remove an input XML template, highlight an entry and click Delete.

5 Select an XML template as an output. 
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6 Click Next. The Temp/Fault Templates panel displays.

If desired, specify a template to be used as a scratchpad under the “Temp Message” pane of the 
dialog window. This can be useful if you need a place to hold values that will only be used 
temporarily during the execution of your component or are for reference only. Under the “Fault 
Message” pane, select an XML template to be used to pass back to clients when an error condition 
occurs.

7 As above, to add additional XML templates, click Add and choose a Part Name, a Template 
Category and Template Name for each. Repeat as many times as desired. To remove an input XML 
template, select an entry and click Delete.

8 Click Next. The Input/Output Headers panel displays:

Using the methods described above for adding Input, Output, Temp and Fault Documents, specify 
Input and Output Header Parts for your service if it will be used with a SOAP Service Trigger.
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9 Click Finish. The component is created, and the Service Editor appears.

If your templates have namespace declarations, Integration Manager will generate a Declare 
Namespaces action for you automatically, at the top of your new Action Model.

Creating a JMS Service
Creation of JMS Services occurs via a wizard that has much in common with the Web Service wizard. 
For step-by-step instructions, see the Integration Manager JMS Connect User’s Guide.

Importing a Service
The import feature allows you to create a copy of an Integration Manager service created in another 
project. Once imported, you can customize the service for use within the current project. 

To import a service:

1 Right-click on the Service item in the Integration Manager window, or choose Import xObject 
from the main File menu.
The Import xObject window appears.

2 Select Web Service as the Type, if it is not selected.
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3 In the File Name field, type in the name of the service you wish to import, or use the Browse 
button to find it. If you import a file from a URL, you must explicitly type “http://,” “https://,” or 
“ftp://.”

4 Modify the Service Name if desired.
5 Type in Descriptive information if desired.
6 Click OK to import the service.

Understanding the Service Editor
The Service Editor is (usually) where you specify the execution of components and services as well as 
perform error logging, decisions, and functions. You can also map, transform, and transfer input and 
output structure and data.

The Service Editor provides a logical working environment for visualizing and manipulating the inputs, 
output, and actions of your service. The Service Editor is composed of multiple mapping panes and a 
single Action Model pane. The mapping panes display the DOMs of your sample input and output 
documents. The Action Model displays actions that operate on the DOMs.( This environment is 
essentially the same as the XML Map Component editor.)

Using the Service Editor
The Service Editor has all the same functions as the XML Map Component Editor. For more information 
on using the Service Editor, see the following topics:

“Creating an Output Document without Using a Template” on page 110
“Creating a Temporary Message Part” on page 111
“Reloading an XML Document” on page 114
“Loading a Sample Document” on page 115
“Saving Your Component” on page 117
“Saving a DOM as an XML Document” on page 117
“Viewing Component Properties” on page 121
“Printing a Component” on page 121
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Building a Service with Components
A service is usually made up of one or more Component actions, each of which performs a specific task 
to map, transfer, and/or transform data for use by the next component or service called in the application. 

You use the Component action to call and execute a component or service with runtime input DOMs and 
outputs DOMs that you specify.

To add a Component action:

1 Select a line in the Action Model where you want to place a call to a component or service. The 
new action is inserted below the line you select.

2 From the Action menu, select New Action then Component. The Action Component Information 
dialog box appears.

3 Select Predefined, by clicking on the radio button, if it is not already selected. (See Chapter 7 for a 
discussion of Predefined versus Dynamic Component Actions.)

4 Select a Component Type from the pulldown menu on the upper left.
5 Select a Component Name to execute.
6 In the Passed ID field, select a Message Part.
7 In the Returned ID field, select either Output or Temp for the Message Part.
8 Click OK.

Looking at an Example Service Action Model
When you add Component actions to a service, they appear in the Action Model pane of the Service 
Editor. A service’s Action Model represents the sequence in which components are called. 

An example Action Model is shown below.

The Action Model functions has some logging functions and executes components as follows:
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1 The first component action calls a component (ProductLookup). It specifies the DOM to be 
passed as the input document handle (Input) through which the component receives data from the 
service, and specifies the DOM to receive the component’s output (ProductLookupOutput).

2 The second component action calls a component (InventoryLookup). It specifies the DOM to be 
passed as the input document handle (Input) through which the component receives data from the 
service, and specifies the DOM to receive the component’s output (InventoryLookupOutput).

3 The third component action calls a component (MergeProductAndInventory). It passes the DOMs 
ProductLookupOutput and InventoryLookupOutput which the component receives data from the 
service as its Input and Input1 DOMs, and specifies a service DOM to receive the component’s 
Output (Output).

Service FAQ

How Do I Pass Data Between Different Types of Components?

Integration Manager provides a variety of Connect components that access different computing 
environments. The inputs and outputs of all component types are simply XML documents, This means 
that the communication between different component types is straightforward and simple.

There are two basic methods for passing data between components. The first method uses a service to 
pass and receive the inputs and output from individually called components. In this method, the 
components don’t interact directly, but instead use the service as their point of contact. The second 
method uses the components to call one another directly. Which method you choose depends on how you 
design your services and the types of tasks they perform.

Can Integration Manager Services Accept More than One Input Document?

It depends how the service is deployed. If it is deployed as a SOAP service, your SOAP server may pass 
multiple input documents to your service (if multiple inputs are specified in your service’s WSDL). In all 
other cases involving the four canonical Integration Manager service trigger types—Params 
(URL/Form), XML (MIME multipart), XML (HTML form field), and XML (HTTP POST)—only one 
XML document can be accepted as input. 

For information on deployment, see your Integration Manager Enterprise Server User’s Guide.

Can a Component Be Executed that is not Called Directly by a Service?

If you create a project with one service which calls two components, it is an acceptable design to have the 
first component call a third component before returning its output to the service which then calls the 
second component. Technically speaking, the third component is not “contained within a service” or 
called directly from it. The key idea to understand about a service is that only a service can be called by 
a “Service Trigger” object on the application server. Components don’t have to be directly linked to a 
service, but if a component is not called somehow in the chain of events, it will never execute.

A Service Trigger object is the Java Servlet, EJB, or MessageListener (in the case of JMS) that you create 
with Integration Manager’s deployment framework. This object is triggered by a URL either embedded 
in a Web page or called from another program on the Web. Once triggered, the Servlet or EJB starts an 
Integration Manager service.

Again, for information on deployment, service triggers, framework objects, etc., see your Integration 
Manager Enterprise Server User’s Guide.
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How Do I Call a Service Deployed in a Different JAR File?

Projects are deployed as JAR files, and normally, if any services or components in your project need to 
call on other services and/or components, the “called” services/components will reside in the same JAR 
file. But on occasion, you may find it convenient (or necessary) to have a service call another service that 
exists in a different JAR file (that is, another deployed project). You can do this by means of the XML 
Interchange action. 

The XML Interchange action allows your component or service to output an XML document via HTTP 
GET, PUT, or POST protocols. By supplying the URL for another Integration Manager service, you can 
have your XML Interchange action fire the servlet trigger for the service in question. See the diagram 
below.

In this diagram, Web Service 2 in Project A wishes to call Web Service 3 in Project B. Although Web 
Service 2 can call Web Service 1 directly, since it resides in the same project JAR, it cannot reach Web 
Service 3 directly. Instead, it must execute an XML Interchange action, which fires the service trigger for 
the remote service.

How Do I Log Activity in a Single File for Each Component Called from within a Service?

Log Actions write information about the activities of components within services. To create a single log 
file in which to record the activities of all components within a service, simply specify the same file name 
in the Log to: field for every Log Action used in the service and each component. Refer to “The Log 
Action” on page 134 for more information about Log Actions.

NOTE:  When specifying the same file name for multiple log actions, make sure you do not select the 
Clear the Log File checkbox. Doing so will erase the log file before each log action writes to it. You may, 
however, want to select this option for the first Log Action encountered in the service; this clears the log so 
you can troubleshoot or animate an action model multiple times without continuously appending 
messages to the end of the file.
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Loading Sample Documents as You Test a Service
Similar to using components, the XML template(s) you use as the Input(s) to your service may contain 
multiple sample documents. During testing, as you step through the actions in the service, you can load 
the appropriate sample documents to verify that the service can handle each instance.

For more information, see “Loading a Sample Document” on page 115.
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15 Working with Registries

This chapter discusses the registry browsing functionality provided in Integration Manager. There are 
currently three different models in popular use for registry browsing: UDDI, ebXML Registry Services 
and WSIL. Integration Manager supports all three of these specifications. They are compared briefly 
below, with reference made to sources of additional information. 

The current business registry standard covering Web Services is UDDI (Universal Description, 
Discovery and Integration), which was designed to give businesses a uniform way to describe their 
services, discover other companies' services, and understand the methods necessary to conduct e-
business in an automated or semi-automated way with remote partners. If you need to learn more about 
UDDI, the complete standard can be obtained at http://www.uddi.org. 

In addition to UDDI, Integration Manager supports ebXML Registry Services. ebXML stands for 
(Electronic Business using eXtensible Markup Language). The ebXML Registry and Repository, like 
UDDI, was developed to enable the storing and sharing of information between parties to allow e-
business collaboration. Integration Manager’s implementation of ebXML is made possible using JAXR 
(Java XML Registries). The specification for ebXML can be found at: 
http://www.ebxml.org/specs/#technical_specifications.

Finally, Integration Manager also supports WSIL (Web Services Inspection Language), yet another 
specification for the discovery and publishing of Web services. In the past few years since its inception, 
UDDI has been criticized for its lack of moderation and an inadequate quality of service. WSIL was 
designed to be more lightweight and portable, and, in a sense, to pick up where UDDI leaves off. 
Although this standard has yet to be submitted to one of the standards bodies (W3C and OASIS) it is 
certainly widely-used and gaining in popularity. To find out more, see http://www-
106.ibm.com/developerworks/webservices/library/ws-wsilspec.html.

UDDI, ebXML and WSIL form the basis for the registry management functionality described in the 
pages below. Familiarity with these standards, as well as a general understanding of the publishing and 
discovery of web services will be assumed here. Your web service may use one or all of these models, 
depending on the nature of the application you are developing. 

Capabilities of the Registry Manager
Integration Manager incorporates a Registry Manager, accessible via the Registries tab at the bottom of 
the Integration Manager main navigation frame. There is also a facility for defining registries through the 
Profiles capability (available via Tools> Profiles... in the Integration Manager main menubar). 

The capabilities of the Registry Manager include:

Adding/removing registries 
Selecting registries to include in the search process
Viewing business information on selected businesses in a given registry
Viewing information on Web Services offered by a given business
Searching for businesses or services within a registry or group of registries, optionally using 
extended query parameters
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Publishing new services to a registry

Registries are specified by URL and can be local or web-based. You can add or delete registries via the 
Profiles dialog (Tools menu, Profiles).

To edit or delete a registry:

1 Select Tools> Profiles . . . from the Integration Manager main menubar. The Profiles dialog 
appears.

2 If you are editing an existing entry, select it from the Profile name pulldown menu, then click the 
Edit button. The Edit a Registry Profile dialog will appear, as shown below. After editing your 
selection, click on OK to save.

NOTE:  If you have changed the name during editing, a new registry is created. If you do not want 
to keep the old one, then you must delete it.
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3 If you are deleting an existing entry, select it from the Profile name pulldown menu, then click the 
Delete button. A message will appear to confirm if your selection is the one you intend to delete. 
After deleting your selection, click on Close to save.

To define a new UDDI or ebXML registry:

1 From the Tools menu, select Profiles.
2 In the Profiles dialog window, click on New. The Create a New Registry Profile dialog will appear.

3 Enter a name for the profile in the Profile name field (required). 
4 Select the Registry type from the pulldown menu. The choices are: ebXML, UDDI and WSIL 

(which is described in a separate procedure, since the fields required for WSIL are unique). If you 
select ebXML or UDDI, the screen will look like the one above.

5 In the Inquiry URL field, enter the URL through which the registry can be queried (required).
6 In the Publish URL field, enter the URL via which new services can be published to the registry.
7 Enter the User name and Credential information, if any, that the registry provider assigned to you 

for publishing access.
8 Check the Include in Registry Search checkbox if you wish to include this registry automatically 

in the default search set.
9 Click OK to close the dialog.
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To define a new WSIL registry:

1 From the Tools menu, select Profiles.
2 In the Profiles dialog window, click on New. The Create a New Registry Profile dialog will appear.

3 Type in a Profile name.
4 Select the WSIL Registry type from the pulldown menu. 
5 Use the blue + icon to add additional WSIL registries.
6 Type in a name for the Organization.
7 Type in the fully qualified WSIL URL, ending in “inspection.wsil.”
8 To delete an organization, use the red - icon.
9 Enter the User name and Credential information, if any, that the registry provider assigned to you 

for publishing access.
10 Check the Include in Registry Search checkbox if you wish to include this registry automatically 

in the default search set.
11 Click OK to close the dialog.

Once you have defined an ebXML, UDDI or WSIL Registry Profile in the above fashion, you will be able 
to use it in the Registry Browser tab on the Navigation Pane of the Integration Manager main window. 
You can also publish services to the registry.
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Registry Browsing
Registry browsing is available via the Registries tab in the Navigation Pane of the Integration Manager 
main window. There are two subpanels within the navigation pane: one for organizations (top) and one 
for services (bottom). To the right is the Editor Pane. See illustration.

Context Menu Items
Context menus, specific to each pane in the Registry Manager, are available when using the Integration 
Manager. 

Organization Context Menu

To view the context menu for Organization, place your cursor in a field in the Organization pane and 
click the RMB (right mouse button). The context menu appears as shown.

The function of the context menu items are as follows:

Copy Text—Allows you to copy text from the currently selected business tree node to another area or 
file.

Clear Tree—Allows you to clear the pane of business information that you retrieved from your search.

Delete Organization—Allows you to delete the selected organization from the registry.

Advanced Search—Allows you to set advanced search criteria via the Set Browsing Criteria dialog.

Content
Organizations

Services

WSDL/WSIL/ebXML
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Services Context Menu

To view the context menu for Services, place your cursor in a field in the service pane and click the RMB 
(right mouse button). The context menu appears as shown.

The function of the context menu items are as follows:

Copy Text—Allows you to copy text from the currently selected tree node to another area or file.

Clear Tree—Allows you to clear the service pane of information that you retrieved from your search.

Retrieve WSDL—Allows you to retrieve the WSDL for the currently selected service from the registry. 
This can also be done via the Retrieve button. If the service you selected has no WSDL definition, a 
message will notify you of this condition.

Delete Service—Allows you to delete a service that you highlighted in either the business or service 
Registry.

Advanced Search—Allows you to set advanced search criteria via the Set Browsing Criteria dialog.

Content Pane Context Menu

To view the context menu for Content pane, place your cursor in a field in the pane and click the RMB 
(right mouse button). The context menu appears as shown.

The functions of the context menu items are as follows:

Edit Data—Allows you to change text from the information contained in the pane to another area or file.

View—There are three choices for viewing the information in the Content pane. They are: Tree, Text and 
Stylized. Click on your preference and the information will appear in the pane as such.

Validate—Runs a validation routine to ensure that your XML is sound.

Expand Tree—Displays all nodes in the pane.

Collapse Tree—Hides all nodes except the root node in the pane.

Reload Tree—Allows you to load the original tree.

Find—Allows you to search, via a dialog box, for a specific word or part of a word within the tree.

Find Next—Allows you to search, via a dialog box, for the next word or part of a word within the tree.
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Action Buttons
The following illustration shows the location of the various action buttons on the Organization and 

Service panes. 

Searching by organization
Searching for an organization (or organizations) is a simple matter of entering a complete or partial 
business name in the text field next to Organization, then clicking on the Search button (or “Go” button, 
shaped like a downturned arrow). A list of matching organizations will appear in tree-view form, in 
which each top-level node in the tree is a registry, each child of a registry is an organizationname, and 
underneath each business is detail information consisting of Descriptions, Categories, and Services. You 
can also enter a group of organization names separated by a vertical bar (pipe character), which allows 
you to search for multiple groups of businesses. For example, Silverton|Silicon etc.

To search organizations by keyword

1 To search on an organization name or partial name (or other keyword), enter text into the keyword 
field, then click the Go button (which looks like a downturned arrow). The search will begin. Note 
that while a search is underway, the Abort button (normally greyed out) is red.

2 Searches can take several minutes. If you want to interrupt a search prematurely, click the Abort 
button. Partial search results will show up in the Organization pane.

3 Wait until the search is complete. You will know it is complete when results have shown up in the 
Organization pane and the Abort button has returned to its normal, greyed-out (disabled) 
appearance.
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To set advanced search criteria

1 If you want to set advanced search criteria, do not enter anything in the text field; merely click the 
Advanced Search Button (shaped like binoculars).

The following dialog box appears.

2 You can select only one of the search-criteria groups at a time. The available options are:
Organization Name: Enter enter a complete or partial organization name or list of names 
separated by a vertical bar (|) in the text field next to Starting with.
Identifier: If you choose this option, a new field called Identifier will appear. From the pulldown 
list, select one of the following: D-U-N-S, or Thomas Register (catalog names). Enter a key from 
the catalog (partial or complete) in the text field next to Starting with. This entry can contain 
numeric values and dashes.
Locator: When you choose this option, a new field called Locator appears. From the pulldown list 
select one of the following: NAICS (North American Industry Classification System), UNSPSC 
(United Nations Standard Products and Services Classification) or GEO (geographical). Enter a key 
from the catalog (partial or complete) in the text field next to Starting with, if you selected NAICS 
or UNSPSC. This entry can contain numeric values. Enter a country (region) abbreviation for GEO. 
Alternatively, click the button at the far right of the control, to bring up a “key picker” in which you 
can doubleclick full or partial key names from a prepopulated list. See below.
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Service Type Name: This allows the search of organizations associated with a particular UDDI 
tModel. Enter a key word for this tModel in the text field next to Starting with.
Discovery URL: Enter an IP address or portion of an IP address for the URL in the text field next 
to Starting with.

3 Select the Registry Profile(s) you want to use for this search. The Profiles box contains a list of 
Registries from which you can search. Registries you have previously selected in the Profiles 
dialog box (see description above) will already be highlighted. However, you may override them by 
selecting or de-selecting one or all of the registries within the list. If you decide to return to your 
original (default) registries, click the Reset button at the bottom of the dialog pane. 

4 Under Sort By, you. can select how you want to sort—by Name, or by Date—in either Asc 
(Ascending) or Desc (Descending) order. The most common technique is to sort on Name 
(alphabetically) by ascending order or on Date (numerically) by descending order. Sorting by Date 
works within groups of businesses with identical names.

5 Under Options, you can select Ignore Case and/or Exact Match by clicking in the appropriate 
checkbox. 

6 Click OK. The dialog goes away and your search begins.

After a search, a tree of matching businesses will be built in the Organization pane; the Service subpane 
will be cleared.

NOTE:  Clicking a Service entry in the Organization tree causes that Service’s detail information (binding, 
etc.) to appear in tree form in the lower Service pane. See below.
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Searching by service
Searching for a service (or group of related services) is a matter of entering a complete or partial service 
name or keyword in the text field next to Service, then clicking on the Search button (or “Go” button, 
shaped like a downturned arrow). A list of matching services will appear in tree-view form, in which each 
top-level node in the tree is the registry that was searched; each immediate child of a registry is a service 
name; and children of the service node(s) contain detail information consisting of the Organization name 
associated with the service, a Description of the service, and bindings for the service. 

Wildcards in Registry Searches

The Integration Manager registry search engine supports the use of the percent sign (%) as a wildcard 
symbol, meaning one or more of any character. This is a particularly useful tool when you want to search 
for business or service names that contain a particular word but might not start with that word. 

NOTE:  The default search logic is “Start With.” Thus a search on “Books” will turn up “BooksRUs” but not 
“ABC Booksellers” nor “Used Books”. The way to override this behavior is to search instead on 
“%Books%”, which will turn up all three.

The Integration Manager registry search engine also supports the use of the | symbol as a logical-OR 
symbol, meaning “look for hits that contain any combination of these words.” You can chain together any 
number of keywords this way. For example:

%Booking% | %Travel% | %Airline% 

would return all names that contain at least one of the words, no matter where in the name that word 
might appear.

To search services by keyword

1 To search on a service name or partial name (or other keyword), enter text into the keyword field, 
then click the Go button (which looks like a downturned arrow). The search will begin. Note that 
while a search is underway, the Abort button (normally greyed out) is red.

2 Searches can take several minutes. If you want to interrupt a search prematurely, click the Abort 
button. Partial search results will show up in the Service pane.

3 Wait until the search is complete. You will know it is complete when results have shown up in the 
Service pane and the Abort button has returned to its normal, greyed-out (disabled) appearance.
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To set advanced search criteria

1 If you want to set advanced search criteria, click the Advanced Search Button (shaped like 
binoculars). 

The following dialog box appears.

2 As indicated by the presence of radio buttons, you can select only one of the search-criteria groups 
at a time. The available options are:
Service Name: Click on the radio button next to Service Name. Enter enter a keyword in the text 
field next to Starting with.
Locator: If you select this search criteria, a new pulldown menu appears from which you must 
select a Locator. You have the following choices: : NAICS (North American Industry Classification 
System), UDDITYPE, UNSPSC (United Nations Standard Products and Services Classification) or 
GEO (geographical). Enter a key from the catalog (partial or complete) in the text field next to 
Starting with, if you selected NAICS or UNSPSC. This entry can contain numeric values. Enter a 
country (region) abbreviation for GEO.
Service Type Name: Allows the search of businesses associated with a particular tModel. Enter a 
key word for this Model in the text field next to Starting with.

3 Select the Registry Profile(s) you want to use for this search. The Profiles box contains a list of 
Registries from which you can search. Registries you have previously selected in the Profiles 
dialog box (see description above) will already be highlighted. However, you may override them by 
selecting or de-selecting one or all of the registries within the list. If you decide to return to your 
original (default) registries, click the Reset button at the bottom of the dialog pane. 

4 Under Sort By, you. can select how you want to sort—by Name, or by Date—in either Asc 
(Ascending) or Desc (Descending) order. The most common technique is to sort on Name 
(alphabetically) by ascending order or on Date (numerically) by descending order. Sorting by Date 
works within groups of businesses with identical names.

5 Under Options, you can select Ignore Case and/or Exact Match by clicking in the appropriate 
checkbox. 

6 Click OK. The dialog goes away and your search begins.
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After a search, a tree of matching services is built in the Service pane; the Organization pane is cleared. 
Clicking a service node in the lower (Service) tree causes that business’s detail information to appear in 
tree form in the upper (Organization) pane. 

Retrieving WSDL from the Registry
After you have found the service that you searched for, now you can retrieve the WSDL definition for this 
service from the Registry. Just highlight the desired service node and click the Retrieve WSDL button, or 
click with the RMB and select Retrieve WSDL from the context menu. If a definition for the service 
exists, you see the Contents pane fill with the WSDL information in a tree format (see illustration). If no 
WSDL exists for the service, an alert dialog will appear, advising you of that fact.

NOTE:  You can tell whether a given service listing has WSDL or not by looking at the service icon to its 
left. A ring icon with a globe in it means the service has WSDL. A ring icon with no globe means it is not a 
WSDL web service.
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You can view the information in the Contents Pane as text or in stylized form by simply clicking on the 
RMB and selecting the view you wish to see.

Publishing to a registry
When you have created WSDL using the Integration Manager editor, you can publish it to a registry by 
following the procedures outlined below.

To publish WSDL to a registry

1 Click on the Publish to Registry button on the toolbar as shown below.
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2 A dialog screen, WSDL Publishing Options, appears.

3 Registry Profile: Select the registry from the pulldown list you wish to publish.
Organization Name: Allows you to lookup organizations and select which one to associate the 
service with. If you click the Lookup button, the following dialog appears:

WSDL Publish URL: Shows the URL to which the service will be published to. You can edit this 
if you desire.

4 Click OK and if your service was successfully entered into the registry you selected, you will see a 
message like the one shown below.
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16 Deploying Your Project 

When you’ve completed the design, building, and testing of your project, the next step is to deploy it to 
the application server, where it will execute.

Some of the major topics discussed in this chapter include:

Deploying Directly from Integration Manager (Enterprise Edition only)
For More Information
Server Profiles
The Deployment xObject
Defining SOAP Triggers 

You can deploy projects directly from Integration Manager to any supported app server (JBoss, 
WebSphere, WebLogic, Tomcat). 

The sections immediately following this one will tell you about:

Architectural considerations relevant to deployment
How Integration Manager handles packaging of EAR files and resources
Integration Manager’s design-time UI for creating and managing deployment artifacts (applicable 
to the Enterprise Edition suite)

App-server-specific issues, including administration issues pertinent to deployed Integration Manager 
services, are discussed in a separate document: the Integration Manager Enterprise Server User’s Guide. 
Consult that guide if you have concerns about issues that are not addressed in this chapter.

NOTE:  This discussion assumes some prior knowledge of J2EE deployment concepts, such as JAR 
(Java archive), WAR (Web archive), and EAR (Enterprise application archive) packaging, deployment 
descriptors, etc. If such concepts are unfamiliar to you, you may want to consult books or articles on J2EE 
deployment architecture before proceeding. 

Planning your Deployment 
Before deploying a Integration Manager service, you should consider:

Packaging requirements—Do you want to deploy services individually, straight from Integration 
Manager, into the app-server environment; or will you instead be packaging whole projects 
(containing multiple services) into WAR or EAR files?
Triggering needs—How will your service(s) be fired off? The trigger object can be a servlet, an 
EJB, an EJB triggered through a servlet, a custom Java class that calls your service 
programmatically (directly), or a JSP that uses Integration Manager tag library routines. If you have 
the JMS ConnecForm Resourcet installed, you can also fire a service from a (JMS) 
MessageListener object that “listens” for incoming requests on a queue. If you have the SAP 
Connect, you can trigger a service off an SAP function. (See the appropriate Connect user guides 
for more information.) 
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How arriving data might be packaged—Will the incoming data be in the form of urlencoded 
param/value pairs appended to a URI (that is, HTTP Get)? Will your service trigger handle 
incoming XML via HTTP Post with multi-part MIME attachment? Will your service be a SOAP 
service? Will the SOAP payload be encrypted or digitally signed?
Shared resources—Do you want to deploy some resources, such as WSDL, JSP, JAR, XSL, or 
XSD files, as published resources so that other Integration Manager services can share them?

These are just some of the considerations will affect how you deploy your Integration Manager-created 
services. For some types of services, you will also want to consider connection pooling, container-based 
transaction management, directory storage of passwords and public key info, and perhaps other items as 
well.

About Service Triggers
A service trigger is a process (such as a servlet or bean) that initiates execution of a Integration Manager 
service in response to some kind of input. The input may arrive via HTTP, but could also be an e-mail 
arriving via SMTP or a JMS message arriving at a queue. Various kinds of Integration Manager triggers 
are available to handle various kinds of requests arriving via various transports. 

The following trigger types are supported by Integration Manager:

E-mail—A process on the server polls a mailbox at a specified interval and kicks off a Integration 
Manager service when an e-mail meeting certain size limits arrives in the mailbox.
EJB—The trigger is an Enterprise Java Bean (which responds to programmatic requests).
EJB with servlet—The trigger is an EJB invoked by a servlet. The servlet “listens” on a URL, 
handles HTTP requests, and uses the bean to mediate interaction with a Integration Manager 
service.
File—A process on the server watches for the arrival of files in a particular location on a physical 
drive. When a file arrives, the Integration Manager service fires.
JMS—The trigger is a JMS listener. Arrival of a message at a topic node causes the Integration 
Manager service to fire.
JSP—The trigger is a Java Server Page containing scriplets that can call a Integration Manager 
service directly. 
SAP Service—Execution of an SAP function causes a Integration Manager service to fire.
Servlet—Arrival of a request over HTTP causes the trigger to invoke a Integration Manager 
service.
SOAP HTTP—Arrival of a SOAP request causes the service to fire.
Timer—A daemon process on the server causes a Integration Manager service to fire at a set 
interval.

In addition to these “event-oriented” trigger types, it is possible for a custom Java class to invoke a 
Integration Manager service directly. 

Triggers and Input Data
In a contractual sense, triggers have two responsibilities: They not only listen for specific events (whether 
it’s the arrival of an HTTP request, arrival of e-mail, etc.) and take action on them; but they also must 
harvest and “hand off” XML data to the Integration Manager service. To do the hand-off, the trigger has 
to know how to collect the data over the transport in question and package it in a form Integration 
Manager can understand. Various helper classes (included in the Integration Manager Server installation) 
are available to help a trigger servlet marshall/unmarshall data appropriately. (Those classes are 
described in more detail in the discussion at “Converter Classes” in the appendix on JSP tag-library 
methods.)
380   Integration Manager User’s Guide



For example, a servlet can acquire data as part of an HTTP GET, or as part of HTTP POST. In the simplest 
case, user data consists of name/value pairs attached to the end of a URL (that is, a request arriving by 
HTTP GET). But data can arrive in other ways as well, such as a SOAP request; XML via HTTP POST 
where XML is embedded in a form field; XML via HTTP POST with XML constituting the entire 
content portion of the stream; or XML via HTTP POST as multipart-mime attachments. Integration 
Manager will also let you define triggers that fire when e-mail is received. In that special case, XML 
arrives in the form of an e-mail attachment.

In the discussions that follow, familiarity with the basic trigger types available in Integration Manager is 
assumed. If you are not already familiar with Integration Manager’s trigger architecture, consult the 
Integration Manager Enterprise Server User’s Guide. 

About Integration Manager-Built Deployment EARs
At deployment time, Integration Manager packages all of the deployable services in a project into an 
EAR (Enterprise application archive). This is the so-called “deployment EAR.” Its contents are as shown 
below.

When you deploy directly from Integration Manager, the following steps happen automatically (in the 
order shown):

1 Integration Manager packages your deployable resources—including the metadata (XML) 
describing your services—into a Project JAR. This JAR, along with the files mentioned below, is 
written to a staging directory (typically a subdirectory in your project directory).

2 Integration Manager creates a WAR file containing two items: a manifest that points to the 
foregoing JAR, and a web-xml file that describes all of the trigger servlets that apply to your 
deployed services (as well as URL bindings for them), so that the app server knows how to find and 
expose your services.

3 The JAR and WAR files are packaged into a deployable EAR. 
4 The EAR is uploaded from the staging area to your app server.

The last step varies in implementation depending on the type (and version) of app server to which you are 
deploying. In some cases, Integration Manager will create and execute a batch file that carries out the 
steps needed to put the EAR (and any deployment descriptors) on the app server. In other cases, 
Integration Manager Enterprise Server will “pull” the deployment EAR onto the server. In all cases, 
Integration Manager will (as part of Step 4) launch your web browser and lead you through a short series 
of forms, where you will provide any user-ID, password, or other information the server may need in 
order for the deployment to finish normally.

It may or may not be necessary to restart the server after deploying the EAR (this varies by app server; 
consult your app server’s documentation). 
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NOTE:  You should ensure that the app server and Integration Manager Enterprise Server are running 
before undertaking any kind of Integration Manager deployment.

Creating EAR, WAR, and JAR Archives
Integration Manager can package your project into EAR, WAR, and JAR archives and write them to disk. 
You can later work with these archives in a J2EE tool of your choice or install the files manually into an 
app server environment of your choice, etc. 

To create EAR, WAR, and JAR archives from within Integration Manager:

1 Using the File menu, select the Archive Project command. A dialog appears.

2 Use the Deployment Object dropdown menu to select the Deployment Object applicable to the 
application you wish to archive.

3 Choose the Server Profile that corresponds to the intended deployment environment. (Use the 
New, Edit, or Delete buttons as necessary.)

4 Click the Archive button to initiate the archiving process, or Cancel to abort.

When Integration Manager has finished creating archives, you will find them under the staging folder 
that you previously specified when creating your deployment object. (To see this preference, open the 
Deployment Object in question and use File > Properties to view its setup params.)

Deployment Options
You can use Integration Manager’s native design-time UI to package and install deployable objects for a 
given project. This method is the easiest and quickest way to deploy Integration Manager-built web 
applications. 

Another option is to build JARs, WARs, and/or EARs manually (or with a third-party tool) and install 
your deployment objects “by hand,” following the procedures recommended by your app-server vendor. 
This option should be considered only when you need low-level control over the deployment process for 
one reason or another. 
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Deploying Directly from Integration Manager
The basic steps involved in deploying your project from the Integration Manager design-time 
environment are:

1 Create a Server Profile
2 Create a Deployment Object
3 Set up Service Triggers and Resources for your Web Service
4 Prepare Objects for Deployment
5 Deploy the EAR to the server

Server Profiles
Server profiles define a target server and the necessary server-specific information required for 
deplyoment to that server. Creation of a server profile is a necessary prerequisite for deployment of a 
Integration Manager project to the app server (regardless of app server type: JBoss, Tomcat, Novell 
exteNd App Server, WebSphere, or WebLogic). 

NOTE:  Server profiles are not project-level resources. They are stored in a properties file and are 
available for use with all projects you create using a given installation of Integration Manager.

Before creating your server profile, you should make sure that the application server to which you will be 
deploying is running and has the Integration Manager Enterprise Server (and any necessary Connects) 
installed and running as well.

To create a Server Profile

1 Select Tools>Profiles from the Integration Manager menu.
2 From the Profiles dialog, select the Servers tab.

3 Click on New... to create the new Server profile. A dialog appears:
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4 Specify a Profile Name. The name you type will be used to identify this particular profile when 
you deploy your project.

5 Select a Server Type from the drop-down list. The choices are:
JBoss 4.0.x
WebSphere 4.0 and 5.0
Tomcat 4.1
WebLogic 8.1
WebLogic 6.1
Novell exteNd 4.0 or 5.2
Novell IDM 2

NOTE:  Consult the Novell website for the latest application server support.

The fields in the “Server Specification Information” area of the dialog will change according to 
which Server Type you specify in this field.

6 In all cases, you will need to provide a Server Name. In the example above, localhost:80 was 
entered, since this refers to a locally installed exteNd Application Server.

If you selected a WebSphere or WebLogic Server, you will also need to identify Target Servers. 
If you select an exteNd Application Server, you will also need to specify a database name to be 
used for deployment.
For Tomcat Servers, no other Server Specification information is required.

7 Enter a User Nameand Password if your server requires authentication. 
8 Click the checkbox if you would like to use this Server Profile as your default.
9 Click OK to create the new server profile.

NOTE:  To modify existing server profiles, go to Tools > Profiles and select the Servers tab. Select the 
profile you wish to change and click on Edit. Similarly, if you wish to delete a Server profile, click on the 
Delete button. 

The Deployment xObject
Deployment objects, like Services, Components and Resources, are another type of Integration Manager 
xObject. They contain metadata about your deployment: information about which service triggers to 
create and which resources to deploy. 
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Like other xObjects, Deployment objects are accessed through Integration Manager’s Navigator Pane.

The procedure for creating a Deployment xObject will probably feel familiar to you, since it involves a 
wizard that operates much like Integration Manager’s other xObject-creation wizards.

To create a Deployment Object:

1 Click with your right-mouse button on Deployment in the Navigator Tree and select New. 
(Alternatively, use File > New > xObject, and select Deployment on the Component panel.)

2 The first screen of the New Deployment Wizard appears:
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3 Provide a Name for the Deployment object.
4 Optionally, provide a Description.
5 Click Next to proceed to the next screen:

6 Specify a Deployed Object Name (this will default to the name you entered on the previous 
screen).

7 Specify a Base URL by entering the URL-prefix where your service triggers and other resources 
(JSPs, images, etc) will be available.

8 Finally, browse your file server to designate a Staging Directory to hold your deployment objects 
and descriptor files.

9 Click Next to proceed to the next screen:
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10 Specify a Resource URL Prefix to be used to access any resources used by your project which you 
would like to be publicly available. 

11 You can also designate a Resource Security Role, if you are using J2EE 1.3 (or higher), to prevent 
users from surreptitiously accessing resources 
NOTE:  The security role is ignored for Integration Manager Services in the project that use the 
resource.

12 Click Next to proceed to the final screen of the Deployment Object creation wizard:

13 This panel provides you with an opportunity to override project variables that exist in the project 
(and any subprojects called by it) and set them to the values they will need at runtime. The table is 
pre-populated with the project variables and their values currently defined in the project.

14 Click Finish to create the deployment object and have it appear in your work area in the form of a 
Deployment Content Tree, as shown below:
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Editing Existing Deployment Object Properties

Like all other xObjects, once a Deployment object is created, you can access a tabbed dialog containing 
all the wizard panels by selecting a Deployment object and using the RMB to select Properties. Values 
can be modified, as necessary, using the Properties dialog. An example of the tabbed interface is shown 
below.

Configuring a Deployment
The discussions below describe how to set up and carry out various kinds of deployment operations from 
the Integration Manager design-time environment using standalone Integration Manager or the 
Enterprise-Edition suite (not Professional Edition).

IMPORTANT:  Before attempting any of the following procedures, you should already have created an 
applicable server profile (see “Server Profiles” above), as well as a Deployment Object (see discussion at 
“The Deployment xObject”) to contain this project’s deployment contents. You should also have already 
created (and added to your Deployment Object) any special resources needed by your service(s), such as 
WSDL resources for SOAP services.
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Service Triggers
One of the most important configuration choices regarding the deployment of services is deciding what 
kind of triggering mechanism to associate with the service. Integration Manager can create many 
different kinds of trigger objects. All you do is decide which kind(s) of triggers to associate with which 
individual services, and specify a few parameters appropriate to each trigger.

Note that you can associate more than one trigger type with a given service. You can also associate more 
than one service with a given trigger type. 

In the sections to follow, you’ll learn about:

Defining EJB-Based Triggers (including EJB-with-Servlet)
Defining E-mail Triggers
Defining File-Based Triggers
Defining JSP-Based Triggers
Defining Servlet-Based Service Triggers
Defining SOAP Triggers
Defining Timer-Based Service Triggers

NOTE:  For information on how to set up JMS-based or SAP-gateway-based service triggers, see the 
separate JMS Connect User’s Guide or the SAP Connect User’s Guide, as appropriate.

Drag-and-Drop Creation of Service Triggers

Most of the procedures described in this chapter use the drag-and-drop GUI metaphor extensively. Drag-
and-drop affords an easy, quick method of associating triggers with services. But it should be noted that 
the same associations can also be created using menu commands instead of drag-and-drop. (See next 
section.)

The drag-and-drop procedure is easy: 

Open a Deployment object 
Select the Web Service category in Integration Manager’s navigator
Drag a particular service instance over to the Deployment tree and drop it on the trigger type of 
interest
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Creating Service Triggers Using Menu Commands

To create a Service Trigger, simply right-click on the object in the Navigator pane. There are caveats, 
however. In order to create a Service Trigger, the following two conditions must be met:

A deployment xObject must be open and active in the native environment panel editor.
The object that was right-clicked on must actually be able to be used to create a service trigger.

If these conditions are met, then the items listed in the sub-menu will be the service triggers that can be 
created using the object that was right-clicked on.

NOTE:  A service must have an associated WSDL resource to be deployable as SOAP HTTP and thus 
for the menu item to appear.

Clicking on one of these items will create the appropriate entry in the deployment tree pane (as if the user 
had dragged it there manually) and cause its property sheet to appear in the deployment properties pane.

You can also create a Service Trigger using the Create Service Trigger submenu in the Component 
menu (in Integration Manager’s main menubar), as illustrated below.

When you make a selection from one of the trigger options shown in the submenu, a small dialog appears:

Use the pulldown menu control to select the service to which the trigger will be bound. Then click OK.
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NOTE:  The JMS and SAP service-trigger options are not available unless the relevant Connect products 
are installed.

Defining E-mail Triggers
You can configure a Integration Manager service to fire when an e-mail arrives in a particular mailbox. 
The e-mail becomes the payload, such that if you were (for example) to write Input.getXML() to 
System.out, using a Function Action, you would see the entire message appear in your system console, in 
XML format, similar to the following:

<?xml version="1.0" encoding="UTF-8"?>
<Message>
  <X-Auth-OK>joeblow@smtp-send.myrealbox.com</X-Auth-OK>
  <Return-Path>&lt;jblow@myrealbox.com&gt;</Return-Path>
  <Received>from JBLOW-DT1 jblow@smtp-send.myrealbox.com [12.23.52.5]
        by smtp-send.myrealbox.com with NetMail SMTP Agent $Revision:   3.42  $
on Novell NetWare;
        Mon, 29 Sep 2003 13:09:23 -0600</Received>
  <Message-ID>&lt;13140405.1064862444476.JavaMail.JBlow@JBLOW-DT1&gt;
</Message-ID>
  <Date>Mon, 29 Sep 2003 15:07:24 -0400 (EDT)</Date>
  <From>joeblow@myrealbox.com</From>
  <To>joeblow@myrealbox.com</To>
  <Subject>Trigger Test Mail</Subject>
  <Mime-Version>1.0</Mime-Version>
  <Content-Type>text/plain; charset=ASCII</Content-Type>
  <Content-Transfer-Encoding>7bit</Content-Transfer-Encoding>
  <Body charset="ASCII" encoding="7bit" subtype="plain" type="text">This is a test 
message
</Body>
</Message>

Before creating an e-mail trigger, you should know:

The IP address of the target mail server (for example, pop3.myrealbox.com)
The protocol (POP3 or IMAP)
The name of the mailbox (typically INBOX)
The account-holder’s name (such as the “myname” in myname@mydomain.com) and any 
associated password

The account name and password info should exist in the form of a Mail Simple Authentication 
connection resource. (Instructions for creating this type of connection resource can be found under “Mail 
Simple Authentication Connection Resource” in the discussion of Connection Resources.) If you have 
not created a resource of this kind to hold your account info, do so before using the procedure shown 
below.

You should also have some idea of how often you would like the target mailbox to be checked, and 
whether or not e-mails larger than a certain size should be ignored.

Note that as e-mails are detected and processed, they are consumed (removed) from the mailbox. Any e-
mails that are detected but not processed (due to size constraints—see below) will be left in the box 
unread.

To associate an E-mail Trigger with a service:

1 In the Navigation Category pane, under Services, click on Web Services.
2 Find the service you wish to deploy in the instance pane and highlight it by clicking.
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3 Drag the service onto the E-mail node of the Deployment tree, under Service Triggers. When you 
let go of the mouse, a property sheet similar to this one should appear:

4 Select IMAP or POP3 from the Protocol menu.
5 Enter the name of the Mailbox (typically INBOX).
6 Under Polling Interval, enter a numeric value representing the time, in seconds, to wait between 

checks of the mailbox. 
NOTE:  If the box contains e-mail and the trigger fires, Integration Manager waits until the service 
finishes executing before checking the box again. If the service takes two seconds to execute, and 
the polling interval is 10 seconds, it might take as long as 12 seconds for the box to be checked 
again after the previous e-mail has been detected.

7 Under Message Size, enter a numeric value representing the size, in kilobytes, of the largest e-mail 
that will be processed. Any e-mail that is smaller in size than this number will be processed: the 
service will fire and the mail will be passed to it (and removed from the mailbox in the process). 
Any e-mail larger in size than this value will simply be ignored.

8 Save your Deployment object.

Defining EJB-Based Triggers
Associating an EJB trigger with a service can be done in two slightly different ways. One way is simply 
to designate an EJB (session bean) as the object through which service access occurs. In this case, there 
is no URL to hit: instantiation of the EJB has to occur programmatically (perhaps through a custom 
trigger object of your own design). The only deployment parameters you can set in this case are the JNDI 
name, session type, and transaction attribute. Your service, after deployment, becomes available through 
normal JNDI/EJB mechanisms, but otherwise has no “web-facing” layer.

The other way of deploying a service to the EJB container is to choose the “EJB with Servlet” trigger 
option and let Integration Manager produce the EJB as well as a servlet that knows how to access the EJB. 
In this case, Integration Manager “front-ends” your EJB-based service with a web-tier component (a 
servlet) that can act on HTTP requests. 

To associate an EJB (or EJB-and-Servlet) with a service:

1 In the Navigation Category pane, under Services, click on Web Services.
2 Find the service you wish to deploy in the instance pane and highlight it by clicking.
3 Drag the service onto the EJB or EJB with Servlet node of the Deployment Profile tree, under 

Service Triggers.
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If you drop the service onto the EJB trigger node, you will get a property sheet that has fields 
only for three items: JNDI Path, Session Type, and Transaction Attribute. See explanations 
below.
If you drop the service onto the EJB with Servlet category node, the property sheet that appears 
will have the aforementioned three items as well as several more:

4 Specify a Servlet URL, as applicable.
5 Fill in the JNDI Path that will be used to find the object.
6 (Enterprise Edition only) For Transaction Attribute, select the applicable JTA transaction 

behavior from the dropdown list. Choices include:
Bean-managed
Mandatory
Never
Not supported
Required
Requires New
Supports

7 Select an Output Type of XML, HTML via PI or XHTML.
8 If a Stylesheet Resource is to be used for transforming this service’s output, select the appropriate 

Stylesheet Resource from the pulldown menu provided. 
NOTE:  You will typically use this option when the Output Type specified in the previous step is 
XHTML.
Deploying Your Project 393



9 If you are using a stylesheet (per the previous step) and you have implemented multiple language 
versions of the stylesheet, and you wish to specify the language version to use, click the Language 
button. A dialog will appear.

Choose one of the radio buttons:
None: Applies no preference.
Environment: Choose the language of the host machine.
Session: Chooses the language specified in the servlet request.

NOTE:  Please refer to “Support for Language Versioning of Resources” for a more detailed 
discussion of this dialog and its intended use.

10 If this is a J2EE 1.3 (or higher) application, optionally specify a Security Role. 
NOTE:  Security roles are a J2EE-defined mechanism for managing access control. The 
implementation of this layer is app-server-dependent. It is not implemented by Integration Manager. 
For more information on J2EE security role concepts, consult the Sun web site and/or your app-
server documentation.

11 If this is a J2EE 1.3 (or higher) application, optionally indicate a Run as Role.
12 Save your deployment-object changes.

Defining File-Based Triggers
The File trigger enables you to set up a scenario in which the appearance of a new file on a particular path 
on the local hard drive will fire a service. This can be useful for situations in which documents that need 
to be processed on a timely basis (as part of a workflow) can be handled in automated fashion.

When a File trigger is used, a process on the server monitors a given folder (or subdirectory) on the local 
hard drive, checking for the appearance of new files at regular intervals. (You can specify any interval 
you want.) As documents appear in the target directory, the trigger detects them and sends them, one by 
one, to your Integration Manager service. Each time a file is detected, the following events take place:

The file is read into memory.
A copy of the file is written to a destination directory. You will specify a destination directory when 
you set up your trigger at design time (see setup procedure below). The destination might, for 
example, be called \dest. At runtime, each time a file is processed, Integration Manager creates a 
new folder within the \dest folder. The new folder’s name will be its timestamp: for example, 
2003.09.30_08.54.48. Thus, a copy of the original file (bearing the original name) is written to 
\dest\2003.09.30_08.54.48. 
Depending on the type of file-handling you specified in your trigger, your service will receive, in 
Input, either the contents of the detected file or a URI that points to a copy of the file. The file-
handling options you can specify are as follows:
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Content as XML—The file itself is assumed to be well-formed XML. The unmodified file 
becomes the Input message part to your service. 
Embed Content in XML—The file contents are copied into a CDATA section of an XML 
skeleton file. That XML file becomes the Input message part in your service. 
File Reference—A URI (relative path) that points to the new copy of the file is placed in an 
otherwise-empty Input message part.

The original file is deleted from the source directory (the directory that the trigger process 
monitors).
The timer restarts. That is, if the polling interval is ten seconds, the clock will start at zero again as 
soon as the service has finished running.

File-Handling Options

You can set up a File trigger to pass data to your service in any of three ways.

Content as XML

When you specify this option, each new file that appears in the target directory is assumed to consist of 
well-formed XML.

Embed Content in XML

The Embed Content in XML option is appropriate when arriving files are not in XML format. (For 
example: EDI files.) Integration Manager merely wraps the content of the file in a CDATA section, so 
that your service’s Input document looks like:

<?xml version="1.0" encoding="UTF-8"?>
<Root>

<![CDATA[ the input file’s raw content appears here ]]>
</Root>

By default, the root element is named Root. But you can override this behavior, as shown further below.

NOTE:  Binary content is not appropriate for CDATA, since binary streams can contain XML-illegal 
characters. If you will be processing binary files, or files that may contain illegal characters, you should not 
use the “Embed Content in XML” option. Instead, use “File Reference,” and read the file via a URL/File-
Read action inside a component, with base64-encoding enabled. (If you need the data in raw form, rather 
than base64-encoded, you will need to perform the necessary file I/O operations yourself, in a custom 
Java class.)

File Reference

When you use the “File Reference” option, your Input will look similar to:

<?xml version="1.0" encoding="UTF-8"?>
<Root>..\dest\2003.09.30_09.10.15\myIncomingFile.dat</Root>

Again, by default, the root element is named Root. But you can override this behavior.

NOTE:  All pathnames are relative to the app-server \bin directory by default. You can override this 
behavior, however.

To create a File-based trigger:

1 In the Navigation Category pane, under Services, click on Web Services.
2 Find the service you wish to deploy and highlight it in the instance pane by clicking.
3 Drag the service onto the File node of the Deployment tree, under Service Triggers. When you let 

go of the mouse, a property sheet similar to this one should appear:
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4 Under Source Directory, enter a URI pointing to a directory on a local storage drive that should be 
checked for arriving files. The URI can be a relative path (in which case it will be treated as relative 
to the \bin directory of your app-server installation), or it can be a fully qualified path, such as 
d:\temp. 
NOTE:  The source directory need not already exist before you deploy the service.

5 Use the dropdown menu under Input Type to specify how each file’s contents should be handled. 
(See the discussion under “File-Handling Options” above.) 

Content as XML—Arriving files are assumed to be well-formed XML. The unmodified file 
becomes the Input to your service. 
Embed Content in XML—File contents are copied into a CDATA section of an XML file. That 
XML file becomes the Input message part in your service. 
File Reference—A URI (relative path) that points to the new copy of the file is placed in an 
otherwise-empty Input message part.

6 Choose an Encoding. The default is UTF-8.
7 If you are using Embed or File-Reference handlers, enter the name you would like Integration 

Manager to use for the root node of the Input document. The default is Root. Change this to any 
XML-legal element name.

8 Under Polling Interval, enter the number of seconds Integration Manager should wait between 
inspections of the Source Directory.
NOTE:  Polling is suspended when your service is executing. It resumes again when the service 
has finished running.

9 Under Destination Directory, enter the path to the directory that will receive copies of processed 
files as described earlier. (Composed will create datestamped folders in this directory at runtime: 
one per file processed.)

10 Save your Deployment object.
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Testing Considerations

The file-I/O portions of a service that uses the File trigger cannot be tested using ordinary design-time 
debugging techniques, since the polling, file-handling, and output functions of the trigger will only work 
on the server. Deployment to a server is a necessary part of testing File-triggered services.

Of course, regular “action model” actions can be tested and debugged as usual in the components that 
implement your service’s business logic. In order for your action model to operate against realistic Input 
data, you may need to “dummy up” some specimen XML documents of the type Integration Manager 
will create in actual operation. (See the XML examples shown under “File-Handling Options” further 
above.) Use sample documents for action-model debugging; then deploy the service and test. 

Defining JSP-Based Triggers
If you are “front-ending” your service with a JSP, you can specify the JSP-to-service binding using the 
following procedure. Note that you should already have created a JSP Resource for the Java Server Page 
in question, prior to beginning this procedure. (For information on how to create JSP Resources, see 
“About JSP Resources” in the section on Resources.)

To associate a JSP with a service:

1 In the Navigation Category pane, under Resources, click on Java Server Pages.
2 Find the particular JSP you wish to use as a trigger in the instance pane and highlight (select) it by 

clicking.
3 Drag the selected JSP Resource onto the JSP node of the Deployment Profile tree, under Service 

Triggers.

4 The JSP Resource you selected now appears as a node under the JSP node in the trigger tree, and 
the JSP Properties sheet is displayed in the editor pane on the right (see illustration).

5 Optionally enter a name to use in Security Role.
NOTE:  Security Roles are valid for J2EE 1.3 only.

6 Fill in a base URL for deployment.
7 Save your deployment-object changes.
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Defining Servlet-Based Service Triggers
In many cases, you will simply trigger a service off a servlet that handles requests on a given URL. (The 
servlet can be exposed through a JSP or not. In this case, we will assume not. If you wish to bind a JSP 
to a particular service, see the discussion at “Defining JSP-Based Triggers” elsewhere.) The servlet may 
be configured to handle data arriving via HTTP GET or POST; and in the latter case, the XML data might 
be contained in a particular form field, or it might arrive as multi-part mime content, or it may comprise 
the content stream of the HTTP POST.

To define a servlet-based trigger for a service:

1 In the Navigation Category pane, under Services, click on Web Services. The names of existing 
services will appear in the instance pane.

2 In the instance pane, find the service you wish to deploy and highlight (select) it by single-clicking.
3 Drag the selected service onto the Servlet node of the Deployment tree, under Service Triggers, as 

shown above.
4 The service you selected now appears as a node under the Servlet branch, and the Servlet Properties 

sheet is displayed in the editor pane.
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5 Fill in a URL for deployment. This will form the tailmost fragment of the URL for your service. 
The complete URL will be something like:
http://localhost:80/[MyDataBase]/[MyDeploymentEAR]/myurl

where [MyDataBase] is the database in which the deployment will occur on the application server 
(Novell exteNd application servers only); [MyDeploymentEAR] is the name of your Deployment 
xObject; and myurl is the value you entered above.

6 Select an appropriate Servlet Type from the dropdown list as the source of data which will be used 
as input to the service. The choices are:

Params (URL/Form)
XML (MIME/Multi-Part)
XML (HTML Form Field)
XML (HTTP/Post)

7 Select an Output Type denoting the MIME type of the response data for the service. Valid types 
include:

XML
HTML via PI
XHTML

8 Optionally enter a Security Role name. 
NOTE:  Security Roles are valid for J2EE 1.3 only.

9 Under Run As Role, type the name of a Role to use while running the service.
10 Save your deployment-object changes.

Defining SOAP Triggers
The procedure for associating a SOAP trigger with a Web Service involves a process similar to the ones 
described above.

NOTE:  The following procedure assumes familiarity with SOAP, WSDL, and XML Signature concepts. If 
you are not familiar with these technologies, consult the http://www.w3.org web site and/or other 
resources as necessary before proceeding.

To associate a SOAP trigger with a service:

1 In the Navigation Category pane, under Services, Click on Web Services.
2 Find the service you wish to deploy in the instance pane and highlight it by clicking.
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3 Drag the service onto the SOAP HTTP node of the Deployment Profile tree, under Service 
Triggers. The property-sheet pane changes to the following appearance:

4 In the property sheet, enter a URL name for the service. This is the final portion of the URL (not 
the complete URL). 
NOTE:  An HTTP GET on this URL will return the WSDL for this service. An actual SOAP request 
on the URL will trigger the service.

IMPORTANT:  The value you enter here will be reflected through to the <service> element of your 
service’s WSDL after deployment. Changes will also be reflected in child elements <port> and 
<soap:address>. In other words, the <service> element is updated dynamically to use the URL you 
specify here.

5 Select the appropriate WSDL Resource if it is not already displayed.
6 Select the appropriate Binding if it is not already displayed. (Some WSDLs define more than one 

binding; when this is the case, you can choose the binding that applies to the URL you specified 
earlier. In the vast majority of cases, you will simply accept the default value shown.)

7 Specify the Operation that this service will handle.
8 Optionally enter a Security Role (for J2EE 1.3+ applications).
9 Optionally use the dropdown list to select a Certificate Resource (if any) from the ones currently 

associated with the project. This is necessary only if the service will sign outgoing responses using 
the XML Signature scheme. (See “About Certificate Resources” for more information on 
Certificate Resources and their usage.)

10 If the service requires inbound SOAP requests to be digitally signed, check the Validate XML 
Signature checkbox. 
NOTE:  If you check this checkbox, it means that every inbound request must contain digital 
signature information in the SOAP header, in accordance with the XML Signature standard. If a 
request does not contain such a signature, a SOAP fault will result.

11 Save your deployment-object changes.
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Defining Timer-Based Service Triggers
A Timer trigger causes a particular Integration Manager service to be executed on a periodic basis, 
independent of any events. This type of triggering mechanism lends itself to many use-cases. For 
example:

You may want a service to generate daily or weekly reports: activity reports, inventory reports, 
payroll, financials, etc. 
You may have “batch jobs” that need to run every night. 
You may have a need to run maintenance jobs on a scheduled basis, such as scanning a database for 
stale data every 48 hours, pruning “opt-outs” from a mailing list every day, etc.

Scheduled Tasks versus Repetitive Tasks

Integration Manager’s Timer trigger supports two types of periodic invocation: two notions of repeat-
processing. At one level is the idea of scheduling: tying the execution of a process to one or more fixed 
dates on a calendar. This is calendar-based recurrence, or simply recurrence. Integration Manager 
supports recurrence in the general case. You can schedule a job to occur once (that is, recur zero times), 
at a given date/time, or you can schedule it to occur at multiple dates/times (which might not be evenly 
spaced). The key intuition is that the job follows a schedule which begins on a certain date and recurs zero 
or more times at other dates.

The second notion of timing supported by the Timer trigger is periodic invocation of a process until a 
certain number of invocations has occurred. The use case here is “This service needs to execute X times, 
with a wait-time between executions of Y seconds” (or minutes, days, etc.), independent of calendar date. 
The implied parameters are an execution count and an execution interval.

By combining these two notions of timing, it’s possible to achieve a high degree of customization of 
execution schedules. For example:

To execute a service once an hour during business hours (for example, 9:00 to 5:00), you can 
schedule the service to recur daily, beginning at 9:00, with an execution count of nine and an 
execution interval of 60 minutes.
To execute a service once an hour, continuously, schedule it as a daily recurring item, with an 
execution count of 24 and an execution interval of 60 minutes.

Integration Manager allows you to configure recurrences based on daily, weekly, or monthly invocations. 
In the weekly case, you can further specify recurrence by one or more specific days (such as every 
Sunday, or Tuesdays-and-Saturdays, or Monday-Wednesday-Friday). When the recurrence is monthly, 
you can further specify that invocation occurs on the first day of the month, the last day of the month, or 
a specific day. 

To create a Timer-based trigger:

1 In the Navigation Category pane, under Services, click on Web Services.
2 Find the service you wish to deploy and highlight it in the instance pane by clicking.
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3 Drag the service onto the Timer node of the Deployment tree, under Service Triggers. When you 
let go of the mouse, a property sheet similar to this one should appear:

4 If you want the trigger to begin on a certain date, click the Calendar button. A dialog will appear, 
similar to the one below.

Use the various controls in this dialog to select the date and time for initial invocation of the 
service. Then click OK to dismiss the dialog. The date and time you chose will appear in the Date 
and Time field of the trigger’s property sheet.

5 If this is to be a recurring process, click the Recurrence button. (It will be labeled “Non-recurring” 
until you have specified more information.)
NOTE:  The Recurrence button will be enabled only if a date is showing in the Date and Time field. 
If the button is disabled, go back to the previous step.
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When you click the Recurrence button, a dialog will appear as shown below.

6 Click the Recurring radio button. Other controls in the dialog become enabled.
7 Click the Daily, Weekly, or Monthly radio button as appropriate. Additional controls become 

enabled.
Under Weekly: Check any checkboxes that apply. Your service will execute every week on the 
days you have checked.
Under Monthly: Check any checkboxes that apply. Your service will execute on the days 
specified.

8 Under Time (near the bottom of the dialog), enter a time (in 24-hour-clock format) representing the 
time of day when the service should kick off. If desired, use the Select Time button to bring up a 
time chooser dialog with spin controls for specifying hour and minutes.

9 Under End Date, enter a date (in YYYY-MM-DD format) representing the final date beyond which 
no more executions will occur. If desired, use the Select Date button to bring up a date chooser 
dialog with point-and-click controls for specifying a calendar date.

10 Click OK to return to the Timer-trigger property sheet.
11 Under Execution Count, enter the total number of repetitions for execution of this service. 
12 Under Execution Interval, enter the time interval to wait between executions. (Integration 

Manager will wait this amount of time, after the service finishes, to execute it again.) Append ‘s’ to 
the numeric value for seconds; ‘h’ for hours; ‘d’ for days. For example, 8h means “eight hours.” 
The default (if no units are specified) is seconds.

13 Save your Deployment object.

Note that it is possible for you to specify recurrences, execution intervals, and counts that, taken together, 
make little sense (such as daily recurrence of a process that is to repeat 10 times at 25-hour intervals). 
Integration Manager won’t complain: It will simply add points to the execution timeline, and try to 
execute your service when each point arrives. The results may or may not be what you expect. It’s up to 
you to sanity-check your trigger’s parameters. 
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Specifying Other Project Resources for Deployment
Resource objects listed in the object detail pane can be added to a deployment by simply dragging them 
onto the appropriate tree node in the deployment-object tree pane. This will add a new child to the 
category in question. You will be able to drop resources only onto targets that are appropriate for the 
category. When you hover over a disallowed drop target, the cursor changes to a circle-slash symbol. 

The drag-and-drop UI metaphor makes resource deployment simple and quick. For example: To deploy 
an image resource, just drag an image resource from the object detail pane to the "Image" node of the 
deployment tree pane. Since resources have no associated properties, the deployment properties pane 
would be blank in this case. Default URLs are automatically assigned based on both the resource type and 
the base URL that were defined when creating the deployment object.

Under some circumstances, you can highlight a resource in the instance pane and then right-click on it to 
expose a context menu from which to deploy the object. Two conditions must be met:

The resource you’ve selected must be one that can be “made publicly available” (published to the 
outside world) in a deployment object. For example, Image resources can be published on a URL. 
But Custom Script resources generally would not be since they are used internally by Integration 
Manager.
A Deployment Object must be open in the editor pane.

If (and only if) these conditions are met, then right-clicking on a resource will bring up a context menu, 
in which the last (bottommost) command is a Publish command.

Deploying Your Project to the Server
Once all the required services and resources have been added to the Deployment xObject, and all trigger 
associations have been specified, the actual deployment of your project to the app server can occur. 

NOTE:  The features described in this section are available only in Integration Manager Enterprise 
Edition. 
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To deploy your project:

1 Choosing Deploy Project from Integration Manager’s File menu.
2 This will take you to a dialog that allows you to associate a Deployment xObject with a server 

profile. 

3 Select a Deployment Object from the dropdown list.
4 Select a Profile Name from the dropdown list of server profiles.
5 Click on Deploy to deploy your project.
6 You will see a status bar indicating the progress of the deployment:

7 When the progress thermometer is finished, your web browser will launch and you will see a screen 
similar to the following. (This example assumes that you are deploying to the Novell app server. 
Somewhat different screens apply in the case of other app servers.)
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8 Enter the name and password information appropriate to your app server in the spaces provided, 
then click the Next button. A new screen will appear.

9 If you are deploying to a Novell 5.x app server, this screen prompts you for the name of the 
database into which the project EAR will be deployed. The default is SilverMaster.

10 Click the Next button. A third and final browser screen appears.

11 Copy and paste the deployment-archive name (that is, the file name shown in italics near the top of 
the page) into the text field shown. (Alternatively, use the Browse button to browse your file system 
until you’ve located the deployment archive you wish to deploy.) This is the delpoyment EAR that 
Integration Manager created in a staging area (the staging area described earlier in “To create a 
Deployment Object:”, above).
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12 Click the Finish button. A status report page will appear:

This page will tell you whether the project deployed normally, or an error was encountered. In case 
of error, there will usually be a complete stack-trace listing information that can be helpful in 
troubleshooting the cause of the problem. (Note that a delay of more than a few minutes in 
navigating between the browser screens described above can cause connections to time out. In that 
case, repeat the deployment procedure as needed.)

For More Information

Integration Manager Enterprise Server Documentation
The deployment characteristics for the supported application server environments vary somewhat across 
product versions and vendors. Accordingly, server-specific instructions for deploying Integration 
Manager projects are given in separate documents: the Enterprise Server User’s Guide for the BEA 
Weblogic Application Server and the Enterprise Server User’s Guide for the IBM Websphere Application 
. Consult those guides for detailed discussion of deployment issues, including:

How to resolve CLASSPATH and security issues. 
How to administer running services.
How to use the Integration Manager Enterprise Server Framework API to create custom trigger 
objects or manipulate Integration Manager objects programmatically.
Additional information about the Integration Manager Enterprise Server runtime architecture, and 
the runtime architecture of Integration Manager services in general.
Deploying Your Project 407



408   Integration Manager User’s Guide



A The Integration Manager JSP Tag Library

Novell Integration Manager comes with a tag library file, composer-taglib.tld, designed to make it easy 
for you to call Integration Manager services, and manipulate associated DOM data, within your own Java 
Server Pages. The tags defined in this file are especially suited to JSP-driven applications in which XML 
data must be collated, formatted, or post-processed immediately before being sent to the client’s browser.

In many cases, you will not need to do any hand-coding in order to use Integration Manager’s custom 
taglib, because many of the wizard-generated JSPs created by Director and Integration Manager contain 
custom-tag calls. (For details on how to generate JSPs using these wizards, see “Creating a JSP-Based 
Service Trigger” on page 239.) In other cases, you will find it desirable to tap the full power of the tag 
library, which does require hand-coding. The discussion below summarizes the features available in the 
custom tag library and the syntax for using the various tags.

Preparing to Use the Tag Library
When you use Integration Manager’s built-in wizards to generate JSPs containing custom tags, then 
deploy your project using Integration Manager’s deployment UI, Integration Manager takes care of 
certain “packaging” issues for you. But when you create your own JSPs from scratch and deploy a 
WAR/EAR manually, you must carry out the following steps yourself in order to ensure that your web 
app is fully custom-tag-enabled.

NOTE:  The following steps apply only if you are hand-creating your own JSP. When you use the 
Integration Manager and Director JSP wizards, these steps are taken care of for you.

To tag-enable your JSP-based web app:

1 Near the top of your JSP, insert the following line:
<%@ taglib uri=”/composer” prefix=”composer” %>

The uri attribute corresponds to a uri definition in the taglib entry of your WAR file’s web.xml 
file. (See next two steps.) 
The prefix attribute allows you to specify a namespace prefix that you can combine with other 
tags specified in the tag library file.

2 In your WAR file, be sure to include the composer-taglib.tld file. A minimal WAR file 
composition is shown below.
The Integration Manager JSP Tag Library 409



3 In your web.xml file, be sure there is a taglib element referencing the uri from Step 1 above as well 
as the location of the tag library. For example:

<web-app>
. . .

<taglib>
<taglib-uri>/composer</taglib-uri>
<taglib-location>/WEB-INF/composer-taglib.tld</taglib-location>

</taglib>
. . .

</web-app>

Custom Tags Defined in composer-taglib.tld
The composer-taglib.tld file defines the following custom tags:

Each of these tags relies on attribute values that, in effect, pass argument values to the underlying Java 
methods. Those attributes and their usage are discussed further below, in the individual discussions of the 
tags.

TAG NAME PURPOSE

execute Executes an Integration Manager service 

fault Provides the ability to handle Integration 
Manager fault documents

forEach Provides the ability to loop over DOM nodes in 
a nodeset contained in an output document

hasnopart Provides conditional processing based on the 
nonexistence of a particular output message 
part

hasnovalue Provides conditional processing based on a 
particular node being empty

haspart Provides conditional processing based on the 
existence of a particular output message part

hasvalue Provides conditional processing based on a 
particular node being non-empty 

if Evaluates children if specified XPath condition 
is true

value Obtains the data value of a particular node
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Tag API 

execute

NOTE:  NOTE: Required attributes are shown in boldface type.

Inside your JSP, you will call your Integration Manager service using the execute tag. The only required 
attribute is the service attribute, which specifies the fully qualified (full-context) service name. This 
attribute identifies the service for Integration Manager’s benefit but does not provide any access to the 
service elsewhere in the JSP (in other tags). If you want to refer to the service in another tag, you can 
define an alias for it using the name attribute.

For example, suppose you’ve built a Integration Manager service called ListInventory (in a deployment 
context of com.inventory) and you want to refer to that service in downstream tags as inventory. To 
execute the ListInventory service, you would do:

<composer:execute name="inventory" service="com.inventory.ListInventory" />

This line will execute your service, using the default “InputFromHttpParams” converter class that 
Integration Manager uses when no other converter is specified. This is equivalent, in other words, to the 
Params (URL/Form) trigger mode. 

You can specify the manner in which your service should obtain its input via the use of the converter 
attribute. 

IMPORTANT:  You should manually inspect all JSPs prior to deployment to verify that the deployment 
context matches the context used in the service attribute of the execute tag. (See example above.) To do 
this: In Integration Manager Enterprise Edition, open your Deployment xObject, then use File > 
Properties to bring up the Properties dialog for the deployment. Inspect the deployment context (as 
shown under “Deployment Context in the Project JAR” on the Deploy tab of the Properties dialog). This 
context must match the context used in the service attribute of the execute tag, in any JSP that executes a 
Integration Manager service.

ATTRIBUTE PURPOSE

converter Converter class to be used when marshalling 
input data (see text for discussion)

faultHandled Flag to indicate whether Integration Manager 
faults will be handled inside the page using 
<composer:fault> tags. The default value is 
“false.”

name Arbitrary identifier for use within the JSP, to 
refer to the service in question.

root Name of the root element of the input message 
part.

service Name of the Integration Manager service to 
invoke.

xmldoc When the GXSInputFromJavaObject converter 
class is used, this attribute must be specified 
and must contain the name of the Java String 
(or String array) variable that points to the input 
document(s) to be passed to the service.
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Converter Classes

Integration Manager Enterprise Server can marshall XML data in a number of ways, using helper classes 
that are part of the Integration Manager installation. When calling a service from a JSP using the 
<composer:execute> tag, you can specify any of five different kinds of data marshalling.

Possible values for the converter attribute are:

com.sssw.b2b.xs.service.conversion.GXSInputFromHttpParams
com.sssw.b2b.xs.service.conversion.GXSInputFromHttpContent
com.sssw.b2b.xs.service.conversion.GXSInputFromHttpMultiPartRequest
com.sssw.b2b.xs.service.conversion.GXSInputFromHttpSpecificParam
com.sssw.b2b.xs.service.conversion.GXSInputFromJavaObject

These classes are part of the Integration Manager Enterprise Server installation runtime. You do not have 
to install them, package them, or register them in any special way to use them from your Integration 
Manager web application.

The mode of operation of each of these classes is described below (and also in the Integration Manager 
Enterprise Server documentation):

com.sssw.b2b.xs.service.conversion.GXSInputFromHttpParams

This converts HttpServletRequest parameters (i.e. those supplied either as URI parameters or form fields 
submitted) into an XML document. The document will use the root name that the service was defined 
with, unless you have specified the root name using the execute tag’s root attribute.

com.sssw.b2b.xs.service.conversion.GXSInputFromHttpContent

This opens an InputStream from the supplied HttpServletRequest and retrieves the content of the request 
buffer, which it expects to be in XML format.

com.sssw.b2b.xs.service.conversion.GXSInputFromHttpMultiPartRequest

This class expects an HTML form with content type multipart/form-data. It will look for a specific file 
parameter (“xmlfile”) and use that as the XML input document. If the mime type for the file thus found 
is not text/xml, then this class will create an XML document and place the contents of the file in a CDATA 
section within the XML document.

com.sssw.b2b.xs.service.conversion.GXSInputFromHttpSpecificParam

This class takes the contents of a form field and uses it as the input XML document. By default, the form 
field containing the XML is expected to be named “xmlfile.” 

com.sssw.b2b.xs.service.conversion.GXSInputFromJavaObject

This class expects the input XML document to be passed as raw XML contained in a Java String.The 
class’s methods are overloaded in such a way that if your service is designed to handle more than one 
input document, you can pass multiple XML strings in a String array, in which case each String will be 
passed to your service as a message part. 
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fault

NOTE: Required attributes are shown in boldface type.

You can place a <composer:fault> element in the JSP to wrapper JSP code that should execute when a fault 
condition occurred in your service.  The tag acts as a conditional expression: If a fault part is returned as 
the result of execution of a service using a <composer:execute> tag, the instructions between the start and 
end tag of the <composer:fault> element are executed.  If no fault condition occurred during execution of 
the service, then the instructions bracketed by the <composer:fault> tags are ignored.

For example, to handle a standard Composer System Fault that might be returned from one Composer 
service and a custom fault returned from a second Composer service executed by a JSP, you might use 
JSP code similar to the following:

…

<composer:execute name="myServ1" service="com.context.myService" xmldoc="myInput" 
/>
<composer:execute name="myServ2" service="com.context.myOtherService"/> 

<HTML>
  <HEAD><TITLE>My Page<</TITLE></HEAD>
<BODY>
…
<composer:fault name="myServ1" part="_SystemFault">
<B>A Fault has occurred!</B><P/>
Component: <composer:value name="localName" xpath="FaultInfo/ComponentName" /><P/>
Date: <composer:value name="localName" xpath="FaultInfo/DateTime" /><P/>
MainCode: <composer:value name="localName" xpath="FaultInfo/MainCode" /><P/>
SubCode: <composer:value name="localName" xpath="FaultInfo/SubCode" /><P/>
Message: <composer:value name="localName" xpath="FaultInfo/Message" /><P/>
</composer:fault>
…
<composer:fault name="myServ2" part="myCustomFault">
  <B>Doh! A fault happened in my other service!</B>
</composer:fault>
…
</BODY>
</HTML>

Note that a JSP may have more than one set of <composer:fault> tags.  All tag sets that satisfy a specified 
name and part will be executed if a fault condition occurs in the service at runtime.

ATTRIBUTE PURPOSE

name Scopes the behavior of the tag to faults thrown 
by a <composer:execute> tag whose 'name' 
attribute has an identical value

part Can be used to specify a user-defined custom 
fault document by name. If not specified, this 
attribute will take on a default value of 
“_SystemFault.”
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forEach

NOTE: Required attributes are shown in boldface type.

The forEach tag provides a looping construct so that you can iterate over the nodes in a nodelist at tag-
execution time. The only required attribute is the xpath attribute, which should be an XPath expression 
that resolves to a nodelist. The expression will be evaluated against the service specified by name and the 
message part (or DOM) specified in part. If no extra attributes are defined, the most recently executed 
service’s Output part is used.

The following example shows how you could loop over a set of ITEM nodes in a message part called 
Output1 produced by a service whose alias (defined by the name attribute in an execute tag) is inventory:

<composer:forEach name="inventory" part=”Output1” xpath="/MYROOT/INVENTORY/ITEM">
   <composer:value xpath="./ITEMNAME" /><br>
   <composer:value xpath="./SKU" /><br>
   <composer:value xpath="./QTY" /><br>
   <composer:value xpath="./PRICE" /><br>
</composer:forEach>

A node value (XML data corresponding to the elements under /ITEM) will be placed in the page where 
each value tag occurs.

hasnopart

NOTE: Required attributes are shown in boldface type.

The hasnopart tag can be used to enclose a block that should execute only when a particular service 
(identified by name) has no Output part.

See haspart (below) for additional information and a code example.

ATTRIBUTE PURPOSE

name Scopes the behavior of the tag to the service 
whose name attribute (as defined within an 
execute tag elsewhere in the JSP) has an 
identical value. 

part Scopes the tag behavior to a particular 
message part associated with the service 
specified by name (above).

xpath An XPath expression to be evaluated against 
the document associated with part and name 
attributes (or with the Output message part, if 
no part attribute is specified). This expression 
should be one that returns a nodelist (as 
defined by the Document Object Model).

ATTRIBUTE PURPOSE

name Scopes the behavior of the tag to the service 
whose name attribute (as defined within an 
execute tag elsewhere in the JSP) has an 
identical value. 
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hasnovalue

NOTE: Required attributes are shown in boldface type.

This tag can be used to enclose a block of markup that should only be evaluated if a particular node in a 
particular output message part contains no data. In other words, this tag can be used in cases where it is 
necessary to handle an empty node. It is complementary in function to the hasvalue tag (see “hasvalue” on 
page 416).

haspart

NOTE: Required attributes are shown in boldface type.

This tag enables conditional processing based on the existence of a particular output message part from 
a particular service. Its behavior is similar to that of the hasvalue tag in that a number of HTML 
statements, JSP markup blocks, and/or <composer:> tags can be embedded between the < 
composer:haspart> opening tag and </composer:haspart> closing tag, and the embedded tags will be 
processed only if the specified part exists.

For example, the following JSP code fragment will display an HTML table and XML data retrieved from 
"myService" if and only if the service actually produced a part named "myFirstPart".

<composer:haspart name="myServiceName" part="myFirstPart">
  <table>
    <tr>
      <td>some data</td>
      <td>
        <composer:value name="myServiceName" 

part="mySecondPart" xpath="root/element/element"/>
      </td>
    </tr>
  </table>

ATTRIBUTE PURPOSE

name Scopes the behavior of the tag to the service 
whose name attribute (as defined within an 
execute tag elsewhere in the JSP) has an 
identical value. 

part Scopes the tag behavior to a particular 
message part associated with the service 
specified by name (above).

xpath An XPath expression to be evaluated against 
the document associated with part and name 
attributes (or with the Output message part, if 
no part attribute is specified). This expression 
should be one that returns a DOM node that 
may contain data.

ATTRIBUTE PURPOSE

name Scopes the behavior of the tag to the service 
whose name attribute (as defined within an 
execute tag elsewhere in the JSP) has an 
identical value. 

part Scopes the tag behavior to a particular 
message part associated with the service 
specified by name (above).
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</composer:haspart>

hasvalue

NOTE: Required attributes are shown in boldface type.

The hasvalue tag enables conditional processing based on a given XPath node (in a particular message 
part, from a given service’s output) being non-empty. This makes it possible for you to “skip over” a 
particular node if it is empty, but process or display it if it contains data. For example, consider the 
following usage:

<composer:value xpath="./CUSTOMER/NAME" /><br>
<composer:hasvalue xpath="./CUSTOMER/ADDRESS">
       <composer:value xpath="./CUSTOMER/ADDRESS" /><br/>
</composer:hasvalue>
<composer:value xpath="./CUSTOMER/CITY" /><br/>
<composer:value xpath="./CUSTOMER/STATE" /><br/>
<composer:value xpath="./CUSTOMER/ZIP" /><br/>

Data from the /ADDRESS node, in this example, will show up in the JSP’s output only if that node is non-
empty. Otherwise, it is skipped.

ATTRIBUTE PURPOSE

name Scopes the behavior of the tag to the service 
whose name attribute (as defined within an 
execute tag elsewhere in the JSP) has an 
identical value. 

part Scopes the tag behavior to a particular 
message part associated with the service 
specified by name (above).

xpath An XPath expression to be evaluated against 
the document associated with part and name 
attributes (or with the Output message part, if 
no part attribute is specified). This expression 
should be one that returns a DOM node that 
may contain data.
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if

NOTE: Required attributes are shown in boldface type.

The <composer:if> tag allows conditional evaluation of a block of markup based on the boolean value of 
an XPath expression. Consider the following example:

<composer:if xpath="string(./CUSTOMER/STATE)=&quot;CA&quot;">
<b>

<composer:value xpath="./CUSTOMER/STATE" />
</b>
</composer:if>

In this example, if /STATE is “CA”, the state value will be written out to output, wrapped in boldface tags. 

A corresponding if block based on modification of the XPath to use inequality (instead of equality) can 
be used inline with the above block to achieve an “else” branch, so that states that are not “CA” are not 
boldfaced.

value

NOTE: Required attributes are shown in boldface type.

The value tag allows you to retrieve data from a DOM node at a specified location in a specified message 
part from a named service. The node location must be specified via an XPath expression. For example:

ATTRIBUTE PURPOSE

name Scopes the behavior of the tag to the service 
whose name attribute (as defined within an 
execute tag elsewhere in the JSP) has an 
identical value. 

part Scopes the tag behavior to a particular 
message part associated with the service 
specified by name (above).

xpath An XPath expression to be evaluated against 
the document associated with part and name 
attributes (or with the Output message part, if 
no part attribute is specified). This expression 
should be one that evaluates to a boolean 
value.

ATTRIBUTE PURPOSE

name Scopes the behavior of the tag to the service 
whose name attribute (as defined within an 
execute tag elsewhere in the JSP) has an 
identical value. 

part Scopes the tag behavior to a particular 
message part associated with the service 
specified by name (above).

xpath An XPath expression to be evaluated against 
the document associated with part and name 
attributes (or with the Output message part, if 
no part attribute is specified). This expression 
should be one that returns a DOM node 
containing data.
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<composer:value xpath=”/MYROOT/INVENTORY/DATE” />

The data at /MYROOT/INVENTORY/DATE will be placed in the JSP output. This example presumes that 
/MYROOT/INVENTORY/DATE is a single, discrete node representing a single piece of XML data. When 
a nodeset is returned, you should iterate over the individual nodes by means of the forEach tag, then apply 
the value tag to each individual node:

<composer:forEach name="inventory" xpath="/MYROOT/INVENTORY/ITEM">
   <composer:value xpath="./ITEMNAME" /><br>
   <composer:value xpath="./SKU" /><br>
   <composer:value xpath="./QTY" /><br>
   <composer:value xpath="./PRICE" /><br>
</composer:forEach>

In this example, it is assumed that /MYROOT/INVENTORY/ITEM returns a set of nodes, each one in turn 
containing ITEMNAME, SKU, QTY, and PRICE child nodes. The above JSP fragment outputs a listing of 
the relevant data for each ITEM.

Notice that the opening forEach tag specifies a name attribute with a value of inventory. This is the local 
(within this JSP) name of the service whose Output DOM we are accessing at this point. You might very 
well execute more than one service from a single JSP page, then access data from each resulting Output 
DOM. The name attribute allows you to operate on different Output DOMs within the same JSP session.

For More Information
The xcs-src.jar file in the \xc_api folder of your Integration Manager installation (under \Common) 
contains the actual Java source code for the Integration Manager tag library. It also contains source code 
for various trigger classes, converter classes, and deployment-related interfaces and support classes that 
Integration Manager relies on at runtime. Javadoc API documentation for these classes is available in the 
same folder. 
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B Reserved Words

The following terms are reserved words in Integration Manager and should be avoided in any user 
created terms or objects.

Input, Temp, Output
Input1, Temp1
Input(n), Temp(n)
ERROR
Math, Date, String, Array, etc. (ECMAScript reserved words)
theComponent
SQLCODE, SQLSTATE, UPDATECOUNT, LASTSQL
USERID PASSWORD

In addition to the above-listed terms, it is good practice not to use Java-language keywords in deployment 
context strings, user variable names, etc. Reserved words in Java include the following:

Java Keywords

abstract boolean break

byte case catch

char class const

continue default do

double else extends

final finally float

for goto if

implements import instanceof

int interface long

native new package

private protected public

return short static

strictfp super switch

synchronized this throw

throws transient try

void volatile while
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C Glossary

Action An action is similar to a programming statement: it takes input in the form of parameters and 
performs specific tasks.

Action Model An Action model is a visual representation of a sequence of actions. An Action model 
is located in a component editor.

Alias A name given to an element identified by an XPath expression for use in Repeat actions. An alias 
ensures that the next repeating element matching the XPath expression is processed separately with 
each iteration of a Repeat loop. 

Animate The process of visually executing a component in Integration Manager, step-by-step, for 
debugging problems or testing new inputs.

Attribute An Attribute is the part of an XML document that is associated with an element and provides 
descriptive information about the element. An Attribute is also an Object type in the DOM 
specification.

CDATA A declaration inside an XML document that prevents any character data inside the CDATA 
section from being interpreted as XML markup language. This allows characters such as the angle 
brackets ( < > ) to be used inside an XML document without being interpreted as part of a start or end 
tag.

Character Data The data contained within an XML document. Character data is any non-markup data. 
Character data in XML documents are composed of characters from the Unicode character set.  See 
also CDATA.

Code Table A code table stores commonly used business codes and their associated descriptions.  Two 
Code Tables work in conjunction with a Code Table Map to produce a translation from one set of 
values to another set of codes.

Component A component is an object that accepts one or more XML documents as inputs, uses a 
collection of actions to operate on the inputs, and returns an XML document as output. Components 
of various types (see Connect products) can also interface with external non-XML data sources such 
as relational databases, 3270 / CICS transactions, etc.

Connect An enterprise connector is an installable Integration Manager component editor (and related 
resources). It allows you to integrate XML data with an enterprise data source or legacy platform that 
does not support XML, by providing the user with a visual representation of the environment. An 
example of an enterprise connector is the JDBC Component editor.

Connection A Connection is a resource used to establish communications with an external data source 
or with a server that uses HTTP authentication.

Content Editor A dialog box available in the Map Action designed to perform XML element level 
transformations of data. The Content Editor can splice and re-splice data by character or character 
position, insert constants, and apply functions.
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Custom Script A collection of user-defined ECMAScript functions in a Integration Manager project.

Deployment The process of packaging and installing an Integration Manager project into an 
application server environment for production use. 

Document An XML document is typically referred to as a document. The document is also an object 
type in the DOM specification. Document is often used synonymously with DOM.

Document Handle The name assigned to an XML document’s DOM. Default document handles are 
Input, Input1, Input(n), for input XML Templates; Temp, Temp1, Temp(n) for Temp documents; and 
Output for all Service and Component results.   Custom Document Handle names can be created via 
Component actions (the Returned ID field), Temp documents (Identifier field), and the XML 
Interchange action. 

Document Type Definition (DTD) A DTD specifies how elements inside an XML document relate to 
each other. It defines semantic rules about the document, as well as elements to which an XML 
document must conform in order to be considered a valid document of that type.

DOM A document object model (DOM) is an XML document constructed as an object in a software 
program’s memory. It provides standard methods for manipulating the object.  In Integration 
Manager, DOM is often synonymous with XML Document.  DOMs are represented as hierarchical 
trees with a single root node.

ECMAScript ECMAScript (based on JavaScript) is an object-oriented scripting language for 
manipulating objects in a host environment. As a host environment, Integration Manager provides 
ECMAScript access to various objects (primarily XML documents) for processing. ECMAScript in 
turn provides a Java-like language that can operate on these objects.

Element An Element is a fundamental part of an XML document containing the majority of the 
document's data. The Element is also an object type in the DOM specification.

Entity An entity in an XML document is a specially formatted placeholder that represents something 
else. (That is, references to entities are replaced with their entity content.) In XML and HTML, there 
are certain predefined entities, such as &gt; for ‘>’ and &lt; for ‘<‘. User-defined entities are also 
allowed.

ERROR A global variable accessible by any component running in the context of a Service.  The value 
in ERROR is set by the Error Expression in the RAISE ERROR action.

Expression Builder The Expression Builder is an interface in Integration Manager that helps you 
construct valid ECMAScript and XPath syntax.

GET An HTTP Request Method used in the XML Interchange action.  The GET method means retrieve 
whatever information (in the form of an entity) is identified by the Request-URI.

Group A Group represents the list of unique values across an element that occurs multiple times in an 
XML document. Groups are used to control Group Repeat loops by determining how many times the 
Repeat Loop will iterate (that is, once for each unique value). Map actions inside a Group Repeat 
based on a group executes only once for each unique value. A Group is created with a Declare Group 
action. Groups are referenced by an alias name that is associated with the XPath of an element that 
repeats.
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Group(Detail) A Group(Detail) represents the list of all values across an element that occurs multiple 
times in an XML document. Group(detail)s are used to control Group Repeat loops by determining 
how many times the Repeat Loop will iterate (that is, once for every value). Map actions inside a 
Group Repeat based on Group(Detail) executes once for every value in the group. A Group(Detail) 
is created automatically with a Declare Group action. Group(Detail)s are referenced by an alias 
name that is the same as the group appended with the text “(Detail).” Group(Detail) Repeat Loops 
must always be used inside a Group Repeat loop.

Group Name An alias for an XPath expression used to define a group for a Repeat action.

Input Input is the term used to describe how a component accepts data. You specify the format for 
inputs for a component by selecting one or more XML templates when you create the component. 
All components accept one or more XML documents as inputs.

In Value The data in a code table map you wish to translate to a different value in another code table.

Input DOM The Input DOM(s) of a component is the XML document containing XML encoded 
information that you wish to map into an external data source and/or transform into another XML 
document type. The Input DOM(s) is passed into a component by the service (or component) that 
calls it. Components can accept one or more Input DOMs. Services can accept only one Input DOM 
from a Service Trigger, but can accept more than one from another component.

JMS Java Messaging Service: A Sun-defined Java API for implementing a standard set of messaging 
operations and constructs. Most popular message-oriented middleware (MOM) products are either 
JMS-aware or pure JMS implementations.

JDBC Java Database Connectivity.  The Sun-designed Java API for accessing relational database data.

Map A generic term used to indicate the association of a source of data with a target of data for the 
purpose of copying data from the source to the target. For instance, an XML Map component 
associates and copies data between source and target XML documents. A Map action associates and 
copies data between source and target elements or attributes.

Mapping Panes Mapping panes represent sources of data that can exchange information via the Map 
action in a component. Mapping Panes display the DOMs associated with the current component’s 
sample input and output documents and display representations of external data sources such as 
relational databases or 3270 screen transactions.

Markup Markup in XML documents consists of reserved metadata symbols and constructs such as 
start-tags, end-tags, empty-element tags, comments, processing instructions, etc. XML relies on 
certain tokens, such as angle brackets, to have special meaning. When these symbols appear in XML 
data, they generally cause the XML document to be invalid. Converting them to entity form (see 
Entity, above) is one way to pass these “reserved characters” through as XML data. Another way is 
to wrap markup in a CDATA section (see CDATA, above).

MessageListener An object that is created when a JMS Service is deployed. The MessageListener 
object registers with a (preexisting) message queue or topic so that a message arriving at the queue 
automatically “fires” the JMS Service. This provides a messaging-based trigger mechanism for 
Integration Manager services.

Namespace A mechanism to ensure that names used in an XML DTD are unique so that names from 
different DTDs can be combined in the same document.
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Node A node is the basic object used to build a DOM. DOMs consist of a collection of connected 
nodes, some of which are XML elements, some of which are attributes, some of which are 
comments, etc. The node is also an object type in the DOM specification. (Note: attributes, 
documents and elements are all nodes.)

NodeList An object returned by an explicit XPath expression (for example, Input.XPath 
("INVOICEBATCH/INVOICE/INVOICEDATE")) that contains one or more nodes. Nodelists are 
usually used in ECMAScript expressions. Only nodelist methods and properties may be applied to a 
nodelist. To apply any node or element methods to a nodelist, you must first select a single node 
using the nodelist method item().

Output Output is the term used to describe how a component returns data. You specify the format for 
output for a component by selecting an XML template when you create the component. All 
components return a single XML documents as outputs.

Output DOM The Output DOM of a component (or service) is the XML document containing the 
results of any transformations performed in the component. The Output DOM is the XML document 
that is returned to the service (or component) that called the component. Components and services 
can only return one Output DOM. 

Out Value The data in a code table map that will be the new value for an associated In Value (see In 
Value).

POST An HTTP Request Method used in the XML Interchange action.  The POST method is used to 
request that the origin server accept the entity enclosed in the request as a new subordinate of the 
resource identified by the Request-URI in the Request-Line.  The actual function performed by the 
POST method is determined by the server and is usually dependent on the Request-URI.

POST with Response An HTTP Request Method used in the XML Interchange action.  Same as 
POST above except that the XML Interchange action is expecting a response XML object back from 
the origin server.

Project A project is a collection of Integration Manager objects designed to perform XML integration 
services. A project holds all the objects for the application you're building. 

Project File When you create a project, Integration Manager creates a project file which is stored as 
<project name>.spf in the folder you choose. The project file contains start-up information for your 
project.

Project JAR When you deploy a Integration Manager project, all the objects in the project are stored 
in a single JAR (Java Archive) file, which is installed in the application server for production use.

Project Variable A name–value pair created in Integration Manager for adding replaceable 
parameters at the project level for Integration Manager services. Project variables are maintained in 
a separate file (project.xml) which when replaced in a deployed application can change its behavior 
without re-deploying the entire project. Project variables are accessed via a system DOM called 
PROJECT/USERCONFIG.

Public An attribute of a custom script function. Public means the function is directly accessible from 
any action that takes an expression as a parameter and makes the function name appear in the 
Expression Builder pick-lists. Non-public functions can only be called by other functions.

PUBLIC A variant specification for the XML DOCTYPE instruction.  PUBLIC is used to specify a 
DTD intended for widespread use and accessibility.
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PUT An HTTP Request Method used in the XML Interchange action.  The PUT method requests that 
the enclosed entity be stored under the supplied Request-URI.

Resource A resource is an xObject that performs a specialized operation to help services and 
components carry out tasks. Resource types include Code Tables, Code Table Maps, Connections, 
and Custom Scripts. At deployment, resources also refer to XML DTDs/Schema files and XSL 
stylesheets that may be deployed separately from the Project JAR.

ROW TARGET The XPath location that serves as the parent element for rows returned by a SQL 
statement. For each row returned, a ROW TARGET element is created and each column in the row 
becomes a child element of the ROW TARGET.

Schema A schema is similar to an XML document definition in that it helps to validate data. But, 
unlike a document definition, a schema is created in a language that is extensible (i.e. XML). Using 
a schema, you can define precisely which element names are permitted in a document and, within 
each element, which sub-elements, attributes, and relations are allowed. 

Service A service is used to combine the various components you build to create a logical unit of work 
within the application server environment. It is initiated with a request XML document and requires 
a response XML document. The work that is performed and the responsibility of each component 
depends on the design of your application. A service typically executes various components in a 
sequential and/or conditional manner and can even execute other services. Other service-level tasks 
may include general error handling and execution logging operations.

Service Trigger A Service Trigger is a Java Servlet or Enterprise Java Bean created when deploying 
a project from Integration Manager. It submits a Service to the application server for execution. A 
Service Trigger is also associated with an URL and converts inbound data into XML documents as 
input to the Service it triggers.

System A reserved XML template category for immutable XML templates such as {ANY}. 

SYSTEM A variant specification for the XML DOCTYPE instruction.  SYSTEM is used to specify a 
DTD intended for private use by an XML document.

UDDI Universal Description, Discovery and Integration—a public-registry standard that gives 
businesses a way to describe their services and discover other companies' services online. 

Unicode A double-byte character set including thousands of useful characters from around the world. 
See also UTF-8.

URI Uniform Resource Identifier.  An extension to URLs that allows more detailed access to 
information within an URL.

URL An URL is a Uniform Resource Locator that specifies the syntax and semantics of text strings 
used to locate and access resources via the Internet. The basic URL is constructed of a scheme 
identifying the communications protocol and a scheme-specific part identifying the resource; 
<scheme>:<scheme-specific-part>.

Userfunc A keyword used in XPath expressions indicating that the following term is a Custom Script 
function that should not be evaluated as part of the XPath.

UTF-8 A character encoding scheme of the Unicode character set whose first 128 characters are 
compatible with 7-bit ASCII characters allowing many common text editors to create XML.
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W3C The World Wide Web Consortium at http://www.w3.org.  A standards body organized to lead the 
World Wide Web to its full potential by developing common protocols that promote its evolution and 
ensure its interoperability.

WSDL Web Services Definition Language—a standard for describing business services in XML. 
WSDL gives Web Service providers a way to understand the methods necessary to conduct e-
business online, in an automated or semi-automated way, with remote partners.

XML Category An XML category contains XML templates. You create XML categories to organize 
XML templates used in a project.

XML Document Definition An XML document definition is the standard validation method created 
by the W3C. It defines the rules of the document, such as which elements are present and what 
structural relationship exists between the elements. A document definition helps to validate the data 
when the receiving application does not have a built-in description of the incoming data.

XML Meta Data xObjects created in Integration Manager are stored on disk as XML files.  These files 
are often referred to as a project’s meta data. 

XML Sample Document An XML sample document is a representative model of the data your 
application will process in a production environment. Sample documents are used to help build 
accurate Action Models.

XML Template An XML template contains sample documents, a document definition, and an XML 
stylesheet associated with a particular document type. You create XML templates in Integration 
Manager, then use them to describe the inputs and outputs of the components you build.

xObject An xObject is a building block of all data integration services. xObjects include services, 
components, resources, and XML templates.

XPath XPath is a language for addressing parts of an XML document. It is a W3C-recommended 
standard and is used as the primary XML addressing language in Integration Manager.

XPointer XPointer is a language to be used to identify fragments within any URI-reference that locates 
a resource of Internet media type. 

XSL Stylesheet An XSL stylesheet defines the display properties of an XML document. You create 
or obtain the stylesheet external to Integration Manager. A stylesheet is useful for a component that 
is creating a page to be displayed in a Web browser.

XSL XSL is a stylesheet language for transforming XML documents into other XML documents. 
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expanding XML documents 100
exploding the main content window 36

exportObject(key,value) 318
Expression Builder 305
expression builder, definition of 422
expression editor

using 227
using to build functions 226

expression language, XPath 311

F
Fault Messages, Fault Docs 112
file menu 37
File Read action 173
File Reference 395, 396
File Reference (File triggers) 395
File trigger 394

file handling options 395
File Write 173
File-Based Triggers 394
Filter Document 179
filtering, document 119, 180
Find 64
Find command 64
Find Qualifiers, UDDI search 373, 375
Find tab 64
Find tool 107
floating point formats 217
forEach tag 414
Form Designer

about 261
absolute positioning region 265
action elements 279
adding controls 266
aligning controls 267
bind element 279
creating submission element 283
data binding 275
Event Editor 279
events 287
grouping controls 267
input 264
Instance Data Pane 279
instance element 278
layout regions 271
limitations 263
Model Editor 279
model element 278
model item properties 286
moving controls 266
output 264
Pageflow link region 265
Property Inspector 279
range 264
removing controls 266
repeat 265
replacing instance data at runtime 282
secret 264
select 264
shortcut keys 263
sizing controls 266
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styling controls 268
submission element 279
submit button 264
switch 265
testing 300, 301
text area 264
trigger styled as link 264
upload 264
using the Form tab 262
validating XML 302
validation errors 287
XHTML content box 265
XHTML image 264

Form Resources 229
Form tab

about 262
FTP Authentication 214
function

applying to an XPath expression 329
creating and validating 219
testing 220
tool tip description, adding 220
transforming elements 328
using the expression editor to build 226
validating syntax 220

function action 133
adding 133

function expression builder
using 134

function, validating 219
functions

XPath 311

G
gDebugMode 347
General Preferences 44
general purpose extensions 315
GEO locator 375
GET, definition of 422
getSessionValue(key) 319
global search and replace 109
GNVXObjectFactory.isRuntime() 347
group (detail), definition of 423
group name, definition of 423
group, creating 332
group, definition of 422
grouping controls 267
GXSInputFromHttpContent 412
GXSInputFromHttpMultiPartRequest 412
GXSInputFromHttpParams 412
GXSInputFromHttpSpecificParam 412
GXSInputFromJavaObject 412

H
help

menu 39
Help > About 23

HTML, transforming XML to 314
HTTP Basic Authentication 212
HttpServletRequest 412

I
Ignore Namespaces option 158
illegal characters, mapping of 141
Image Resources 230
IMAP 391
Imported xObjects 71
importing

XML Resource 254
XML Templates 83
XSL Resource 260

In Value, definition of 423
input documents, multiple 362
input DOM, definition of 423
input element 108
input mapping pane 103, 104
input, definition of 423
Input.getXML() 391
instance data 279

replacing at runtime 282
Instance Data Pane 263
instance element 278
Instance Pane 42
Instance Pane Context Menu 42
Integration Manager

closing 33
starting 33

Integration Manager Enterprise Server 20
internal applications integration services 21
invoking two components at once 162
isNaN() 308
isRuntime() 347

J
JAR Resources 234
Java

documentation resources 322
example 322, 347
in custom scripts 321
when to use 321

Java class
accessing 224
browser 222
integrating with custom scripts 222
showing content 222

Java Messaging Service 353
Javadoc (deployment-related) 418
JAXR (Java XML Registries) 365
JDBC

definition of 423
JMS Service 356
JMS Services 353
JPEG image resources 230
JSP
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automatic code generation 239
fault handling 413
taglib 409

JSP Resources 237
JSP triggers 397

K
keyword search, UDDI 374
keywords, Java 48

L
labels for XPath 132
large documents 119
large DOMs 119
layout regions 271
LDAP

connection-param lookup via 210
LDAP Expression Editor 210
leaf elements 324
leaf elements, mapping 323
libraries, custom script 305
license string updating 23
license string(s) 23
locators, for UDDI search 375
log action 134

creating 136
system log 135
system output 135
user log 135

log file, clearing 363
Log Level setting 44
Log Levels 135

M
Mail via SMTP Simple Authentication 144
map action

adding 138
definition of 137

map, Code Table 205
map, definition of 423
mapping

advanced options 140
deep copy behavior 140
default behaviors 139
target node autocreation 140

Mapping a Parent and its Children 324
Mapping a parent element without its child elements 325
mapping an input element to an output element 108
mapping CDATA 141
mapping leaf elements 323
mapping pane 108

about 103
context menu 104
definition of 423
input 103

markup, conversion to entities 139
markup, definition of 423
markup, mapping of 141
memory conservation 119, 180
memory, how to increase 119
menu commands, complete listing of 37
Message element, WSDL 244
message oriented middleware 353
Message Parts

temporary 111
MessageListener 356
Messages

Fault 112
Model Editor 279
model element 278
model item properties

about 286
calculate 286
constraint 287
readonly 286
relevant 286
required 286

moving controls 266
multipart/form-data 412
multiple input documents 362
multithreading, components and 162

N
namespace, definition of 423
namespaces 99

ignoring 160
namespaces, Output DOM 99
NaN 308
nested subprojects 71
node 95

automatic creation in mapping 140
definition of 424
ECMAScript extension methods 315

nodelist 316, 317
nodelist, definition of 424
nodes, XPath addressing of 309
Novell Extensions

in custom scripts 315
when to use 320

NTLM Authentication 47
Number() 307

O
Obtaining a stylized view 243
onMessage() method 356
on-the-fly entitizing 139
out of memory 119
Out Value, definition of 424
output 108
Output DOM

namespace issues 99
output DOM 110
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output element 108
output mapping pane 108
output, definition of 424
override Starts With search logic 374

P
Packages (Java access in scripts) 322
packaging issues (deployment) 381
Pageflow link region 265
parameter values, dynamic 305
parent, mapping to a child 324
performance 162

ECMAScript and 308
performance filters 119, 180
persistent globals 66
pick lists 143
POP3 391
Port Type element, adding to WSDL 246
Post with Response 177
POST with response, definition of 424
POST, definition of 424
Preferences 44
printing a component 121
priority levels (logging) 135
private key 200
programmatic execution of components 303
project

creating 53
creating new 54
definition of 424
deleting 58
finding an xObject within a project 64
locating at startup 58
managing 53
opening 56
opening when recent project is not found 57
Save Project As 59
what it is 53

project file
definition of 424
deployed 65
naming 66
where they are stored 65

Project JAR 381
project JAR, definition of 424
Project Settings 48
Project Tab 41
project variable

adding 67
creating 66
definition of 424
dynamic 68
using to turn debugging on or off 347

Project Variables 48
PROJECT.xml 68
Properties dialog 88, 121
Property Inspector 263, 279
proxy settings 46
Proxy Settings dialog 47

PUBLIC, definition of 424
public, definition of 424
Publish/Subscribe 356
Publishing to a registry 377
PUT, definition of 425
putSessionValue(key,value) 319

R
RAM allocation 119
recent project 57
Recent xObjects 38
Recurrence (Timer trigger) 402
Registry browsing 369
registry searching, wildcards and 374
reload XML documents 101
reloading an XML doc 114
removeSessionValue(key) 319
removing controls 266
Repeat Actions 181
repeat for element

creating 104
Repeat for Element action 330
repeat for element action 184
repeat for group

adding 187
Repeat for Group action 186, 331
repeat for group action

creating 332
Repeat While action 188
repeat while action 333

adding 334
replacing text 109
requirements

analyzing 30
requirements for planning service 29
Resetting All Documents 346
resource 54

creating 197
definition of 425
description 28

resources
Certificate 200
COBOL Copybook 216
Code Table 201
Code Table Map 205
Custom Script 217
Form (XForm) 229
Image 230
JAR 234
JSP 237
schema 256
WSDL 240
WSIL 251
XSL 258

resources, Connection 208
result field, changing the format of an object within 327
Retrieving WSDL from the Registry 376
ROW TARGET, definition of 425
running to a breakpoint 340
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runtime
using DOMs 96

S
sample document

loading 115
sample documents 256
Save XML As 89, 118, 119
saving a DOM 117, 118, 119
scheduled versus repetitive tasks 401
schema 79

automatic generation of 256
Schema Generator 256
Schema Resources 256
schema, definition of 425
schemas 156
schemas and DTDs 74
scope of script variables 307
scope/visibility of variables 72
script editor window 219
search 64

within a DOM 107
search logic 374
searches 64
searching

UDDI registries 374
Searching by business in the Registry Manager 371
Searching by service in the Registry Manager 374
Send Mail action 144
sentinel variable 347
server profiles 383
service 53

action model, an example 361
building 31
building with components 361
calling from JSP 411
creating 353
creating new 356
data passing 362
deploying 31
description 28
designing 30
editor 360
editor, using 360
example 355
executing a component that is not called directly 362
execution 31
importing 359
loading sample documents as you test 364
logging activity in a single file for each component called 363
multiple input documents to 362
passing data between different types of components 362
requirements 29
specifying XML templates 356
what they are 19
WSDL 354

service element, WSDL 248
service trigger, definition of 425
service triggers 380

drag-and-drop UI 389
EJB 392
E-mail 391
File 394
JSP 397
JSP-based 239
servlet 398
SOAP HTTP 399
Timer 401
XML data and 380

Service Types 353
service, definition of 425
services 41
Services, Components, and Resources Pane 41
servlet triggers 398
session variables 318
setting a value 108
Show/Hide 84
Simultaneous Components Action 162
sizing controls 266
SMTP Simple Authentication 144
SOAP services 399
SOAP trigger 399
Sort By, Registry search 373, 375
source code, taglib 418
spawned components 162
split() 308
staging directory 381
stepping into an action 341
stepping over an action 343
style as link 274
styling controls 268
Stylized View 243
stylized view 87, 106
Stylized view of a WSDL document 243
submission element 279
Subprojects 48, 70
Switch Action 149
Switch example 149
synchronization of spawned components 163
syntax checking, ECMAScript 305
System button on About dialog 23
system log 135
system log, preferences 44
system messages

Log Levels and 44
system output 135
SYSTEM, definition of 425
System, definition of 425

T
Tag API (Integration Manager JSP taglib) 411
tag library API 409
taglib

forEach tag 414
Temp XML Document 97, 358
Template Categories 75
template importing 83
Templates 41
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templates
workiing with 87

templates, XML
deleting 91
instance pane 76
moving 91
renaming 91
viewing 88

temporary Message Parts 111
testing a component 122
testing XForms 301
text search

in DOMs 107
in xObjects 64

text view 106
theComponent (script global) 318
threading of components 162
thresholds, logging 135
Throw Fault action 163
tiling windows 36
Timer trigger 401

Recurrence parameter 402
tModel 373
To publish to a registry 377
To search businesses by keyword in the Registry Manager 371
To search services by keyword in the Registry Manager 374
Todo Action 152
Todo items

tracking 153
toggling a breakpoint 339
tools menu 38
Tracing 39
Transaction action 165
Transaction Attribute 393
transforming elements 325

using content editor 326
transformNodeViaDOM() 314
transformNodeViaXSLURL() 314
tree view 105
triggering 354
triggers 264
triggers (see service triggers) 380
try/catch 308
Try/On Fault action 167

U
UDDI

search techniques 374
tModel 373

UDDI (Universal Description, Discovery and Integration 365
Unicode, definition of 425
unlocking Connects 23
UNSPSC 375
updating license strings 23
URI, definition of 425
URL File Read 173
URL, definition of 425

URLs, deployment and 399
user log 135
USERCONFIG 68
Userfunc

 329
Userfunc, definition of 425
Using DOMs at Runtime 119
UTF-8, definition of 425

V
Validate button 305
Validating a WSDL document 250
validating XML 302
validation of input docs 79
variables, session 307, 318
view menu 38
view options, DOM 105
Visual Editor 263
VM_PARAMS 119

W
W3C, definition of 426
web service

calling via WS Interchange 174
interchange action 174

Web Service Interchange action 174
Web Services 354
Web Services (Chapter 13) 353
web.xml 410
web-xml 381
wildcard search (illustration) 376
wildcard searching using * 64
wildcards in UDDI search 374
window arrangement 36
window controls 36
window layout 101
window menu 39
WS Interchange action 174
WSDL 174

adding elements to 244
binding element 247
message element 244
portType element 246
publishing to registry 377
retrieval, UDDI and 376
retrieving from registry 376
service element 248
stylized view 243
type-ahead, in editor 249
validation 250

WSDL and Integration Manager services 354
WSDL editor 244
WSDL Resources 240
WSIL (Web Services Inspection Language) 365
WSIL Resources 251
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X
x509 certificate 200
xc_api folder 418
xconfig.xml 49
xcs-src.jar 418
XForm Resources 229
XForms 265, 287

about 261
absolute positioning region 265
action element 279
Actions 290
bind element 279
custom event handlers 300
delete action 290
dispatch action 291
Event Editor 288
events 287
HTML content box 265
input 264
insert action 292
instance element 278, 279
launching Event Editor 288
load action 293
message action 294
model element 278
model item properties 286
output 264
preview 301
range 264
Rebuild action 295
Recalculate action 295
Refresh action 295
repeat 265
Reset action 296
Revalidate action 295
secret 264
select 264
send action 296
set focus action 297
set index action 297
set value action 298
submission element 279
submit button 264
switch 265
testing 300, 301
text area 264
toggle action 299
trigger styled as link 264
trigger, Form Designer 264
upload 264
validation XML 302
XHTML image 264

XForms validation errors 287
XML

content, adding 221
Resource 253
templates 29
validation of 74

XML category
definition of 426

XML document
collapse 100
expand 100
reload 101
reloading 114
samples 73
viewing 88

XML document definition, definition of 426
XML documents

viewing in Custom Script editor 221
XML Interchange

performance filters in 179
XML interchange action 177

adding 177
XML map component

creating 93, 96
definition 93
editor 99
using XML template sample documents to build one 93

XML meta data, definition of 426
XML sample document, definition of 426
XML Schema Resources 256
XML Template

generating from schema 81
XML template 54, 75

creating 77
definition of 426
deleting 91
description 29
editing 88
importing 83
moving to a different category 91
organizing 73
renaming 91
using samples to build an XML map component 93
where they are stored on your hard drive 91
working with 87

xObject
creating 59
definition of 426
deleting 63
displaying properties 62
importing 62
managing 59
printing properties 62
renaming 63
searching for 64

xObjects, imported 71
XPath

applying a function 329
basic method 137
context 309
custom labels (alias) 132
definition of 426
documentation resources 313
example 310
examples (Table) 313
expression builder 141
functions 311
in custom scripts 309
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in ECMAScript 311
in groups 311
in the map action 310
syntax 141
target audience 309
when to use 309

XPath syntax rules summary 141
XPath() method in Integration Manager 309
XPointer, definition of 426
XSD 75, 79

automatic generation from sample 256
XSD resources, creating 256
XSL 75

an example 315

definition of 426
documentation resources 315
in custom scripts 314
style sheet, definition of 426
style sheets 73
target audience 314
templates 73
what it is 314
when to use 314

XSL Resource 258
XSL stylesheet, stylized DOM view 106
XSLT (XSL Transformations) 314
XSLT Transform action 170, 314
xuserpref.xml 49
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